EPO Online Filing

User guide

OLF software version 5.10
Table of contents

1 Legal notices ................................................................. 9

2 Introduction ............................................................................. 10
  2.1 Help and Support ........................................................................ 10
  2.2 Typographical conventions .......................................................... 11

3 Overview of Online Filing ......................................................... 12
  3.1 Network-based online filing .......................................................... 14
  3.2 National procedures in Online Filing ............................................. 16
  3.3 Updating the Online Filing software ............................................. 17
  3.4 Help on using Online Filing .......................................................... 18

4 File Manager ............................................................................ 20
  4.1 Toolbars ................................................................................... 22
  4.2 Folders ..................................................................................... 24
  4.3 Applications .............................................................................. 26
    4.3.1 Creating a new application ....................................................... 27
    4.3.2 Saving applications ................................................................ 28
    4.3.3Renaming applications ............................................................... 29
    4.3.4 Moving applications ................................................................ 30
    4.3.5 Deleting applications ............................................................... 30
    4.3.6 Previewing applications ............................................................ 31
  4.4 Templates ................................................................................ 33
    4.4.1 Creating a new template ........................................................... 33
    4.4.2 Using a template .................................................................... 36
    4.4.3 Modifying a template ............................................................... 37
  4.5 Workflow and status ................................................................... 38
    4.5.1 Changing the status of an application in File Manager .......... 39
    4.5.2 Changing the status of an application in the form ................. 40
  4.6 Validation ................................................................................ 41
  4.7 Internal Notes ........................................................................... 43
  4.8 Address Book .......................................................................... 45
    4.8.1 Creating names in the Address Book ....................................... 47
    4.8.2 Routes and roles .................................................................... 48
    4.8.3 Adding names from the Address Book to a form ................. 49
    4.8.4 Saving names from a form to the Address Book .................. 50
    4.8.5 Exporting Address Book names .............................................. 52
    4.8.6 Importing Address Book names .............................................. 54
  4.9 User Preferences ..................................................................... 57
    4.9.1 Startup ............................................................................... 57
    4.9.2 Language ............................................................................ 57
# Table of contents

4.9.3  Signing preferences ................................................................. 58
4.9.4  Confirmations ........................................................................... 58
4.9.5  Working directories ................................................................. 59
4.9.6  Network settings ...................................................................... 60

4.10  System Preferences ..................................................................... 61
4.10.1 Security and user management .................................................. 62
4.10.2 Password policy ......................................................................... 62
4.10.3 Signing settings .......................................................................... 65
4.10.4 Runtime variables ...................................................................... 66
4.10.5 PMS gateway interface ............................................................. 66
4.10.6 Filing settings ........................................................................... 68

4.11  User Administration ..................................................................... 69
4.11.1 Users ......................................................................................... 71
4.11.2 Unblocking users ...................................................................... 73
4.11.3 Changing your password ........................................................... 75
4.11.4 Groups ..................................................................................... 76
4.11.5 Profiles for group authorisations ............................................... 78
4.11.6 List of privileges ........................................................................ 80
4.11.7 Mapping profiles to groups ......................................................... 83
4.11.8 Sharing folders with groups ....................................................... 84

4.12  Fee management ......................................................................... 86

4.13  Maintenance table viewer ............................................................. 88

5  Processing applications ................................................................. 90
5.1  Preparing documents for attachment ............................................. 90
5.2  Signing applications ..................................................................... 92
5.2.1  Alphabetical signatures ............................................................. 95
5.2.2  Facsimile signatures .................................................................. 97
5.2.3  Smart cards ................................................................................ 99
5.2.4  Checking the smart card ............................................................ 102
5.2.5  Soft certificates .......................................................................... 103
5.2.6  Non-repudiation signature ........................................................ 105

5.3  Sending applications ................................................................... 106
5.3.1  Viewing receipts ......................................................................... 107
5.3.2  Batch sending ........................................................................... 108

5.4  Exporting data from Online Filing ............................................... 109
5.4.1  Exporting items .......................................................................... 110
5.4.2  Deleting items from the database after archiving ...................... 112
5.4.3  Exporting data as XML to ZIP file .............................................. 113
5.4.4  Exporting data as XML to folder ................................................ 113

5.5  Importing data into Online Filing .................................................. 115
5.5.1  Importing data as XML from ZIP file .......................................... 115
5.5.2  Importing data as XML from folder ........................................... 117
# Table of contents

7.6  Euro-PCT(1200E2K) – Fee Payment.............................................................. 203
  7.6.1  Payment details.......................................................................................... 204
  7.6.2  Fee selection............................................................................................. 206

7.7  Euro-PCT(1200E2K) – Annotations .............................................................. 209

7.8  Reusing previous data for filing with Euro-PCT(1200E2K).......................... 210

8  EP(1038E) 211

8.1  EP(1038E) – Application Number ............................................................... 213

8.2  EP(1038E) – Names ..................................................................................... 213

8.3  EP(1038E) – Requests .................................................................................. 215
  8.3.1  Request for accelerated search/examination (Form 1005) ..................... 215
  8.3.2  Enquiry as to the processing of the file (Form 1012) ........................... 217

8.4  EP(1038E) – Documents ............................................................................ 218
  8.4.1  Document types for EP(1038E) by category ....................................... 219
  8.4.2  Attaching documents............................................................................. 225
  8.4.3  Filing non-public documents ................................................................. 227
  8.4.4  Filing appeal documents ...................................................................... 228
  8.4.5  Viewing attached documents ................................................................. 230

8.5  EP(1038E) – Fee Payment .......................................................................... 230
  8.5.1  Payment details........................................................................................ 231
  8.5.2  Fee selection............................................................................................ 234
  8.5.3  Designation of states.............................................................................. 238

8.6  EP(1038E) – Annotations .......................................................................... 239

8.7  Reusing previous data for filing with EP(1038E) ......................................... 240

9  EP(Oppo) 242

9.1  EP(Oppo) – Opposition ............................................................................... 245
  9.1.1  Reference ............................................................................................... 246
  9.1.2  Grounds.................................................................................................... 247

9.2  EP(Oppo) – Names ....................................................................................... 248
  9.2.1  Persons in conjunction with "Notice of opposition or intervention" ....... 248
  9.2.2  Persons in conjunction with "Other action" ............................................ 252

9.3  EP(Oppo) – Requests ................................................................................... 254

9.4  EP(Oppo) – Documents ............................................................................... 258
  9.4.1  Document types for EP(OPPO) as defined by functional role ............ 259
  9.4.2  Attaching documents............................................................................. 260
  9.4.3  Filing non-public documents ................................................................. 263
  9.4.4  Evidence - publications ....................................................................... 264
  9.4.5  Evidence - other.................................................................................... 265

9.5  EP(Oppo) – Fee Payment ............................................................................ 266

9.6  EP(Oppo) – Annotations ............................................................................ 269

9.7  Previewing the completed form ................................................................... 270
## 10 PCT/RO/101

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1</td>
<td>Creating a new PCT/RO/101 application</td>
<td>276</td>
</tr>
<tr>
<td>10.1.1</td>
<td>Saving the form</td>
<td>278</td>
</tr>
<tr>
<td>10.1.2</td>
<td>Working with templates</td>
<td>279</td>
</tr>
<tr>
<td>10.2</td>
<td>PCT/RO/101 – Request</td>
<td>281</td>
</tr>
<tr>
<td>10.3</td>
<td>PCT/RO/101 – States</td>
<td>284</td>
</tr>
<tr>
<td>10.4</td>
<td>PCT/RO/101 – Names</td>
<td>286</td>
</tr>
<tr>
<td>10.4.1</td>
<td>Applicant</td>
<td>288</td>
</tr>
<tr>
<td>10.4.2</td>
<td>Inventor</td>
<td>292</td>
</tr>
<tr>
<td>10.4.3</td>
<td>Agent</td>
<td>294</td>
</tr>
<tr>
<td>10.4.4</td>
<td>Power of attorney document</td>
<td>297</td>
</tr>
<tr>
<td>10.4.5</td>
<td>Adding names from the Address Book to a form and vice versa</td>
<td>300</td>
</tr>
<tr>
<td>10.5</td>
<td>PCT/RO/101 – Priority</td>
<td>303</td>
</tr>
<tr>
<td>10.6</td>
<td>PCT/RO/101 – Biology</td>
<td>306</td>
</tr>
<tr>
<td>10.7</td>
<td>PCT/RO/101 – Declarations</td>
<td>308</td>
</tr>
<tr>
<td>10.7.1</td>
<td>Declaration as to the identity of the inventor</td>
<td>309</td>
</tr>
<tr>
<td>10.7.2</td>
<td>Declaration as to applicant’s entitlement to apply for and be granted a patent</td>
<td>310</td>
</tr>
<tr>
<td>10.7.3</td>
<td>Declaration as to applicant’s entitlement to claim priority</td>
<td>311</td>
</tr>
<tr>
<td>10.7.4</td>
<td>Declaration of inventorship</td>
<td>312</td>
</tr>
<tr>
<td>10.7.5</td>
<td>Declaration as to non-prejudicial disclosures or exceptions to lack of novelty</td>
<td>314</td>
</tr>
<tr>
<td>10.7.6</td>
<td>Previewing declaration sheets</td>
<td>315</td>
</tr>
<tr>
<td>10.8</td>
<td>PCT/RO/101 – Contents</td>
<td>316</td>
</tr>
<tr>
<td>10.8.1</td>
<td>International Application</td>
<td>319</td>
</tr>
<tr>
<td>10.8.2</td>
<td>PDF attachments</td>
<td>320</td>
</tr>
<tr>
<td>10.8.3</td>
<td>Single specification file (PDF)</td>
<td>322</td>
</tr>
<tr>
<td>10.8.4</td>
<td>XML attachments</td>
<td>325</td>
</tr>
<tr>
<td>10.8.5</td>
<td>Accompanying Items</td>
<td>327</td>
</tr>
<tr>
<td>10.8.6</td>
<td>Sequence listing</td>
<td>329</td>
</tr>
<tr>
<td>10.8.7</td>
<td>Pre-conversion archive</td>
<td>332</td>
</tr>
<tr>
<td>10.9</td>
<td>PCT/RO/101 – Fees</td>
<td>334</td>
</tr>
<tr>
<td>10.10</td>
<td>PCT/RO/101 – Payment</td>
<td>336</td>
</tr>
<tr>
<td>10.10.1</td>
<td>Signing the deposit account authorisation</td>
<td>338</td>
</tr>
<tr>
<td>10.11</td>
<td>PCT/RO/101 – Annotate</td>
<td>338</td>
</tr>
<tr>
<td>10.11.1</td>
<td>Designating inventor for certain states only</td>
<td>342</td>
</tr>
<tr>
<td>10.12</td>
<td>Processing the PCT/RO/101 application</td>
<td>343</td>
</tr>
<tr>
<td>10.12.1</td>
<td>Signing the form</td>
<td>344</td>
</tr>
<tr>
<td>10.12.2</td>
<td>Sending the form</td>
<td>346</td>
</tr>
<tr>
<td>10.12.3</td>
<td>Exporting and importing a form</td>
<td>347</td>
</tr>
</tbody>
</table>

## 11 PCT-SFD

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>PCT-SFD</td>
<td>349</td>
</tr>
</tbody>
</table>
11.1 PCT-SFD – Application ........................................................................ 351
  11.1.1 Filing office and capacity in which it is acting .............................. 351
  11.1.2 Past record ................................................................................ 352

11.2 PCT-SFD – Names ............................................................................. 353

11.3 PCT-SFD – Documents ...................................................................... 353
  11.3.1 Documents filed with the Receiving Office (RO) ......................... 353
  11.3.2 Documents filed with the International Searching Authority (ISA) .... 357
  11.3.3 Documents filed with the International Preliminary Examining
       Authority (IPEA) ............................................................................ 359
  11.3.4 Documents filed with the Supplementary International Searching
       Authority (SISA) ............................................................................ 362
  11.3.5 Attaching PDF documents .......................................................... 363
  11.3.6 Attaching sequence listings ....................................................... 365
  11.3.7 Viewing attached documents ...................................................... 367

11.4 PCT-SFD – Fee Payment .................................................................... 368
  11.4.1 Payment details ........................................................................... 368
  11.4.2 Fee selection .............................................................................. 370
  11.4.3 Fees payable to the Receiving Office (RO) .................................. 372
  11.4.4 Fees payable to the International Searching Authority (ISA) ......... 373
  11.4.5 Fees payable to the International Preliminary Examining Authority
       (IPEA) ............................................................................................. 374
  11.4.6 Fees payable to the Supplementary International Searching
       Authority (SISA) ............................................................................ 376

11.5 PCT-SFD – Annotations .................................................................... 376

11.6 Signing an application with Form PCT-SFD ..................................... 377

12 PCT-DEMAND (PCT/IPEA/401) ................................................................. 379
  12.1 PCT-DEMAND – Demand ................................................................. 380
  12.2 PCT-DEMAND – Names ................................................................. 382
    12.2.1 Applicant ............................................................................... 382
    12.2.2 Agent .................................................................................... 384
    12.2.3 Address for correspondence .................................................. 385
  12.3 PCT-DEMAND – Examination Basis .............................................. 386
  12.4 PCT-DEMAND – Documents .......................................................... 388
    12.4.1 Examination documents .......................................................... 388
    12.4.2 Accompanying items ............................................................... 391
    12.4.3 Attaching sequence listings ...................................................... 392
    12.4.4 Pre-conversion archive ............................................................ 393
    12.4.5 Viewing attached documents ................................................... 394
  12.5 PCT-DEMAND – Fee Payment ......................................................... 395
    12.5.1 Fee selection ........................................................................... 396
    12.5.2 Payment details ....................................................................... 396
# Table of contents

12.5.3 Viewing the fee sheet ......................................................................................... 398
12.6 PCT-DEMAND – Annotations ............................................................................... 399

## 13 Server Manager  
401

13.1 Server Manager overview .................................................................................. 402
13.2 Services management ......................................................................................... 403
13.3 Database management (Backup) .......................................................................... 406
  13.3.1 Backing up database .................................................................................... 407
  13.3.2 Restoring database ....................................................................................... 409
  13.3.3 Creating a new empty database .................................................................... 410
13.4 Exporting items .................................................................................................. 411
13.5 Importing items .................................................................................................. 413
13.6 User sessions ........................................................................................................ 414
13.7 Unlocking forms .................................................................................................. 416
13.8 History ................................................................................................................ 418
13.9 Settings ................................................................................................................ 418
  13.9.1 Settings for file locations .............................................................................. 419
  13.9.2 Default Network Settings ............................................................................ 420
13.10 Live Update ........................................................................................................ 420
  13.10.1 Settings for Live Update .............................................................................. 421
  13.10.2 Downloading updates ................................................................................. 424
  13.10.3 Installing updates ....................................................................................... 426
13.11 Data Migration .................................................................................................... 428
  13.11.1 User Data Migration .................................................................................... 428
  13.11.2 Database Migration ...................................................................................... 430

## 14 Glossary  
432

## 15 Index  
435
1 Legal notices

Copyright
© European Patent Office (EPO), 2016. All rights reserved.
Accurate reproduction of EPO-created information contained in this documentation is authorised, provided the source is acknowledged and unless otherwise stated (e.g. that use is restricted or subject to prior permission).
Further use of third-party works requires permission from the copyright holder, unless this is waived under the law applicable.

Trade marks and logo
The EPO's official logo is likewise protected worldwide as an emblem of an international organisation under the Paris Convention for the Protection of Industrial Property.

Disclaimer
EPO Online-Services and the associated data from EPO databases are regularly maintained and updated. Great care has likewise been taken in writing the instructions for using the services provided, to ensure that the information supplied is correct. Furthermore, the EPO makes every effort to prevent technical malfunctions. Given the amount of data and information provided, however, it is not possible to rule out all errors and omissions.
The EPO therefore accepts no liability for the completeness and accuracy of the data and information made available in connection with these services, and it does not guarantee that the underlying files and the formats used are error-free and will not cause the user's systems to malfunction. Nor can the EPO guarantee that the information presented in this documentation about the functionality and use of these services is fully up to date, complete, and without any errors or mistakes.

Other access conditions
The EPO reserves the right to modify, extend or discontinue the available services, in full or in part, without prior notice.

Using the Online Filing software (OLF)
The EPO grants users the right to use the Online Filing software free of charge for an unlimited period. The software is exclusively intended for online filing with the EPO, i.e. for European patent applications and other documents.
Please refer to the EPO's website and go to Applying for a patent > Online services > Online filing > Download documentation (http://www.epo.org/applying/online-services/online-filing/documentation.html) to download the most recent version of the Conditions for the loan and use of the Online Filing software (http://docs.epoline.org/onlinefilingdocs/olf-license-en.pdf).
2 Introduction

Intended audience
This guide is intended for users of the Online Filing software and EPO Online Services. To use EPO Online Services, you need a username and a smart card registered and supplied free of charge by the EPO. You can enrol for a smart card using the enrolment form provided on the EPO website (http://www.epo.org/online-services).

What this guide contains
This guide details the features of the Online Filing Software and describes the processes for submitting patent applications or subsequently filed documents electronically. Online Filing supports applications via the EP and PCT routes as well as the use of additional national filing routes with the EPO as interface.

Additional information
The information presented in this document may change over time as online services develop. The latest documents and software updates are available for download from the EPO website (http://www.epo.org/online-services).

2.1 Help and Support

The EPO operates a helpdesk for Online Filing users. Send us your question using our contact form on the EPO website at www.epo.org/contact-form. Our experts will get back to you as soon as possible.
You can also reach us by phone or e-mail:

<table>
<thead>
<tr>
<th>Open:</th>
<th>Monday to Friday, 08:00 to 18:00 (CET)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phone:</td>
<td>00800 8020-2020 (free call from most countries worldwide)</td>
</tr>
<tr>
<td>E-mail:</td>
<td><a href="mailto:support@epo.org">support@epo.org</a></td>
</tr>
<tr>
<td>Internet:</td>
<td>Online filing on the EPO website: <a href="http://www.epo.org/online-filing">www.epo.org/online-filing</a></td>
</tr>
<tr>
<td></td>
<td>Contact us online on the EPO website: <a href="http://www.epo.org/contact">www.epo.org/contact</a></td>
</tr>
<tr>
<td></td>
<td>Visit the Online filing discussion forum (English only): <a href="http://forums.epo.org/onlineservices-your-say-online-filing/">http://forums.epo.org/onlineservices-your-say-online-filing/</a></td>
</tr>
</tbody>
</table>
### 2.2 Typographical conventions

The following text styles identify special information.

<table>
<thead>
<tr>
<th>Style</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
<td>Interactive elements in the application such as windows, options, menu items, icons, buttons and data entry fields.</td>
</tr>
<tr>
<td><strong>Text Entry</strong></td>
<td>Text that you type in data entry fields.</td>
</tr>
<tr>
<td><strong>KEY</strong></td>
<td>Keys that you press on your computer keyboard, e.g. P, ALT or CTRL.</td>
</tr>
<tr>
<td><strong>KEY1+KEY2</strong></td>
<td>Keys that you press at the same time: hold down KEY1 and press KEY2.</td>
</tr>
<tr>
<td><strong>Filename.ext</strong></td>
<td>Name and extension of files used in Online Filing.</td>
</tr>
</tbody>
</table>
3 Overview of Online Filing

Online Filing version 5.10 lets you file EP, Euro-PCT and PCT applications with the EPO and make submissions within the opposition, appeal, limitation and revocation procedures. It also lets you submit subsequently filed documents for all EP procedures. EPO Online Filing can furthermore be used to submit applications and documents to participating national offices. The EPO recommends that all applicants use the Online Filing software for their filings to the EPO. This method guarantees the quality of the data and documents transmitted. As soon as the EPO receives the electronic application, you are sent a receipt with the application number and the date of filing. What is more, the EPO grants Online Filing users a reduction on certain fees.

If you file an application online with the EPO, you should use the same procedure, where possible, for subsequent communications and document submission. In particular, you should not send a confirmation fax or letter to the EPO by post.

Running Online Filing
The Online Filing software opens with File Manager. Log on by entering the user name and password you were assigned by the Online Filing Administrator. User names are associated with roles that allow you to perform certain tasks on the system. Online Filing only allows you to use the options appropriate to the role assigned to your user name - e.g. only certain roles may add or remove signatures.

Online Filing modes
Online Filing operates in two different work environments: production mode or demo mode. The appropriate mode is selected when starting File Manager.

Production mode is for real filings. The default is production mode. You can also set this startup mode in User Preferences (p. 57).

Demo mode is provided to allow users to practice the processes of completing, signing and sending applications, without submitting a real filing. Demo mode transmissions go to a different EPO server address from production transmissions and submissions are only confirmed by a demo receipt.

All settings, forms, applications and Address Book entries, as well as users, groups and user profiles are specific to the current mode, i.e. demo mode or production mode, to ensure that any work in one is kept entirely separate from the other.
File Manager

File Manager is the central administration interface for using the Online Filing suite. This is where you organise your applications and track their processing status.

- Create folders for applications and templates
- Edit applications in the workflow process (Draft - Sign - Send)
- Check the legal and formal requirements of applications
- Export applications
- Save names and contact details in the Address Book
- Customise File Manager to suit individual user preferences
- Create user names and manage user privileges
- Set up your own password policy
- Manage general system settings.

Electronic Forms

At the EPO, electronic online filing is available for the following procedures – also referred to as forms – which can be found in the Forms folder in File Manager:

  Form EP(1001E2K) is the default form used for requesting the grant of a European patent and examination of the application under Article 94 EPC. The application can be filed directly to the EPO or via one of the participating national offices.

- **EP(1038E) – Subsequently filed documents (in EP procedures)**
  All subsequently filed documents should be submitted using Form EP(1038E), except in the opposition procedure, when they should be submitted with Form EP(Oppo) (p. 242). Form EP(1038) can also be used to submit an appeal and/or documents filed subsequently in appeal proceedings. If you file documents and fees related to an appeal, you cannot file other documents or fees, i.e. non-appeal-related documents or fees – at the same time.
  Non-public documents can also be filed with Form EP(1038E). Please note that you cannot file non-public documents at the same time as any other documents, i.e. public documents. Nor can you file non-public documents at the same time as you pay fees related to public documents.
  You can also use Form EP(1038E) exclusively to pay a fee.
  At present, Online Filing does not allow the filing of priority documents, with the exception of US certified priority documents.

- **Euro-PCT(1200E2K) – Entry into the European phase (EPC 2000)**
  Euro-PCT(1200E2K) is the form used for entry of an international application into the European phase before the EPO as designated or elected office.

- **EP(Oppo) – EP opposition**
  The EP(Oppo) form is used for filing an opposition and/or submitting subsequently filed documents in opposition proceedings (not for appeal proceedings). It should be used by all parties involved in opposition proceedings.
3 Overview of Online Filing

- **PCT/RO/101 – PCT/RO/101 Request**
  You can use Form PCT/RO/101 to submit an international application filed under the PCT to the EPO. You can define the EPO as both receiving office (RO) and international searching authority (ISA).

- **PCT-SFD – PCT Subsequently filed documents**
  You can use Form PCT-SFD to file documents submitted after the filing of an international application under the Patent Cooperation Treaty (PCT). You can also use it to select the fees for the subsequently filed documents and the way you want to pay them.

- **PCT-DEMAND – PCT Demand (PCT/IPEA/401)**
  Form PCT/IPEA/401 is used for filing demands for international preliminary examination according to Chapter II of the Patent Cooperation Treaty (PCT).

The electronic forms are structured along the same lines as traditional paper forms to simplify data entry. You can open and work in several forms at the same time. You can create new applications and produce your own templates by copying your drafts and applications already filed.

**Server Manager**

The Server Manager tool allows the Online Filing administrator to manage services, servers and databases.

- Monitor, start and stop services
- Activate and deactivate services for national procedures
- Backup and restore databases
- Export and import data
- Manage user connections to the server
- Monitor and log the progress of all actions
- Configure and run Live Update for software updates
- Select countries for the update of national procedures via Live Update
- Migrate either the user configuration or the Online Filing database.

### 3.1 Network-based online filing

Online Filing is a client-server application and can be configured as either a stand-alone installation or a network installation.

In a **stand-alone installation**, the client and server both run on the same computer. There is usually only one user here who is also the administrator.

For **network installation**, the Online Filing server is installed with the database on a specific computer in the applicant’s company or a patent attorney firm. This server centrally administers all applications, data and users. The individual users have an Online Filing client installed on their PC workstations. Data is accessed via the company network or via a private internet connection (VPN tunnel), allowing persons working at discrete locations all over the world to co-operate on joint applications.
User authorisation and authentication
The data and software functions released for users in Online Filing are specified individually by the administrator. An application that is being processed by a user is locked for all other users, but is available in read-only mode. All users can see who edited and saved the application last, ensuring that workflows remain transparent and fully documented. Smart cards (p. 99) are used for signing applications as well as for authentication when making transmissions to the EPO. All users who have signing and sending privileges need their personal smart card with PIN and a smart card reader in their offices.

Network settings when installing Online Filing
The exchange of data between the client and the server is managed by the computer network. How the data is exchanged is defined by the network protocol. The Online Filing server works with two different protocols - CORBA and SOAP - and reserves individual ports for each service.
CORBA is recommended, since SOAP considerably slows down the rendering of the graphical user interface. Also, SOAP does not work with procedure PCT/RO/101. However, SOAP is useful when the server is accessed via a WAN through a firewall.
During the Online Filing client setup, you are prompted to specify the settings for the connection to the server. CORBA is set by default.
➢ Enter the correct IP address of the server or its computer name in your network (available from your system administrator).

The localhost address should only be used if the client and server are running on the same logical PC.

![Figure 2: Setting the server address when installing the client](image)
When configuring the Online Filing server, you have the option of entering a specific port for each individual procedure. You can leave the default ports, provided that they are not already otherwise assigned in your network. Ask your network specialist or system administrator for more information.

![Figure 3: Settings for CORBA and SOAP ports during installation](image)

For more information on installing Online Filing, refer to the installation manual, which is available from the EPO website at [Online services > Online filing > Download documentation](http://www.epo.org/applying/online-services/online-filing/documentation.html).

### 3.2 National procedures in Online Filing

All national procedures compatible with Online Filing are integrated by default in the software as standalone plug-ins and are systematically installed. Individual plug-ins can be activated and deactivated subsequently as required in Server Manager; see Services management (p. 403).

You can select the options **Typical** and **Custom** when setting up Online Filing as a server installation or stand-alone installation.

**Typical installation**
- Installs all national plug-ins without activating them

**Custom installation**
- Installs the default services and all national plug-ins
- Also activates selected national plug-ins
For more information on installing Online Filing, refer to the installation manual, which is available from the EPO website at Online services > Online filing > Download documentation (http://www.epo.org/applying/online-services/online-filing/documentation.html).

For an overview of all national procedures, see the EPO website at Online services > Online filing > Online Filing in national offices (http://www.epo.org/applying/online-services/online-filing/national.html).

### 3.3 Updating the Online Filing software

The EPO is constantly developing and upgrading the Online Filing system and software in response to customer requirements to improve performance, data quality and workflow. All software updates are made available via the Live Update service, and installation files are published on the EPO website for manual download.

**Live Update**

The EPO recommends that all software users configure the Live Update function. This ensures that you are always using the latest version of Online Filing, incorporating the most recent procedural and fee changes, for your submissions. Live Update also lets you download and install updates for specific national procedures. For details on how to use and configure this tool, see Live Update (p. 420) in the Server Manager section of this manual.

**Manual Update**

A chronological list of all downloadable updates for version 5.0 can be found on the EPO website at Online services > Online filing > Download software for filing with the EPO (http://www.epo.org/applying/online-services/online-filing/download.html).

**Release notes**

The new features and changes implemented by the current and previous Online Filing software updates are listed at Online services > Online filing > Download software for filing with the EPO > Version 5 (http://www.epo.org/applying/online-services/online-filing/download/version-5.html).

**RSS feed**

If you would like to keep abreast of all new versions, updates, patches and maintenance data, you can subscribe to the EPO Online Services RSS feed. The RSS feed will then notify you as soon as new software modules are available for download. For the link to the RSS feed visit the Online services page (http://www.epo.org/online-services) or go to http://www.epo.org/rss/online-services.xml.
3.4 Help on using Online Filing

Apart from reading this guide, there are other things you can do to get help on using the Online Filing software.

Contacting EPO User Support

- In the menu, click Help > Info.

The About File Manager window provides contact details for EPO User Support as well as information on the type of installation and the build numbers for the modules currently installed. It is important to have this data to hand when talking to Customer Services. Contact details for the national patent offices can also be found in the upper part of the window.

- To see more addresses, scroll down this pane.

The lower part of the window contains information on all the national procedures installed.

- To see all the plug-ins, scroll down this pane.

![About File Manager](image)

Figure 4: Helpful information on Online Filing

Creating a diagnostic file

When you contact EPO User Support, it is always useful to have detailed information on your OLF system setup at hand. The helpdesk can then get a clear picture of how your Online Filing software is configured and this can enable the support staff to help you efficiently with advice and troubleshooting.

You can export all the relevant information, i.e. version number, installed plug-in versions, installed patches, original installation settings and server configuration, into a diagnostic file and mail this to EPO User Support.

- Start the Online Filing Server Manager.
- In the menu, click Help > Create diagnostic file.
- Note the warning message in the next dialog window.
- Click Create.
Online Filing Server Manager exports all relevant data into the `EPOolfDiagnostic.txt` file. You are prompted to select the storage location for the diagnostic file on your hard disk.

- Open the `EPOolfDiagnostic.txt` file in Windows Notepad to inspect the contents including the warning message.
- If required, you can now modify the file's contents before sending it to EPO User Support.

![EPOolfDiagnostic.txt file in Windows Notepad](image)

**Figure 5: Contents of the diagnostic file in Windows Notepad**

**Online help**

Online Filing's integrated online help files contain all information from this user guide for reference. An index is provided to help you search for keywords.

- Click the **Help** button in the toolbar on the right.

  ![Help button](image)

  or

  In the menu, click **Help > Online Filing Help**.

The Online Filing help opens in a new window in the default browser specified in the relevant Windows system settings, e.g. Microsoft Internet Explorer.
4 File Manager

Online Filing opens with the **File Manager** window. The **Forms** folder is always displayed when you start the application, enabling you to select a procedure immediately to create a new application.

- Click *All Applications* to see the application list.

![File Manager - Overview](image)

*Figure 6: File Manager - Overview*
## Elements in File Manager

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>Contains all commands that you need to create, edit and save applications, options for configuring the program properties of Online Filing as well as other tools.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td><strong>Location Indicator Bar</strong></td>
<td>Contains specific information on the application currently selected: folder, status, procedure, user reference.</td>
</tr>
<tr>
<td><strong>Status Selection Bar</strong></td>
<td>Displays the applications in a selected folder filtered by their current status: Draft, Ready to sign, Ready to send or Sent.</td>
</tr>
<tr>
<td><strong>Search</strong></td>
<td>Searches the list of applications (or templates) for a specific search term. To find a term, select the column you want to search in the drop-down list and enter the search term in the field to the right. The first application (or template) in the list that matches your search terms is highlighted in grey after you click the Search icon. Click the Search icon again to jump to the next application that matches your search criteria.</td>
</tr>
<tr>
<td><strong>Folders and Templates</strong></td>
<td>Contains the system folders All Applications, Default Folder, Forms, Templates and Trash. You can create additional folders and sub-folders as required for your applications and templates.</td>
</tr>
<tr>
<td><strong>Info Pane</strong></td>
<td>Displays general information on the application (or template) currently highlighted in the list. Click View... to preview the application. The application then appears in the PDF Viewer with a list of all attached files that can also be displayed in PDF view.</td>
</tr>
<tr>
<td><strong>Application List</strong></td>
<td>Shows the content of the folder that you selected on the left, that is, all applications, templates or forms that are in this folder.</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Shows information on the last action executed in the program.</td>
</tr>
</tbody>
</table>

## Customising File Manager

You can customise File Manager to only display the elements you wish to see.

1. **Click the options checked in the View menu one by one**, e.g. **Status Bar** and **Location Indicator**.
   - The check marks are removed and the **Status Bar** and **Location Indicator** elements will be hidden.
2. **Click an option in the View menu again** to set the check mark and display the element once more in File Manager.
Exiting File Manager

Use the **File** menu to close File Manager and exit Online Filing.

→ Click **Exit** to close the program.

→ Click **Log off** if you want to operate the program under a different user name.

4.1 Toolbars

The Online Filing toolbars provide buttons for the most common tasks you need to complete as you prepare, sign and send your application. All of these functions can also be activated via options on the File Manager menu bar. Another alternative is the shortcut menu, which you open by right-clicking an element. The shortcut menu always contains a list of frequently used options.
File Manager toolbar

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>New draft</td>
<td>Creates a new application based on a standard procedure or template.</td>
</tr>
<tr>
<td>-</td>
<td>Delete</td>
<td>Moves the selected item to the Trash folder.</td>
</tr>
<tr>
<td>←</td>
<td>Previous</td>
<td>Moves the application back a step in the workflow process.</td>
</tr>
<tr>
<td>→</td>
<td>Next</td>
<td>Moves the application forward a step in the workflow process.</td>
</tr>
<tr>
<td>✔️</td>
<td>Validation</td>
<td>Displays validation messages for the selected application.</td>
</tr>
<tr>
<td></td>
<td>Internal Notes</td>
<td>Creates application notes not intended for transmission to the EPO. Notes for the EPO are inserted in the Annotations tab on a form.</td>
</tr>
<tr>
<td>🗝️</td>
<td>Address Book</td>
<td>Opens the Online Filing Address Book to edit contact details for legal and natural persons.</td>
</tr>
<tr>
<td>🌐</td>
<td>System preferences</td>
<td>Opens the System Preferences (p. 61) window.</td>
</tr>
<tr>
<td>📚</td>
<td>Help</td>
<td>Opens the online help for File Manager.</td>
</tr>
</tbody>
</table>

Forms toolbar

When you edit an application in Online Filing, the software opens a form in a separate window, e.g. Form EP(1001E2K). The form view window also features buttons for the most common tasks.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📝</td>
<td>Save</td>
<td>Stores a copy of your work so far.</td>
</tr>
<tr>
<td>🕒</td>
<td>Next</td>
<td>Moves the application forward a step in the workflow process.</td>
</tr>
<tr>
<td>✔️</td>
<td>Validation</td>
<td>Shows validation messages for the tab currently open.</td>
</tr>
<tr>
<td></td>
<td>Internal Notes</td>
<td>Creates notes not intended for transmission to the EPO.</td>
</tr>
<tr>
<td>📹</td>
<td>Preview</td>
<td>Shows a preview of the application in the PDF Viewer.</td>
</tr>
<tr>
<td>🎨</td>
<td>Add</td>
<td>Adds a new item, e.g. adding details for a new applicant or attaching a new file.</td>
</tr>
<tr>
<td>✖️</td>
<td>Delete</td>
<td>Removes the selected item from the form.</td>
</tr>
<tr>
<td>📚</td>
<td>Help</td>
<td>Opens the online help for the EP forms.</td>
</tr>
</tbody>
</table>
### 4.2 Folders

File Manager features a series of special system folders to help with organising your work. You cannot rename or delete these.

<table>
<thead>
<tr>
<th>Icon</th>
<th>System Folder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon] All Applications</td>
<td>Contains a list of all applications (apart from items in the Trash folder).</td>
<td></td>
</tr>
<tr>
<td>![Icon] Default Folder</td>
<td>All new drafts are filed here unless you specify a different location when saving.</td>
<td></td>
</tr>
<tr>
<td>![Icon] Forms</td>
<td>Contains the official forms prescribed for the various procedures that are available for applications. The list of procedures available depends on the settings chosen during installation.</td>
<td></td>
</tr>
<tr>
<td>![Icon] Templates</td>
<td>Contains modified forms with user-specific information.</td>
<td></td>
</tr>
<tr>
<td>![Icon] Trash</td>
<td>Contains deleted applications (or templates). Once the Trash folder has been emptied, none of the items deleted in Online Filing can be retrieved.</td>
<td></td>
</tr>
</tbody>
</table>

You can create your own folders and sub-folders in File Manager. These folders could be named by type of application, company name or any other criteria that suit you. Folders are ordered alphabetically under the **Default Folder**. You can rename and delete folders you create.

Folders containing sub-folders are marked by a little black triangle on the left. To open a folder and view its sub-folders, double-click the folder.

![Figure 8: Folders with sub-folders in File Manager](image)

**Creating a folder**

1. In the menu, click **File > New Folder**.
2. Right-click in the folder area and select **New Folder** from the shortcut menu.
3. Type a name for the folder and press ENTER.
Creating a sub-folder

- Right-click the folder to which you want to add a sub-folder.
- Select **New SubFolder** from the shortcut menu.
- Type a name for the sub-folder and press **ENTER**.

Renaming a folder

- Right-click the folder you want to rename.
  
  or
  
  Press the **F2** key.
- Select **Rename Folder** from the shortcut menu.
- Enter the new name and press **ENTER**.

Deleting a folder

You can only delete folders which do not contain any applications or templates.

- Right-click the folder you want to delete.
- Select **Delete Folder** from the shortcut menu.
  
  The folder is deleted immediately.

Sorting a folder

- Select the folder you wish to sort.
- In the menu, click on **View > Sorting**, then choose the name of the column you want to sort the list by.
4.3 Applications

The list of applications indicates the most important properties of all applications in the folder currently selected:

- **Last saved** - Date of the last change
- **Reference**
- **Title**
  - Number of validation messages by validation level (see "Validation" p. 41)
- **Type** of procedure/form used
- Number of attachments
- **Status** in the workflow process
You can customise the list of applications and filter it by various criteria.

- In the menu, click **Status > View**, then choose the status you want, e.g. **Ready to send**.
  - or
  - Click the appropriate button in the **Status Selection Bar**.
- In the menu, click **View > Columns**, then select the columns you want to display in the list of applications.
- Double-click the dividing line between two column headers to resize the columns so that they fit their content.

### 4.3.1 Creating a new application

You can create a new application in File Manager using a form from the **Forms** folder or a customised form from the **Templates** folder.

- In the menu, click **File > New Draft**.
  - or
  - Click the **New Draft** button in the toolbar.
    - or
    - Double-click a form or template.
    - or
    - Press **CTRL+N** on your keyboard.

The **Create a New Application** window opens.

- Enter the **User Reference** for the new application.
- Select the type of procedure you want to choose from in the **Group** list, e.g. **EP**.
  - This is not mandatory but it reduces the number of forms displayed in the **Procedure** list, making selection easier for you if the number of procedures installed is very high.
- Select the option you want in the **Procedure** list.
  - The procedure on which an application is based cannot be changed afterwards.
  - Data automatically appears in the **Description** field and cannot be edited.
- If you want to use one of your templates as a basis for the new application, select it in the **Based on Template** list.
- Select the language you want in the **Language of proceedings** list.
  - The application form will be created in this language. However, this setting has no effect on the language of the Online Filing graphical user interface.
Select the folder where you want to save the new application.

Click Create.

A warning appears if the user reference you entered has already been assigned to an application.

- Confirm this message with Yes if you are sure you want to use the same user reference for the new application.
- Click No to change the user reference in the Create a New Application window.
- If you create a new PCT/RO/101 application, only unique user references are allowed; see Creating a new PCT/RO/101 application (p. 276) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

The option Customer number is only available for the UK procedures UK-IPO(F1), UK-IPO(NP1) and UK-IPO(SFD).

Example
This new EP(1001E2K) draft is not based on a template. English is selected as the language of proceedings and the application is stored in one of the personal folders.

4.3.2 Saving applications

A new application is only transferred to the database after the draft has been saved for the first time. Changes made in the subsequent workflow process can be saved at any time. Saving changes ensures that the data displayed in File Manager is also updated.

- In the form view menu, click File > Save.
  
or
  Click the Save button in the toolbar.
You can use the **Save As** option in the **File** menu to create a new item from an open application:

- **Select Save copy as Draft** and enter a reference to save as a new copy. The original remains as it was when last saved. All subsequent changes apply to the new document.
- **Select Save as Template** to save as a customised form (see "Templates" p. 33) on which to base new drafts.

The saving options in form PCT/RO/101 are slightly different; see Saving the form (p. 278) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

### 4.3.3 Renaming applications

You can only rename applications while they are still in **Draft** status. Applications based on form PCT/RO/101 cannot be renamed.

- **Open File Manager and select the application you wish to modify.**
- **Right-click the application in the list and select Rename user reference from the shortcut menu.**

![Figure 15: Rename user reference for application](image)

- **Enter the new user reference in the Rename user reference window.**
- **Click Rename to save your changes.**

The user reference in the database will be updated. It can take a few moments for the change to appear in File Manager.
4.3.4 Moving applications

- In File Manager, select the application (or template) you want to move.
- Right-click the application.
- Select Move to folder from the shortcut menu.
- Select the destination folder for the application in the Move to folder window.
  - You can display sub-folders by double-clicking the parent folder.
- Click OK.
  - The application is now in the selected folder.

Figure 16: Selecting the folder where you want to move an application

4.3.5 Deleting applications

There are a number of ways to delete applications (or templates). At every stage of the deletion process, Online Filing asks if you are absolutely sure you want to delete an application. This is not a setting that can be deactivated in the user preferences.

Deleted applications are first moved to the Trash folder where they remain until you empty the trash.

- In File Manager, select the application(s) or template(s) you wish to delete.
  - You can select multiple items one after the other by clicking them with the CTRL key held down.
- In the menu, click Edit > Delete application.
  - or
  - In the toolbar, click the Delete button.
  - or
  - Right-click the application(s) and select Delete from the shortcut menu.
  - or
  - Press DELETE on your keyboard.
Retrieving deleted items

→ Click the **Trash** folder.

→ Select the application you want to restore.

→ Right-click the application and select **Move to folder** from the shortcut menu.

→ Select the required folder in the **Move to folder** window and click **OK**.

Removing items from the Trash folder

You can clear all items or individual items in the **Trash** folder.

→ Right-click the **Trash** folder and select **Empty Trash Folder** from the shortcut menu.

or

→ Select the items you want to remove and delete them as described above.

### 4.3.6 Previewing applications

Just like in any word processing application, you can open a preview of an application in Online Filing to display the application form as it appears in print. In Online Filing, the preview of the application is displayed as a PDF file in the **PDF Viewer** window, which runs the **Adobe Acrobat Reader** application installed on your PC. This window also displays all attached files as well as the system files generated by Online Filing.

→ Select an application in File Manager.

The **info pane** provides more information on a selected application, including information that is not yet visible in the list of applications:

- **ID** is the internal number of the application in the database.
- **Title** is the title of the invention (for applications using the EP(1001E2K) form only, otherwise blank).
- **Last saved** indicates the user’s name and the date.
- **Applicant** indicates the name(s) of the applicant.
- **Internal Notes** provides a short summary of remarks by the persons handling the application.

→ Click the **View...** button in the info pane.

or

Select **View > List of attached documents**.

![Figure 17: Info pane with application information](image)

The **PDF Viewer** opens with a preview of the required application (*ep-request.pdf*). A list of all files associated with this application is displayed on the left.
In this example, the technical documents are contained in one attachment (SPECEPO-1.pdf).

The XML files listed are the system files required for transmission to the EPO. The f1002-1.pdf file is the designation of inventor generated internally by Online Filing.

The list of files displayed by the PDF Viewer includes the acknowledgement of receipt (receipt.pdf) once an application has been successfully transmitted to the EPO.

The user reference appears on the bottom left of each page in the PDF document created by Online Filing.

The PDF Viewer provides a toolbar and other items for handling the PDF document.

- To print the form, click the **Print file** icon in the PDF Viewer's toolbar.
- To save a copy of the PDF file to your PC, click the **Save file** icon.
- To resize the width of the left navigation pane, click the grip at the centre of the divider (symbolised by three dots) and drag it to the required position.

![PDF Viewer](image)

*Figure 18: Application displayed in the PDF viewer*
4.4 Templates

Templates are user-defined forms, containing data that you need every time you prepare certain applications, such as information relating to a particular applicant or to fee payments.

4.4.1 Creating a new template

In File Manager, you can create a template from a draft application, start with a blank form or use an existing template. Specific instructions on how to create a template for PCT/RO/101 applications can be found in Working with templates (p. 279) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

Creating a template with a blank form

- In the menu, click **File > New Template**.
- or
  - Press **SHIFT+CTRL+N**.
- In the **Create a New Template** window, enter the **Template Name**.
- Select the required **procedure** and the **language of proceedings**.
- To store the new template in one of your template folders, double-click the **Templates** folder and select the appropriate sub-folder in the **Save to folder** field.
- If you wish, enter a **description** to help identify the template. This is displayed in the **Title** column in File Manager.
- Click **Create**.

![Figure 19: Creating a new template](image)

The new template opens in the form view where it can be edited.
Creating a template from an existing application (draft)
The application is in Draft status.

→ Double-click the application to open it in the form view.
→ In the menu, click File > Save As > Save as Template.
→ Enter the template name in the Save As Template window.
→ Select a folder if you want to save the template in a sub-folder of the Templates folder.
   ① Double-click the Templates folder to display all sub-folders.
→ Enter a description.
→ Click Save.

Figure 20: Saving an application as a template

The new template remains open in the form view.

Converting an application (draft) into a template
Only an application in Draft status can be converted into a template. This removes the application from its original location and creates a new template in the selected template folder.

→ In File Manager, right-click the application you want to convert into a template.
→ Select Convert to template from the shortcut menu.
→ Select a folder in the Convert to template window.
→ Enter a description.
   ① You cannot change the template name here.
→ Click Save.
Figure 21: Converting an application into a template

The template then appears in the selected template folder in File Manager.

Figure 22: Templates folder with sub-folders and new template

Creating a template from an application already processed (Sent, Ready to send, Ready to sign)

Only applications still in Draft status can be directly converted into templates. There is, however, also a way to create a template from an application, for instance, that has already been sent.

In File Manager, select the application you want to use as a template. Its status can be Ready to sign, Ready to send or Sent.
→ Right-click the application and select **Copy application** from the shortcut menu.
→ Type a new **user reference**.
→ Click **Copy**.
   The copy now appears in **Draft** status in File Manager.
→ Right-click this application and select **Convert to template** from the shortcut menu.
→ To continue, proceed as described above.

**Copying a template**

→ Click the **Templates** folder.
→ Select the template you want to copy.
→ Right-click the template and select **Create a copy of template** from the shortcut menu.
→ Enter a name for the new template in the **Copy template** window.
→ Click **Copy**.

![Copy template window](image)

*Figure 23: Creating a new template by copying an existing template*

In File Manager, the new template appears in the same folder as the copied template.

**4.4.2 Using a template**

You can use your templates immediately to create a new application.

→ In the **Templates** folder, double-click the template you require.

  or

→ Click the **New Draft** button in the toolbar.

The **Create a New Application** window opens.

→ Where applicable, select the template you want in the **Based on Template** list.
→ Enter the details for the new application.
→ Click **Create**.
4.4.3 Modifying a template

You cannot change the underlying procedure in a template. Nor can you rename a template. Changes made to a template are not transferred to existing applications based on this template.

Editing data in a template

→ Click the Templates folder.
→ Select the template you want to edit.
→ Right-click the template and select Edit template from the shortcut menu.
  The template will open in the form view.
→ Modify the data as required and save the template.

Updating fee information in a template

When you create a template, the most recent fee schedule for the selected procedure is always entered in full in the template. The Live Update routine updates the fee information in Online Filing - but not in existing templates - whenever the EPO issues new fees. A warning message appears if the template that you try to open to create a new application still contains outdated fee information.

Figure 25: Warning when you open a template containing outdated fee information
→ Click **OK** to cancel the operation.
→ To update the template, right-click the template in File Manager and select **Edit template** from the shortcut menu.
   A warning message about updating fee information appears.

![Figure 26: Warning about updating fee information in a template](image)

→ Click **OK**.
   - The template now opens with the new fees.
→ Save the template.

**Modifying the template description**

→ Click the **Templates** folder.
→ Select the template you want to edit.
→ Right-click the template and select **Properties** from the shortcut menu.
→ Change the text in the **Template description** field in the **Template properties** window.
→ Click **Save**.

![Figure 27: Changing template properties](image)

4.5 **Workflow and status**

In Online Filing, the **workflow** is the sequence of all tasks related to the filing of an application, that is, from the creation of a draft to the successful transmission of an application to the EPO. The **status** of an application indicates which tasks have already been performed for an application and which task can be performed next.

File Manager shows the current status of each application, that is, either **Draft**, **Ready to sign**, **Ready to send** or **Sent**. You can filter the list of applications so that only applications in a specific status are displayed.

→ Click a status button for a list of all the applications in the relevant status.
### All
Shows all applications in the folder currently selected.

### Draft
All applications that are still being processed. Applications in this status are missing either mandatory information or documents required for the procedure.

### Ready to sign
Mandatory information and documents have been included but signatures have not been added.

### Ready to send
Mandatory information and documents have been included and signatures have been added.

### Sent
The application was successfully transmitted to the EPO and the acknowledgement of receipt was received from the EPO.

#### 4.5.1 Changing the status of an application in File Manager

The workflow process in Online Filing helps you to fill out applications correctly and in full. The software checks the documents and data contained in an application for compliance with the legal framework and the Validation (p. 41) function informs you about which data is missing or has to be corrected. An application can only move forward to the next status in the workflow if all necessary data was entered and is correct (where verifiable).

You can only change the status of applications if your user name is assigned the corresponding privileges in Online Filing.

You can change the status of applications either via the Next and Previous workflow buttons in the toolbar or via the Workflow menu. The workflow buttons only ever change the status one step at a time, to the next or previous stage. In contrast, you can use the menu options to change the status several steps at a time, e.g. from Ready to send directly back to Draft.

→ Select the application you want in File Manager.

→ In the menu, click Workflow > Change Status followed by the required option to move the application to a specific status.

or

Keep clicking the relevant workflow button until the application reaches the status you want.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Next_icon.png" alt="" /></td>
<td>Next</td>
<td>Move the application forward a step in the workflow process. You can only move an application to the next step if the current data is sufficient, e.g. only an application signed with a digital signature can be moved to Ready to send status.</td>
</tr>
<tr>
<td><img src="Previous_icon.png" alt="" /></td>
<td>Previous</td>
<td>Move the application back a step in the workflow process, e.g. return it to Draft status so that changes can be made.</td>
</tr>
</tbody>
</table>

#### Example 1

In this example, the selected application is in Draft status and already contains all mandatory information. Clicking the Next button moves the application to Ready to sign status and
opens it in the PDF Viewer. Notice that the Previous button is disabled because Draft is the first step in the workflow process. The tool-tip on the Next button says "Ready to sign".

Example 2
In this example, the status of the selected application is Ready to sign. Clicking the Next button initiates the signing process. Note that the Previous button is enabled. Clicking it would return the application to Draft status.

In this example the tool-tip on the Next button says "Sign".

4.5.2 Changing the status of an application in the form
An application remains in Draft status until you actively change its status, e.g. move the application to Ready to sign status.

- Open an application in Draft status.
- In the form toolbar, click the Next button.
In the menu, click File > Close, then select Move to Ready to Sign and exit.

When an application leaves Draft status, the next step in the workflow process automatically starts the next time the application is opened. For example, the signing process automatically starts if you open an application in Ready to sign status and the sending process initiates if you open an application in Ready to send status.

Use the Previous button in File Manager to move the application back to Draft status in order to make changes in the form view.

Form PCT/RO/101 provides different functions; see Processing the PCT/RO/101 application (p. 343) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

### 4.6 Validation

The Online Filing software incorporates validation mechanisms that check the logical consistency of data entered in an application and compares it with the legal requirements of the EPC and the various filing offices. For the latest version of the EPC, see the EPO website at Law & practice > Legal texts > European Patent Convention (http://www.epo.org/law-practice/legal-texts/epc.html).

There are three severity levels for validation messages:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Severity</th>
<th>Validation state</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>1</td>
<td>The red icon for error means that mandatory information required by the EPC is missing or the data provided is incorrect. You must supply or amend this information before you can submit the application.</td>
</tr>
<tr>
<td>🚨</td>
<td>2</td>
<td>The yellow icon for warning means that some information is missing but may be supplied subsequent to your filing.</td>
</tr>
<tr>
<td>🟥</td>
<td>3</td>
<td>The grey icon for message means that helpful hints concerning your filing are available.</td>
</tr>
</tbody>
</table>
In File Manager, the total number of validation messages about an application is shown both in the application list and the info pane.

There are no validation indications for the PCT/RO/101 requests shown in the overview screens as the validation system operated by the PCT/RO/101 is not compatible with the data format used by the EPO Online Filing File Manager. For more information on validation messages, please refer to PCT/RO/101 (p. 274) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

![Figure 32: Number of validation messages in the info pane and application list](image)

In the form view, the validation status is indicated by icons in the tabs corresponding to the form sections.

![Figure 33: Validation icons in a form's tabs indicate missing data](image)

The total number of validation messages per severity level is also displayed in the status bar of the currently opened application.

![Figure 34: Number of validation messages indicated in the form's status bar](image)

Note that the validation icons change dynamically as you enter new data.

- Click the **Validation** button in an application's form view to view the messages specific to the currently displayed tab.
- Click the **Validation** button in File Manager to see all the messages concerning the selected application.
The validation messages are displayed in a separate window.

Figure 35: All validation messages for an application

You can leave the validation window open to keep track of your applications while working in File Manager.

- In the menu, click View > Validation > Docked to dock the validation window under the File Manager window.
  
  - If you want the validation window to appear docked to the form window each time, select the corresponding option for Startup (p. 57) in User Preferences.

- If you prefer, you can select View > Validation > Undocked. This option leaves the floating window open and allows resizing of the window.

- To close the validation window, click View > Validation > Hide.

4.7 Internal Notes

Internal Notes can be used by the persons handling an application within a company to exchange information without sending it to the EPO. You can only create and delete internal notes in the applications, not in File Manager. Notes are displayed as read-only when opened from File Manager. Information for the EPO is inserted in the form’s Annotations tab, see EP(1001E2K) – Annotations (p. 172).

For instructions on annotations and notes in form PCT/RO/101, please refer to PCT/RO/101 – Annotate (p. 338) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

Creating Internal Notes

- In the procedural form, click the Internal Notes button in the toolbar.

  Any notes already created for this form are listed.

- Click the New button.
Enter the author's name, subject and note text.

![Internal Notes window](image1.png)

Figure 36: Sample for internal notes, created in the form

**Viewing Internal Notes**

- In File Manager, select the application of which you wish to view the notes.
- Click the **Internal Notes** button in the toolbar.
  
  Like the validation window, the Internal Notes window can be set to **Docked**, **Undocked** or **Hide** in the **View** menu.

- In the list click a note to display it.

![Internal Notes window](image2.png)

Figure 37: Example of an internal note in the docked Internal Notes window in File Manager
4.8 Address Book

The Address Book is a facility for storing contact details (e.g. applicants, representatives, inventors).

In the File Manager menu, click Tools > Address Book.

or

Click the Address Book button in the toolbar.

Figure 38: Opening Address Book in File Manager

Entries in the Address Book are grouped by legal and natural persons. Note that a legal person is represented by the icon 📚 and a natural person by the icon 📚.

Figure 39: Address Book with legal and natural persons
Address Book functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add</strong></td>
<td>Click ![image] to create a new Address Book entry.</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Click ![image] to delete the Address Book entry currently selected.</td>
</tr>
<tr>
<td><strong>Revert changes</strong></td>
<td>Click ![image] to cancel entries or changes.</td>
</tr>
<tr>
<td><strong>Search</strong></td>
<td>Select the data field you want to search in the Find in drop-down list and then enter the relevant search term in the search field. Click the Search icon ![image] to find matching Address Book entries.</td>
</tr>
<tr>
<td><strong>Enter details</strong></td>
<td>Edit the personal details in the data fields. You must enter at least a first and last name for a natural person or at least the company name for a legal person.</td>
</tr>
<tr>
<td><strong>Select route</strong></td>
<td>Click this field to open a drop-down list of routes.</td>
</tr>
<tr>
<td><strong>Select role</strong></td>
<td>Click this field to open a drop-down list of features for the selected route.</td>
</tr>
<tr>
<td><strong>Enter registration number</strong></td>
<td>Click the field to enter the registration number.</td>
</tr>
</tbody>
</table>

Exchange of data between Address Book and forms

When filling out forms, you can copy entries (see "Adding names from the Address Book to a form" p. 49) from the Address Book for the persons listed in the Names tab. You can also copy the information on a person you entered in a form to a new entry (see "Saving names from a form to the Address Book" p. 50) in the Address Book.

For instructions on exchanging address data with form PCT/RO/101, please refer to Adding names from the Address Book to a form and vice versa (p. 300) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

Data loss can occur in Online Filing if information from an EP form is copied to the Address Book and then transferred to a non-EP form, and vice versa. You should therefore check the integrity of address data when transferring Address Book entries and add any missing information manually.

Exchange of data between Address Book and external files

You can create Address Book entries either directly in Online Filing or import (see "Importing Address Book names" p. 54) them from existing CSV files. You can also export (see "Exporting Address Book names" p. 52) entries created in Online Filing to an external CSV file.
4.8.1 Creating names in the Address Book

- In the Address Book menu, click **File** and then **New Person** or **New Company**.
  - or
  - Click the **Add** button, and then select **Legal Person** or **Natural Person**.

![Figure 40: Creating a new person](image)

- Enter the details in the fields on the right.
- Click the **Save Changes** button.
  - A warning appears if there is already an Address Book entry with the same name.

![Figure 41: Warning: Record already exists in the Address Book](image)

- The data in the First Name, Last Name and Registration No. fields is compared for natural persons. The Address Book allows you to create two entries with the same first name and last name but different registration numbers.
- You can save two entries with the same company name but different registration numbers for legal persons.

Editing names in the Address Book

- Select the name you wish to change.
- Edit the data.
- Click the **Save Changes** button to store the changes.
  - To cancel the changes, click the **Undo** button.

Deleting names from the Address Book

- Select the entry you wish to remove.
- Click the **Delete** button.
4.8.2 Routes and roles

The Route, Role and Registration No. fields are grouped as a table in the Role sub-tab, situated on the right side of the Address Book below the personal data. A registration number is no longer required for filing with the EPO.

Adding a route and role to a name

→ Select the name you wish to use in the Address Book.
→ Click the New button (in the Role sub-tab).

The route EP and the role Applicant are added automatically.

→ To select another route, click the field to open it for editing.
All routes supported by Online Filing are listed in the Route drop-down list, irrespective of whether they are actually activated in your system.
→ Select the role in the same manner.
- The roles for the EP route are Applicant and Representative.
- The roles for the PCT route are Applicant only and Agent.

Figure 42: Selecting a role for the EP route

→ Click the grey field in the Registration No. column to activate it.
→ Enter the registration number for the selected role.
  ① For more information on the format of registration numbers, contact the relevant national office.

Multiple registration numbers
If a person has registration numbers for different filing offices, you can create multiple lines with routes, roles and registration numbers.

→ To create a second line, click the New button once more.
→ Select the Route and Role options.
→ Enter the registration number.

Figure 43: Multiple roles and registration numbers entered

Deleting a route and role
→ Select the relevant line in the Address Book entry.
Click the **Delete** button (in the **Role** sub-tab).

4.8.3 Adding names from the Address Book to a form

You can insert the names saved in the Address Book into your applications.

- In the **Names** tab of Form EP(1001E2K) click the **Add** button.
- Select a role, e.g. **Representative, Legal Practitioner**.

![Selecting Representative, Authorised](image)

**Figure 44: Selecting Representative, Authorised**

- Click the **Copy from Address Book** button.

The Address Book opens. The list of names is filtered and only shows natural persons because the **Representative, Legal Practitioner** role is defined as a natural person.
- In the Address Book, select the name as appropriate.
- Click the **Copy person to the form** button.

![Copy representative's data to the form](image)

**Figure 45: Copy representative’s data to the form**
The entry is added to the **Names** tab of the current form.

![Image of the Names tab](image-url)

**Figure 46: Data and registration number for representative entered automatically in form**

### 4.8.4 Saving names from a form to the Address Book

If you enter details on a person in a form's **Names** tab, you can save this information in the Address Book for future use.

- In the **Names** tab, select the name you wish to save.
- Click the **Copy to Address Book** button.

A warning appears and the entry is not saved in the Address Book if the name already exists in the Address Book.

![Warning dialog box](image-url)

**Figure 47: Warning: Record already exists in Address Book**
If the data has been successfully copied to the Address Book, a message to this effect is displayed in the status bar.

**Figure 48: Applicant's data successfully copied from the form to the Address Book**

**Multiple entries for a legal person**
You can specify a separate address for correspondence with one of the applicants, e.g. see Applicants (p. 129) in the EP(1001E2K) section.

- Add an address for correspondence and enter the required information.
- Click the **Copy to Address Book** button.
This creates an additional Address Book entry for a legal person with the same company name, but with different address data.

**Figure 49: Additional address for correspondence copied to the Address Book**
Data required for Address Book entries

An entry for a natural person must contain the first and last name while an entry for a legal person must contain the name of the company.

An appropriate message appears in the status bar if the entry in the form does not satisfy these conditions and the entry is not saved to the Address Book.

![Incomplete entry is not copied to the Address Book from the form](image)

### 4.8.5 Exporting Address Book names

This option allows you to save names from the Online Filing Address Book to an external location on your computer.

- In the Address Book menu, click **File > Export**.

![Exporting data from the Address Book](image)

- Select a **location** and enter a **file name**, and then click **Save**.

The entire Address Book is exported and saved as a **CSV file**.

**CSV files** (CSV = character separated values) contain data in text-only format that can be read by many different programs. These files display data records as single lines in which the
individual data fields are separated by delimiters. A delimiter is a marker, such as a comma, a semicolon or a tab character.

**Example**
The figure below shows a CSV file exported from the Address Book and opened in *Microsoft Notepad*. In this case, the delimiters are semicolons. The first line is the header containing the field names. These are only in English and are for internal use in Online Filing. The second line contains information on the first person in the Address Book.

![Figure 52: Sample CSV file opened in Notepad](image)

This is how the same CSV file appears in *Microsoft Excel*. The data records are arranged in rows here and the data fields in columns. The first line again contains the field names as column headings. Persons are sorted by the date when the entry was created in the Address Book.

![Figure 53: Sample CSV file in Microsoft Excel spreadsheet](image)

The application associated with CSV files depends on your computer's configuration. A Windows system opens CSV files by default with Microsoft Excel, provided this software is installed on the PC.
4.8.6 Importing Address Book names

This option allows you to import names from an external CSV file into the Online Filing Address Book.

Preparing the CSV file with multiple roles

When importing addresses from an external CSV file, all data on the route, role and registration number is contained in the Role field. All of the data must be within the one field but divided by vertical bars (|). The different terms for representative and applicant in the various routes must be entered in English so that they can be imported by Online Filing.

![Figure 54: Different sets of data for EP and PCT routes](image)

Importing the CSV file

- In the File Manager menu, click Tools > Address Book.
- or
  - Click the Address Book button in the toolbar.
- In the Address Book menu, click File > Import.

![Figure 55: Importing data into Address Book](image)

- Select the CSV file you want to import on your PC.
- Click Open.
The CSV file must not be open in another program at the same time.

![Image of CSV file selection for import into Address Book]

**Mapping field names**

Online Filing compares the names of the fields in the CSV file with the names of the fields in the address book. The fields' names are automatically assigned to each other if they match up exactly. If the name in the CSV File Field column differs from the name in the **Address Book Field** column, **None** is displayed in the list. In this case, you have to map the names manually.

- Open a drop-down list of available field names by double-clicking the entry you want to change in the **CSV File Field** column.
- Select the matching field in your CSV file. If there is no matching field, set the option to **None** to leave the Address Book field blank.

![Image of Address Book field mapping]

Figure 57: Import Address Book - matching field names
Handling duplicate entries
The import process is now started. If the software finds a duplicate name in the Address Book, a message appears.

![Figure 58: Address Book message for duplicate entries](image)

- Click **Overwrite** to replace the existing name with the imported data. If the software finds a further duplicate name, you will be asked again how you wish to proceed.
- Click **Overwrite all** to replace all existing duplicate names at once.
- Click **Skip** if you do not wish to import a particular duplicate name. You will be prompted again if the software finds a further duplicate name.
- Click **Skip all** if you do not wish to import any of the duplicate names.
- Click **Add as new record** to import the duplicate name as a new entry in the Address Book.

If no person type (either natural or legal) is indicated for a record, a legal person type is assumed by default. If both first name and last name are indicated, a natural person type is assumed.
4.9 User Preferences

Online Filing enables all users to individually set their preferred settings for working with the software. These user preferences can be set independently both in production mode and demo mode.

- In the File Manager menu, click **Tools > Preferences > User Preferences**. Changes take effect the next time you start File Manager.
- Click **OK** to apply your changed settings and restart File Manager.
- Click **Reset All Settings** to restore the previous user preferences.

![User Preferences](image)

**Figure 59: User preferences in File Manager, default options**

### 4.9.1 Startup

- Select your preferred mode for startup: **Production** or **Demo**. The working mode is selected in the login window; see [Overview of Online Filing](p. 12).
- If you want the validation messages to appear each time you open an application, select the check box **Dock validation in forms at startup**. The **Validation Messages** window can be docked below the form; see [Validation](p. 41).

### 4.9.2 Language

The File Manager user interface can be used in English, German, French, Dutch, Spanish, Romanian, Slovak, Polish or Swedish.

- Select the **startup language** you wish to work in.
By default, a form's user interface is displayed in the selected language of proceedings; see Creating a new application (p. 27).

If you want to work in the same language in the form as in File Manager, select the check box **Open forms in the language of the File Manager**.

This option does not apply for PCT/RO/101 forms. The PCT/RO/101 form's interface will always be in the language which was set in File Manager when creating the new application.

The language of proceedings, however, can only be English, French or German. Therefore, the default language of proceedings in a new application will be English if you set Dutch, Spanish, Romanian, Slovak, Polish or Swedish as the language for File Manager.

### 4.9.3 Signing preferences

The signing preferences show the options allowed by the Online Filing system settings; see Signing settings (p. 65). If an option is greyed out, this means that your Online Filing administrator has disabled it in the System preferences.

Select the type of signature you usually use:

- **Smart card** (default)
- **Soft certificate** (only available in demo mode)
- **Alphabetical**
- **Facsimile**

When signing an application, you can still select a different type of signature if required.

> The EPO does not currently accept soft certificates as an electronic signature for filings to the EPO server. Other offices may, however, accept them for online filing. See the website of the office concerned for details.

### 4.9.4 Confirmations

Online Filing displays warning messages following certain actions. You can avoid some extra clicks by de-activating these confirmation dialogs.

> If you do not wish to receive notifications about deletions of files, clear the check box for **Confirm upon deletion of entries in applications**.

> When this message appears in the procedural form, you can choose not to display it in future.
If you do not wish to receive notifications about renaming of files, clear the check box for *Show information about renaming of attached files.*

or

When this message appears in the procedural form, you can choose not to display it in future.

Select the check box *Start signing immediately when moving application forward from draft status* if you want an application in *Draft* status to move directly to *Ready to sign* status by clicking the *Next* workflow button in File Manager.

If you want to use an existing user reference for a new application and not receive a warning, clear the check box *Warn when creating an application with an already existing user reference.*

or

If this message appears when creating a new application, you can choose not to display it in future.

The creation of *working directories* is advisable if you tend to always access the same PC or network folders via Online Filing, for instance, when selecting electronic documents to attach to your applications or when importing data. You can create a central storage location in your
company for documents associated with ongoing patent applications and allow shared access to all users of Online Filing. The default for all working directories is \Program Files\EPO_OLF5\fm, i.e. the installation folder that was selected when setting up Online Filing.

- Click Browse... to set the working directories for Import, Export, Attach (i.e. attaching files) and CD-R.

  The directory specified for CD-R is used by Online Filing when you select the Physical Media option in the sending dialog; see Sending applications (p. 106). The application data is saved in a special file format and can be burned to a CD or DVD later.

  Working directories are not supported when working with the PCT procedure (Form PCT/RO/101).

- Select the check box Remember the last used directory if you want Online Filing to access the last directory you opened each time you import, export or attach files. These working directories are updated in the user preferences every time you select another directory during the corresponding action.

![Figure 64: Modified working directories](image)

### 4.9.6 Network settings

The network settings depend on how the computer network is configured in your company. By default, the Online Filing Thin Client (i.e. File Manager) uses the same internet connection as the Online Filing server, which can be configured in Server Manager.

- To modify the internet connection for your personal Online Filing Client, clear the check box User Default Network Settings. This opens the other fields for editing.

- Enter the IP address or the proxy server name in the Proxy Server field.

- Enter the number of the proxy server port in the field after the colon.

- If required, enter username and password for authorisation at the proxy server.

  The SSL Version is set to TLSv1 by default and cannot be changed. To provide for enhanced security in terms of data encryption, Online Filing does not use previous SSL versions anymore.

- Please contact your system administrator if you are unsure about the information you need to enter in your situation.
4.10 System Preferences

In **System Preferences**, you can change global settings that apply to all users of Online Filing. This is usually done by the Online Filing administrator or another user with appropriate user rights; see Profiles for group authorisations (p. 78).

The settings for production mode and demo mode are configured independently.

- In the File Manager menu, click **Tools > Preferences > System Preferences**.
- or
- Click the **System Preferences** button in the toolbar.

- Edit the settings as required.
- To apply your settings, click **Save**.
  You are prompted to restart File Manager for the changes to take effect.
- To discard your changes and return to the Online Filing default settings, click **Reset All Settings**.
- To quit without applying any changes, click **Cancel**.

![System Preferences for File Manager](image_url)

**Figure 66: System preferences for File Manager**
4.10.1 Security and user management

To protect your IP data, it is highly recommended that you establish uniform security rules for all users in your company working with Online Filing. All users should log on with their user name and password, even if you have installed the standalone version for a single-user environment.

**Enabling User Management**

Only the Online Filing *Administrator* can enable user management either immediately during the installation of Online Filing or later in *System Preferences*. If user management is enabled, users must always enter their user name and password to log on to File Manager.

- To enable User Management subsequent to the installation of the software, go to *System Preferences* in File Manager.
- Select the **Enable User Management** check box.
- Click **Save**. You are prompted to restart File Manager for the changes to take effect.
- Create user names and passwords as required; see Users (p. 71).

**Enabling Folder Management**

Folder management is not enabled by default. This option governs whether or not the Folders tab is active in *User Administration*; see Sharing folders with groups (p. 84).

- To enable folder management, enable user management if it is not already enabled.
- Then select the **Enable Folder Management** check box.
- Click **Save**. You are prompted to restart File Manager for the changes to take effect.

![System Preferences](image)

*Figure 67: Enabling folder management after user management has been enabled*

4.10.2 Password policy

If your company has a password policy for its network, you will be able to set up a similar policy in Online Filing should you wish to. That way, users are presented with a log-on method and style with which they are already familiar.

To enable password policy, user management has to be enabled by the Online Filing *Administrator* either during installation of the software or later in File Manager’s *System Preferences*. 
Enabling password policy when installing Online Filing
You can set up a password policy to protect access to Online Filing with a user name and password when installing the server or standalone version.

- This will enable user management and password policy at the same time.
- The master user Administrator is created.
- You are requested to enter a password for the master user Administrator that complies with the Online Filing default password policy.

For more information, please refer to the Online Filing Installation guide.

Enabling password policy in File Manager
If required, you can enable user management and password policy in System Preferences subsequent to installation.

- To enable user management and password policy, go to System Preferences in File Manager.
- Select the Enable User Management check box.
- The Enable password policy check box becomes available.
- Select the Enable password policy check box as appropriate.

Figure 68: The password policy can be enabled if user management has been enabled

The password settings become editable.

- To apply the Online Filing default settings, click Save

Password policy is activated when you restart File Manager.

Figure 69: Enabling password policy with the default settings
If you disable user management, password policy will also be disabled. The user accounts and passwords as well as the password policy settings, however, remain stored in the Online Filing database and will be activated again the next time user management and password policy are enabled.

**Defining a password policy**

When defining a password policy in Online Filing, the following setting parameters apply:

1. The minimum password length is 6 characters, i.e. letters, special characters or digits.
2. The maximum password length is 20 characters. This means that a number between 6 and 20 is allowed in the minimum length field.
3. These special characters are allowed: ! # $ % * + , . / ; = ? @ [ \ ] ^ _ { } ~
4. The four minimum-number fields (lower-case letters, upper-case letters, special characters, digits) added together must not exceed the value entered as the minimum length of the password.

Example of a mismatch of password settings:
- Enter 6 in the **Minimum length of password** field.
- Enter 2 in each of the following fields: **Minimum number of lowercase characters**, **Minimum number of uppercase characters**, **Minimum number of special characters** and **Minimum number of digits**.
  These four fields add up to 8, which is greater than 6.
- Click Save.
  You will see an error message prompting you to correct your settings.

**Changing your password policy**
- In File Manager, go to **System Preferences**.
- Modify the field entries to match your password rules as required.
  - To display more helpful information about the fields, move your mouse pointer over the little icons.
- To discard your entries and return to the default values, click **Reset to default settings**.
- To apply the new settings, click Save.
  You are prompted to restart File Manager for the changes to take effect.
If a user's password does not comply with the new password policy, he or she is prompted to provide a new password when logging on to File Manager the next time, see Changing your password (p. 75).

4.10.3 Signing settings

This is where you define the types of signature that your company should support for signing applications. The settings are made separately for demo mode and production mode.

- Click **Signing** in the list on the left under the heading **Online Services File Manager**.
- Select or clear the check boxes as required.

For instance, if the **Alphabetical** check box is cleared, users cannot apply an alphanumeric signature to their applications.
4.10.4  Runtime variables

Runtime variables enable you to customise Online Filing in line with user requirements that extend beyond the scope of the simple user preferences. There is currently only one runtime variable for File Manager: 

**EP_warning_for_no_payment_mode_indicated**. The EP prefix indicates that this variable affects all EP procedures. The variable governs whether a grey or yellow validation icon is displayed on the **Fee Payment** tab in EP forms if a mode of payment was not specified for this application.

**Changing the value of a variable**

- Click **Runtime Variables** in the **System Preferences** window and select the variable you want to change.
- Click the field in the **Value** column to open the drop-down list.
- Select **True** or **False**.
- Click somewhere else in the variables list to close the drop-down list.
- Click **Save**.

![Figure 72: Changing the runtime variable to “True”](image)

**False**: Grey validation icon, the validation message is "Please enter mode of payment".

**True**: Yellow validation icon, the validation message is "Warning (set by system preferences): no mode of payment is indicated".

The yellow validation icon is displayed in EP forms after you restart File Manager.

![Figure 73: Yellow validation icon for the Fee Payment tab after changing the runtime variable](image)

4.10.5  PMS gateway interface

The PMS gateway is used to exchange data with the EPO over a local OLF server. Users of other patent management systems (PMS) can use this interface to send their applications.
directly to the EPO via the OLF server, without actually processing the applications with the OLF software. For EPO authentication, a smart card reader with valid smart card must be connected to the computer running the OLF server.

For more information on the PMS gateway, refer to the following material on the EPO website under **Online services > Online Filing:**

- Under **Download software for filing with the EPO**
  (http://www.epo.org/applying/online-services/online-filing/download.html): Online Filing v5 PMS development kit (for applicants and PMS providers)
- Under **Download documentation**
  (http://www.epo.org/applying/online-services/online-filing/documentation.html): Importing Data into Online Filing version 5 and higher

The PMS gateway interface can only be configured in File Manager's production mode. If you want to test the PMS gateway interface in demo mode, please enable it in production mode first. Your production mode settings will apply in the demo mode.

→ Open the **System Preferences** window.
→ Click **PMS gateway interface.**
The default setting is **Not enabled.**
→ Select the **Smart card** option and enter the **smart card PIN code.**
  ① At present, applications in EP procedures cannot be signed with a soft certificate and filed with the EPO.
→ Enter the **HTTP port number** of the server and the **valid term** for the password or PIN.

![Figure 74: Settings for the PMS gateway interface when using a smart card](image)

Figure 74: Settings for the PMS gateway interface when using a smart card
Technical coordination with the EPO
The EPO or the other patent offices can only accept files via the PMS interface if the PMS software used has already been approved. This guarantees that applicants only use PMS software that has been compatibility-tested with the EPO Online Filing system.
If you are using custom-made PMS software, approval must be obtained from the EPO User Support or the customer services departments of other patent offices before you use the software with the PMS gateway.

→ If these requirements are satisfied, select the check box **I confirm that the PMS software has been approved by the patent office(s) concerned.**
→ The check box **Enable filing to production allowed** activates after this confirmation.
  ① Do not select this check box until your tests have been successfully completed and you want to enable the interface for your users for the transmission of documents to the EPO.

### 4.10.6 Filing settings

The sections **EP-Filing** and **PCT-Filing** in the **System Preferences** window contain information on the software version, the date of installation and the options for sending applications. You can define the settings individually for each procedure installed.

ℹ️ The EPO recommends **Online** (online filing over the internet) as the default setting for filing applications.

The **Physical Media** option is an alternative for sending applications over a secure internet connection. You can burn data to a CD- or DVD-ROM and send it by post or courier to the EPO. This might be suitable for very large files (e.g. extremely long sequence listings) that would take considerable time to transfer over an internet connection.

![Figure 75: Settings for EP filing, "Online" send method](image)
The default setting can be changed to **Physical Media**.

![Figure 76: Settings for EP filing, "Physical Media" send method](image)

The **Allow CD-R filing** check box is selected by default so that users always have the opportunity to choose between **Online** and **Physical Media** when sending applications. If this check box is cleared, **Online** is the only option allowed and applications cannot be filed over physical media.

![Figure 77: Settings for EP filing, CD-R filing not allowed](image)

### 4.11 User Administration

User Administration in Online Filing can be used to create individual authorisation concepts for users and user groups. This enables you to provide details on the Online Filing system administrator, specify which data is released in a network and which actions may be performed in the software by individual users. User management settings are specific to the current mode, that is, to demo mode or to production mode, to ensure that any work in one is kept entirely separate from the other.

**Enabling or disabling user management**

Only a user with **Administrator** ID has the privilege to enable **User Management** in File Manager and assign administrator rights to others. As a master user, the **Administrator** is automatically created when installing the Online Filing server and cannot be deleted later. If User Administration is enabled, users are always prompted to log on with their user name and password when starting Online Filing.

**Attention:** Make sure you create a second user with full administrator rights, i.e. with authorisation to perform user administration. The **Administrator** user is blocked after three successive attempts to log on with the wrong password. If this happens, there is no
way to reset the password unless there is another user with administrator rights configured on your system.

- Log on to **File Manager** with the **Administrator** user name.
- In the File Manager menu, click **Tools > User Administration**.
- If the option is unavailable, go to **Tools > Preferences > Systems Preferences** and select the check box **Enable User Management**.
- After enabling or disabling user management, restart File Manager. Disabling user management does not mean that your existing user-rights configuration is deleted. If you enable user management again, the same user names and passwords apply as before.

Once User Administration has been configured, this data can be transferred to a different server machine running Online Filing. For more details see User Data Migration (p. 428) in the Server Manager section.

**Features in User Administration**

There are five tabs in the **User Administration** window.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Users</td>
<td>Entering details for individuals, creating passwords and assigning users to groups.</td>
</tr>
<tr>
<td>Groups</td>
<td>Creating groups based on company roles, or other criteria as appropriate.</td>
</tr>
<tr>
<td>Profiles</td>
<td>Creating lists of privileges for using the software.</td>
</tr>
<tr>
<td>Mapping</td>
<td>Assigning profiles to groups.</td>
</tr>
<tr>
<td>Folders *)</td>
<td>Assigning authorisations for individual folders to groups.</td>
</tr>
</tbody>
</table>

*) The Folders tab is only active if the **Enable Folder Management** option is selected in System Preferences; see Security and user management (p. 62).

Changes that you have made but not yet saved in User Administration are indicated by a small grey arrow on the right. The total number of entries with unsaved changes in the open tab is displayed on the status bar.

- Click the **Save All** button to save your work in all tabs within User Administration.

- Click the **Revert All** button to discard all changes.
4.11.1 Users

The Users tab lists all persons who are authorised to use Online Filing. Login names and passwords are case sensitive, so they must be typed exactly as created in upper and lower case.

Configure groups and profiles first and then add the individual users to the groups you want.

Creating a new user

The Administrator and other users with user administration authorisation can create new users and assign them privilege profiles. The Administrator is automatically created when installing the software and cannot be renamed or deleted later.

- Click the New button on the left.
- In the middle panel enter the first name and last name.
- Enter the login name.
- The login name is the one that appears as Last saved in the info pane – see Previewing applications (p. 31) – so it should be readily identifiable to all system users.
- Enter a password for the new user.
- Enter the password once again in the Verification field.
If password policy is enabled and your proposed password does not comply with it, you will be prompted to supply a new password once you click the **Verification** field; see Changing your password (p. 75).

Figure 79: New user with login name

**Adding user to a group**

- Click the **New** button in the middle of the tab under **Is Contained in the Following Groups**.
  
  The **Add User to Group** window opens.
- Select the group(s) for this user.
- Click **Add**.
  
  The user inherits all privilege profiles assigned to these groups.

Figure 80: Adding users to a group

- Finally click the **Save All** button.
Modifying user data

The **Administrator** and other users with user-administration authorisation can change user data if necessary. For example, if a user forgets his or her password, the **Administrator** can create a new password for this user. When users are logged in, they can change their password via **Tools > Change password**; see Changing your password (p. 75).

The **Administrator**'s name and login name cannot be modified, however. These data fields are locked by default.

### 4.11.2 Unblocking users

Online Filing automatically disables a user account after three successive attempts to log on with the wrong password.

![Blocked user is unable to log on to File Manager](image)

**Figure 81: Blocked user is unable to log on to File Manager**

The user **Administrator** - or another user who is member of the **Administrators** group - can unblock the user to let him log on to Online Filing again.

**Attention:** Make sure you create a second user with full administrator rights, i.e. with authorisation to perform user administration. The **Administrator** user is blocked after three successive attempts to log on with the wrong password. If this happens, there is no way to reset the password unless there is another user with administrator rights configured on your system.

**Unblocking a user account**

- Select the blocked user in User Administration.
- Clear the **Account is disabled** check box.
- Click the **Save All** button.
Blocking a user account
The administrator can, if required, also disable a specific user, assuming permanent deletion of the user is not intended.

- Select the **Account is disabled** check box.
- Click the **Save All** button.

Unblocking the Administrator
The administrator account can also be blocked after three failed attempts to log on. To unblock this account, another user with user management privileges must log on to File Manager. The following message box appears when opening User Administration:

![User is disabled and can be re-activated in User Administration](image)

- Click **OK**.
  User Administration opens. The check mark in the **Account is disabled** check box automatically disappears.
- Click the **Save All** button to complete the operation and re-activate the administrator account.
4.11.3 Changing your password

When you are logged on to File Manager you can change your password.

- In the menu, click **Tools > Change password**. The **Change password** window opens.
- Enter your **old password**.
- Enter your **new password**.
- Enter your new password a second time to confirm.
- Click **OK**.

Applying password policy

If password policy is enabled and your new password does not comply with it, you are prompted to modify your new password after you click **OK** in the **Change password** window.
The same warning message appears if you log on to File Manager after the password policy has been changed and your old password no longer complies with it.

![Warning](image)

**Figure 86: New password does not comply with the password policy**

- To close the warning message, click **OK**.
- Edit your new password as required in the **Change password** window.

Only the following special characters are allowed:

```
! # $ % * + , - . / : ; = ? @ [ \ ] ^ _ { } ~
```

For more information, please see **Password policy** (p. 62).

### 4.11.4 Groups

The **Groups** tab is used to administer the user groups that were defined for your company. You can name the groups after employee roles, such as attorneys, paralegals and assistants, or use any other definitions that suit your requirements.

The group **Administrators** already exists and cannot be deleted. The **Users** group is also automatically created when installing Online Filing, but can be edited as required.

#### Creating groups

- In the **Groups** tab, click the **New** button.
- In the middle panel enter a name in the **Group Name** field.
- If required, also enter a **Description** for the group.
- Click the **Save All** button.
As a new group does not have any privilege profiles, **No privileges assigned yet** appears on the right under **Summary**. Privileges are assigned on the **Mapping tab** (see "Mapping profiles to groups" p. 83).

**Adding users or subgroups to a group**

You can add individual users or even complete groups to a group.

> It is not recommended to create complex group structures, i.e. groups that contain groups containing other groups. This kind of right management can become very confusing and may result in the authorisation of users for certain tasks they should not be allowed to perform.

> Click the **Add** button in the middle of the **Groups** tab.

> Select **Add Users** or **Add Groups**.

> The list of all registered users or groups is created. The list does not include blocked users.

> Select all users or groups you want to add to the selected group.

> Click **Add**.
Click the **Save All** button.

The users or groups added inherit all authorisations of the group you just edited. If a user tries to carry out an action in the software that is not within his rights, he will receive a message warning him that he does not have the appropriate rights. Thus, if a user's access rights are not sufficient to perform certain operations, the Administrator should move him or her to a more appropriate group.

### 4.11.5 Profiles for group authorisations

The **Profiles** tab allows you to create different lists of privileges and assign them to groups. You can use profiles to define authorisations for specific activities in the company, combine them as required and assign them to the various user groups. You can also select individual privileges from the list of all available privileges and modify profiles again at any time. Changes to profile-specific privileges only take effect after you save and quit user administration.

The privileges are grouped into four headings:

- Address Book Management
- Application Workflow
- Folder/Data Management
- User Management

Three standard profiles are created when you install the software:

- **Administrators profile** – this profile is mapped to the Administrators group. You cannot deactivate the privileges under User Management nor can you delete the Administrators profile.
- **Default administrator profile** – this profile can be used as a template to provide additional user groups with administrator rights as well as to set specific rights restrictions. The settings under User Management can therefore be edited.
- **Default user profile** – this profile is suitable for user groups mainly involved in processing applications. The Edit Maintenance Fees privilege under Folder/Data Management is deactivated.
Apart from the restrictions specified above, you can edit and rename these three profiles as required.

**Creating profiles**

- In the **Profiles** tab, click the **New** button.
- In the middle panel enter a name in the **Profile Name** field.
- Click the **Save All** button.

**Selecting privileges**

The list of all privileges in the middle is available after a save. No privileges are selected by default.

- Under **Privileges for “<profile name>”**, double-click the text of the heading you wish to modify.
  
  or

  Double-click the small black pointer to the left of the heading.

- Select the check boxes you require for this profile.
  
  You can select an entire group of privileges by selecting the check box next to the relevant heading.

- To close the list again, double-click the pointer.
  
  or

  Double-click the text of the heading.

- Enter a short description of the new profile in the **Description** field.
4.11.6 List of privileges

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Address Book Management</strong></td>
<td>Create, delete and edit entries in the Address Book.</td>
</tr>
<tr>
<td>Create Contact</td>
<td>Add entry to Address Book.</td>
</tr>
<tr>
<td>Delete Contact</td>
<td>Remove entry from Address Book.</td>
</tr>
<tr>
<td>Edit Contact</td>
<td>Change details for an existing Address Book entry.</td>
</tr>
<tr>
<td><strong>Application Workflow</strong></td>
<td>Control tracking and management of all activities from start to finish.</td>
</tr>
<tr>
<td>Delete Application in &quot;Ready to Send&quot; state</td>
<td>Place application with &quot;Ready to Send&quot; status in Trash folder.</td>
</tr>
<tr>
<td>Delete Application in &quot;Ready to Sign&quot; state</td>
<td>Place application with &quot;Ready to Sign&quot; status in Trash folder.</td>
</tr>
<tr>
<td>Delete Application in &quot;Sent&quot; state</td>
<td>Place application with &quot;Sent&quot; status in Trash folder.</td>
</tr>
<tr>
<td>Move Application Back from &quot;Ready to Send&quot; to &quot;Ready to Sign&quot;</td>
<td>Change status to &quot;Ready to Sign&quot;. This action removes all signatures from application.</td>
</tr>
<tr>
<td>Privilege</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Move Application Back from &quot;Ready to Sign&quot; to &quot;Draft&quot;</td>
<td>Return application to &quot;Draft&quot; status. The application may then be edited.</td>
</tr>
<tr>
<td>Move Application from &quot;Ready to Sign&quot; to &quot;Ready to Send&quot;</td>
<td>Change status to allow sending.</td>
</tr>
<tr>
<td>Remove Signature/Signatures</td>
<td>Allow use of Remove button for individual signatures in signing window.</td>
</tr>
<tr>
<td>Send Application</td>
<td>Transmit application to EPO.</td>
</tr>
<tr>
<td>Sign Application</td>
<td>Apply alphabetical/facsimile/digital signature according to signing methods supported in File Manager &gt; Tools &gt; System Preferences.</td>
</tr>
<tr>
<td>View Application in &quot;Ready to Send&quot; State</td>
<td>Open application with &quot;Ready to Send&quot; status to display data entered. Status cannot be changed.</td>
</tr>
<tr>
<td>View Application in &quot;Ready to Sign&quot; State</td>
<td>Open application with &quot;Ready to Sign&quot; status to display data entered. Status cannot be changed.</td>
</tr>
<tr>
<td>View Application in &quot;Sent&quot; State</td>
<td>Open application with &quot;Sent&quot; status to display data entered. Status cannot be changed.</td>
</tr>
<tr>
<td>Draft</td>
<td>Control activities relating to applications which can still be edited.</td>
</tr>
<tr>
<td>Create Draft</td>
<td>Add new application based on a procedural form.</td>
</tr>
<tr>
<td>Delete Draft</td>
<td>Place application with &quot;Draft&quot; status in Trash folder.</td>
</tr>
<tr>
<td>Edit Draft</td>
<td>Change data entered in application with &quot;Draft&quot; status.</td>
</tr>
<tr>
<td>Move Draft to &quot;Ready to Sign&quot;</td>
<td>Change status of application to allow signing. Once the application has been moved to &quot;Ready to Sign&quot; it can only be edited if it is moved back to &quot;Draft&quot;.</td>
</tr>
<tr>
<td>View Draft</td>
<td>Open application with &quot;Draft&quot; status to display data entered. Status cannot be changed.</td>
</tr>
<tr>
<td>Template</td>
<td>Control activities relating to templates used to create new drafts.</td>
</tr>
<tr>
<td>Copy template</td>
<td>Add a copy of an existing template.</td>
</tr>
<tr>
<td>Create template</td>
<td>Use an existing application or draft to save as template.</td>
</tr>
<tr>
<td>Delete template</td>
<td>Move a template to Trash folder.</td>
</tr>
<tr>
<td>Edit template</td>
<td>Open a template to modify data.</td>
</tr>
<tr>
<td>Folder/Data Management</td>
<td>Control activities relating to external information, file maintenance and reference settings.</td>
</tr>
<tr>
<td>Export/Import</td>
<td>Control activities relating to information stored outside the Online Filing software application.</td>
</tr>
<tr>
<td>Export Address Book</td>
<td>Send Address Book data to external CSV file.</td>
</tr>
<tr>
<td>Export XML (GUI)</td>
<td>Back up and archive Online Filing data. Send Online Filing data to external XML files in folder or ZIP format.</td>
</tr>
<tr>
<td>Import Address Book</td>
<td>Bring external CSV data into Address Book.</td>
</tr>
<tr>
<td>Import XML (GUI)</td>
<td>Bring external XML data into Online Filing.</td>
</tr>
<tr>
<td>Privilege</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>File Manager</strong></td>
<td>Control activities related to file maintenance and preference settings.</td>
</tr>
<tr>
<td>Change Global File Manager Settings</td>
<td>Set preferences for overall system usage.</td>
</tr>
<tr>
<td>Change Personal File Manager Settings</td>
<td>Set preferences for individual system usage.</td>
</tr>
<tr>
<td>Create Folder</td>
<td>Add a new folder for storing applications in File Manager.</td>
</tr>
<tr>
<td>Delete Folder</td>
<td>Remove a folder from File Manager. The &quot;Default&quot; folder cannot be deleted.</td>
</tr>
<tr>
<td>Edit Maintenance Fees</td>
<td>Change fees in File Manager &gt; Tools &gt; Fee Management.</td>
</tr>
<tr>
<td>Empty Trash</td>
<td>Permanently delete any items in Trash folder.</td>
</tr>
<tr>
<td>Move To Folder</td>
<td>Change location where application is stored.</td>
</tr>
<tr>
<td>Rename Folder</td>
<td>Edit folder name.</td>
</tr>
<tr>
<td><strong>Live Update/Start Application</strong></td>
<td>Control activities relating to Online Filing system updates.</td>
</tr>
<tr>
<td>Use Live Update - Apply</td>
<td>Check for software updates.</td>
</tr>
<tr>
<td>Use Live Update - Download</td>
<td>Bring suggested updates into your local storage area.</td>
</tr>
<tr>
<td><strong>User Management</strong></td>
<td>Control activities relating to setting up user and group profiles and assigning system privileges in Tools &gt; Administration.</td>
</tr>
<tr>
<td>Create Group</td>
<td>Add a new group name.</td>
</tr>
<tr>
<td>Delete Group</td>
<td>Remove an existing group name.</td>
</tr>
<tr>
<td>Edit Group</td>
<td>Add individual users to a group or remove them.</td>
</tr>
<tr>
<td>Rename Group</td>
<td>Change a group name.</td>
</tr>
<tr>
<td><strong>Modify Mapping</strong></td>
<td>Control activities relating to applying privileges to groups and individuals.</td>
</tr>
<tr>
<td>Profile</td>
<td>Control activities relating to assigning and maintaining lists of privileges for users and groups.</td>
</tr>
<tr>
<td>Create Profile</td>
<td>Add a profile name and assign privileges to it.</td>
</tr>
<tr>
<td>Delete Profile</td>
<td>Remove a profile name.</td>
</tr>
<tr>
<td>Edit Profile</td>
<td>View and change privileges assigned to a profile.</td>
</tr>
<tr>
<td></td>
<td>This privilege is required for any activity relating to creating sets of privileges, mapping privileges to users or groups, or changing privileges.</td>
</tr>
<tr>
<td>Rename Profile</td>
<td>Change a profile name.</td>
</tr>
<tr>
<td><strong>User</strong></td>
<td>Control activities relating to maintaining list of system users.</td>
</tr>
<tr>
<td>Create User</td>
<td>Add an individual name, enter login name and initial password for user and assign to group.</td>
</tr>
</tbody>
</table>
### Privileges

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete User</td>
<td>Remove an individual name.</td>
</tr>
<tr>
<td>Edit User</td>
<td>Change login name and password for user and change group assignments.</td>
</tr>
<tr>
<td>Rename User</td>
<td>Change an individual's first name / last name.</td>
</tr>
</tbody>
</table>

#### 4.11.7 Mapping profiles to groups

The **Mapping** tab is where you assign the required privilege profiles to groups. The **Administrators** group is mapped by default to the **Administrators profile**. This assignment cannot be revoked.

- Click a group name on the left.
- Select the check box in the middle panel to assign the associated profile.
  - You can assign multiple profiles to a group. This means that the group will inherit all privileges contained in the individual profiles.
- Click the **Save All** button.

- To make sure each group has the privileges you intend, click each group name in turn, and then scroll down the summary of privileges on the right.

---

*Figure 91: Check privileges after mapping profiles to groups*
4.11.8 Sharing folders with groups

In the **Folders** tab, you can define which of the user-defined folders in File Manager may be accessed by which user group.

The **Folders** tab is only active if the **Enable Folder Management** check box is selected in the System Preferences; see Security and user management (p. 62).

**Default folder rights**

1. The system folders **All Applications**, **Default Folder**, **Forms**, **Templates** and **Trash** are visible to all users.
2. The items contained in the **Default Folder** and **Templates** folder are accessible to all users.
3. The items contained in **All Applications** and **Trash** are only accessible to the user who created them and to the **Administrators** group. For example, if a user creates an application and moves it to the **Trash** folder, only this user or a member of the **Administrators** group can see that item.
4. The user-defined folders are accessible only to the user who created them and to the **Administrators** group. The same applies for sub-folders in user-defined folders and for sub-folders in the **Templates** folder.

**Assigning folders to a group**

To make a user-defined folder and its contents accessible to other users, a user with user management authorisation can assign this folder to a specific user group.

- In **User Administration**, click the **Folders** tab.
  
  All user-defined folders that were created in File Manager are listed in the window's central pane.

- Click a group name on the left. The folders and sub-folders that are currently accessible to the selected group are shown on the right.

- To assign another folder to the selected group, select the corresponding check box in the central pane. If a parent folder is selected, all of its sub-folders are also selected, even those yet to be created.

- To assign individual sub-folders to the selected group, double-click the relevant parent folder. The sub-folders are displayed.

- Select the check boxes for the relevant sub-folders, including sub-folders in the **Templates** folder.

- Finally click the **Save All** button.
The selected folders and sub-folders are then displayed on the right. This sequence corresponds to the order in which the selected user group will see the folders in File Manager.

![Figure 92: Assigning folders to a group](image)

The assigned folders are then displayed for the users from the selected user group when they log on to File Manager.
In this example, the sub-folder **2013** was subsequently created. Because its parent folder, **Nano Enterprise**, has been assigned to the **Assistants** group, the new sub-folder is also automatically shared to the **Assistants** group.

![Image: Folders visible to a user through group sharing](image)

**Figure 93: Folders visible to a user through group sharing**

### 4.12 Fee management

The **Fee Management** option shows you which fees are valid in Online Filing at a given date. Fees are displayed from the effective date on the **Fee Payment** tab of the EP forms when a new application is created.

Online Filing version 5.10 does not allow you to either create your own fee tables or delete EPO fee tables. The **+** and **−** buttons are therefore deactivated.

#### Viewing fee tables

- In the File Manager menu, click **Tools > Fee Management**.
  
  The fees are grouped on the left by type of fee and creation date.
- Click a group to see the list.
  
  The new fees that were added as supplementary options following the various fee reforms can be found at the end of the list. The codes for these fees have a lower-case **e** suffix. The forms may display both fee variants for selection, depending on the options selected for fee payment.
Modifying fee amounts

The EPO always releases the latest revision of fees for manual download and for installation via Live Update (p. 420). This means that you normally are not supposed to change any of the fee information. If, however, you do need to change fees for operational reasons, you can edit the individual amounts in the fee table. Your Online Filing user account must have the necessary rights for this.

**Attention:** Once you have saved your changes, you cannot automatically reload the original amounts in the fee tables. However, you can manually change the fees to bring them into line with the EPO’s latest schedule of fees.

- Select the fee you want on the right-hand side of the list.
- Click the amount you want to change in the *New amount* column. The field is opened for editing.
- Enter the new amount as a whole number.
- Click the *Revert All* button to discard changes.
- Click the *Save All* button to apply the changes.
4.13 Maintenance table viewer

The maintenance tables allow you to view lists of standard data, e.g. filing offices and depositary institutions. Maintenance tables cannot be edited. The EPO makes changes available via Live Update.

- In the File Manager menu, click **Tools > Maintenance Table Viewer**, and then select the option you require:
  - **Common Maintenance** for a list of countries with country codes and regional divisions.
  - **EP Maintenance** for filing offices and other data
  - **PCT Maintenance** for receiving offices and other data.

Depending on the national plug-ins installed, additional options are displayed.

- Select an entry on the left to display any associated data from the maintenance table on the right, for instance, select **Filing Offices**.
  This table also contains the URLs (internet addresses) of the production server and demo server in the filing offices involved.

- To retrieve information relevant at a date in the past or in the future, select a different date in the box in the top right corner.
Figure 96: Common Maintenance, Filing Offices Table
5 Processing applications

After a new draft has been created, more actions are required before the application can be submitted to the receiving office. This section describes the submission workflow common to all standard procedures (EP and PCT) and explains some additional functions for data handling in Online Filing.

- The patent specification and all other accompanying documents are made available in an appropriate format for electronic filing; see Preparing documents for attachment (p. 90).
- The application is signed by one of the methods accepted by the receiving office. A digital signature, usually with a personal smart card and PIN, is always required in addition to alphabetical or facsimile signatures; see Signing applications (p. 92).
- The application is sent to the receiving office, either electronically or physically; see Sending applications (p. 106).
- Applications and templates can be exported from Online Filing for backup and archiving purposes; see Exporting data from Online Filing (p. 109).
- Going in the other direction, previously exported items can be imported back into Online Filing for use as a basis for new applications or for looking up information; see Importing data into Online Filing (p. 115).

5.1 Preparing documents for attachment

Depending on the selected procedure and the type of document requested, you can select from several file types when attaching electronic documents to a form.

<table>
<thead>
<tr>
<th>File type</th>
<th>Document type</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>All document types, default option</td>
<td>EP, PCT</td>
</tr>
<tr>
<td>XML (PatXML)</td>
<td>Patent specification; prepared with the PatXML Software, including referenced JPG or TIF images</td>
<td>EP(1001E2K), PCT/RO/101</td>
</tr>
<tr>
<td>TIFF (TIF)</td>
<td>Facsimile signature</td>
<td>EP</td>
</tr>
<tr>
<td>JPEG (JPG)</td>
<td>Facsimile signature</td>
<td>EP, PCT</td>
</tr>
<tr>
<td>TIFF (TIF)</td>
<td>All document types</td>
<td>PCT</td>
</tr>
<tr>
<td>JPEG (JPG)</td>
<td>All document types</td>
<td>PCT</td>
</tr>
<tr>
<td>TXT</td>
<td>Sequence listing</td>
<td>EP, PCT</td>
</tr>
<tr>
<td>APP, SEQ</td>
<td>Sequence listing, compliant with WIPO Annex C/ST.25</td>
<td>EP, PCT</td>
</tr>
<tr>
<td>ZIP</td>
<td>Pre-conversion archive, sequence listing</td>
<td>EP, PCT</td>
</tr>
</tbody>
</table>

Generating XML files

Various software products are available from national and international patent offices which allow users to generate XML files which meet their standards:

- PatXML (EPO) is based on Microsoft Word®. Users can prepare their documents in the familiar Word environment or import documents formatted using standard sections. The file type of the finished XML files is .pxml.

More information about PatXML can be found on the EPO website at Applying for a patent > Online services > Online Filing > Download auxiliary software (http://www.epo.org/applying/online-services/online-filing/auxiliary.html).

- **PCT-SAFE Software** (WIPO)
  For information about this product see the WIPO website at IP Services > PCT > PCT Electronic Filing (http://www.wipo.int/pct-safe/en/).

Images which are part of the technical documents are referenced in the XML file to be attached and are automatically uploaded in the background. You will see these files later in Online Filing's PDF Viewer.

### Generating PDF files

The PDF format is suitable for all documents containing text or images. For example, you can save additional descriptions and notes relating to your application to PDF files or scan original documents not available in electronic form and convert them into PDF files.

To generate PDF documents for use in Online Filing, it is recommended that you use the **Amyuni® PDF Converter** which is delivered free of charge with the Online Services starter kit CD-ROM. The **Amyuni® PDF Converter** has been customised to embed all fonts (even the copyrighted ones) and has been preset with the required paper size.

Besides Adobe Acrobat®, there are many other products on the market that generate PDF documents. You may use any software which produces compliant PDF documents in a format compatible with Adobe Portable Document Format version 1.4 (Acrobat version 5 or higher).

### Compatibility requirements by the EPO and WIPO

The European Patent Office can only accept documents which are compliant with Annex F. A full version of Annex F can be found on the WIPO website at IP Services > PCT > Legal Texts (http://www.wipo.int/pct/en/texts/).

#### Rules for Annex F-compliant PDF files

- PDF files must be compatible with Adobe PDF version 1.4 or higher.
- The text in the PDF files must not be encrypted.
- PDF files must not contain any embedded OLE objects.
- The text in PDF files must not be compressed.
- Any fonts used in the PDF file must be embedded.
- The paper size in the PDF file may exceed A4 or US letter format by up to 5%, so, sizes up to 312 mm by 227 mm or 12.28" by 8.94" are accepted. Online Filing issues a warning if the document's paper size is larger and will not attach the PDF file.
- A mixture of landscape and portrait formats is allowed in a file.

#### Rules for Annex F-compliant images

- **TIFF** (file type .tif)
  - Only black and white images are allowed
  - When saving an image as TIFF the following settings should be selected: TIFF V6.0 with Group 4 compression, single strip, Intel encoded (i.e. for IBM PC format, not Macintosh).
  - Image resolution must be 300 or 400 dpi.
Creating ZIP archives for attachment as pre-conversion archive

You can create ZIP files by using archiving software such as WinZip or WinRAR. However, the easiest method is to use the Send to option in Windows Explorer:

1. Select the files or folders you wish to archive.
2. Right-click the selection and from the shortcut menu select **Send to > Compressed (zipped) folder**.

   The selected files or folders are packed into a new ZIP file.

---

The EPO does not recognise documents as legally binding if they are exclusively filed as part of a ZIP archive. To be accepted as legally binding filings, the official patent documents must always be attached as PDF or ST.25 files under the correct document type.

---

5.2 Signing applications

Once all the mandatory information is completed, the application can be signed by users with appropriate user rights in Online Filing.

Types of signature

The EPO accepts three legally recognised types of signature:

1. **Alphabetical**
   - The name of the signatory is entered in the electronic form via the computer keyboard; see Alphabetical signatures (p. 95).

2. **Facsimile**
   - An electronic file containing a scanned image of a handwritten signature is attached to the application; see Facsimile signatures (p. 97).

3. **Enhanced digital signature with smart card**
   - A personal smart card is inserted into the reader connected to the PC and the user’s PIN code is entered; see Smart cards (p. 99).

An application can contain multiple alphabetical and/or facsimile signatures. It cannot be sent, however, until an enhanced digital signature has also been applied. No further signatures can be added once an enhanced digital signature is added as this finalises the signing process.

Applying a signature

A signature may be applied by any smart card user in any of the three accepted formats when filing to the EPO.

A person applying an alphabetical or facsimile signature need not be party to or authorised in proceedings but the signature applied must be of a person authorised and recognised by the EPO to act in the proceedings in question. Any such signature will then need to be confirmed by an enhanced digital signature for non-repudiation before it is sent. This confirms the identity of the smartcard user applying any such signature (not applicable to appeal proceedings).

An enhanced digital signature using a smart card should only be applied for normal signing purposes by a smart card holder who is authorised to act in proceedings before the EPO, for the application being signed. The smart card signature of a smart card holder not authorised to act in the proceedings for which that signature is applied will not be accepted as valid.

Preparing for signature

If you want an application to be signed, you must first move it to Ready to sign status in the workflow process. There are two ways to do this while the application is still in Draft status:

- In the open application, click File > Save As > Ready to Sign.
  The form view closes, leaving the application in Ready to sign status in File Manager.
  or
- In File Manager, select the application and click the Next button (the tool-tip indicates "Ready to sign")

Starting the signing process in File Manager

If the status of the application is Ready to sign, the signing process is automatically started as the next stage in the workflow process as soon as you open the application or click the Next button.

- Double-click the application.
  or
- Select the application and click the Next button (the tool-tip indicates "Sign").
Starting the signing process directly from draft status in the form

You can skip the **Ready to sign** status by activating the option **Start signing immediately when moving application forward from draft status** under **Confirmations** (p. 58) in User Preferences. This means that the signing dialog will be opened immediately.

- In the menu, click **File > Save As > Ready to Sign and Sign**.
  
  or
  
  Click the **Next** button (the tool-tip indicates "Move to Ready to Sign and Sign").

Form PCT/RO/101 provides different functions; see Processing the PCT/RO/101 application (p. 343) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

**Signing**

The **PDF Viewer** opens with a preview of the application. It is recommended that you use this opportunity to check all documents for accuracy before the application is signed.

- To proceed, click **Sign Now** on the lower right of the PDF Viewer.
- To stop the signing process, click **Cancel**.
  
  This returns the application to the **Ready to sign** status in File Manager.
5.2.1 Alphabetical signatures

In the example below, the proprietor of the patent files a submission in opposition proceedings. The proprietor is represented by a patent attorney, whose secretary is going to send the application to the EPO.

You, the secretary, apply an alphabetical signature on behalf of the attorney and then sign the application with your own smart card for non-repudiation; i.e. you confirm the validity of the alphabetical signature with your own smart card signature.

- Select the representative’s name as signatory in the Sign Application window.
- Under Type of signature, select Alphabetical.
- In the Signature field, enter the name of the person enclosed in slashes, e.g. /David Kilburn/.
- Enter the Place of signing (optional).
- Click Sign.
Figure 101: Applying alphabetical signature for the representative

A warning appears if you accidentally remove or forget to enter the slashes in the **Signature** field.

- **Click OK.**
  
The missing slashes are automatically inserted by the software.

Figure 102: Note on alphabetical signature

**Other actions**

- **Add more signatures if required.**
- **To remove a signature, select the corresponding name and click** Remove. 
- **To save the current selection for the type of signature, select the check box** Save settings as default. 
  
  This changes the Signing preferences (p. 58) in the User Preferences.

- **Click Close when ready.**
5 Processing applications

Figure 103: Other options in the Sign Application window

The following message box appears while Online Filing is processing the text signature.

Figure 104: Message box that appears when a signature is being created

The Sign Application window closes automatically when the process finishes. The status of the application remains in Ready to sign in File Manager because the sending process cannot be initiated without an electronic signature.

5.2.2 Facsimile signatures

In this example, the applicant is a legal body and represented by an employee under Article 133(3) EPC. The facsimile signature of the employee is attached to the application.

- Prepare the signature as an image file by scanning a sheet of paper with the handwritten text or using a pen tool to write the signature in a suitable graphics suite.
  - You can use files in either TIFF (*.TIF) or JPEG (*.JPG) format. The default is TIFF.
  - The file name must not contain any spaces or special characters.
  - The signature file must be Annex F-compliant (see "Preparing documents for attachment" p. 90).
- In the Sign Application window select the relevant Applicant (if not already selected).
The **Employee name (Art. 133 EPC)** field is automatically populated with the name entered in the **Names** tab and cannot be edited.

The **Function of person signing** field remains empty and is disabled.

- Under **Type of signature**, select **Facsimile**.
- Enter the **Signatory Name**.
- To attach the image file with the signature, click **Choose File**, navigate to the file’s storage location and click **Open** to select it. The button’s label changes to **Remove**.
- Enter the **Place of signing** (optional).
- Click **Sign**.
- Click **Close** when ready.

![Sign Application](image)

**Figure 105: Facsimile signature for the applicant’s employee attached in JPG format**

The following message box appears while Online Filing is processing the facsimile signature.

![Warning](image)

**Figure 106: Message box that appears when a signature is being created**

The **Sign Application** window closes automatically when the process finishes. The status of the application remains in **Ready to sign** in File Manager because the sending process cannot be initiated without an enhanced electronic signature.
5.2.3 Smart cards

The European Patent Office provides registered users of Online Services with smart cards for digital signing. Smart cards are a very secure method for encrypting signatures. Smart cards can be ordered free of charge from the EPO. Alternatively, you can register existing smart cards with the EPO for filing. For more information, go to the EPO website at Applying for a patent > Online services > Security > Smart cards (http://www.epo.org/applying/online-services/security/smart-cards.html).

The smart card is produced by a certification agency. It includes two certificates, a PKCS#7 certificate and a PKCS#11 certificate. Both contain a public and a private RSA key for the user. The private key is only visible if a user logs on to the smart card administration tool (GemSafe Toolbox) with the smart card PIN.

![Image of smart card]

*Figure 107: Inserting smart card into card reader*

**Security information**

When an attorney leaves a company, the company should inform EPO User Support and have the attorney's card revoked. It should also tell the EPO the identity of the attorney taking over the relevant files. The files are then detached from the previous representative and attached to the new one. After this has been done the previous attorney will no longer be able to see the files as "his" assets.

Smart cards may not be shared. Each and every person in a company who has the right to access Online Filing should apply for a personal smart card. These should not be given to any other employee. The personal smart card allows the holder to use all EPO Online Services for which he is authorised by his enrolment.

**Signing with the smart card as an applicant or representative**

A smart card signature is legally binding. You cannot add any more signatures after you sign an application with the smart card.

In this example, you, the representative, are a natural person and you sign the application yourself.

1. Select the representative in the Sign Application window.
2. Under Type of signature, select Smart Card.
3. Insert your personal smart card into the reader connected to your PC; see Checking the smart card (p. 102).
→ Enter your PIN code.
→ Enter the Place of signing (optional).
→ Click Sign.

![Sign Application](image)

**Figure 108: Representative signing with her personal smart card and PIN code**

**Signing with the smart card as a legal applicant**

The legal owner or director of a company may sign an application with a personal smart card, if there is no authorised employee or representative. The function of the person signing can be optionally specified in the signing dialog. However, the name of the smart card holder will always appear on the PDF form to identify the signatory to the EPO.

In the example below, you, the director of a company, enter a function and sign as the applicant.

→ In the **Sign Application** window, select the role on the left.

The **Employee name (Art. 133 EPC)** field remains empty and is disabled.

→ Enter the **Function of person signing**, e.g. **Director** (optional).

→ Under **Type of signature**, select **Smart Card**.

→ Enter the **PIN code**.

→ Enter the **Place of signing** (optional).

→ Click **Sign**.
Signing with the smart card as an employee under Article 133 EPC

Only an employee who is authorised to represent the applicant under Article 133 EPC is allowed to sign an application for the applicant. That employee's name is indicated in the Names tab of form EP(1001E2K), Euro-PCT(1200E2K) or EP(Oppo); see the corresponding sections in this user guide.

For more legal information visit the EPO website to read the full text of Article 133 EPC (http://www.epo.org/law-practice/legal-texts/html/epc/2010/e/ar133.html).

The example below shows you, an employee authorised under Article 133 EPC, signing for the opponent, legal person.

- Select the applicant on the left.
  - The Applicant Name and Employee Name (Art. 133 EPC) fields are automatically populated and locked for editing.
  - The Function of person signing field remains empty and is disabled.
- Under Type of signature, select Smart Card.
- Enter the PIN code.
- Enter the Place of signing (optional).
- Click Sign.
The message box "The electronic signature is being applied ..." appears while Online Filing is processing the digital signature. The **Sign Application** window closes automatically when the process finishes. The status of the application changes to **Ready to send** in File Manager.

### 5.2.4 Checking the smart card

The **Smart Card Checker** tool is automatically installed together with File Manager, i.e. the Online Filing client.

Smart Card Checker makes work easier for users signing with different types of smart card issued by different national patent offices. Smart Card Checker automatically checks the type and manufacturer of the smart card as soon as it is inserted in the reader, automatically finds the correct smart card driver software on the computer and checks the registered certificates. Smart Card Checker starts at the same time as File Manager. When active, the Smart Card Checker icon is displayed on the Windows toolbar. The icon for the smart card reader shows a small certificate when the user data has been successfully read from the smart card.

![Programme icons in the Windows system tray](image)

- Make sure that the smart card reader is connected to your computer and working properly.
- Insert your smart card into the reader.
  - The green LED stops flashing and lights continuously when the smart card is operational.
5 Processing applications

Right-click the system tray icon and select **Check Smartcard**.

![Check Smartcard](image)

*Figure 112: Check smart card*

The smart card is checked. Smart Card Checker displays the message "Smart Card recognized".

![Smart card recognized](image)

*Figure 113: Smart card recognized*

If no smart card reader is connected to your computer, if the smart card is not properly inserted or if it is invalid, Smart Card Checker will tell you that the smart card has not been recognized. The green LED on the reader flashes if the smart card was not inserted correctly or cannot be read. The reader's icon also shows that there is no smart card in the reader, indicating that certificates could not be read.

![Smart card not recognized](image)

*Figure 114: Smart card not recognized*

### 5.2.5 Soft certificates

The EPO does not currently accept soft certificates as an electronic signature for filings to the EPO server. Other offices may, however, accept them for online filing. See the website of the office concerned for details.

**Signature with a soft certificate**

In this example, a PCT/RO/101 application to the International Bureau as the receiving office is digitally signed with a soft certificate issued by WIPO.

- Select the signatory in the list.
- Under **Type of signature**, select **Soft Certificate**.
- Click **Choose File**.
  - Online Filing accepts PKCS#12 certificates as files of type .p12 or .pfx.
- Select the soft certificate file and click **Open**.
The button label changes to **Remove**.

- Enter the **PIN code**.
- Enter the **Place of signing** (optional).
- Click **Sign**.

Figure 116: Applicant signing with soft certificate and PIN code
The following message box appears while Online Filing is processing the digital signature.

![Warning Message]

*Figure 117: Message window that appears when the electronic signature is being created with a soft certificate*

The *Sign Application* window closes automatically when the process finishes and the status of the application changes to *Ready to send* in File Manager.

### 5.2.6 Non-repudiation signature

An application without an enhanced digital signature, i.e. which has been signed with an alphabetical or facsimile signature but not with a smart card, must be manually changed to *Ready to send* status in File Manager.

Before the application can be sent, a *signature for non-repudiation* is required. Applying a non-repudiation signature not only validates the sender but also time-stamps the transaction, so it cannot be claimed subsequently that the transaction was not authorised or was not valid.

A non-repudiation signature can only be applied with a valid smart card.

1. Select the application in *Ready to sign* status.
2. Click the *Next* button ("Ready to send" is displayed as the tool-tip).
   The application switches to *Ready to send* status.
3. Click the *Next* button ("Send" is displayed as the tool-tip).

![File Manager Screenshot]

*Figure 118: Moving the application to "Send" in the workflow requires the signature for non-repudiation* The window *Please sign for non-repudiation* opens.

1. Select the type of signature you want: *Smart Card* or *Soft Certificate*. The default setting is *Smart Card*.
2. Enter the *PIN code* of your smart card.
3. Click *Sign*. 

The application is signed for non-repudiation and the sending dialog appears.

5.3 Sending applications

Once you have added a digital signature to your application it is ready to be sent to the EPO. It has moved from **Ready to sign** to **Ready to send** status.

- In File Manager, click the **Ready to send** status button.
- Select the application you wish to send.
- Click the Next workflow button ("Send" is displayed as the tool-tip).

The next dialog allows you to verify the selected method of sending.

- Modify the filing option or signing option, if required.
- Ensure that the transmission is going to the location you intend (demo server or production server).
- Click **Continue Sending**.

In the **Please enter PIN** window, enter your PIN and then click **OK**.
5 Processing applications

The application is now sent to the EPO. A progress indicator lets you know what stage the transmission is at.

5.3.1 Viewing receipts

When the transmission is finished, a message appears notifying you that filing has been completed and asking if you want to view the receipt.

- Click **Yes** to see the PDF version of the receipt.

The acknowledgement of receipt opens in the **PDF Viewer**. The acknowledgement contains the EPO application number and is stamped with the exact data and time of receipt. You can print the receipt by clicking the **Print file** icon in the PDF Viewer, or you can save a copy to your PC using the **Save file** icon.

- Click **Close** to quit the PDF Viewer.
- Any time you want to view a receipt again, select the application in File Manager and click **View...** in the **info pane**.
  - Or
  - In the menu, click **View > List of attached documents**.
5.3.2 Batch sending

Online Filing enables you to send more than one application at the same time.

- In File Manager, click the **Ready to send** status button.
- Select the first application you want to send with a click and all other individual applications with **CTRL+click**.
  - or
  - Select the first application and then press **SHIFT+click** the last one to select all of them.
- Click the **Next** workflow button (**Send** is displayed as the tool-tip).
Figure 125: Applications with “Ready to send” status selected for batch sending

The batch sending process and the process for sending single applications are basically identical save for the following modifications:

- The warning window and the window for PIN entry only appear once.
- The window to sign for non-repudiation appears if one of the applications has not yet been digitally signed.
- As each application is being sent, a progress indicator lets you know what stage the transmission is at.
- The window prompting you to view the acknowledgement of receipt does not appear.

5.4 Exporting data from Online Filing

Online Filing provides different functions for exporting data from File Manager, from the form and from Server Manager. Exporting can also be used to reduce database size by archiving and removing applications that are no longer needed for your current work.

Exporting from File Manager

The export functions in File Manager allow the export of both multiple applications/templates and individual items. Three options are available:

- **Export Forms** - select one or multiple items (EP forms, templates and PCT/RO/101 forms) in the Forms Export dialog; see Exporting items (p. 110).
- **Export XML to File(s)** - select one or multiple items (only EP forms) in one of the File Manager's folders. Each item is exported as a ZIP file; see Exporting data as XML to ZIP file (p. 113).
- **Export XML to Folder(s)** - select one or multiple items (only EP forms) in one of the File Manager's folders. Each item is exported to a new folder; see Exporting data as XML to folder (p. 113).

**Exporting from the form view**
You can export the last saved status of an application (or a template) that is currently open in the form view. Exporting from the form is only possible while an application is still in Draft status.
- For EP forms, two options are available:
  - **Export** - creates a ZIP file.
  - **Export XML to folder** - exports the data into an existing folder in your file system.
- For PCT/RO/101 forms, please refer to Exporting and importing a form (p. 347) in the section on PCT/RO/101 or in the online help for form PCT/RO/101.

**Exporting from Server Manager**
The **Export** function in Server Manager offers extended filtering and sorting options for preparing the range of applications to be exported; see Exporting items (p. 411) in the Server Manager section.
Note that the **Export** function of Server Manager is not available for data created in the File Manager's demo mode.

**Archiving database content**
Keeping a large number of applications in the Online Filing database may eventually affect the system performance. It is therefore recommended to clear out the folders occasionally by archiving your application data to other storage locations on your computer system.
Selecting the option **Delete items from database after archiving** in the **Forms Export** dialog removes all selected applications from Online Filing after backup copies are made; see Deleting items from the database after archiving (p. 112).

**5.4.1 Exporting items**
If you want to export any sent applications, templates, or previously prepared EP and/or PCT forms at the same time, the recommended procedure is described below.
- In the File Manager menu, click **File > Export > Forms**.
  - All available applications are shown by default.
- Select the check boxes of the items you wish to export.
- Click **OK**.
Figure 126: Selecting individual applications for export

Online Filing navigates to the working directory specified for export in **User Preferences**.

- Navigate to the destination folder you require.

Each time you export an application, the Export function creates a new ZIP file and names it according to the application's user reference. If a ZIP file of the same name already exists in the export folder, e.g. `sample_oppo.zip`, the following ZIP files will be named `sample_oppo_001.zip`, `sample_oppo_002.zip` and so on. The same applies if two or more applications have the same user reference.

- Click **OK** to confirm the file location.

**Figure 127: Select location for export**

- In the **Export complete** message, click **OK**.
- View the ZIP files in the selected export folder.
An exported ZIP file contains a number of PDF files and XML files that have been created internally by Online Filing. In this example, the ZIP file also contains DAT files that have been generated by the packing and signing process.

![Figure 128: Exported ZIP file contents](image)

5.4.2 Deleting items from the database after archiving

In order to free up database space, it is recommended to archive submitted applications on a regular basis.

In this example, all Sent applications are marked for archiving. They will be removed from the Online Filing database.

- Select the Sent folder on the left.
- Click the green check label in the list heading to select all forms.
- Select the check box Delete items from database after archiving.
- Click OK and then proceed as described in Exporting items (p. 110).

![Figure 129: Select all applications with Sent status for export and deletion from the database](image)

The data can always be imported back into Online Filing via the Import functions of File Manager or Server Manager.
After deleting applications from the database, it is advisable to use the *Empty Database* function in Server Manager to clean the database and physically free up the additional space; see Creating a new empty database (p. 410).

### 5.4.3 Exporting data as XML to ZIP file

Individual applications can be exported as XML files packed into a compressed ZIP file. This operation can be carried out from File Manager or directly from an opened form.

- When in File Manager, select the application and, in the menu, click *File > Export > XML to File(s).*
  - or
  - When in the form, click *File > Export.*

Online Filing navigates to the working directory specified for export in *User Preferences*.

- Edit the *File name* as required.
  - If you are exporting from File Manager, the application's user reference is already entered by default.
  - If you are exporting from the form view, the *File name* field will be empty.

- Click *Save* to start exporting.

The ZIP file is saved on your computer. If the destination folder already contains a ZIP file with the same name, a warning message will be displayed asking you if you want to replace the existing file.

![Figure 130: Enter file name for exporting XML to ZIP](image)

### 5.4.4 Exporting data as XML to folder

Individual applications in Online Filing can be exported as XML files to an external folder. This operation can be carried out from either the main File Manager interface or directly from the form view.
When in File Manager, select the application(s) and, in the menu, click **File > Export > XML to folder(s).**

or

When in the form, click **File > Export XML to folder.**

Online Filing navigates to the working directory specified for export in **User Preferences.**

Specify the target folder for export.

- If exporting from File Manager, the new folder will be created automatically with the same name as the application's user reference.

- If exporting from the form view, click **Make New Folder** and enter a name for this folder. If you do not do this, the exported files will be stored in the specified destination but will not have a separate sub-folder for unique identification.

Click **OK** to start exporting.

If the destination folder already contains folders or files with the same names, a warning message will be displayed asking you whether existing files should be overwritten.

In the **Export complete** message, click **OK.**

The new folder now contains XML and PDF files created by Online Filing.
5.5 Importing data into Online Filing

Previously exported applications can be imported back into Online Filing in File Manager or Server Manager and through the form. Importing applications generally resets their status to Draft. This means that Online Filing also removes all signatures or acknowledgements of receipt from re-imported applications which had Ready to send or Sent status before they were exported. Only when re-imported via Server Manager do sent applications retain their Sent status.

Importing via File Manager
The Import function in File Manager allows you to import one application at a time. Importing creates a new draft and immediately opens the form for editing.

Importing in the form view
You can create a new blank draft form and then import an application which is based on the same procedure. Note that importing into an opened form will delete any previously entered data.

This import function is not available for the PCT/RO/101 form.

Importing via Server Manager
The most convenient way to import multiple applications at once is to use the Import function in Server Manager. For more details, see Importing items (p. 413) in the Server Manager section.

The Import function of Server Manager is not available for data created in the File Manager demo mode.

5.5.1 Importing data as XML from ZIP file

- When in File Manager, click File > Import > XML from File.
  - or
  - When in the form, click File > Import.
  - Online Filing navigates to the working directory specified for import in User Preferences.
- Select the ZIP file and click Open to start importing.
The **Create a New Application** window opens.

- Enter a new user reference.
  - When importing a PCT application, only unique user references are accepted.
- Select a folder, and then click **Create**.

The application then opens in the form view.

- Continue with the application and save your work as you require.
5.5.2 Importing data as XML from folder

- In the menu (File Manager or form view), click **File > Import > XML from folder.**
  Online Filing initially navigates to the working directory specified for import in **User Preferences.**
- Select the folder containing the application to be imported.
- Click **OK.**

![Select folder to import application](image)

*Figure 135: Select folder to import application*

The **Create a New Application** window opens.

- Enter a new user reference.
  1. When importing a PCT application, only unique user references are accepted.
- Select a File Manager folder and click **Create.**
  The application then opens in the form view.
- Continue with the application and save your work as you require.
6 EP(1001E2K)

Form EP(1001E2K) is the default form used for requesting the grant of a European patent and examination of the application under Article 94 EPC. The application can be filed directly to the EPO or via one of the participating national offices.


Data input in form EP(1001E2K)

Form EP(1001E2K) is organised into eight tabs. It is recommended to enter the data in the tab sequence given, i.e. starting with the Request tab. Certain options and conditions in the Documents tab, for instance, are determined by the selections you make in the Request tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Request</td>
<td>Select the filing office, request examination in admissible non-EPO language,</td>
</tr>
<tr>
<td></td>
<td>select the procedural language, enter the title of invention, enter details of</td>
</tr>
<tr>
<td></td>
<td>divisional application or reference to a previously filed application.</td>
</tr>
<tr>
<td>Names</td>
<td>Enter details of applicant(s), representative(s), inventor(s) and authorisations.</td>
</tr>
<tr>
<td>States</td>
<td>Designate contracting states, extension states and validation states.</td>
</tr>
<tr>
<td>Priority</td>
<td>Declare national, regional or international priorities.</td>
</tr>
<tr>
<td>Biological Material</td>
<td>Enter details of deposited microorganisms and the depositary institution.</td>
</tr>
<tr>
<td>Documents</td>
<td>Attach the specification documents, their translations and other electronic files.</td>
</tr>
<tr>
<td>Fee Payment</td>
<td>Enter the mode of payment, select fees according to the appropriate fee schedule.</td>
</tr>
<tr>
<td>Annotations</td>
<td>Supply additional information for the EPO.</td>
</tr>
</tbody>
</table>

Mandatory fields

A red triangle in the upper right-hand corner of a field indicates mandatory information. You must either manually fill out this field or select one of the options provided. If mandatory fields are not completed, the corresponding tab will show a red validation icon. Consult the validation messages for more information.

Figure 136: Filing Office is a mandatory field in the Request tab and is marked with a red triangle
Elements in Form EP(1001E2K)

**Figure 137: Form EP(1001E2K) - Overview**

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>Provides all options needed to edit, save, import and export drafts, set the display and change the status, as well as other tools.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td><strong>Location Indicator Bar</strong></td>
<td>Shows the selected procedure, the current status and the user reference for the open draft.</td>
</tr>
<tr>
<td><strong>Navigation Bar</strong></td>
<td>Displays tabs corresponding to the sections of the form. These tabs can contain sub-tabs, which are a sub-division of the main tab sections within the form.</td>
</tr>
<tr>
<td><strong>Details Area</strong></td>
<td>Displays data entry fields appropriate to the selected tab.</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Displays information about the current activity. Shows the total number of validation messages for the open draft.</td>
</tr>
</tbody>
</table>
6.1  EP(1001E2K) – Request

The Request tab of Form EP(1001E2K) features three sub-tabs, in which you enter the following information:

Request
- Filing office
- Language in which the request for examination is made
- Declaration under Rule 6(4)
- Waiver pursuant to Rule 70(2)
- Procedural language, i.e. language in which the form is being submitted to the EPO
- Filing language, i.e. language in which the attached application is being filed or in which a previous application has been filed (technical documents)
- Title of the invention in English, French and German

Divisional
- Indication that it is a divisional EP application
- Application number of earlier application
- Date of filing of earlier application
- Generation of the divisional application

Reference
- Declaration that the application is an Article 61(1)(b) application
- Reference to a previously filed application
- Data relating to the previously filed application
- Various options as to how the referenced application is to be used in the procedure

6.1.1  Request details

The basic details relating to an EP(1001E2K) application are entered in the Request sub-tab of the Request tab.

Filing office
- Select the relevant patent office from the Filing office drop-down list or enter the two letter country code.
  This information is mandatory.
  The list of filing offices includes the EPO and all national patent offices that allow online filing with the EP(1001E2K) procedure.

Language in which the request for examination is made
Applicants who are nationals of an EPC contracting state or who have their residence or principal place of business in an EPC contracting state can request examination in an official language of that state, if this language is an admissible non-official EPO language, i.e. if it is not English, French or German (Article 14(4) EPC).
→ If appropriate, select the check box **Request for examination in admissible non-official EPO language**.
→ Select the relevant language from the drop-down list.

The text "Examination of the application under Art. 94 EPC is hereby requested" is displayed in the selected language.

**Declaration under Rule 6(4) EPC**

The check box for the declaration under Rule 6(4) becomes available if you select one of these options:

- **Request for examination in admissible non-official EPO language**
- **Admissible language of an EPC contracting state** (under **Filing language of attached or previous application**)

The validation messages in the **Request** tab (severity level 2) provide further details. If each applicant fulfils the conditions of Rule 6(4) EPC, then you should select the corresponding check box intended for the declaration under Rule 6(4) EPC to enable the Online Filing software to calculate the fee reduction.

Under Rule 6(3) EPC, the EPO grants a reduction in the examination fee and filing fees if applicants referred to in Article 14(4) EPC belong to one of the following groups specified in Rule 6(4) EPC:

(a) small and medium-sized enterprises (SMEs);
(b) natural persons; or
(c) non-profit organisations, universities or public research organisations.

→ To declare that the applicant(s) fulfil the conditions of Rule 6(4), select the check box **The/Each applicant hereby declares that he is an entity or a natural person under Rule 6(4) EPC**.

→ When you enter the relevant data in the **Names** tab, please verify that all applicants fulfil the conditions of both Article 14(4) EPC and Rule 6(4) EPC; see **Applicants** (p. 129) for more details.

If the declaration under Rule 6(4) EPC is selected and all applicants fulfil the conditions of Article 14(4) EPC, then the reduced fees will become available in the **Fee selection** sub-tab:

- The examination fee (006) will be reduced by 30%.
- The filing fee (001), the additional divisional fees (522 to 525) and the additional filing fee for the 36th and each subsequent page (501) will be reduced by 30%.

**Waiver pursuant to Rule 70(2)**

→ If you wish, select the check box **The applicant waives his right to be asked whether he wishes to proceed further with the application (Rule 70 (2))**.

This waiver does not apply until after payment of the examination fee. If you select **Automatic debit order** in the **Fee Payment** tab, fee 006 will be paid automatically. If you select another mode of payment, you should select fee 006 manually in the **Fee selection** sub-tab. A validation message to that effect (Severity 3) is displayed in the **Fee Payment** tab.
Procedural language
At the time of creating a new application, you select the procedural language from the three official languages: English, French or German. The application form will be created in this language. However, this setting has no effect on the language of the Online Filing graphical user interface.

- If required, change the procedural language now by selecting another language from the drop-down list.

Filing language
The filing language is the language in which the attached application is being filed or in which a previous application has been filed, i.e. it is the language that is used in the technical documents. Applicants who are nationals of an EPC contracting state or who have their residence or principal place of business in an EPC contracting state can file their application in an official language of that state, if this language is an admissible non-official EPO language, i.e. if it is not English, French or German (Article 14(4) EPC).

- Select the **Filing language of attached or previous application** from one of the three options.
  - The default option is the selected procedural language.
- Select either **Admissible language of an EPC contracting state** or **Other language** to activate the corresponding drop-down list.
- Select the appropriate language.

Title of invention
The title of invention must be a clear and concise technical designation of the invention in the procedural language you selected. It is advisable to supply translations in the other two official
languages so that the title of invention can be published in all three languages (Article 14 EPC). If you do not enter any translations, these will be supplied by the EPO.

- Please enter the title of invention and the translations in capital letters.
  - To harmonise patent bibliographic data, as of 1 April 2015 the EPO’s systems will automatically convert all titles and their translations to uppercase for all new applications filed.

- In the Request sub-tab enter the Title of invention in English.
- Enter the Translation into French and the Translation into German.
  - The sequence in which the fields for the title of invention and the translations appear will change if you change the procedural language. You should therefore make sure that each language version is in the correct field.

![Figure 140: Title of invention in English, French and German](image)

### 6.1.2 Divisional application

Divisional applications can only be filed with the EPO. If you selected a different filing office in the Request sub-tab, you will not be able to enter any data in the Divisional sub-tab.

- European divisional applications must be filed while the earlier European application is still pending (Rule 36 EPC).

- Select the Divisional application check box.
  - This activates the sub-tab for editing. All fields are mandatory.
- Enter the Application number of earlier application.
- Enter the Date of filing (Art. 80/Rule 40 EPC).
- From the drop-down list next to This divisional application is of the following generation, select the appropriate option.
  - The EPO charges an additional fee as part of the filing fee for divisional applications of the second or any subsequent generation; see Fee selection (p. 168).
If you change the **Date of filing (Art. 80/Rule 40 EPC)** in the **Divisional** sub-tab under the **Request** tab, all of the designation states and none of the extension and validation states will be selected, i.e. the default settings appear and any states previously expressly selected in respect of the applicant(s) are lost. If this happens, please click the **States** tab and select the states again as appropriate. The yellow validation icon in the **States** tab notifies you of a warning message to this effect.

**Requesting the EPO to copy the sequence listing from the parent application for search purposes**

Under Rule 40(1)(c) EPC, a sequence listing that is part of the description of the divisional application must be submitted together with the other documents making up the divisional application, unless reference is made to a previously filed application containing a sequence listing as part of the application (OJ EPO 2013, 542).

If you have submitted a Standard-compliant sequence listing in computer-readable format together with the parent application, however, you can ask the EPO to use that sequence listing **for search purposes only (i.e. not as part of the description)** in respect of the divisional application.

- To ask the EPO to add a copy of the sequence listing filed for the earlier application to the dossier and to declare that the sequence listing does not extend beyond the content of the divisional application as originally filed, select the check box labelled **The Office is requested to add a copy [...].**

**6.1.3 Reference**

In the **Request** tab's **Reference** sub-tab, you can make a reference to a previously filed European or international application.

- Select the check box **Reference is made to a previously filed application.** This activates the tab's other fields for editing.

**Reference to an application previously filed with the EPO**

- Select the EPO as the **Office where previous application was filed.**
- Select patent application as the **Kind of application.**
- Enter the **Filing date** of the previous application.
→ Enter the EP application number of the previous application into the Application number field in the format YYnnnnnn.d, i.e. including the check digit.

Reference to a previous PCT application
→ Select the Office where previous application was filed.
→ Select PCT application as the Kind of application.
→ Enter the Filing date.
→ Enter the Application number of the previous PCT application in the format PCT/CCYYYY/nnnnnn or PCT/CCYY/nnnnn.
The 2-digit country code (CC) is automatically pre-set in the Application number field when you select the international office from the drop-down list.

Reference to a previous international or national application
→ Select the Office where previous application was filed.
→ Select the Kind of application (the available options depend on the office where the application was filed).
→ Enter the Filing date.
→ Enter the Application number of the previous application.
Hints for the correct format of this application number are shown to the right of this field.
Additional options depending on other application-specific data

Reference replaces claims
- Select the check box *It is hereby declared that the reference to the previously filed application also replaces the claims (Rule 57(c)),* if applicable.
- Enter the appropriate *Number of claims in previous application.*
- Enter the *Number of claims you intend to pay for (including first 15 claims).*
  - This indication is exclusively for the purpose of fee calculation. If you do not intend to pay for any claims with this application, please enter 0 (zero) in this field.
  - If you do not enter a reference to the claims in the *Request* tab, you will be notified of this oversight by an error message in the *Documents* tab (red validation icon). You can attach a file with claims here or indicate that you intend to file the claims later; or you reference the claims.

Previous application is the priority document
- Select the check box *Previously filed application is also a priority application,* if applicable.

The warning (yellow validation icon) in both the *Request* and *Documents* tabs indicates that a copy of the search results required under Rule 141(1) EPC must be provided.
The related document can be attached in the **Documents** tab; see **Additional documents** (p. 162).

**Figure 147: A copy of the search results must be provided**

A copy of the search results does not need to be supplied if it can be assumed that it is available to the EPO. This is the case if the previous application was filed with the **EP, JP, US, AT, GB, KR, DK** or **ES** office (exempted offices). A message to this effect (grey validation icon) appears.

**Figure 148: Earlier applications filed with one of the exempted offices are not required to file search results**

**Certified copy**

The check box **A certified copy will be filed later** is available if the selected filing office is not the EPO. In this case, a warning (yellow validation icon) appears, indicating that a certified copy of the previously filed application must be supplied within two months. The warning disappears as soon as you select the check box **A certified copy will be filed later**.

**Figure 149: A certified copy of the previously filed application must be supplied**

**Sequence listing**

You can specify that a sequence listing from the previously filed application should be used in the EP procedure.

- Select the check box **The description contains a sequence listing in accordance with Rule 30(1) EPC**.

In this case, you can only attach a sequence listing that complies with WIPO Standard ST.25 in the **Documents** tab; PDF formats are not allowed; see **Sequence listings** (p. 159).

**Re-establishing rights**

The check box **Re-establishment of rights** is active if the date of the earlier application is more than 12 months but less than 14 months prior to the date of the present filing and you have selected the check box **Previously filed application is also a priority application**. An
appropriate warning (yellow validation icon) indicates that you must request the re-establishment of rights.

- Select the check box **Re-establishment of rights**.

You can attach the reasons for re-establishment in the **Documents** tab (see Additional documents (p. 162)) or enter the text in the **Annotations** tab.

![Validation Messages/Request](image)

*Reference application: if priority date before 12 months from filing, re-establishment must be requested and fee paid, but can be provided subsequently to filing.*

**Figure 150: Re-establishment of rights must be requested and the fee paid**

### Art. 61(1)(b) application of earlier application

The check box **Art. 61(1)(b) application of earlier application** is only active if the EPO is selected as the filing office in the **Request** tab and the **Divisional application** check box is not selected in the **Divisional** tab.

### 6.2 EP(1001E2K) – Names

The **Names** tab of EP(1001E2K) is where you enter details of applicants, representatives and inventors. At least one applicant is required. Details of the inventor(s) may be filed later.

**Adding names**

- In the **Names** tab, click the **Add** button.
- Select a role.

![Options for adding names](image)

**Figure 151: Options for adding names**

- Complete the details in the entry fields on the right or copy a name from the Address Book.

**Exchanging names with the Address Book**

Online Filing provides an Address Book to help you organise your names and addresses. You can copy information from the current form to the Address Book or call up existing data from your Address Book.

1. Storing data entered in the form in the Address Book
   - Select a name (e.g. one of the applicants) and click the **Copy to Address Book** button.

   ![Copy to Address Book](image)

   If the data is successfully copied this is indicated in the status bar of the form.

2. Copying data from the Address Book to the form
Open the Address Book by clicking the Copy from Address Book button.

Select the required name.

Copy the data to the form by clicking the Copy records to form button.

The Address Book closes.

Removing names from the form

Select the name to be removed on the left-hand side of the form.

Click the Delete button.

6.2.1 Applicants

At least one applicant is required for filing. You can designate multiple natural and legal persons as applicants. The applicant you add to the form first will also be the first-named applicant in the patent application.

In the Names tab, click the Add button.

Select Applicant, Legal or Applicant, Natural.

Enter the details for the applicant or use the Copy from Address Book button.

Add more applicants if required by repeating the above procedure.
Figure 152: Details of legal applicant

**Address for correspondence**

You can specify a separate address for correspondence with the first-named applicant if you have not added a representative to the form. The country in the address for correspondence must be an EPC contracting state. The address for correspondence is only valid if the country in the applicant's main address is also an EPC contracting state.

The **Address for correspondence** check box is unlocked after the mandatory fields for the first-named applicant have been completed, i.e. First Name, Last Name (or Company), City and Country.

- Select the first-named applicant.
- Select the **Address for correspondence** check box.

**Address for correspondence** then appears in the list on the left.

Entering the address for correspondence is now mandatory. The red validation icon in the **Names** tab notifies you of a validation message to that effect.
Figure 153: A red validation icon is visible if the address for correspondence has not yet been provided

- Click the **Add** button and select **Address**.
  - Note that the **Representatives** options have disappeared.

Figure 154: Adding address for correspondence with the first-named applicant

The first applicant's name appears under **Address for Correspondence** on the left and the data entry fields become available on the right.

- Edit the address information as required.
  - The applicant's name cannot be edited in the address for correspondence. The **Company** field (legal applicant) and the **Last Name** and **First Name** field (natural applicant) are locked.
  - If you subsequently modify the first-named applicant's name under **Applicants**, the name in the address for correspondence will be updated accordingly.
  - If you delete the first-named applicant, the address for correspondence will also be removed from the form.
Applicant is represented by an employee

If the applicant is a company (legal person) with principal place of business in an EPC contracting state, it can be represented by an employee. An employee can only be selected as a representative if no other representative (legal or natural person) has been added to the form.

- Select the check box **[Company] is represented by the following employee acting pursuant to Art. 133(3) EPC.**
- Enter **Last Name** (mandatory field), **First Name** (mandatory field) and **Title**. The name of this employee will be automatically filled into the **Sign Application** dialog and cannot be modified. Only an employee who is authorised by the applicant under Article 133 EPC is entitled to sign.
- Enter the **General Authorisation** number (where applicable).
Conditions under Article 14(4) EPC for making the declaration under Rule 6(4) EPC

Under Rule 6(3) EPC, the EPO grants a reduction in the examination fee and filing fees if applicants referred to in Article 14(4) EPC belong to one of the following groups specified in Rule 6(4) EPC:

(a) small and medium-sized enterprises (SMEs);
(b) natural persons; or
(c) non-profit organisations, universities or public research organisations.

If the check box **The/Each applicant hereby declares that he is an entity or a natural person under Rule 6(4) EPC** in the **Request** tab is selected, the Online Filing software will validate the data that you enter for the applicants in the **Names** tab and cross-check these with the languages that you indicated in the **Request** tab.

To qualify for the fee reduction, all applicants have to fulfil both the above-mentioned conditions under Rule 6(4) EPC and the following conditions under Article 14(4) EPC:

- Natural applicants must be nationals of an EPC contracting state having an admissible non-official EPO language or residents in an EPC contracting state having an admissible non-official EPO language.
- Legal applicants must have their principal place of business in an EPC contracting state having an admissible non-official EPO language.
- The selected language must be both an official language of the EPC contracting state of at least one of the applicants and an admissible non-official EPO language (i.e. it must not be English, French or German).

The validation messages in the **Request** tab and **Names** tab will tell you how to correct your data if these conditions are not met.

Examples

The following examples demonstrate whether the applicants indicated in the **Names** tab fulfil the conditions of Article 14(4) or not – always in relation to the languages selected in the **Request** tab. If the answer is **yes**, the applicants can select the declaration under Rule 6(4) in order to get the fee reduction.

1. A company from the Netherlands selects Dutch as the language of the request for examination.
   **Yes**: Dutch is the official language in the Netherlands.

2. A natural person is a Swiss national and selects Italian as the filing language.
   **Yes**: Italian is one of the official languages in Switzerland, along with French and German.

3. A natural person is a national of Italy with residence in the UK and files a request for examination in Italian.
   **Yes**: Italian is the official language in Italy and the applicant is an Italian national.

4. A company has its principal place of business in the United Kingdom and files the request for examination in Italian.
   **No**: The UK is an EPC contracting state which does not have an admissible non-official EPO language and Italian is not an official language in the UK. The applicant does not fulfil the conditions under Article 14(4).
5. The applicants are a company from Poland and a company from Italy. They select Italian as the filing language.  
   **Yes**: Both applicants are from an EPC contracting state and Italian as the official language of Italy is an admissible non-official EPO language. In this example, the applicants could also choose between Polish and Italian because both languages are admissible.

6. The applicants are a company from Poland and a company from Germany. They select Polish as the filing language.  
   **No**: Germany is an EPC contracting state which does not have an admissible non-official EPO language. The applicant from Germany does not fulfil the conditions under Article 14(4).

6.2.2 Representatives

The **Representative** option is only available if no address for correspondence has been entered and if the applicant is not being represented by an employee under Article 133(3) EPC. The country of the representative must be an EPC contracting state.

- In the **Names** tab, click the **Add** button.
- Select **Representative, Association, Representative, Legal Practitioner** or **Representative, Authorised**.
- In the **Name and Address** sub-tab, complete the details or copy the name from the Address Book.
  - You can add more than one representative.

![Figure 157: Details of representative](image)

**Details relating to the representative's authorisation**

The **Authorisation** sub-tab is used to provide details relating to each representative.

- Select the **General Authorisation** check box.
- Select the appropriate option.
Related documents can be attached in the **Documents** tab; see Additional documents (p. 162).

![Figure 158: Details relating to the general authorisation of the representative](image)

### 6.2.3 Inventors

The yellow validation icon in the **Names** tab indicates that details of the inventor are required, but may be filed later. You can name any number of inventors.

**Applicant is also inventor**

If an applicant is a natural person, the same person can also be named as an inventor.

- Select the name of the applicant on the left.
- Select the check box **Applicant is also inventor** at the bottom of the form.

![Figure 159: The applicant is also the inventor](image)

**Designating one or multiple inventors**

If none of the applicants is a natural person and also inventor, the inventor(s) must be named separately.
Click the Add button.

Select Inventor.

or

Press CTRL+I.

Complete the fields in the Name and Address tab or copy an entry from the Address Book.

Select the appropriate option to describe the legal relationship between first-named applicant and inventor.

Deceased inventor

If one of the inventors to be designated is no longer alive, select the Deceased check box.

All the address fields except the Country field (mandatory) are locked.
Inventor waivers Rule 19(3) and Rule 20(1) EPC

An inventor is entitled to waive both his right to be notified by the EPO under Rule 19(3) EPC and his right to be mentioned as an inventor under Rule 20(1) EPC.

- Select the inventor concerned.
- Select the required options.

The corresponding validation messages (yellow icon) explain that each waiver must be signed by the inventor and filed as an additional document.

![Figure 162: Options for inventor waivers with corresponding validation messages](image)

Online Filing automatically generates a PDF document which is pre-filled with the inventor's and applicant's data.

- Open the PDF Viewer; see Viewing attached documents (p. 163).
- Print the waiver using the Print file icon in the PDF Viewer.
- Have the waiver signed by the inventor.
- Create a new PDF document from the signed waiver.
- Attach the waiver to the application under Additional documents (p. 162) in Form EP(1001E2K).

or

Submit it as a subsequently filed document with Form EP(1038E) (p. 211).
Public and non-public inventors

In this example, four inventors have been added to the form. One of the inventors has signed the waiver under Rule 20(1) EPC and is therefore designated as a non-public inventor.

Note that the waiver under Rule 19(3) EPC is a non-public document in this example, because that waiver is signed by the same non-public inventor for whom the waiver under Rule 20(1) EPC is being filed.

Online Filing generates two separate Designation of inventor PDF forms: one for the public inventors and one for the non-public inventors.
File **f1002-1.pdf** lists the public inventors.

![Figure 164: PDF form 1002-1 with designation of public inventors](image1)

File **f1002-2.pdf** lists the non-public inventors.

![Figure 165: PDF form 1002-2 with designation of non-public inventors](image2)
6.3 EP(1001E2K) – States

In the **States** tab you can designate the countries in which you require patent protection.

- You can specify all contracting states to the EPC in the **Designation** sub-tab.
- You can specify the extension states you want in the **Extension** sub-tab.
- You can specify the validation states you want in the **Validation** sub-tab.

The available states displayed in the three sub-tabs are determined by:

- your version of the Online Filing software (its release date and whether you have installed any relevant updates).
- the filing date of the earlier application if your application is a divisional application. The states available are those which were contracting states, extension states or validation states at the time of filing of the earlier application.
- the date on which the validation agreement with the national patent office of the relevant state has entered into force.

For the latest list of EPC contracting states, extension states and validation states see the EPO website at **About us > European Patent Organisation > Member states** (http://www.epo.org/about-us/organisation/member-states.html). The EPC contracting states include all overseas departments and territories.

---

If you change the **Date of filing (Art. 80/Rule 40 EPC)** in the **Divisional** sub-tab under the **Request** tab, all of the designation states and none of the extension and validation states will be selected, i.e. the default settings appear and any states previously expressly selected in respect of the applicant(s) are lost. If this happens, please click the **States** tab and select the states again as appropriate. The yellow validation icon in the **States** tab notifies you of a warning message to this effect.
6.3.1 Designating contracting states

In the **Designation** tab a list of the contracting states can be found under the heading **All states which are contracting states to the EPC at the time of filing of this application are hereby designated.** All states are automatically selected and cannot be edited.

![Figure 166: All contracting states to the EPC designated](image)

If you selected the check box **Divisional application** in the **Divisional** sub-tab you will see a message to the effect that the list of states corresponds to the states valid for the earlier application at the time of filing the divisional application.

![Figure 167: Reference to contracting states valid at the time of filing of the earlier application](image)

**Different designations for different applicants**

If more than one applicant is entered in the **Names** tab, you can define the designated states for each one. You can designate all states for each applicant, or exclude certain states for one or more applicants.

→ In the **Designation** sub-tab select the check box **Different designations for different applicants**.
→ Select an applicant from the list.
All states are automatically selected.

- Clear the check boxes for those states which you wish to exclude for the selected applicant.

In this example AT, DE and IT have been cleared.

![Designation Table](image)

Figure 168: Designating different states for different applicants

- Select another applicant from the list.

All states are once again automatically selected.

- Clear the boxes for the states you wish to exclude for the selected applicant.

In this example all the check boxes have been cleared except for AT, DE, IT, MC and MT. MC and MT are therefore designated for both applicants.

![Designation Table](image)

Figure 169: Designating individual states for further applicant

Payment of the designation fee means that all contracting states are designated for an application, regardless of the individual states designated on the form. If you expressly do not wish to designate one or more specific states for the entire application, you must submit your request in writing to the EPO. You can attach this document to the application in electronic format; see Attaching documents (p. 225).
6.3.2 Extension states

In the **Extension** sub-tab, select the states with extension agreements to which the patent application filed should also be extended. Appropriate fees are payable for this extension.

- Click the **Extension** sub-tab.
- Select the required option and, where appropriate, the individual states required.
  - Make sure you also select the extension fees for these states in the **Fee Payment** tab.

![Figure 170: Selecting extension states](image)

6.3.3 Validation states

In the **Validation** sub-tab, select the states with validation agreements to which the patent application filed should also be extended. Appropriate fees are payable for the selected validation states.

- Click the **Validation** sub-tab.
- Select the required option and, where appropriate, the individual states required.
  - Make sure you also select the validation fees for these states in the **Fee Payment** tab.

![Figure 171: Selecting validation states](image)
6.4 EP(1001E2K) – Priority

In the Priority tab of EP(1001E2K) you can give details of the priorities you wish to claim. You can declare more than one priority.

Translations of priority documents can be attached in the Documents tab.

→ In the Priority tab click the Add button and select National, Regional or International.
→ Select the office, the type of application and the filing date.
→ Enter the Application Number.
    For international and regional priorities the Application Number field offers a pre-set format for the application number, e.g.:
    - PCT/US__/___ when you select US as the receiving office of the international application.
      After the letters US enter the four digits for the year and the six digits of the application number. The pre-set slash remains in place.
    - EP______. when you select EP as the regional office.
      After the letters EP enter eight digits and the check digit for the application number.
      The pre-set full stop remains in place.
    For national priorities the format (where known) is shown to the right of the Application Number field. For example, if Italy (IT) is selected as the national office, different formats apply:
    - LL YYYY A nnnnnn for patent applications from 01.01.1991 until 30.06.2016.
      LL stands for the province (e.g. TO for Torino/Turin), YYYY for the year, A for patent application and nnnnnn for the number.
    - LL YYYY U nnnnnn for utility models from 01.01.1991 until 30.06.2016.
      U stands for utility model.
    - 10 YYYY nnnnnnnnn for patent applications from 01.07.2016 onwards.
    - 20 YYYY nnnnnnnnn for utility models from 01.07.2016 onwards.
    When entering national priority numbers you need not be concerned about the correct splitting format within data strings, i.e. you can use hyphens or commas instead of spaces as the format of the punctuation is not critical.
→ Select the check box Re-establishment of rights is hereby requested if the date of filing of the priority application is between 12 and 14 months prior to the current date. Applications should normally be filed within 12 months of the date of filing of the claimed priority. A yellow validation icon appears if you do not select the check box for re-establishment of rights.
→ To initiate accelerated processing under the PACE programme, select the check box It is not intended to file a (further) declaration of priority.
To complete the priority claim, a certified copy of the previous application containing the original of the certificate as issued by the receiving authority must be submitted within sixteen months of the earliest priority date claimed (Rule 53(1) EPC). See also the Decision of the President of the European Patent Office dated 17 March 2009 on the filing of priority documents, published in OJ EPO 4/2009, 236-237.

Filing search results for priority claims
A copy of the search results required under Rule 141(1) EPC for a priority claim does not have to be provided if the results are already available to the EPO; see also Reference (p. 124).

- If the selected office is not exempted from the obligation to file the search results, a yellow validation icon appears in the Priority tab.
- If the selected office is exempted from the obligation, a grey validation icon appears. At present (July 2016), these offices are EP, JP, US, AT, GB, KR, DK and ES.

  ➤ Click Choose file to attach the file with the search results.
  The file is renamed PRSR-1.pdf.
  The caption on the button changes to Detach file.
  ➤ If necessary, click Detach file to remove this file and attach a different document for this priority declaration.
6.5 EP(1001E2K) – Biological Material

In the Biological Material tab of EP(1001E2K) you can give details pertaining to the biological material used in/related to by the invention. Sequence listings are attached in the Documents tab.

Details of the deposit of biological material

- Click the Add button and select Biology.
- In the Deposit details sub-tab enter the identification reference.
- Select the Depository institution from the list (sorted alphabetically).
  The data in the name and address field is automatically added.
- The corresponding reference is entered in the accession number field and all you have to do is add your individual number.
- Under the Further details sub-tab you can attach a copy of the receipt issued by the depositary institution and other electronic documents.
6.6 EP(1001E2K) – Documents

In the **Documents** tab of form EP(1001E2K) you can add the mandatory parts of the application as well as other documents. Various options are available for your documents in the three sub-tabs **Specification**, **Sequence listings** and **Additional documents**.

In order to file your application, you must attach a description of the invention. The abstract, claims and any translations required can be filed later. The attached documents are copies of the originals. If the original changes and you wish to include the changes in the patent application, you will need to reattach the document.

**File formats**
The Online Filing software offers a number of ways of attaching your technical documents in electronic form:

1. Technical documents (description, claims, abstract and drawings) in one or more PDF files
2. Technical documents as XML or PatXML files
3. Pre-conversion archives as ZIP files

**File names**
On attachment, all documents are automatically renamed with standard system names, but for ease of recognition, the original file names are stored in Online Filing and appear later both
on the form (next to the system names) as well as on the confirmation of receipt issued by the EPO.

**Attaching documents**

→ Click the **Add** button.

A list of the documents which may be attached is shown.

![Image: Document types for attached files]

**Language of the documents**

The default language of the documents is **English**. Depending on the procedural language selected in the **Request** sub-tab and the language of the application, translations into the procedural language may additionally be requested.

In the example shown, **German** has been selected as the procedural language. The application itself is in Italian. The applicant must therefore file the original application documents in Italian along with translations into German.

![Image: Attaching documents in another language]

Translations may be filed later if required.

→ Select the check box **A translation will be supplied later** on the left-hand side below the list of attached documents.

The list of documents which may be attached changes accordingly.

![Image: Attaching documents in another language - translations to be filed later]
Removing documents

→ Select the document you want to remove.
→ Click the **Delete** button.

The copy of the file stored in the database is deleted. You can then add new documents again.

6.6.1 Attaching PDF files

You can attach one or more PDF files to your application as technical documents. For example, you can combine all components in a single file, create a separate file for each component or attach a number of components to multiple files. To do this, first attach a file in the **Specification** sub-tab, then specify the type of document and, where applicable, enter the page numbers for the individual components.

**Example 1 - All technical document components are attached as individual PDF files**

→ Click the **Specification** sub-tab in the **Documents** tab.
→ Click the **Add** button and select **Technical document(s) in English**.
→ Navigate to the folder on your computer where you already saved the files.

Online Filing opens the working directory that was created under **Tools > User Preferences** in File Manager.
→ Select the required file.
→ Click **Open**.

![Figure 178: Navigating to where the documents you want to attach are saved](image)

The file is attached and renamed **SPECEPO-1.pdf**.
→ Select the check box for the component you attached (**Description**, for instance).

The page numbers are automatically entered in the **From page:** and **to:** fields.
Figure 179: Description added as a PDF file in the "Specification" sub-tab

- Attach the next PDF file.
  The file is renamed **SPECEPO-2.pdf**.
- Select the check box for the component you attached (**Claims**, for instance).
- When attaching claims, enter the additional data in the two mandatory fields:
  - **Number of claims**
  - **Number of claims you intend to pay for (including first 15 claims)**.
  This indication is exclusively for the purpose of fee calculation. If you do not intend to pay
  for any claims with this application, please enter **0** (zero) in this field.
  If the number of claims you intend to pay for is lower than the number of claims indicated,
  a yellow validation icon will appear in the **Documents** tab. In this case, please specify the
  claims for which you intend to pay by writing a note to the EPO in the **Annotations** tab.
Repeat the process until all components are attached. The software automatically recognises and enters all page numbers.

Select the appropriate check boxes for the attached documents. You can only attach Description, Claims or Abstract once; these check boxes are disabled once you have attached a PDF file and you go to attach the next file. However, you can add as many drawings as you wish.

Enter additional data for the individual documents:
- If the abstract also contains a drawing: Figure to be Published with Abstract
- If you attach drawings: Number of Drawings
Figure 181: All four technical document components are added as PDF files

Example 2 - A PDF file with more than one component is attached

- Click the **Add** button and select *Technical document(s) in English*.
- Attach the required PDF file.
  The file is renamed **SPECEPO-1.pdf**.
- Select the check boxes for those components contained in the file (*Description* and *Abstract*, for instance).
- Enter the page numbers in the appropriate fields.
  - All pages in the document must be accounted for and there must be no overlaps.
  - The order of the individual components is not important, that is, the description does not have to appear as the first section on page 1 but can be the last section in the document.
  - Every element in the attached document must start on a new page.
- Claims may be filed later if required.
- Select the check box *It is intended to submit claims later* on the left-hand side below the list of attached documents.
6.6.2 Attaching XML and PatXML files

You can add XML files with the file extension .xml or .pxml. The file extension .pxml indicates that the file was generated using the PatXML software. XML files generated in accordance with EPO standards contain the prescribed components: description, claims, abstract and (embedded) drawings, so that no further files need to be attached. For more information about generating XML documents see Preparing documents for attachment (p. 90).

- In the Documents tab click the Specification sub-tab.
- Click the Add button and select Technical documents in English (XML).
- Go to where your file is stored.
- Select the appropriate file type: PatXML files or XML files.
- Select the required file.
- Click Open.

The file is attached and renamed to application-body.xml.

- If applicable, enter the number of the Figure to be published with abstract.
  
  The number of claims is identified by the software and automatically inserted.

- Enter the number of claims you intend to pay for (including first 15 claims). This data is not imported from the XML file.

  This indication is exclusively for the purpose of fee calculation. If you do not intend to pay for any claims with this application, please enter 0 (zero) in this field.

  However, the number of figures is identified by the software and automatically inserted.
6.6.3 Technical documents in other languages

The options available for adding technical documents depend on the procedural language and the filing language selected in the Request tab.

Where the language of the technical documents differs from the selected procedural language, each document in another language must be translated into the procedural language. Various combinations of files are available.

Example 1: Original-language technical documents are attached as a PDF file and the translation is attached as an XML file

- In the Documents tab, click the Specification sub-tab.
- Click the Add button and select Original in Italian.
  - In this example, Italian was selected as the filing language in the Request tab.
- Navigate to your PDF document and attach it.
  - The file is renamed SPECNONEPO.pdf.
- Enter the number of claims.
  - Enter the number of claims you intend to pay for (including first 15 claims).
  - This indication is exclusively for the purpose of fee calculation. If you do not intend to pay for any claims with this application, please enter 0 (zero) in this field.
- Enter the number of figures.
  - If your document does not have any drawings, enter 0.
- If applicable, enter the number of the Figure to be published with abstract.
Figure 184: Attaching the Italian original

- Click the **Add** button again and select *Translations into German (XML)*. In this example, German was selected as the procedural language in the **Request** tab, so a translation of the original application into German is required.
- Navigate to the XML document containing the translation and add it. The file is renamed **application-body.xml**.
Example 2: Multiple PDF files are attached for originals and translations
You can attach up to two files for documents in the original language, i.e. either a PDF file containing the complete set of documents (including drawings) or one file with the documents and another with the drawings. If you would like to attach the drawings separately, we strongly recommend performing the following steps in the order shown:

- Attach **Drawings in Italian**.
  - The file is renamed **DRAWNONEPO.pdf**.
- Enter the **Number of figures**.
- Next, select **Original in Italian** and attach the file.
  - The file is renamed **SPECNONEPO.pdf**.
- Enter all additional data.
  - The **Number of figures** field is deactivated if you already attached a file with drawings.
Figure 186: Documents added in the original language

- To attach the two documents with the translations, select the option *Translation of technical document(s) into German* for each document.
- Attach the translated drawings first. The file is renamed SPECTRANEPO-1.pdf.
- Select the check box for *Drawings*. The page numbers are automatically entered in the *From page:* and *to:* fields.
- Attach the translated specification. The file is renamed SPECTRANEPO-2.pdf.
- Select the check boxes for *Description, Claims* and *Abstract* and enter the page numbers for the components.
6.6.4 Pre-conversion archive

The pre-conversion archive option allows you to add your original documents, before converting them into PDF or XML files, as a compressed ZIP archive file. This may be helpful if you wish to provide the EPO with your original documents in colour. The documents contained in the ZIP file will not be publicly available nor will they be an integral part of the visible internal procedural file, but they can be accessed for reference, e.g. in the event of quality issues.

The EPO does not recognise documents as legally binding if they are exclusively filed as part of a ZIP archive. To be accepted as legally binding filings, the official patent documents must always be attached as PDF or ST.25 files under the correct document type.

**Attaching pre-conversion archive**

- In the **Documents** tab under the **Specification** sub-tab click the **Add** button.

- Select **Pre-conversion archive**.
- Navigate to where you have stored your ZIP file and select it.
- Click **Open** to add the file.
  The file is renamed to **OLF-ARCHIVE.zip**.
The names of the original files from the attached pre-conversion archive are listed on the right.

Figure 188: Attaching pre-conversion archive

6.6.5 Sequence listings

For a first filing, sequence listings must always be submitted in computer-readable format in accordance with WIPO Standard ST.25. If the sequence listing is not available in computer-readable format, you can submit it to the EPO first as a PDF file and subsequently as an ST.25 file, together with an additional fee.

Computer-readable sequence listings can be attached as the following text-only file types:

- Nucleotide and Amino Acid Sequence Listing (file type .app or .seq)
- ASCII Text (file type .txt)
- Archive File Format (file type .zip)

→ Click the **Sequence Listings** sub-tab under **Documents**.
→ Select the check box for **The European patent application contains a sequence listing as part of the description**.

A red validation icon appears in the **Documents** tab, indicating that in order to file your application you must attach a sequence listing either as a computer-readable file or in PDF format.
Figure 189: A sequence listing must be filed as part of the description

**Sequence listing in computer-readable format**

- Select the check box *In computer-readable format in accordance with WIPO Standard ST.25.*
  This deactivates the *In PDF format* check box.
- Click *Choose file...*
- Select the appropriate file type.

Figure 190: Selecting file type for sequence listing in computer-readable file format
Navigate to the required file and attach it. Depending on the file type selected, the file is renamed `SEQTXT.app`, `SEQTXT.seq`, `SEQTXT.txt` or `SEQTXT.zip`. The button's caption changes to **Detach file**.

![Figure 191: Sequence listing in APP format attached](image)

**Sequence listings in PDF format**

- Select the **In PDF format** check box.
  This deactivates the check box **In computer-readable format in accordance with WIPO Standard ST.25**.
  You cannot file a sequence listing in PDF format if you selected **The description contains a sequence listing in accordance with Rule 30(1) EPC** in the Reference (p. 124) tab under **Request**. In this case, the check box is deactivated and you can only attach a file in computer-readable format.
- Click **Choose file**...
- Navigate to the required PDF file and attach it.
  The file is renamed `SEQTXT.pdf`.
  The button's caption changes to **Detach file**.

![Figure 192: Sequence listing in PDF format attached](image)
The warning (yellow validation icon) indicates that the sequence listing has to be filed later in computer-readable format and an additional fee has to be paid to the EPO.

![Warning following the attachment of a sequence listing in PDF format](image)

**Changing the sequence listing format**

If you attach a PDF file and then decide to replace it with a computer-readable file (or vice versa), proceed as follows:

- First, clear the check box for the currently selected format. This detaches the current file; both check boxes are now available for selection.
- Select the check box for the required format and attach the corresponding file.

**6.6.6 Additional documents**

In the *Additional documents* sub-tab you can attach all other documents you wish to send to the EPO, including authorisations, translations of priority documents or other documents.

**Example**

In this example you are going to add three documents: a translation of the priority documents, an additional information sheet and the search results for an earlier application.

- Click the *New* button.
- Navigate to the required PDF file and select it.
- Click *Open* to attach the file.
- From the *Document type* list, select the option *Translation of priority documents*. The file is renamed *PRIOTRAN-1.pdf*.

![Attaching translation of priority documents as an additional document](image)

- Click the *New* button again to add the second additional document.
- Navigate to the PDF file and attach it.
- Select *<other document>* from the *Document type* list. The file is renamed *OTHER-1.PDF*.
- To describe this document, enter the words *Additional information sheet* in the *Type name* field.
Search results for earlier application

If your application refers to an earlier application which has been declared a priority document, under Rule 141(1) EPC you must file the search results obtained for said earlier application if they are not already available to the EPO. The validation message for the yellow validation icon in the Documents tab tells you what to do; see Reference (p. 124).

- Click the New button.
- Navigate to the PDF file and attach it.
- From the Document Type list select the option Search results required under Rule 141(1) EPC for previously filed application.

The file is renamed PRSR-REF.pdf.

6.6.7 Viewing attached documents

Use the Preview option to check your application as it appears in print.

- In the tool bar click the Preview button.

or

Select Preview from the Tools menu.

The application is shown in the PDF Viewer.

The attached documents are listed in Section 44 of Form EP(1001E2K) with their original file names. On the left you can see a list of the files with their respective system names. In this example the form is in German, because German was selected as the procedural language.
Figure 197: Previewing the application (technical documents section) in the PDF Viewer

Click the name of a document to view it in the PDF Viewer. Do the same to view drawings attached as linked images together with an XML document.

Figure 198: Attached drawings shown in the PDF Viewer
6.7 EP(1001E2K) – Fee Payment

In the Fee Payment tab you can select the fees associated with your application and indicate how you wish to pay them. All fees must be paid in euros. The fees displayed in the Fee Payment tab reflect the fee schedules located in File Manager > Tools > Fee Management.

Make use of the Live Update function in Online Filing to ensure that your fee schedule is always up to date. You will find the most recent fee schedule on the EPO website at Applying for a patent > Online services, following the link Interactive schedule of fees (http://www.epoline.org/portal/portal/default/epoline.Scheduleoffees).

For more information on EPO deposit accounts and the automatic debiting procedure, please refer to the Official Journal:

- Arrangements for deposit accounts (ADA)
- Notice from the European Patent Office dated 12 February 2015 concerning revision of the Arrangements for deposit accounts (ADA) and their annexes
- Decision of the President of the European Patent Office dated 29 September 2016 revising points 5.3 and 7 of the Arrangements for deposit accounts (ADA)

Online fee payment

The EPO offers a quick and secure online fee payment service designed for holders of EPO deposit accounts. For more information, go to the EPO website and navigate to Applying for a patent > Online services > Online fee payment (http://www.epo.org/applying/online-services/fee-payment.html).

6.7.1 Payment details

In the Payment details sub-tab you can specify the mode of payment and provide details of the account number and account holder.

You have to specify the mode of payment before you can make a payment. If you do not, no fees will appear in the form for the EPO, even if you have selected one or more fees in the Fee selection sub-tab.

- **Automatic debit order**
  If you select this option the check boxes in the Fee selection sub-tab are automatically deactivated and the total amount of the fees is shown as EUR 0.00. The EPO will calculate the amount of the fees payable using the information you provided and will debit this amount direct from your account. With this option you cannot select the fees yourself in the form.

- **Debit from deposit account**
If you choose this mode of payment, the relevant fees will be debited directly from your EPO deposit account. If you issue a debit order during normal working hours (08.00-18.00 hrs), you can usually view it under pending orders within about 30 minutes. The actual deduction from your account will appear 5 to 6 days later.

- **Bank transfer**
  All payments in EUR must be transferred to the EPO’s bank account with the Commerzbank AG in Munich, Germany. The IBAN and BIC codes of the EPO’s bank account are supplied automatically when you select the Commerzbank from the drop-down list.

- **Not specified**
  Choose this option if you do not intend to pay fees with this form or if you are not sure how you will be paying your fees.
  The grey validation icon in the Fee Payment tab indicates that the mode of payment is required, but may be specified later.

**Debit from deposit account**

- Select **Debit from deposit account** as **Mode of payment**.
- Enter the **deposit account number**.
  EPO deposit account numbers are made up of eight digits, starting with 28. You are not required to enter 28 as the leading digits of the deposit account number, since these are automatically supplied by the software. Just enter the six remaining digits. If the deposit account number is not entered correctly, e.g. you enter more than six digits, you will see a red validation icon in the Fee Payment tab. The corresponding validation message tells you to verify the deposit account number. The same rule applies to the deposit account number for reimbursement.
- Enter the name of the **account holder**.
- If you wish to have the fees debited from your account later than the filing date of your application, enter the date in the **Deferred execution date** field.
- Hover your mouse pointer over the symbol  to the right of the **Deferred execution date** field to see the **Important information**: This functionality allows you to indicate explicitly that your payment order is to be executed at a later date than the submission date.
  In this case, the payment date will be deemed to be the deferred execution date, provided that you have sufficient funds on your deposit account on that date.
  Please choose the deferred execution date option only if the fees are to be debited on a future date, as otherwise the default execution date is the date of receipt.
  The deferred execution date can be a maximum of 40 days in the future.
  Please ensure that the deferred execution date lies within the time limit set for paying the selected fees.
  Please note that any debit orders (standard or deferred execution) can only be revoked until 00.00 hrs CET on the date of submission (Arrangements for deposit accounts, 7).
Bank transfer

- Select **Bank transfer** as **Mode of payment**.
- Select **DE, Commerzbank AG, München** from the list. This information is mandatory.
  The IBAN and BIC codes of the EPO's bank account are supplied automatically.

Further options

The **Fee Payment** sub-tab offers some additional options at the bottom of the screen.

- If you wish the EPO to make any **reimbursements** to a deposit account with the EPO, select the corresponding check box.
  This information applies to all selected modes of payment. If you selected **automatic debit order** or **debit from deposit account**, you are only required to enter an account number here if that number is different from the account number used for payment.
  - Enter the EPO deposit account number and supply the account holder's name.
- If you want to request a refund of the search fee, select the corresponding check box and enter the application number of the earlier search report.
- If you need **additional copies of the documents cited in the European search report**, select the corresponding check box and enter the number of copies required.
  The validation message (yellow icon) informs you that the corresponding fee 055 should also be selected. You should therefore select the check box for fee 055 in the **Fee selection** sub-tab (it is not selected by default).
6.7.2 Fee selection

Frequently paid fees such as the Filing fee (001) and the Fee for a European search (002) are automatically selected and calculated by the software.

Other fees such as extension fees or the fee for additional copies of documents cited in the search report (055) become applicable based on the selections you make in the form.

The validation messages indicate which fees are to be paid.

- Select the check boxes of the fees to be paid.
  - The relevant quantity is already entered.
  - The amount to pay is automatically calculated.
  - The check boxes for fees not applicable in this application are locked.
Filtering the fees displayed
You can filter the list of fees by selecting one of the options in the **Show** list:

- **All fees**
- **Selected fees only**: all fees selected for the current application.

The claims fees, **015** and **015e**, are selected by default and always locked. The quantity for both fees is determined by the **Number of claims you intend to pay for (including first 15 claims)** field in the **Documents** tab and cannot be edited in the **Fee selection** sub-tab.

Figure 203: Selecting fees
Selecting the appropriate generation in the **Divisional** sub-tab immediately triggers the selection of the correct fee in the **Fee selection** sub-tab, e.g. **Additional fee for 2nd generation (552)**. The check box for this fee cannot be cleared.

![Figure 204: Showing selected fees only](image)

**Changing the fee quantity**

The value in the **Quantity** column can only be edited for the following fees:

- 002 - Fee for a European search - Applications filed on/after 01.07.2005
- 029 - Certified copy of application; priority document
- 055 - Add. copy of docs cited in search report
- 501 - Additional filing fee for the 36th and each subsequent page

**Editing fee amounts and reductions**

If you wish to edit a fee amount or apply a specific reduction, you have to select the **Edit fee amounts** check box. If you do so, please note that there will be no automatic fee correction for this application. Depending on your selected mode of payment, the total amount shown will be debited from your deposit account or is payable by bank transfer.

1. Select the **Edit fee amounts** check box.
   - This activates the **Amount EUR** and **Reduction** fields for editing.
2. Select the fee you wish to edit.
3. Click in the field to be edited, in our example **Amount EUR**.
4. Enter the new amount.
Click anywhere on the form.

The value in the **Amount to pay EUR** column and the total amount of the fees are automatically recalculated.

If you want to undo changes to the fee amounts, you can restore the values from the fee table in Online Filing.

- Clear the **Edit fee amounts** check box.

  The original values for all fees are restored in the form.
6.8 EP(1001E2K) – Annotations

In the *Annotations* tab you can enter notes to be transmitted to the EPO.

**Creating notes for the EPO**

→ Click the *Add* button and select *New Note*.

→ Enter the relevant information in the *Author*, *Subject* and *Note* fields.

![Figure 207: Adding a new note for the EPO](image)

→ To add notes that are not intended for the EPO, use the *Internal notes* (p. 43) function on the form's toolbar.
7 Euro-PCT(1200E2K)

Euro-PCT(1200E2K) is the form used for entry of an international application into the European phase before the EPO as designated or elected office. To file an application via the Euro-PCT procedure it must previously have been filed as an international application via the PCT route. For more information visit the WIPO website and go to IP Services > PCT > Legal Texts (http://www.wipo.int/pct/en/texts/).

Data input in form Euro-PCT(1200E2K)
Form Euro-PCT(1200E2K) is organised into seven tabs. It is recommended to enter the data in the tab sequence given, i.e. starting with the **EP-Phase** tab. Certain options and conditions in the **Documents** tab, for instance, are determined by the selections you make in the **EP-Phase** tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>EP-Phase</td>
<td>Select the EPO’s role, request examination in admissible non-EPO language, enter details of the international application, select the ISA and IPEA</td>
</tr>
<tr>
<td>Names</td>
<td>Enter changes concerning applicant(s), representative(s) and authorisations named in the international application.</td>
</tr>
<tr>
<td>States</td>
<td>Designate contracting states, extension states and validation states.</td>
</tr>
<tr>
<td>Biological Material</td>
<td>Enter details of deposited microorganisms and the depositary institution.</td>
</tr>
<tr>
<td>Documents</td>
<td>Attach amendments, translations of priority applications and other electronic files.</td>
</tr>
<tr>
<td>Fee Payment</td>
<td>Enter the mode of payment, select fees according to the appropriate fee schedule.</td>
</tr>
<tr>
<td>Annotations</td>
<td>Supply additional information for the EPO.</td>
</tr>
</tbody>
</table>

Mandatory fields
A red triangle in the upper right-hand corner of a field indicates mandatory information. You must either manually fill out this field or select one of the options provided. If mandatory fields are not completed, the corresponding tab will show a red validation icon. Consult the validation messages for more information.

![Figure 208: The PCT application number is a mandatory field in the EP Phase tab and is marked with a red triangle](image_url)
**Elements in Form Euro-PCT(1200E2K)**

*Figure 209: Euro-PCT(1200E2K) - Overview*

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>Provides all options needed to edit, save, import and export drafts, set the display and change the status, as well as other tools.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td><strong>Location Indicator Bar</strong></td>
<td>Shows the selected procedure, the current status and the user reference for the open draft.</td>
</tr>
<tr>
<td><strong>Navigation Bar</strong></td>
<td>Displays tabs corresponding to the sections of the form. These tabs can contain sub-tabs, which are a sub-division of the main tab sections within the form.</td>
</tr>
<tr>
<td><strong>Details Area</strong></td>
<td>Displays data entry fields appropriate to the selected tab.</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Displays information about the current activity. Shows the total number of validation messages for the open draft.</td>
</tr>
</tbody>
</table>
7.1 Euro-PCT(1200E2K) – EP Phase

The EP Phase tab of Euro-PCT(1200E2K) is where you request examination of your application under Article 94 EPC.

For the latest version of the EPC see the EPO website at Law & practice > Legal texts > European Patent Convention (http://www.epo.org/law-practice/legal-texts/epc.html).

The EP Phase tab contains two sections for entering data:
- Entry into the European phase (EPO as designated or elected office)
- Past Record

7.1.1 Entry into the European phase

Select the EPO as either designated office or elected office.

Language in which the request for examination is made

Applicants who are nationals of an EPC contracting state or who have their residence or principal place of business in an EPC contracting state can request examination in an official language of that state, if this language is an admissible non-official EPO language, i.e. if it is not English, French or German (Article 14(4) EPC).

If appropriate, select the check box Request for examination in admissible non-official EPO language.

Select the relevant language from the drop-down list.

The text "Examination of the application under Art. 94 EPC is hereby requested" is displayed in the selected language.

Declaration under Rule 6(4) EPC

The check box for the declaration under Rule 6(4) becomes available if you select the check box Request for examination in admissible non-official EPO language.

The validation message in the EP Phase tab (severity level 2) provides further details. If each applicant fulfils the conditions of Rule 6(4) EPC, then you should select the corresponding check box intended for the declaration under Rule 6(4) EPC to enable the Online Filing software to calculate the fee reduction.

Under Rule 6(3) EPC, the EPO grants a reduction in the examination fee and filing fees if applicants referred to in Article 14(4) EPC belong to one of the following groups specified in Rule 6(4) EPC:

(a) small and medium-sized enterprises (SMEs);
(b) natural persons; or
(c) non-profit organisations, universities or public research organisations.

To declare that the applicant(s) fulfil the conditions of Rule 6(4), select the check box The/Each applicant hereby declares that he is an entity or a natural person under Rule 6(4) EPC.
To qualify for the fee reduction, all applicants have to fulfil both the above-mentioned conditions under Rule 6(4) EPC and the following conditions under Article 14(4) EPC:

- Natural applicants must be nationals of an EPC contracting state having an admissible non-official EPO language or residents in an EPC contracting state having an admissible non-official EPO language.
- Legal applicants must have their principal place of business in an EPC contracting state having an admissible non-official EPO language.
- The selected language must be both an official language of the EPC contracting state of at least one of the applicants and an admissible non-official EPO language (i.e. it must not be English, French or German).

Please verify that all applicants, both those already available to the EPO from the international application and those for whom you indicate changes in the Names tab, fulfil these conditions. For more details, see Applicants (p. 129) in the Form EP(1001E2K) section.

The reduction in the examination fee (006/006e) is determined by the role(s) selected for the EPO in the Past Record (p. 177) section:
- 30% if the EPO is the designated office
- 30% if the EPO is the elected office and the IPEA is not the EPO
- 65% if the EPO is the elected office and the IPEA is the EPO.

Waiver, Rule 70(2)

If the EPO is not selected as the International Searching Authority (ISA) and if appropriate, select the check box The applicant waives his right to be asked under Rule 70(2) EPC whether he wishes to proceed further with the application. This waiver does not apply until after payment of the examination fee; see Fee selection (p. 206).

Waiver, Rules 161(1) or (2) and 162

If applicable, select the check box The applicant waives his right to the communication under Rules 161(1) or (2) and 162 EPC. This waiver does not apply until after payment of the claims fees. Account holders participating in the automatic debiting procedure should pay any claims fees due on entry into the European phase using another permitted mode of payment; see Payment details (p. 204).
7.1.2 Past Record

- Select the *language of the international publication* from the drop-down list. This information is mandatory.
- Enter the number of the previous application under *PCT application number*. This information is mandatory.
- Enter the *PCT publication number* and the *EP application number* where applicable.
- Enter the corresponding *international filing date*. or
- Select the date using the calendar icon.

   The international filing date is mandatory and should match the year of the PCT application number. If the year of filing is different from the year in the PCT application number, a yellow validation icon is displayed. You can file your application to the EPO nevertheless, but please ensure that the data you enter is correct.
- Select the appropriate *International Searching Authority (ISA)*. This information is mandatory.
- If the EPO is the elected office, select the appropriate *International Preliminary Examining Authority (IPEA)*. The default option is *IPEA is EPO*.
7.2 Euro-PCT(1200E2K) – Names

The *Names* tab of Euro-PCT(1200E2K) is where you can make changes to applicant and representative details. You can also specify an extra address for correspondence with the first-named applicant or add a new representative. You are not required to enter any extra data if there are no changes to either the applicant or the representative.

**Additional information about applicant**

- In the *Names* tab, click the *Add* button.
- Select *Applicant, Legal* or *Applicant, Natural*.
- Enter the details for the applicant or use the *Copy from Address Book* button.
Removing names from the form

- Select the name to be removed on the left-hand side of the form.
- Click the **Delete** button.

Address for correspondence with the applicant

You can specify a separate address for correspondence with the first-named applicant if you have not added a representative to the form. The country in the address for correspondence must be an EPC contracting state. The address for correspondence is only valid if the country in the applicant’s main address is also an EPC contracting state.

The **Address for correspondence** check box is unlocked after the mandatory fields for the first-named applicant have been completed, i.e. First Name, Last Name (or Company), City and Country.

- Select the first-named applicant.
- Select the **Address for correspondence** check box.

**Address for correspondence** then appears in the list on the left.

Entering the address for correspondence is now mandatory. The red validation icon in the **Names** tab notifies you of a validation message to that effect.

- If there is no change of applicant and you just want to add a different address for correspondence, select the check box **The applicant has earlier been recorded by the International Bureau.**
- Click the **Add** button and select **Address.**

Note that the **Representatives** options have disappeared.
Figure 213: Adding address for correspondence with the applicant

The first applicant's name appears under **Address for Correspondence** on the left and the data entry fields become available on the right.

- Edit the address information as required.
  - The applicant's name cannot be edited in the address for correspondence. The **Company** field (legal applicant) and the **Last Name** and **First Name** field (natural applicant) are locked.
  - If you subsequently modify the first-named applicant's name under **Applicants**, the name in the address for correspondence will be updated accordingly.
  - If you delete the first-named applicant, the address for correspondence will also be removed from the form.

Figure 214: Address for correspondence with the applicant

**Applicant is represented by an employee**

If the applicant is a company (legal person) with principal place of business in an EPC contracting state, it can be represented by an employee. An employee can only be selected as a representative if no other representative (legal or natural person) has been added to the form.
Select the check box **Company is represented by the following employee acting pursuant to Art. 133(3) EPC.**

Enter **Last Name** (mandatory field), **First Name** (mandatory field) and **Title**.

The name of this employee will be automatically filled into the **Sign Application** dialog and cannot be modified. Only an employee who is authorised by the applicant under Article 133 EPC is entitled to sign.

Enter the **General Authorisation** number (where applicable).

![Figure 215: Applicant is represented by an employee](image)

**Representative**

The **Representative** option is only available if no address for correspondence has been entered and if the applicant is not being represented by an employee under Article 133(3) EPC. The country of the representative must be an EPC contracting state.

- In the **Names** tab, click the **Add** button.
- Select **Representative, Association, Representative, Legal Practitioner** or **Representative, Authorised**.
- In the **Name and Address** sub-tab, complete the details or copy the name from the Address Book.
Authorisation

The **Authorisation** sub-tab is used to give details relating to the representative.

- Select the **General Authorisation** check box.
- Select the appropriate option.
  - Related documents can be attached in the **Documents** tab; see Additional documents (p. 197).

States

The **States** tab of Euro-PCT(1200E2K) is where you designate the countries in which you wish to obtain patent protection.

For the latest list of EPC contracting states, extension states and validation states see the EPO website at [About us > European Patent Organisation > Member states](http://www.epo.org/about-us/organisation/member-states.html). The EPC contracting states include all overseas departments and territories.

Under the automatic debiting procedure, extension fees and validation fees will be debited only for the states indicated here, unless the EPO is instructed otherwise before expiry of the period for payment.
Designation
You do not have to select the designated states. All the contracting states party to the EPC at the time of filing of the international patent application and designated in the international application are deemed to be designated (see Article 79(1) EPC).

Figure 218: All contracting states designated

Extension
➔ Select the appropriate option.
➔ If required, select individual states.
   1. Make sure you also select the extension fees for these states in the Fee Payment tab.

Figure 219: Selection of extension states
**Validation**

In the **Validation** sub-tab, select the states with validation agreements to which the patent application filed should also be extended. Appropriate fees are payable for the selected validation states.

» Click the **Validation** sub-tab.

» Select the required option and, where appropriate, the individual states required.

1. Make sure you also select the validation fees for these states in the **Fee Payment** tab.

![Figure 220: Selecting validation states](image)

If you change the international filing date in the **EP Phase** tab, none of the extension states and validation states will be selected, i.e. the default settings appear and any states previously expressly selected are lost. If this happens, please click the **States** tab and select the states again as appropriate. The yellow validation icon in the **States** tab notifies you of a warning message to this effect.

### 7.4 Euro-PCT(1200E2K) – Biological Material

The **Biological Material** tab of Euro-PCT(1200E2K) is where you input details of any biological material filed and give the name the depositary institution.

The form assumes that the invention relates to and/or uses biological material deposited under Rule 31 EPC. For the latest version of the EPC see the EPO website at [Law & practice > Legal texts > European Patent Convention](http://www.epo.org/law-practice/legal-texts/epc.html).

#### Adding biological material details

» In the **Biological Material** tab, click the **Add** button and select **Biology**.

» In the **Deposit details** sub-tab, enter the **Identification Reference**.

» Select the **Depositary institution** from the list.

The **Name and Address** field data is supplied automatically.

» Enter the depositary institution code followed by your individual number in the **Accession number** field.

» You can add a copy of the acknowledgement of receipt from the depositary institution or a waiver of the right to an undertaking from the requester pursuant to Rule 33(2) EPC in the **Further details** tab.
Figure 221: Deposit details for biological materials

7.5 Euro-PCT(1200E2K) – Documents

The **Documents** tab of Euro-PCT(1200E2K) is where you confirm the documents to be used in proceedings before the EPO. This is also where you can attach amendments, translations, sequence listings and any additional documents.

**Proceedings**

In the **Proceedings** tab, specify which documents are to be used as a basis for proceedings in addition to the published international application documents.

- Select the check box **Enclosed amendments** under **Proceedings** if you plan to attach amendments.
  - You can also file documents with subsequent annotations or highlighted annotations/amendments to amended technical documents as the document type **Amendments with annotations** in the **Additional documents** (p. 197) tab.
- Select the declaration on the **priority documents**, if appropriate.
The Use of Test reports check box is automatically selected and cannot be edited. It is only selected if the options EPO as designated office and IPEA is EPO were selected on the EP Phase tab.

Figure 222: Options for documents in proceedings

7.5.1 Amendments and translations

Add amendments and translations for the international application, translations of amendments, translations of the priority application or translations of the annexes to the international preliminary examination report in the Amendments and Translations tab. Documents containing highlighted annotations/amendments can be attached as Amendments with annotations in the Additional documents (p. 197) tab.

- Click the Add button.
- Select the appropriate type of document, e.g. Amendments.
  The option Amendments only appears if Enclosed amendments has been selected in the Proceedings sub-tab.
  There are various different translation options depending on the data entered in the Request tab on the role of the EPO (designated or elected office) and on the language of the international application.
Figure 223: Selecting document category for amendments and translations

- Navigate to the PDF file location.
- Select the file and click **Open** to attach it.

Figure 224: Find and open a PDF file

- Select the check box for the component you added to the amended document, e.g. **Amended claims**.
  
The file is renamed **AMSPECPO-1.pdf**. The original file name is displayed for reference.
  
The number of pages is supplied automatically.
- Repeat the process to attach additional documents, e.g. the translation of the priority application.
Figure 225: Attaching amended claims

Proceed as follows to attach a PDF file containing multiple components of the international application's translation:

- Click the **Add** button and select *Translation of international application*.
- Attach the PDF file.
  - The file is renamed *SPECTRANEPO-1.pdf*.
- Select the check boxes one at a time for the components contained in the file and enter the appropriate page numbers.
7.5.2 Document Overview

Enter the number of pages the individual documents contain in the Document Overview tab. If you make reference to already-published parts of the international application, but do not attach them, please make sure that the location and number of pages are also entered for these documents.

This information is needed for the purpose of calculating the correct fee because the EPO charges an extra fee for each page from the 36th onwards.

The Document Overview tab is organised into four sub-tabs:

1. Overview
2. Description
3. Claims
4. Drawings

The document part options in the various tabs differ depending on the role you selected for the EPO (designated or elected office) and the language of the international application; see Entry into the European phase (p. 175).

Overview

In the beginning, a red validation icon appears in the Documents tab if there are no amendments or translations attached. The validation messages indicate that information on the relevant documents is mandatory in the Description and Claims tabs.
Irrespective of the other data, the software calculates a single page by default as the minimum page count.

![Software interface showing document pages](image)

**Figure 227: Overview of documents' pages, one page calculated by default**

**Description**

In this example, you have made reference to an already-published description.

- Select the check box *International application as published*.
- Enter the *number of pages*.
  
  The software automatically calculates the *total number of pages - description*. 
Claims
The EPO needs the number of patent claims for the purpose of calculating the correct fee. Please include all claims from both the international application and subsequent amendments. In this example, you attached a file with amended patent claims in the Amendments and Translations tab.

- Enter the number of claims on entry into the European phase.
- Enter the number of claims you intend to pay for (including the first 15 claims).
  - This indication is exclusively for the purpose of fee calculation. If you do not intend to pay for any claims with this application, please enter 0 (zero) in this field.
  - If the number of claims you intend to pay for is lower than the number of claims indicated, a yellow validation icon will appear in the Documents tab. In this case, please specify the claims for which you intend to pay by writing a note to the EPO in the Annotations tab.
- Select the check box Amendments on entry into the European phase and specify the Pages from... to...
- Enter the number of pages.
  
The software automatically calculates the total number of pages - claims.
Figure 229: Information on the claims

**Drawings**

In this example, you make reference to the drawings in the international application.

- Select the check box **International application as published**.
- Use the **Pages from ... to ...** field to specify the location of the drawings in the international application.
- Enter the **number of pages**.
Figure 230: Information on drawings in the international application

**Total number of pages**

- Finally, go to the **Overview** tab and check if all relevant documents are entered with the correct number of pages.
- In this example, the total number of pages to be examined is **20**.
7.5.3 Sequence listings

The **Sequence Listings** tab lets you specify whether or not the international application contains nucleotide and/or amino acid sequences. If a computer-readable sequence listing file has not yet been submitted to the EPO, please attach the relevant electronic sequence listing here also.

Sequence listings must always be submitted in computer-readable format in accordance with WIPO Standard ST.25. If the sequence listing is not available in computer-readable format, you can submit it to the EPO first as a PDF file and subsequently as an ST.25 file, together with an additional fee.

Computer-readable sequence listings can be attached as the following text-only file types:
- Nucleotide and Amino Acid Sequence Listing (file type .app or .seq)
- ASCII Text (file type .txt)
- Archive File Format (file type .zip)

> In the **Documents** tab, click the **Sequence Listings** sub-tab.
>
> Select the check box for **The international application discloses nucleotide and/or amino acid sequences**. This activates the associated group of tab options for editing.
Reference to an existing sequence listing
The default setting is The sequence listing was filed under Rule 5.2(a) PCT, or furnished to the EPO as ISA under Rule 13ter.1a) PCT, or it is otherwise available to the EPO, in computer-readable format in accordance with WIPO-ST.25.

- If this is selected, there is no need to submit a sequence listing.
  The options for attaching files are therefore deactivated.
  No error or warning validation icon is on display in the Documents tab.

Attaching a sequence listing
- Select the check box The sequence listing is attached.
  This activates the other options for editing.
  A red validation icon shows in the Documents tab because, in this case, attaching a document is mandatory.
Sequence listings in computer-readable format

- Select the check box **In computer-readable format in accordance with WIPO Standard ST.25**.
  This deactivates the **In PDF format** check box.
- Click **Choose file**...
- Select the appropriate file type.
- Navigate to the required file and attach it.
  Depending on the file type selected, the file is renamed SEQLTXT.app, SEQLTXT.seq, SEQLTXT.txt or SEQLTXT.zip.
  The caption on the button changes to **Detach file**.

![Figure 234: Sequence listings in computer-readable format attached](image)

Sequence listings in PDF format

- Select the **In PDF format** check box.
  This deactivates the **In computer-readable format in accordance with WIPO-Standard ST.25** check box.
- Click **Choose file**...
- Navigate to the required file and attach it.
  The file is renamed to SEQLTXT.pdf.
  The caption on the button changes to **Detach file**.

![Figure 235: Sequence listing in PDF format attached](image)
The warning (yellow validation icon) indicates that the sequence listing has to be filed later in computer-readable format and an additional fee has to be paid to the EPO.

Figure 236: Warning following the attachment of a sequence listing in PDF format

**Changing the sequence listing format**

If you attach a PDF file and then decide to replace it with a computer-readable file (or vice versa), proceed as follows:

- First, clear the check box for the currently selected format.
  This detaches the current file; both check boxes are now available for selection.
- Select the check box for the required format and attach the corresponding file.

**Declarations**

- If the sequence listing you attached is identical to the listing from the international application, select the check box *The sequence listing does not include matter that goes beyond the content of the application as filed.*

**7.5.4 Additional documents**

In the *Additional Documents* tab, attach all other documents that you want to submit to the EPO:

- Authorisations
- Other documents
- Reply to written opinion
- Search results required under Rule 141(1) EPC
- Amendments with annotations

**Authorisations**

- Click the *Add* button.

- Select *Other document*.
- Navigate to the required PDF file and select it.
- Click *Open* to attach the file.
- In the *Document Type* list select *General Authorisation* or *Specific Authorisation*.
  The document is renamed *GENAUTH-1.pdf* and *SPECAUTH-1.pdf*, respectively.
Other documents

- Click the **Add** button and select **Other document** to attach another document.
- Navigate to the required PDF file and attach it.
- Select the document type **<other document>** from the list.
- The file is renamed **OTHER-1.pdf**.
- Enter a description of the document in the **Type Name** field, e.g. **Assignment documents**.

Replies

Provided it was chosen to act as the IPEA in the EP phase, the EPO considers all amendments filed as a substantive reply to the written opinion on the international preliminary examination report (IPER).

If the EPO was chosen as the designated office upon entry into the EP phase, the amendments filed under Article 19 PCT are considered a substantive reply to the written opinion of the International Searching Authority (ISA).

If you have drafted your own written reply, you can attach it as an additional document.
- Click the **Add** button.
- Select **Reply to written opinion/IPER**.
- Navigate to the required file and select it.
- Click **Open** to attach the file.

The file is renamed **REPLYWo-1.pdf**.
**Search results**

Under Rule 141(1) EPC applicants claiming a priority must on entry into the European phase file a copy of the search results drawn up by the office of first filing if these results are not already available to the EPO.

- Click the **Add** button.

- Select *Search results required under Rule 141(1) EPC*.

- Navigate to the required file and select it.

- Click **Open** to attach the file.

  The file is renamed to **PRSR-1.pdf**.

![Figure 240: Adding search results from the office of first filing](image)

**Amendments with annotations**

Use this document category to file documents with subsequent annotations or highlighted annotations/amendments to amended technical documents:

- Amended claims with annotations
- Amended description with annotations
- Amended drawings with annotations

Documents with handwritten amendments are no longer accepted (for exceptions to this rule see the EPO Official Journal 2013, 603-604) [link](http://archive.epo.org/epo/pubs/oj013/12_13/12_6033.pdf).

- Click the **Add** button.

- Select *Amendments with annotations*.

- Navigate to the required file and select it, e.g. the amended drawings with annotations.

- Click **Open** to attach the file.

- Select the document type *Amended drawings with annotations* from the list.

  The file is renamed **DRAW-HWA.pdf**.
7.5.5 Pre-conversion archive

The pre-conversion archive option allows you to add your original documents, before converting them into PDF files, as a compressed ZIP archive file. This may be helpful if you wish to provide the EPO with your original documents in colour. The documents contained in the ZIP file will not be publicly available nor will they be an integral part of the visible internal procedural file, but they can be accessed for reference, e.g. in the event of quality issues.

\[\text{The EPO does not recognise documents as legally binding if they are exclusively filed as part of a ZIP archive. To be accepted as legally binding filings, the official patent documents must always be attached as PDF or ST.25 files under the correct document type.}\]

Attaching pre-conversion archive

\[\text{In the Documents tab under the Amendments and Translations sub-tab, click the Add button.}\]

\[\text{Select the option Pre-conversion archive.}\]

\[\text{Navigate to your ZIP file and select it.}\]

\[\text{Click Open to attach the file.}\]

The file is renamed OLF-ARCHIVE.zip.

The names of the original files from the attached pre-conversion archive are listed on the right.
7.5.6 Previewing attached documents

You can view the list of all attached documents in the form preview.

- Click the Preview button in the toolbar.

The application is displayed in the PDF Viewer. The enclosed documents are listed with their original file names in Section 12 of the form (epf1200.pdf).

All files are listed with their system names on the PDF Viewer's left pane.
- Click the name of a document in the list to the left to display it in the PDF Viewer.
The number of claims and information on documents intended for proceedings before the EPO are provided in section 6 of the PDF form. If a copy of the search results has been attached, this is indicated in section 6.3.
The various translations attached are listed in section 7.

Figure 244: Number of claims and information on the use of documents in the PDF preview of Form Euro-PCT(1200E)

7.6 Euro-PCT(1200E2K) – Fee Payment

In the Fee Payment tab you can select the fees associated with your application and indicate how you wish to pay them. All fees must be paid in euros. The fees displayed in the Fee Payment tab reflect the fee schedules located in File Manager > Tools > Fee Management.

Make use of the Live Update function in Online Filing to ensure that your fee schedule is always up to date. You will find the most recent fee schedule on the EPO website at Applying for a patent > Online services, following the link Interactive schedule of fees (http://www.epoline.org/portal/portal/default/epoline.Scheduleoffees).

For more information on EPO deposit accounts and the automatic debiting procedure, please refer to the Official Journal:

- Arrangements for deposit accounts (ADA)
  Supplementary publication 3/2015, p. 8-16
Notice from the European Patent Office dated 12 February 2015 concerning revision of the Arrangements for deposit accounts (ADA) and their annexes
Supplementary publication 3/2015, p. 2-7

Decision of the President of the European Patent Office dated 29 September 2016 revising points 5.3 and 7 of the Arrangements for deposit accounts (ADA)

Online fee payment
The EPO offers a quick and secure online fee payment service designed for holders of EPO deposit accounts. For more information, go to the EPO website and navigate to Applying for a patent > Online services > Online fee payment
(http://www.epo.org/applying/online-services/fee-payment.html).

7.6.1 Payment details
In the Payment details sub-tab you can specify the mode of payment and provide details of the account number and account holder.
You have to select a mode of payment before you can pay any fees, even if you have selected one or more fees in the Fee selection tab.

- **Automatic debit order**
  If you select this option the check boxes in the Fee selection sub-tab are automatically deactivated and the total amount of the fees is shown as EUR 0.00. The EPO will calculate the amount of the fees payable using the information you provided and will debit this amount direct from your account. With this option you cannot select the fees yourself in the form.

- **Debit from deposit account**
  If you choose this mode of payment, the relevant fees will be debited directly from your EPO deposit account. If you issue a debit order during normal working hours (08.00-18.00 hrs), you can usually view it under pending orders within about 30 minutes. The actual deduction from your account will appear 5 to 6 days later.

- **Bank transfer**
  All payments in EUR must be transferred to the EPO’s bank account with the Commerzbank AG in Munich, Germany. The IBAN and BIC codes of the EPO’s bank account are supplied automatically when you select the Commerzbank from the drop-down list.

- **Not specified**
  Choose this option if you do not intend to pay fees with this form or if you are not sure how you will be paying your fees.

The grey validation icon in the Fee Payment tab indicates that the mode of payment is required, but may be specified later.

Debit from deposit account
- Select **Debit from deposit account** as **Mode of payment**.
→ Enter the **deposit account number**. EPO deposit account numbers are made up of eight digits, starting with **28**. You are not required to enter **28** as the leading digits of the deposit account number, since these are automatically supplied by the software. Just enter the six remaining digits. If the deposit account number is not entered correctly, e.g. you enter more than six digits, you will see a red validation icon in the **Fee Payment** tab. The corresponding validation message tells you to verify the deposit account number. The same rule applies to the deposit account number for reimbursement.

→ Enter the name of the **account holder**.

→ If you wish to have the fees debited from your account later than the submission date of your entry into the European phase, enter the date in the **Deferred execution date** field.

→ Hover your mouse pointer over the symbol  to the right of the **Deferred execution date** field to see the **Important information**:

This functionality allows you to indicate explicitly that your payment order is to be executed at a later date than the submission date. In this case, the payment date will be deemed to be the deferred execution date, provided that you have sufficient funds on your deposit account on that date. Please choose the deferred execution date option only if the fees are to be debited on a future date, as otherwise the default execution date is the date of receipt. The deferred execution date can be a maximum of 40 days in the future. Please ensure that the deferred execution date lies within the time limit set for paying the selected fees. Please note that any debit orders (standard or deferred execution) can only be revoked until 00.00 hrs CET on the date of submission (Arrangements for deposit accounts, 7).

![Figure 245: Payment details entered](image)

**Further options**

The **Fee Payment** sub-tab offers some additional options at the bottom of the screen.

→ If you wish the EPO to make any **reimbursements** to a deposit account with the EPO, select the corresponding check box.
This information applies to all selected modes of payment. If you selected **automatic debit order** or **debit from deposit account**, you are only required to enter an account number here if that number is different from the account number used for payment.

- Enter the EPO deposit account number and supply the account holder’s name.

⇒ If you need **additional copies of the documents cited in the European search report**, select the corresponding check box and enter the number of copies required. This check box is only available if the EPO was not selected as the International Searching Authority (ISA) in the **EP Phase** tab.

---

**Figure 246: Other options for fee payment in Form Euro-PCT(1200E2K)**

The validation message (yellow icon) informs you that the corresponding fee 055 should also be selected. You should therefore select the check box for fee 055 in the **Fee selection** sub-tab (it is not selected by default).

---

### 7.6.2 Fee selection

Frequently paid fees are automatically selected and calculated by the software. The number of claims for calculating the **claims fee for the 16th to the 50th claim (015)**, for example, and the total number of pages used as the basis for calculating the **additional filing fee for the 36th and each subsequent page (520)** are provided in the Document Overview (p. 189) tab.

Other fees such as extension fees or the fee for additional copies of the search report (055) become applicable based on the selections you make in the form. The validation messages indicate which fees are to be paid.

---

**Figure 247: Validation messages with information on the fees to be paid**

⇒ Select the check boxes of the fees to be paid.

- The relevant quantity is already entered.
- The amount to pay is automatically calculated.
- The check boxes for fees not applicable in this application are locked.
Filtering the fees displayed

You can filter the list of fees by selecting one of the options in the Show list:

- **All fees**
- **Selected fees only**: all fees selected for the current application.
  
  The claims fees, **015** and **015e**, are selected by default and always locked. The quantity for both fees is determined by the **Number of claims you intend to pay for (including first 15 claims)** field in the Documents tab and cannot be edited in the Fee selection sub-tab.

Changing the fee quantity

The value in the **Quantity** column can only be edited for the following fees:

- **002** - Fee for (supplementary) European search for applications filed on/after 01.07.2005
- **002e** - Fee for (supplementary) European search for applications filed before 01.07.2005
- **055** - Add. copy of docs cited in search report
- **121** - Fee for further processing (late performance as of acts R. 71(3))
- **122** - Fee for further processing (non-fee-related cases)
- **123** - Fee for further processing (late payment of a fee – 50% of the relevant fee)
- **400** - Surcharge for extension fees
- **520** - Additional filing fee for the 36th and each subsequent page - entry into EP phase

Editing fee amounts

If you wish to edit a fee amount or apply a specific reduction, you have to select the **Edit fee amounts** check box. If you do so, please note that there will be no automatic fee correction for this application. Depending on your selected mode of payment, the total amount shown will be debited from your deposit account or is payable by bank transfer.

- Select the **Edit fee amounts** check box.
  
  This activates the **Amount EUR** and **Reduction** fields for editing.
- Select the fee you wish to edit.
- Click in the field to be edited, in our example **Reduction**.
Enter the new value.

Figure 249: Editing a fee after selecting the option to edit fee amounts

Click anywhere in the form.

The value in the **Amount to pay EUR** column and the total amount of the fees will be automatically recalculated.

Figure 250: Amount to pay and total amount of the fees updated after editing

If you want to undo changes to the fee amounts, you can restore the values from the fee table in Online Filing.

Clear the *Edit fee amounts* check box.

The original values for all fees are restored in the form.
7.7 Euro-PCT(1200E2K) – Annotations

In the **Annotations** tab you can enter notes to be transmitted to the EPO.

**Creating notes for the EPO**

→ Click the **Add** button and select **New Note**.

→ Enter the relevant information in the **Author**, **Subject** and **Note** fields.

![Figure 251: Adding a new note for the EPO](image)

→ To add notes that are not intended for the EPO, use the **Internal notes** (p. 43) function on the form's toolbar.
7.8 Reusing previous data for filing with Euro-PCT(1200E2K)

You can use an application already sent with the PCT/RO/101 form to create a new application with the Euro-PCT(1200E2K) form for entry into the regional phase.

- Open File Manager and select the folder where the sent application is saved.
- Click the **Sent** status button.
- Select the required application - the PCT application number is displayed in the **App.number** column.
- Right-click to select the option **Reuse data for a subsequent filing**.

![Figure 252: Creating a new application for entry into the European phase (Euro-PCT(1200E2K) form) using a PCT application already sent](image)

The **Create a New Application** window opens. Enter a new user reference of your choice or use the existing one. The Euro-PCT(1200E2K) form then opens with the following data from the PCT application previously sent:
- PCT application number and international application date
- Designated office and international searching authority (ISA)
- Name of the first applicant
- Name of the first representative
- Language of filing of the international application

Make your amendments or enter new data and save the application. Once the application has been successfully sent, it appears in File Manager with the same PCT application number.
Form **EP(1038E)** is used for submitting documents filed subsequently in the European patent procedure, namely:

- all subsequently filed documents (except within the opposition procedure, when you should use Form **EP(Oppo)** (p. 242))
- appeals and/or subsequently filed documents in appeal proceedings; see **Filing appeal documents** (p. 228)
- US certified priority documents (other priority documents cannot be filed online)
- non-public documents; see **Filing non-public documents** (p. 227).

You can also use Form EP(1038E) to:

- create a subsequent submission based on an EP(1001E2K) application sent via Online Filing; see **Reusing previous data for filing with EP(1038E)** (p. 240)
- pay a fee and submit payment information
- file a request for accelerated search or accelerated examination under the PACE programme (non-public submission)
- submit an enquiry as to the processing of the file (public submission)
- supply further information to the EPO in the form of an annotation.

**Minimum requirements for subsequent filing with Form EP(1038E)**

When filing with Form EP(1038E), at least one of the following actions must be performed:

- attach a document
- create a request or enquiry
- indicate a payment
- write an annotation.

**Data input in Form EP(1038E)**

Form EP(1038E) is organised into five tabs. It is recommended to decide on the general type of the submission first, i.e. public or non-public, and then proceed with attaching corresponding documents and selecting fees.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Application No</strong></td>
<td>Enter the EP application number to which this subsequently filed data belongs.</td>
</tr>
<tr>
<td><strong>Names</strong></td>
<td>Enter details on applicant or representative.</td>
</tr>
<tr>
<td><strong>Requests</strong></td>
<td>Create a request for accelerated search or accelerated examination, or create an enquiry as to the processing of the file.</td>
</tr>
<tr>
<td><strong>Documents</strong></td>
<td>Attach the subsequently filed documents.</td>
</tr>
<tr>
<td><strong>Fee Payment</strong></td>
<td>Enter the mode of payment, select a fee schedule and select fees.</td>
</tr>
<tr>
<td><strong>Annotations</strong></td>
<td>Supply additional information for the EPO.</td>
</tr>
</tbody>
</table>

When filing a non-public submission with Form EP(1038E), you may only select non-public fees, i.e. fee codes 025, 026, 027, 029 or 080.
Mandatory fields
A red triangle in the upper right-hand corner of a field indicates mandatory information. You must either manually fill out this field or select one of the options provided. If mandatory fields are not completed, the corresponding tab will show a red validation icon. Consult the validation messages for more information.

Figure 253: The Deposit account number is a mandatory field in the Fee Payment tab and is marked with a red triangle

Elements in Form EP(1038E)

Figure 254: Form EP(1038E) - Overview
<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>Provides all options needed to edit, save, import and export drafts, set the display and change the status, as well as other tools.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td><strong>Location Indicator Bar</strong></td>
<td>Shows the selected procedure, the current status and the user reference for the open draft.</td>
</tr>
<tr>
<td><strong>Navigation Bar</strong></td>
<td>Displays tabs corresponding to the sections of the form. These tabs can contain sub-tabs, which are a sub-division of the main tab sections within the form.</td>
</tr>
<tr>
<td><strong>Details Area</strong></td>
<td>Displays data entry fields appropriate to the selected tab.</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Displays information about the current activity. Shows the total number of validation messages for the open draft.</td>
</tr>
</tbody>
</table>

### 8.1 EP(1038E) – Application Number

The **Application No** tab of EP(1038E) is where you enter the EP application number. The red validation icon in the tab indicates that this information is mandatory.

- Enter your **EP application number** in the field provided.

*Figure 255: Sample EP application number*

An EP application number is made up of 8 digits and 1 check digit. A check digit contains an algorithm that verifies the other numbers entered and prevents you from entering invalid application numbers. Once a correct application number has been entered, the validation icon in the tab will disappear.

### 8.2 EP(1038E) – Names

The **Names** tab of EP(1038E) is where you add details for an applicant or a representative. You can add exactly one name to the form.

**Adding a name**

- In the **Names** tab, click the **Add** button.
- Select a role, e.g. **Applicant, Legal**.

*Figure 256: Adding a name*
Enter name and address or copy an entry from the Address Book. Once a role has been selected, the Add button becomes unavailable.

**Applicant is represented by an employee**

If the applicant is a company (legal person) with principal place of business in an EPC contracting state, it can be represented by an employee.

- Where applicable, select the check box **[Company] is represented by the following employee acting pursuant to Art. 133(3) EPC.**
- Enter **Last Name** (mandatory field), **First Name** (mandatory field) and **Title**. The name of this employee will be automatically filled into the **Sign Application** dialog and cannot be modified. Only an employee who is authorised by the applicant under Article 133 EPC is entitled to sign.
- Enter the **General Authorisation** number (where applicable).

![Figure 257: Applicant's details filled in](image)

**Removing names from the form**

- Select the name to be removed on the left-hand side of the form.
- Click the **Delete** button.
8.3 EP(1038E) – Requests

The **Requests** tab of Form EP(1038E) allows you to either create a specific request under the programme for accelerated prosecution of European patent applications (**PACE**) or submit an **enquiry as to the processing to the file** as a request.

The PACE request (**Form 1005**) is a non-public submission, whereas the enquiry as to the processing of the file (**Form 1012**) is a public submission. Public and non-public submissions must be filed separately; see **Filing non-public documents** (p. 227). You can file a submission either by creating a PACE request or an enquiry as to processing of the file – not both – in the **Requests** tab, or, alternatively, by attaching one of the two forms as a PDF file in the **Documents** tab; see **Document types for EP(1038E) by category** (p. 219).

You can choose one of these four options as appropriate:

<table>
<thead>
<tr>
<th>PACE request (Form 1005)</th>
<th>Enquiry as to the processing of the file (Form 1012)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) In the <strong>Requests</strong> tab, select either <strong>Accelerated search</strong> or <strong>Accelerated examination</strong> (only one PACE request can be made per submission with Form EP(1038E)). Online Filing creates the electronic form <strong>epf1005.pdf</strong> as part of the package that will be sent to the EPO.</td>
<td>(2) In the <strong>Requests</strong> tab, select <strong>Enquiry as to the processing of the file</strong>. Online Filing creates the electronic form <strong>epf1012.pdf</strong> as part of the package that will be sent to the EPO.</td>
</tr>
<tr>
<td>(3) In the <strong>Documents</strong> tab, attach the non-public document type <strong>Request for accelerated search/examination</strong>. Online Filing renames your file <strong>1005.pdf</strong>.</td>
<td>(4) In the <strong>Documents</strong> tab, attach the document type <strong>Enquiry as to the processing of the file</strong>. Online Filing renames your file <strong>1012.pdf</strong>.</td>
</tr>
</tbody>
</table>

More information is available online:

- Notice from the European Patent Office dated 30 November 2015 concerning the programme for accelerated prosecution of European patent applications (**PACE**)  
  OJ EPO 2015, A93  

- Notice from the European Patent Office dated 2 August 2016 concerning the handling of enquiries as to the processing of files  
  OJ EPO 2016, A66  

8.3.1 Request for accelerated search/examination (Form 1005)

To file a request for accelerated search or accelerated examination under the PACE programme, you can either create the request electronically or attach a PDF file in the **Documents** tab. No fees are due for this request.

**Notice:** A request for accelerated search or accelerated examination is a non-public submission.
To create the request electronically, go to the **Requests** tab.

Under **PACE request**, select the check box **Under the programme for accelerated prosecution of European patent applications**, I/we hereby request that the **European patent application specified in the Application No tab undergo**:

This enables the two associated check boxes and disables the check box under **Enquiry as to the processing of the file**.

Select the appropriate request: **Accelerated search** or **Accelerated examination**. The two check boxes are mutually exclusive.

![Requesting accelerated search under the PACE programme](image)

Online Filing generates a PDF document with the information you indicated. When you sign the Form EP(1038E), the same signature will also be applied to the PACE request.

To view the request, click the **Preview** button in the toolbar.

The Form EP(1038E) opens in the PDF Viewer.

Click **epf1005.pdf** in the list on the left of the screen.

In the electronic PDF form, the box for the selected request is selected.

![Previewing the PACE request in the PDF Viewer](image)
If you have selected the PACE request in the **Request** tab, you are not allowed to attach the document **Request for accelerated search/examination** in the **Documents** tab. You will see a severity 1 validation message to that effect.

![Validation message if the document "Request for accelerated search/examination" is attached and the PACE request is selected](image)

**Figure 260:** Validation message if the document "Request for accelerated search/examination" is attached and the PACE request is selected

### 8.3.2 Enquiry as to the processing of the file (Form 1012)

To submit an enquiry as to the processing of the file, you can either create the request electronically or attach a PDF file in the **Documents** tab. No fees are due for this request.

- An enquiry as to the processing of the file is a public submission.

- To create the request electronically, go to the **Requests** tab.
- Under **Enquiry as to the processing of the file**, select the check box *I/We hereby enquire when the EPO will deliver the (supplementary) European search report / next communication for the application/patent specified in the Application No. tab.* This disables the check box under **PACE request**.

![Creating an enquiry as to the processing of the file](image)

**Figure 261:** Creating an enquiry as to the processing of the file

Online Filing generates a PDF document with the information you indicated. When you sign the Form EP(1038E), the same signature will also be applied to the enquiry.

- To view the enquiry, click the **Preview** button in the toolbar.
The Form EP(1038E) opens in the PDF Viewer.

- Click `epf1012.pdf` in the list on the left of the screen.

The electronic PDF form displays the text of the enquiry and the application/patent number.

![PDF Viewer](image)

**Figure 262: Previewing the enquiry as to the processing of the file in the PDF Viewer**

If you have selected the enquiry in the **Request** tab, attaching the document **Enquiry as to the processing of the file** in the **Documents** tab is not allowed. You will see a severity 1 validation message to that effect.

![Validation Message](image)

**Figure 263: Validation if the document "Enquiry as to the processing of the file" is attached and the enquiry request is selected**

### 8.4 EP(1038E) – Documents

The **Documents** tab of EP(1038E) is where you attach documents subsequent to your original filing. Please find a list of all document types currently allowed for filing with EP(1038E) in section **Document types for EP(1038E) by category** (p. 219).

Initially there is a red validation icon on the **Documents** tab. However, if you perform one of the other possible actions (create a request, indicate a payment or write an annotation), the validation icon for the **Documents** tab disappears, since in this case no document is necessary.

> Form EP(1038E) may not be used for the PCT patent grant procedure. Please use Form PCT-SFD for filing documents subsequent to a PCT application.
8.4.1 Document types for EP(1038E) by category

Where available, please select the correct document type for your file attachments. This simplifies and speeds up the internal processing by the EPO. If you are unable to find an appropriate document type in Form EP(1038E), you can select the general purpose General enquiry document type from the Search and Examination or the All Documents category.

The most frequently used general categories appear at the top of the list, whereas the lesser used, more specific options appear at the bottom. The All Documents category in the bottom section lists all available document types.

In this list, a single document type may be assigned to multiple categories to facilitate your selection.

Top section

Filing and search
- Amended claims (clean copy)
- Amended claims with annotations
- Amended description (clean copy)
- Amended description with annotations
- Amended drawings (clean copy)
- Amended drawings with annotations
- Amendments before examination
- Designation of inventor
- Designation of inventor (non-public)
- Document concerning search matters
- Document concerning the priority claims
- Drawings
- Enquiry as to the processing of the file
- Inventor waiver – Rule 19(3) EPC
- Inventor waiver – Rule 19(3) EPC (non-public)
- Inventor waiver – Rule 20(1) EPC (non-public)
- Missing parts of description
- Missing parts of drawings
- Modified abstract
- Reply to request for clarification
- Reply to search opinion/written opinion/IPER
- Request for extension of time limit during search procedure
- Search results required under Rule 141(1) EPC
- Statement of non-availability of search results required under Rule 141(1) EPC
- Subsequently filed claims
- Translation of previously filed application
- Translation of priority document
- Translation of the international preliminary examination report
- US certified priority document

**Search and examination**
- Acknowledgement
- Authorisation of representative
- Claims
- Document concerning fees and payments
- Document concerning microorganisms and medical inventions
- Document concerning representation
- Document concerning sequence listing, PDF
- Document concerning sequence listing, TXT
- Document concerning the designation and extension of states
- Document concerning the inventorship
- English translation of the claims
- Enquiry as to the processing of the file
- French translation of the claims
- General enquiry
- German translation of the claims
- Grounds for re-establishment of rights
- Letter relating to the search and examination procedure
- Maintenance of the application
- Miscellaneous requests concerning client data
- Request for automatic debiting
- Request for a decision
- Request for assignment
- Request for change of address
- Request for change of name
- Request for change of representative
- Request for correction of the documents (Rule 139 EPC)
- Request for further processing
- Request for re-establishment of rights
- Request for suspension/interruption of the procedure
- Request for transfer of rights
- Translation of description
- Translation of text in drawings
- Translation of priority document
- Translation of the abstract
- Waiver in respect of communication under Rule 161/162 EPC
- Withdrawal of an application
- Withdrawal of automatic debit order
- Withdrawal of designated or extension states

**Examination**
- Document filed during examination procedure
- Enquiry as to the processing of the file
- Letter dealing with oral proceedings
- Reply to a communication under Rule 70b EPC
- Reply to examination report
- Reply to the communication under Rule 71(3) EPC
- Request for correction/amendment of the text proposed for grant sent from 01.04.2012
- Request for correction/amendment of the text proposed for grant sent until 31.03.2012
- Request for examination
- Request for extension of time limit during examination procedure
- Withdrawal of a request for oral proceedings

**Non-public**
- Designation of inventor (non-public)
- Inventor waiver – Rule 19(3) EPC (non-public)
- Inventor waiver – Rule 20(1) EPC (non-public)
- Medical certificate
- Non-public annex
- PPH: documents for examination
- PPH: documents for search
- Request for accelerated search/examination
- Request for certified copies of the application
- Request for inspection of the file
- Request for participation in the Patent Prosecution Highway

**Appeal**
- Amended claims with annotations (appeal procedure)
- Amended description with annotations (appeal procedure)
- Amended drawings with annotations (appeal procedure)
- amicus curiae (statement by third parties in the proceedings before the Enlarged Board of Appeal in accordance with Art. 10 RPEBA)
- Annexes (other than cited documents) regarding appeal procedure
- Annexes (other than cited documents) regarding review procedure
- Cited documents during appeal procedure
- Claims (appeal procedure)
- Description (appeal procedure)
- Drawings (appeal procedure)
- Evidence in support of the appeal
- Grounds for re-establishment of rights (appeal procedure)
- Incoming letter in referral procedure
- Intervention of the assumed infringer
- Letter dealing with oral proceedings during the appeal procedure
- Letter relating to appeal procedure
- Letter relating to the review procedure
- Non-patent literature cited during the appeal procedure
- Non-patent literature filed by a third party during the appeal procedure
- Notice of appeal
- Observations by third parties (Art. 115 EPC) during the appeal procedure
- Oral proceedings: request for postponement (appeal procedure)
- Patent document cited during the appeal procedure
- Patent document filed by a third party during the appeal procedure
- Reply to appeal
- Request for extension of time limit during appeal procedure
- Request for further processing (appeal procedure)
- Request for interpreters during oral proceedings (appeal procedure)
- Request for oral proceedings (appeal procedure)
- Request for re-establishment of rights (appeal procedure)
- Statement of grounds of appeal
- Translation of statement of grounds of appeal
- Translation of notice of appeal
- Withdrawal of a request for oral proceedings (appeal procedure)
- Withdrawal of an appeal

Third-party observations
- Citations filed by a third party
- Non-patent literature filed by a third party
- Observations by third parties (Art. 115 EPC)
- Patent document filed by a third party
- Reply from applicant/patentee regarding third party observations
- Reply to communication to third party

Limitation and revocation
- Citation for the limitation procedure
- Letter regarding the translation of the limited claims
- Letter/request relating to the limitation request
- Letter/request relating to the revocation procedure
- Reply to the limitation report
- Request for revocation of patent
- Withdrawal of limitation request

Bottom section

All documents

Amendments
The “with annotations” document type is to be used for amended documents with annotations or highlighted annotations/amendments. Documents with handwritten amendments are no longer accepted (for exceptions to this rule see the EPO Official Journal 2013, 603-604) (http://archive.epo.org/epo/pubs/oj013/12_13/12_6033.pdf).
- Amended claims (clean copy)
- Amended claims with annotations
- Amended description (clean copy)
- Amended description with annotations
- Amended drawings (clean copy)
- Amended drawings with annotations
- Amendments before examination
- Drawings
- Modified abstract

**Applicant-representative-inventor**
- Designation of inventor
- Designation of inventor (Non-public)
- Document concerning representation
- Documents concerning the inventorship
- Inventor waiver – Rule 19(3) EPC
- Inventor waiver – Rule 19(3) EPC (non-public)
- Inventor waiver – Rule 20(1) EPC (non-public)
- Miscellaneous requests concerning client data

**Biology**
- Document concerning micro-organisms and medical inventions
- Document concerning sequence listing, PDF
- Document concerning sequence listing, TXT
  - Use this document type for the file types .txt, .app or .seq.

**Filing**
- Missing parts of description
- Missing parts of drawings
- Subsequently filed claims
- Translation of previously filed application

**Forms**
- Authorisation of representative
- Designation of inventor

**Legal Remedies**
- Grounds for Re-establishment of Rights
- Request for a decision
- Request for further processing
- Request for Re-establishment of Rights

**Other**
- Document concerning search matters
- Document concerning the designation and extension of states
- Letter dealing with Oral proceedings
- Letter relating to the search and examination procedure
- Withdrawal of a request for oral proceedings

Priorities
- Document concerning the priority claims
- Translation of priority document
- US certified priority document

Replies
- Acknowledgement
- Claims
- Document filed during examination procedure
- Reply to a communication under rule 70b EPC
- Reply to examination report
- Reply to request for clarification
- Reply to search opinion/written opinion/IPER
- Reply to the communication under rule 71(3) EPC
- Request for correction/amendment of the text proposed for grant sent from 01.04.2012
- Request for correction/amendment of the text proposed for grant sent until 31.03.2012
- Search results required under Rule 141(1) EPC
- Statement of non-availability of search results required under Rule 141(1) EPC

Request
- Enquiry as to the processing of the file
- General enquiry
- Maintenance of the application
- Request for assignment
- Request for automatic debiting
- Request for certified copies of the application
- Request for change of address
- Request for change of name
- Request for change of representative
- Request for correction of the documents (Rule 139 EPC)
- Request for examination
- Request for extension of time limit during examination procedure
- Request for extension of time limit during search procedure
- Request for suspension/interruption of the procedure
- Request for transfer of rights
- Waiver in respect of communication under Rule 161/162 EPC

Translations
- English translation of the claims
- French translation of the claims
- German translation of the claims
- Translation of description
- Translation of previously filed application
- Translation of priority document
- Translation of text in drawings
- Translation of the abstract
- Translation of the international preliminary examination report

Withdrawals
- Withdrawal of an application
- Withdrawal of automatic debit order
- Withdrawal of designated or extension states

8.4.2 Attaching documents

→ In the Documents tab of EP(1038E), click the Add button.

→ Navigate to the storage location of your file.

1. Note this special case: If you want to attach a sequence listing file, change the option in the files of type drop-down list from Portable Document Format (default) to ASCII Text (file type .txt) or Nucleotide and Amino Acid Sequence Listing (file type .app or .seq).

→ Select the file and click Open.

![Open dialog box](image)

Figure 264: Selecting document for attachment

The file is attached to the application under its original file name.

→ Select the appropriate document category from the Category drop-down list.
Select the appropriate document from the **Document type** drop-down list.

The file is renamed to the Online Filing default file name.

**Example: Designation of contracting states is withdrawn**

- Click the **Add** button.
- Navigate to your file and attach it.
- Select the **Withdrawals** category.
- In the **Document type** list, select the option **Withdrawal of designated or extension states**.
Repeat the process for additional documents if you want to withdraw multiple designated states.

8.4.3 Filing non-public documents

The Online Filing software lets you submit documents in non-public proceedings to the EPO.

You can attach public and non-public documents to Form EP(1038E), but not at the same time. If you attach a non-public document, you cannot select a fee which is only applicable for public submissions or create a public request. Please use separate forms for public and non-public submissions to the EPO.

- Click the Add button.
- Navigate to your file and attach it.
- Select the Non-public category.
- In the Document type list, select the appropriate document type, e.g. Request for accelerated search/examination.

The file is renamed 1005.pdf.
If, after having attached your non-public document, you proceed to attach one of the files from the assortment of public document types, a red validation icon appears on the Documents button. The validation message explains the error.

Figure 271: Validation message after attaching public and non-public documents

If you select the PACE request check box in the Request tab and then attach the document type Request for accelerated search/examination, you will see a severity 1 validation message because only one PACE request can be submitted with the same form.

Figure 272: Validation message if the PACE request is selected and the document "Request for accelerated search/examination" is attached

8.4.4 Filing appeal documents

You can use the Online Filing software to file a notice of appeal and submit documents in appeal proceedings to the EPO.

You can attach appeal documents and non-appeal documents to Form EP(1038E), but not at the same time. If you attach an appeal document, you cannot create a public or non-public request. Please use separate forms for filing appeal documents and all other submissions to the EPO.
→ Click the **Add** button.
→ Navigate to your file and attach it.
→ Select the **Appeal** category.
→ In the **Document type** list, select the appropriate document type, e.g. **Statement of grounds of appeal**.
→ The file is renamed **APPEAL-GRDS-1.pdf**.

![Figure 273: Statement of grounds of appeal attached under the appeal document category](image)

If, after having attached your appeal document, you then attach one of the other document types, a red validation icon appears on the **Documents** button. The validation message explains the error.

![Figure 274: Validation message after attaching appeal and non-appeal documents](image)

If you select the **PACE request** or the **Enquiry** check box in the **Request** tab and then attach a document from the **Appeal** category, you will see a severity 1 validation message, because requests (public or non-public) and appeal documents cannot be submitted with the same form.

![Figure 275: Validation messages if an appeal document is attached but a request has already been selected in the "Requests" tab](image)
8.4.5 Viewing attached documents

- Click the **Preview** button in the toolbar.
  
  This opens the PDF Viewer.
- Click a file name in the list on the left of the screen to display the attached document.
  The example below shows two subsequently filed non-public documents.

![PDF Viewer](image)

*Figure 276: Attached files in the PDF Viewer*

8.5 EP(1038E) – Fee Payment

Select the fees that you want to subsequently pay for the application on the EP(1038E) form’s **Fee Payment** tab and specify the mode of payment. The currency for all fees is EUR.

*If the date of filing or of entry into the regional phase of your application is earlier than 1 April 2009 it is your responsibility to ensure that you have selected the correct schedule of fees for the application; see Payment details (p. 231).*

The fees displayed in the **Fee Payment** tab reflect the fee schedules located in **File Manager > Tools > Fee Management**.

Make use of the **Live Update** function in Online Filing to ensure that your fee schedule is always up to date. You will find the most recent fee schedule on the EPO website at **Applying**
for a patent > Online services, following the link Interactive schedule of fees (http://www.epoline.org/portal/portal/default/epoline.Scheduleoffees).
For more information on EPO deposit accounts and the automatic debiting procedure, please refer to the Official Journal:

- Arrangements for deposit accounts (ADA)
- Notice from the European Patent Office dated 12 February 2015 concerning revision of the Arrangements for deposit accounts (ADA) and their annexes
- Decision of the President of the European Patent Office dated 29 September 2016 revising points 5.3 and 7 of the Arrangements for deposit accounts (ADA)

Online fee payment
The EPO offers a quick and secure online fee payment service designed for holders of EPO deposit accounts. For more information, go to the EPO website and navigate to Applying for a patent > Online services > Online fee payment (http://www.epo.org/applying/online-services/fee-payment.html).

8.5.1 Payment details
In the Payment details sub-tab you can select a mode of payment and the schedule of fees applicable to your application.

Mode of payment
- Select the appropriate option from the Mode of payment list.
  - Automatic debit order
    If you select this option the check boxes in the Fee selection sub-tab are automatically deactivated and the total amount of the fees is shown as EUR 0.00. The EPO will calculate the amount of the fees payable using the information you provided and will debit this amount direct from your account. With this option you cannot select the fees yourself in the form.
  - Debit from deposit account
    If you choose this mode of payment, the relevant fees will be debited directly from your EPO deposit account. If you issue a debit order during normal working hours (08.00-18.00 hrs), you can usually view it under pending orders within about 30 minutes. The actual deduction from your account will appear 5 to 6 days later.
  - Bank transfer
    All payments in EUR must be transferred to the EPO's bank account with the Commerzbank AG in Munich, Germany. The IBAN and BIC codes of the EPO's bank account are supplied automatically when you select the Commerzbank from the drop-down list.
• **Not specified**
  Choose this option if you do not intend to pay fees with this form or if you are not sure how you will be paying your fees.

**Debit from deposit account**
An EPO deposit account is required to use the options **Automatic debit order** or **Debit from deposit account**.

- Enter the number of your deposit account and the name of the account holder.
  EPO deposit account numbers are made up of eight digits, starting with **28**. You are not required to enter **28** as the leading digits of the deposit account number, since these are automatically supplied by the software. Just enter the six remaining digits. If the deposit account number is not entered correctly, e.g. you enter more than six digits, you will see a red validation icon in the **Fee Payment** tab. The corresponding validation message tells you to verify the deposit account number. The same rule applies to the deposit account number for reimbursement.

- If you wish to have the fees debited from your account later than the submission date, enter the date in the **Deferred execution date** field.

- Hover your mouse pointer over the symbol ![icon](image) to the right of the **Deferred execution date** field to see the **Important information**:
  This functionality allows you to indicate explicitly that your payment order is to be executed at a later date than the submission date. In this case, the payment date will be deemed to be the deferred execution date, provided that you have sufficient funds on your deposit account on that date. Please choose the deferred execution date option only if the fees are to be debited on a future date, as otherwise the default execution date is the date of receipt. The deferred execution date can be a maximum of 40 days in the future. Please ensure that the deferred execution date lies within the time limit set for paying the selected fees.

Please note that any debit orders (standard or deferred execution) can only be revoked until 00.00 hrs CET on the date of submission (Arrangements for deposit accounts, 7).
Selecting the correct fee schedule
The fee schedule shown in Form EP(1038) depends on the date of filing or entry into the regional phase of the patent application to which this subsequently filed application belongs.

- Select the appropriate fee schedule option.
  - (a) Date of filing or entry into regional phase on or after 01.04.2014
    This is the default option.
  - (b) Date of filing or entry into the regional phase from 01.04.2009 to 31.03.2014 inclusive
  - (c) Date of filing or entry into the regional phase before 01.04.2009 or Euro-PCT application with date of filing or earliest priority before 01.09.2006

Declaration under Rule 6(4) EPC
The check box for the declaration under Rule 6(4) EPC is available if the option Date of filing or entry into the regional phase on or after 01.04.2014 is selected.

Applicants who are nationals of an EPC contracting state or who have their residence or principal place of business in an EPC contracting state can request examination or file their application in an official language of that state, if this language is an admissible non-official EPO language, i.e. if it is not English, French or German (Article 14(4) EPC). They can also file their request subsequently using Form EP(1038E).

Under Rule 6(3) EPC, the EPO grants a reduction in the examination fee and filing fees if applicants referred to in Article 14(4) EPC belong to one of the following groups specified in Rule 6(4) EPC:
  - (a) small and medium-sized enterprises (SMEs);
  - (b) natural persons;
  - (c) non-profit organisations, universities or public research organisations.

- To declare that the applicant(s) fulfil the conditions of Rule 6(4), select the check box The/Each applicant hereby declares that he is an entity or a natural person under Rule 6(4) EPC.

- To select the reduced fees applicable to your application, go to the Fee selection sub-tab. The Fee selection (p. 234) sub-tab displays the standard fees and the optional extra fee options with either a 30% or 65% reduction.

Further options
The Fee Payment sub-tab offers some additional options at the bottom of the screen.
If you wish the EPO to make any reimbursements to a deposit account with the EPO, select the corresponding check box. This information applies to all selected modes of payment. If you selected automatic debit order or debit from deposit account, you are only required to enter an account number here if that number is different from the account number used for payment.
- Enter the EPO deposit account number and supply the account holder’s name.

8.5.2 Fee selection

There is no fee selected by default in Form EP(1038E).
- Select the check boxes of the fees to be paid.
  The total fee amount is automatically calculated.

Filtering the fees displayed

You can filter the list of fees by selecting one of the options in the Show list:
- All fees
- Selected fees only

![Figure 279: Selecting fees](image)

Applying fee reductions

If the declaration under Rule 6(4) check box in the Payment details sub-tab is selected, the extra fees reduced by 30% or 65% are displayed in the fee selection table.
- The 30% reduction applies to:
  - 001r - Filing fee - EP direct - online
- 001er - Filing fee - EP direct - not online
- 006r1 - Examination fee - For applications filed on/after 01.07.2005
- 006er1 - Examination fee - For applications filed before 01.07.2005 and for international applications filed on/after 01.07.2005 without supplementary European search report
- 501r - Additional filing fee for the 36th and each subsequent page
- 552r - Additional fee for divisional 2nd generation
- 553r - Additional fee for divisional 3rd generation
- 554r - Additional fee for divisional 4th generation
- 555r - Additional fee for divisional 5th or subsequent generation

- The 65% reduction applies to:
  - 006r2 - Examination fee - For applications filed on/after 1.07.2005
  - 006er2 - Examination fee - For applications filed before 01.07.2005 and for international applications filed on/after 01.07.2005 without supplementary European search report

You can combine both standard fees and reduced fees in one application, provided that you, the applicant(s), fulfil the conditions for fee reduction under Article 14(4) and Rule 6(4) EPC. However, if you select a specific reduced fee, all other fee options for this fee, e.g. the examination fee, are locked.

- Select the reduced fees individually as appropriate.

![Figure 280: Selecting reduced fees for applicants under Rule 6(4)](image)

Selecting fees when filing non-public submissions

When attaching non-public documents to your application or making a non-public request (PACE request), only certain fees can be selected at the same time. These are:

- 025 - Duplicate copies of the patent certificate
- 026 - Extracts from the Europ. Patent Register
- 027 - Inspection of files (paper copies max. 100 pgs, electr. storage medium)
- 029 - Certified copy of application; priority document
- 080 - Certification of other documents
For all other fees, a separate submission is required. If you select a fee that is incompatible with non-public filings, a red validation icon will appear in the Documents tab.

Changing the fee quantity

The value in the Quantity column can be edited for the following fees:

- 002 - Fee for (supplementary) European search for applications filed on/after 01.07.2005
- 002e - Fee for (supplementary) European search for applications filed before 01.07.2005
- 005 - Designation fee (for applications filed before 01.04.2009)
- 008 - Printing fee for 36th and each subsequent page
- 015 - Claims fee for the 16th to the 50th claim (for applications filed on/after 01.04.2009) / for the 16th and each subsequent claim (for applications filed before 01.04.2009)
- 015e - Claims fee - For the 51st and each subsequent claim
- 016 - Claims fee in accordance with R. 71(4) - For the 16th to the 50th claim (for applications filed on/after 01.04.2009) / Claims fee in accordance with R. 71(4) (for applications filed before 01.04.2009)
- 016e - Claims fee in accordance with R. 71(4) - For the 51st and each subsequent claim
- 025 - Duplicate copies of the patent certificate
- 029 - Certified copy of application; priority document
- 055 - Add. copy of docs cited in search report
- 121 - Fee for further processing (late performance as of acts R. 71(3))
- 122 - Fee for further processing (non-fee-related cases)
- 123 - Fee for further processing (late payment of a fee – 50% of the relevant fee)
- 400 - Surcharge for extension fees
- 501 - Additional filing fee for the 36th and each subsequent page
- 501r - Additional filing fee for the 36th and each subsequent page (30% reduction)
- 520 - Additional filing fee for the 36th and each subsequent page - entry into EP phase

» Select the fee you wish to change.
» Click the Quantity field.
» Enter the new amount.

![Figure 281: Changing the quantity for a selected fee](image)

» Click anywhere on the form.
The value in the **Amount to Pay EUR** column and the total amount of the fees are automatically recalculated.

![Figure 282: Recalculated total of the fees selected](image)

**Editing fee amounts and reductions**

If you wish to edit a fee amount or apply a specific reduction, you have to select the **Edit fee amounts** check box. If you do so, please note that there will be no automatic fee correction for this application. Depending on your selected mode of payment, the total amount shown will be debited from your deposit account or is payable by bank transfer.

1. Select the **Edit fee amounts** check box below the fee selection table.
2. Select the fee you wish to modify.
3. Click in the field to be edited, **Amount EUR** or **Reduction**.
4. Enter the new value.
5. Click anywhere in the form.

The amounts in the column **Amount to pay EUR** and the total amount of the fees are automatically recalculated.

![Figure 283: Recalculated amount shown](image)

If you want to undo changes to the fee amounts, you can restore the values from the fee table in Online Filing.

1. Clear the **Edit fee amounts** check box.
   - The original values for all fees are restored in the form.
   - The value in the **Quantity** column will not be reset, however.
8.5.3 Designation of states

The options for the designation fees depend on the fee schedule selected in the Payment details sub-tab.

If Date of filing or entry into regional phase on or after 01.04.2014 or Date of filing or entry into the regional phase from 01.04.2009 to 31.03.2014 inclusive is selected:

- Select fee 005e - Designation fee - For all Contracting States designated in the Fee selection sub-tab.

![Figure 284: All contracting states designated](image)

If Date of filing or entry into the regional phase before 01.04.2009 or Euro-PCT application with date of filing or earliest priority before 01.09.2006 is selected:

- Select fee 005 - Designation fee for each state designated (max. 7x).
  
  The Designation states sub-tab becomes visible.

![Figure 285: Selecting fee 005 makes the "Designation states" sub-tab visible](image)

- Click the Designation states sub-tab.
- Select the appropriate option: All states or Fewer than seven.
Select the states for which designation fees should be paid.
The number of fees and the amount to be paid are then automatically calculated in the **Fee selection** tab.

**Figure 286: Selecting states for designation fees**

### 8.6 EP(1038E) – Annotations

You can use Form EP(1038E) to send an annotation to the EPO without supplying any other data or attaching a document.

In the **Annotations** tab you can enter notes to be transmitted to the EPO.

#### Creating notes for the EPO

- Click the **Add** button and select **New Note**.

- Enter the relevant information in the **Author**, **Subject** and **Note** fields.
8.7 Reusing previous data for filing with EP(1038E)

Instead of creating a new application with the EP(1038E) form, you can simply re-use the data from the first filing you created and sent with the EP(1001E2K) form and on which the subsequent filing should be based.

- Open File Manager and select the folder where the sent application is saved.
- Click the **Sent** status button.
- Select the required application - the EP application number is displayed in the **App.number** column.
- Right-click to select the option **Reuse data for a subsequent filing**.
The **Create a New Application** window opens. Enter a new user reference of your choice or use the existing one. The EP(1038E) form then opens with the following data from the application previously sent:

- EP application number
- Name of the first applicant
- Payment details entered
- Selected fees

Make your amendments or enter new data and save the application. Once the application has been successfully sent, it appears in File Manager with the same EP application number.

---

**Figure 288: Creating a new application for subsequently filed documents (form 1038E) using an application already sent**
9 EP(Oppo)

The EP(Oppo) form is used for filing an opposition and/or submitting subsequently filed documents in opposition proceedings (not for appeal proceedings). It should be used by all parties involved in opposition proceedings. The following section describes how to draft the electronic form for both of these situations. The different options available in Form EP(Oppo) are explained using four examples. The options for attaching different documents are a prerequisite in the following for the designation of persons and the selection of grounds and requests.

- Example 1: An opposition is filed by multiple opponents
- Example 2: An intervener with representatives files an opposition and designates a witness
- Example 3: The proprietor of a patent responds to the opposition filed against her patent
- Example 4: A third party files evidence

First communication – filing the notice of opposition or intervention
All natural or legal persons can use Form EP(Oppo) to file an opposition to a patent with the EPO, provided they have their residence or corporate headquarters in a contracting state to the EPC. **Opponents** may be represented by one of their employees (example 1). Further parties can join ongoing opposition proceeding as **interveners** and designate any representatives they may have. Both opponents and interveners can designate other persons as **witnesses** (example 2).

Persons who do not have their residence in a contracting state to the EPC must authorise a professional **representative** or a legal practitioner entitled to act as a professional representative.

The opponent must uniquely identify the opposed patent, specify his or her grounds for opposition and submit a written reasoned statement. The time allowed for filing notice of opposition is nine months from the publication of the mention of the grant of the patent in the European Patent Bulletin.

For more information, see the EPO's Notes to the notice of opposition (http://documents.epo.org/projects/babylon/eponet.nsf/0/7843500A258C080CC125725D004F1CF5/$File/2300_notes_en.pdf).

Second communication – other actions
**Proprietors** of an opposed patent can use Form EP(Oppo) to respond to the opposition and designate their own witnesses and submit documents (example 3).

**Third parties** can lodge further objections (example 4).

When filing with Form EP(Oppo), at least one of the following actions must be performed by the party who selected the **Other action** option:
- attach a document
- submit a request
- attach a piece of evidence
- indicate a payment
- write an annotation.
Data input in Form EP(Oppo)

Form EP(Oppo) is organised into six tabs. It is recommended to enter the data in the tab sequence given, i.e. starting with the **Opposition** tab. The options and conditions in the **Names** tab, for instance, are determined by the selections you make in the **Opposition** tab, and the options in the **Documents** tab depend on the selection in the **Names** tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opposition</strong></td>
<td>Select the kind of communication, enter reference to the patent opposed, specify grounds for opposition</td>
</tr>
<tr>
<td><strong>Names</strong></td>
<td>Enter details of the persons involved: opponent(s), intervener(s), representative(s), proprietor(s), witness(es) or third parties.</td>
</tr>
<tr>
<td><strong>Requests</strong></td>
<td>Select options for additional request: refer to withdrawal/revocation, to oral proceedings, to extension of time limit, etc.</td>
</tr>
<tr>
<td><strong>Documents</strong></td>
<td>Attach facts and arguments, publications for evidence, other evidence and other documents.</td>
</tr>
<tr>
<td><strong>Fee Payment</strong></td>
<td>Enter the mode of payment, select fees according to the appropriate fee schedule.</td>
</tr>
<tr>
<td><strong>Annotations</strong></td>
<td>Supply additional information for the EPO.</td>
</tr>
</tbody>
</table>

**Mandatory fields**

A red triangle in the upper right-hand corner of a field indicates mandatory information. You must either manually fill out this field or select one of the options provided. If mandatory fields are not completed, the corresponding tab will show a red validation icon. Consult the validation messages for more information.

![Figure 289: The Patent No. of the patent opposed is a mandatory field in the Opposition tab and is marked with a red triangle](image.png)
Elements in Form EP(Oppo)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>Provides all options needed to edit, save, import and export drafts, set the display and change the status, as well as other tools.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td><strong>Location Indicator Bar</strong></td>
<td>Shows the selected procedure, the current status and the user reference for the open draft.</td>
</tr>
<tr>
<td><strong>Navigation Bar</strong></td>
<td>Displays tabs corresponding to the sections of the form. These tabs can contain sub-tabs, which are a sub-division of the main tab sections within the form.</td>
</tr>
<tr>
<td><strong>Details Area</strong></td>
<td>Displays data entry fields appropriate to the selected tab.</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Displays information about the current activity. Shows the total number of validation messages for the open draft.</td>
</tr>
</tbody>
</table>
9.1 EP(Oppo) – Opposition

The **Opposition** tab is where you basically choose the purpose for which you want to use Form EP(Oppo). Your alternatives are either **Notice of opposition or intervention** or **Other action**. All subsequent options are dependent on this selection. If you switch alternatives after entering data, you will lose any data that does not apply to the new setting.

- Select the appropriate option.
  
  The option **Notice of opposition or intervention** is selected by default (examples 1 and 2).

![Figure 291: The option "Notice of opposition or intervention" is selected](image1)

- If you choose the **Other action** option (examples 3 and 4), you should also select the check box **following summons to oral proceedings** if you have already received communication of this kind from the EPO.
  
  This option guarantees that your filing is assigned the highest priority for internal processing at the EPO.

![Figure 292: The "Other action" option is selected](image2)

The red validation icon on the **Documents** button indicates that at least one document or piece of evidence is missing in this case and needs to be attached or that an application, payment or annotation needs to be made.

Enter information on the patent and your statement of grounds in the **Reference** and **Grounds** sub-tabs.
9.1.1 Reference

Enter information about the opposed patent in the Reference sub-tab (examples 1 and 2).

- Enter the number of the opposed patent as published in the European Patent Bulletin in the Patent No. field. This information is mandatory.
- Enter the number of the application in the Application No. field. This information is mandatory.
- Enter the relevant date in the field under Date of mention of the grant in the European Patent Bulletin. This helps the EPO to determine the possible time left for filing notice of opposition.
  1. If the period between the date entered and the current processing data is more than nine months, an appropriate message is output with a yellow validation icon in the list of validation messages.
- Enter the name of the invention in the Title of invention field, using the same wording as the title of the published specification.
- In the Proprietor of the patent field, enter the party named first as proprietor in the patent specification.
  1. If you select the Other action option (examples 3 and 4), you only have to enter the patent number in this sub-tab because this is the number that the EPO uses for the administration of proceedings. All other settings are optional.

Figure 293: Information on the opposed patent entered in the “Reference” sub-tab
9.1.2 Grounds

Enter the grounds for your opposition to the patent as a whole or specific patent claims in the Grounds sub-tab (examples 1 and 2).

- Select the claim(s) No(s). option and enter the numbers of the relevant claims in the field provided if you only want to file an opposition to certain claims. The option the patent as a whole is selected by default.
- Select at least one of the check boxes (a) to (c) under Grounds for opposition.
  ① Please note that a written reasoned statement is also to be attached in the Documents tab.

If you selected non-patentability pursuant to Article 100 (a) EPC as the grounds for opposition, please provide more details by choosing one or more of the reasons listed:

- Select the relevant grounds: it is not new, it does not involve an inventive step or patentability is excluded on other grounds.
- Enter the relevant EPC articles such as 53 (c) in the other grounds field.

If you select the Other action option, all fields in the Grounds sub-tab become inactive because grounds for opposition are not needed in this instance (examples 3 and 4).

Figure 294: Stating the grounds for opposition
9.2 EP(Oppo) – Names

Use the Names tab on Form EP(Oppo) to enter the name of the persons who file the opposition (first communication, examples 1 and 2) or perform other actions (second communication, examples 3 and 4). There are number of different options available for these two alternatives.

Be aware that you can only attach documents to the EP(Oppo) form if at least one person is indicated in the Names tab. Please enter all names and their roles before you proceed to the Documents tab. The options for attaching documents depend on the roles chosen in the Names tab.

9.2.1 Persons in conjunction with "Notice of opposition or intervention"

If you selected the Notice of opposition or intervention option in the Opposition tab, you must specify at least one opponent or intervener. Multiple opponents or interveners can be specified. You can also designate one or more representatives and witnesses, or enter an address for correspondence with the opponents/interveners.

- Click the Add button in the Names tab.
- Select the appropriate option.

![Figure 295: Options for adding persons when "Notice of opposition" is selected](image)

- Enter the details for the person or use the Copy from Address Book button.
- Repeat this procedure to add additional persons.

Removing names from the form

- Select the name to be removed on the left-hand side of the form.
- Click the Delete button.
Example 1: Multiple opponents are designated
In this example, two legal persons and one natural person were added as opponents. The first-named opponent, a company, is represented by one of its employees.

- Select the first-named opponent.
- Select the check box [Company] is represented by the following employee acting pursuant to Art. 133(3) EPC.
- Enter Last Name (mandatory field), First Name (mandatory field) and Title.
  The name of this employee will be automatically filled into the Sign Application dialog and cannot be modified. Only an employee who is authorised by the applicant under Article 133 EPC is entitled to sign.
- Enter the General Authorisation number (where applicable).

![Figure 296: Designation of multiple opponents; the first opponent is represented by an employee](image)

Address for correspondence
You can specify a separate address for correspondence with the first-named opponent, intervener or proprietor if you have not added a representative to the form. The country in the address for correspondence must be an EPC contracting state.

The Address for correspondence check box is unlocked after the mandatory fields for the first-named opponent (intervener or proprietor, respectively) have been completed, i.e. First Name, Last Name (or Company), City and Country.

- Select the first-named opponent.
- Select the Address for correspondence check box.
  Address for correspondence then appears in the list on the left.
  Entering the address for correspondence is now mandatory. The red validation icon in the Names tab notifies you of a validation message to that effect.
Click the Add button and select Address. The first opponent's name appears under Address for Correspondence on the left and the data entry fields become available on the right.

Edit the address information as required.

- The opponent's name cannot be edited in the address for correspondence. The Company field (legal opponent) and the Last Name and First Name field (natural opponent) are locked.
- If you subsequently modify the first-named opponent's name, the name in the address for correspondence will be updated accordingly.
- If you delete the first-named opponent, the address for correspondence will also be removed from the form.

Example 2: One intervener, his or her authorised representative and one witness are designated

In this example, a natural person was designated as the intervener. The intervener is represented by a legal practitioner.

Use the check boxes beside Authorisation(s) to indicate how the representative's authorisation is substantiated.

- If you select is/are enclosed, you have to attach the authorisation as an electronic file in the Documents tab. The validation messages for the Documents tab indicate that this document is mandatory.
- If you select has/have been registered under No., you have to enter the authorisation number in the adjoining - now mandatory - data field.
Click the Add button again and select Witness. Only natural persons can be designated as witnesses.
Enter the name of the witness.
Select the address to which the witness summons should be sent. The options available are:
- to the party (i.e. the intervener in this example)
- to the following address.
9.2.2 Persons in conjunction with "Other action"

In addition to the options listed in the previous section, selecting the Other action alternative in the Opposition tab lets you select one or more proprietors or third parties. You can therefore add either opponents, interveners, proprietors or third parties in addition to representatives and witnesses, or enter an address for correspondence with the opponents/interveners/proprietors. It should be noted that third parties cannot remain anonymous should they file with this option.

- Click the Add button in the Names tab.
- Select the appropriate option.

Figure 300: Options for adding persons for the second communication
Example 3: Proprietor and representative are designated
In this example, the proprietor of the patent wants to submit additional information on her opposed patent. The company is represented by an attorneys' office (association).

- Add the proprietor of the patent.
  Because the proprietor's data is registered with the EPO, only the name is mandatory (company name for legal proprietor, last name and first name for natural proprietor).
- Add the representative.
  You can add exactly one representative.
- Enter information on the representative's authorisation; see example 2.

![Figure 301: Designation of proprietor and representative](image-url)
Example 4: A third party is designated
In this example, a third party who has not yet been involved in the proceedings makes observations on the opposition to the patent.

- Enter the name and address of the third party.
  - A witness cannot be added in this instance.

![Designation of third party](image)

Figure 302: Designation of third party

9.3 EP(Oppo) – Requests

Use the Requests tab to file additional requests that extend beyond the scope of the opposition or, in the case of a second communication, respond or refer to the opposition. The options available are directly dependent on the settings you chose or the data you entered in the Opposition and Names tabs.

Example 1: The opponents submit an auxiliary request for oral proceedings with an interpreter

- Select the check box Request for oral proceedings.
  This automatically activates and selects the check box auxiliarily. This means that your request for oral proceedings only applies if the EPO decides against your interests.
- Clear the check box auxiliarily if you want the request for oral proceedings to apply irrespective of the EPO decision.
- Select the check box Request for interpreting if you are only able to participate in oral proceedings in a specific language.
Select one of the EPO’s three official languages (English, German and French) for the options *listening in* and *speaking in*. These inputs are mandatory if you enter a request for interpreting.

Select the check box *Request for accelerated processing* as applicable.

Type the *reason* for this request into the text box.

**Figure 303: Request for oral proceedings with interpreting and request for accelerated processing**

**Example 2:** The interveners submit a request for oral proceedings irrespective of the EPO decision and a request for the taking of witness evidence

In this example, the *Request for oral proceedings* check box is selected and the check box *auxiliarily* has been cleared.

The check box *Request for the taking of evidence by the hearing of a witness* is always automatically selected if one or more persons were named as witnesses in the *Names* tab.

If you are expressly against the taking of witness evidence in oral proceedings, clear this check box.
Example 3: The opponent submits a request for extension of the time limit
As from 1 July 2016, any request for extension of the time limit will be granted only in exceptional cases and if duly substantiated. If you wish to request extension of the time limit, you must explain your grounds in written detail and attach this letter to the EP(Oppo) form. For more information, see the Notice from the EPO concerning the opposition procedure as from 1 July 2016, OJ EPO 2016, A42(4) (http://www.epo.org/law-practice/legal-texts/official-journal/2016/05/a42.html).

- Select the check box **Request for extension of the time limit**.
- To attach the request document, click **Choose file**.
  The file is renamed **TIMEEXTREQ.pdf**.
  The caption on the button changes to **Detach file**.
**Example 4: The proprietor of the patent requests revocation of the patent**

The *Request for revocation of the patent* option is only active if you named one or more persons as the proprietor of the patent in the *Names* tab. If the check box is selected, all other options with the exception of *Request for accelerated processing* and *Other requests* are deactivated.

- Select the check box *Other requests* as applicable.
- Describe your request in greater detail in the text field provided.

---

*Figure 305: Request by the opponent for extension of the time limit*
9.4 EP(Oppo) – Documents

Use the Documents tab on Form EP(Oppo) to attach all documents needed in support of your opposition. You can also submit data on publications as evidence, amendments to the patent description, translations and authorisations as well as many other documents.

Be aware that you can only attach documents to the EP(Oppo) form if at least one person is indicated in the Names tab. The Add button for document attachment is disabled if no role has been added on the Names tab.

The Documents tab is split into the Documents, Evidence - publications and Evidence - other sub-tabs. The options available in these sub-tabs for the type of documents to be attached change depending on the communication type selected, the designated persons and the requests entered.

- In the event of opposition (examples 1 and 2), Facts and Arguments is a mandatory attachment. A red validation icon therefore appears on the Documents button.
- If you select the Other action option (examples 3 and 4), the attachment of documents is optional, provided you enter data in the Requests, Fee Payment or Annotations tabs. Otherwise, a red validation icon also appears here.

You can only attach PDF files. All electronic documents attached must be compliant with Annex F; see Preparing documents for attachment (p. 90).
9.4.1 Document types for EP(OPPO) as defined by functional role

The options for the type of documents to be attached in the Documents sub-tab depend on what you selected in the Opposition and Names tabs:

Notice of opposition or intervention – role: opponent or intervener

- Facts and Arguments
- Other documents:
  - General authorisation
  - Specific authorisation
  - Document containing information about further representatives
  - Request for change of address
  - Request for change of name
  - Request for change of representative
  - Request for transfer of rights
  - <other document>

Other action – role: proprietor

- Reply to notice(s) of opposition
- Reply to an examination report in opposition proceedings
- Main request document
- Separate auxiliary request document
- Acknowledgement
- Non-public documents:
  - Medical certificate
  - Non-public annex
  - Request for certified copies of the application
  - Request for inspection of the file
- Other documents:
  - General authorisation
  - Specific authorisation
  - Document containing information about further representatives
  - German translation of claims
  - English translation of claims
  - French translation of claims
  - Request for change of address
  - Request for change of name
  - Request for change of representative
  - Request for transfer of rights
  - Translation of priority document

Please provide the application number, for which the translation of the priority document is filed, as a note to the EPO under EP(Oppo) – Annotations (p. 269).
- Request for re-establishment of rights
- Grounds for re-establishment of rights
- Request for a decision
9.4.2 Attaching documents

Example 1: The opponents submit the facts and arguments and an authorisation

The grounds for opposition with an explanation of the facts should be presented pursuant to Rule 76 (2) c) EPC in a separate file with the opposition.

In this example, the first-named opponent, a company, is represented, by an employee. The specific authorisation for representation is presented as a separate document.

→ In the Documents sub-tab, click the Add button.

→ Select Facts and Arguments.

→ Navigate to where your file is saved.
Select the file and click **Open** to attach it.

The file is renamed **OPPO.pdf**.

The original file name and the number of pages are indicated on the form.

![Figure 307: Facts and arguments document attached](image)

Click the **Add** button again to attach the authorisation.

Select **Other documents**.

Navigate to where your file is saved.

Select the file and click **Open** to attach it.

Select an option - in this example **Specific authorisation** - in the **Document type** list.

The file is renamed **SPECAUTH-1.pdf**.

![Figure 308: Authorisation attached](image)

**Example 3:** The proprietor of the patent submits a reply to the notice of opposition filed, a translation of the claims and the acknowledgement

In this example, the proprietor responds to the notice of opposition filed against the patent. An English translation of the claims is also filed.

Click the **Add** button in the **Documents** sub-tab.
Select **Reply to notice(s) of opposition**.

Navigate to where your file is saved.

Select the file and click **Open** to attach it.

The file is renamed **OBS03.pdf**.

The original file name and the number of pages are indicated on the form.

![Figure 309: Reply to notice of opposition attached](image)

- Click the **Add** button again to attach the translation.
- Select **Other documents**.
- Navigate to where your file is saved.
- Select the file and click **Open** to attach it.
- Select an option - in this example **English translation of claims** - in the **Document type** list.

The file is renamed **CLMSTRAN-EN-1.pdf**.

![Figure 310: Translation of claims attached](image)

- Click the **Add** button again to attach the acknowledgement.
- Select **Acknowledgement**.
- Navigate to where your file is saved.
- Select the file and click **Open** to attach it.

The file is renamed **ADV0FDELIVRY.pdf**.
9.4.3 Filing non-public documents

The filing of non-public documents is available for the opponent, intervener and proprietor role if you selected Other action in the Opposition tab,

You cannot attach a combination of both public and non-public documents to Form EP(Oppo). If you attach non-public documents in the same form, you cannot submit a request by selecting one of the options in the Request tab or select a fee. Please use separate forms for public and non-public submissions to the EPO.

→ Click the Add button and select Non-public documents.
→ Navigate to your file and attach it.
→ In the Document type list, select the appropriate document type, e.g. Medical certificate.
→ The file is renamed MEDA-1.pdf.

If, after having attached your non-public document, you then attach one of the files from the assortment of public document types, a red validation icon appears on the Documents button. The validation message explains the error.
9.4.4 Evidence - publications

You can attach the following documents in the Evidence - publications sub-tab:

- Patents
- Articles
- Books
- Database
- Internet publications

Additional details on the publication should be provided for every document attached, including the date, author, publisher or URL.

Example 2: The interveners present multiple publications as evidence

In this example, the interveners present two publications as evidence: an article from a periodical and a publication on the internet. Copies of both publications are provided as PDF files.

- Click the Evidence - publications sub-tab.
- Click the Add button.
- Select Articles and attach the relevant PDF file.
- Enter information on the publication in the fields provided:
  - **Reference** is an internal code under which you archived the publication or evidence. The maximum length of the reference is 8 characters.
  - **Author's surname and first name**
  - **Title** of the published article
  - **Periodical name** of the periodical in which the article appeared, and where applicable **Volume number** and **Article No.**
  - **Publication date** in the format DD.MM.YYYY or month and year
  - **ISBN** number, if appropriate
  - **Particular relevance** indicates items of particular relevance in the article

![Figure 314: Example of an article attached as evidence](image)

- Click the Add button again to attach the internet publication.
→ Select *Internet publications* and attach the relevant PDF file.
→ Enter information on the internet publication, particularly the reference, the exact wording of the title and the date when you retrieved the publication.

![Example of an internet publication as evidence](image)

**Figure 315: Example of an internet publication as evidence**

### 9.4.5 Evidence - other

You can attach all other evidence in the **Evidence - other** sub-tab:

- Affidavit
- Images or photo (PDF)
- Cover letter for non-scannable object
- Other evidence
- Translation of evidence

For every document, enter your internal reference for the evidence.

**Example 4: The third party presents an affidavit and other evidence**

In this example, the third party presents an affidavit. The third party has prepared a video recording as evidence and sent a DVD with the digital video film to the EPO by mail. The copy of the reference sheet to this DVD is presented as another piece of evidence in the online proceedings.

- Click the **Evidence - other** sub-tab.
- Click the **Add** button.
- Select **Affidavit** and attach the relevant PDF file.
  - The file is renamed **Affidavit-1.pdf**.
- Enter your internal reference in the **Reference field**.
  - The maximum length of the reference is 8 characters.
- Select **Cover letter for non-scannable object** and attach the second PDF file.
  - The file is renamed **Model-Reference-1.pdf**.
- Enter your internal reference in the **Reference field**.
9.5 EP(Oppo) – Fee Payment

Select the fees that you want to pay on Form EP(Oppo)'s Fee Payment tab and specify the mode of payment. The currency for all fees is EUR.

For more information on EPO deposit accounts and the automatic debiting procedure, please refer to the Official Journal:

- Arrangements for deposit accounts (ADA)
  Supplementary publication 3/2015, p. 8-16
- Notice from the European Patent Office dated 12 February 2015 concerning revision of the Arrangements for deposit accounts (ADA) and their annexes
  Supplementary publication 3/2015, p. 2-7
- Decision of the President of the European Patent Office dated 29 September 2016 revising points 5.3 and 7 of the Arrangements for deposit accounts (ADA)

Online fee payment

The EPO offers a quick and secure online fee payment service designed for holders of EPO deposit accounts. For more information, go to the EPO website and navigate to Applying for a patent > Online services > Online fee payment (http://www.epo.org/applying/online-services/fee-payment.html).

Payment details

- Click the Payment details sub-tab.
- Select the Mode of payment in the drop-down list.
  - The options Automatic debit order and Debit from deposit account assume that you have an EPO deposit account.
    The Automatic debit order option is only valid for the proprietor(s) of the patent.
  - Select the Bank transfer option if you want to transfer the fees to the EPO's bank account with the Commerzbank AG in Munich, Germany.
The IBAN and BIC codes of the EPO's bank account are supplied automatically when you select the Commerzbank from the drop-down list.

- Select Not specified if you are not sure how you will be settling the fees.

If you wish to have the fees debited from your account later than the submission date, enter the date in the Deferred execution date field.

Hover your mouse pointer over the symbol 🔄 to the right of the Deferred execution date field to see the Important information:

This functionality allows you to indicate explicitly that your payment order is to be executed at a later date than the submission date.

In this case, the payment date will be deemed to be the deferred execution date, provided that you have sufficient funds on your deposit account on that date.

Please choose the deferred execution date option only if the fees are to be debited on a future date, as otherwise the default execution date is the date of receipt.

The deferred execution date can be a maximum of 40 days in the future.

Please ensure that the deferred execution date lies within the time limit set for paying the selected fees.

Please note that any debit orders (standard or deferred execution) can only be revoked until 00.00 hrs CET on the date of submission (Arrangements for deposit accounts, 7).

Once you select a mode of payment, a red validation icon appears on the Fee Payment tab. The associated message indicates that the total fee amount is zero.
Further options
The Fee Payment sub-tab offers some additional options at the bottom of the screen.

- If you wish the EPO to make any reimbursements to a deposit account with the EPO, select the corresponding check box.
  - This information applies to all selected modes of payment. If you selected automatic debit order or debit from deposit account, you are only required to enter an account number here if that number is different from the account number used for payment.
    - Enter the EPO deposit account number and supply the account holder's name.

Fees for observations filed by third parties
If you enter any data in the Payment details sub-tab when filing as a third party, a red validation icon will appear in the Fee Payment tab. Please reset all data entries, i.e. set the Mode of payment to Not specified and clear the Reimbursement check box.

Fee selection
- Click the Fee selection sub-tab.
- Select the check boxes for the fees to be paid.
  - The fee amount is automatically calculated.
  - The check boxes for fees not applicable in this application are locked.
9.6 EP(Oppo) – Annotations

In the **Annotations** tab you can enter notes to be transmitted to the EPO.

**Creating notes for the EPO**

→ Click the **Add** button and select **New Note**.

→ Enter the relevant information in the **Author**, **Subject** and **Note** fields.

If you selected **Other action** in the **Opposition** tab, you can use Form EP(Oppo) for the sole purpose of transmitting an annotation to the EPO. The red validation icon in the **Documents** tab will disappear after you enter your text in the **Note** field. The application is ready for filing and can be signed in the next workflow step.

![Annotation interface](image)

*Figure 319: Opponent annotation for the EPO*

→ To add notes that are not intended for the EPO, use the **Internal notes** (p. 43) function on the form's toolbar.
9.7 Previewing the completed form

Two different PDF views of Form EP(Oppo) are displayed in preview mode depending on whether you started by selecting **Notice of opposition** or **Other action**.

- Click the **Preview** button in the toolbar.

**Example 1: Multiple opponents**

If you selected the **Notice of opposition** option, EPO Form 2300E entitled **Notice of opposition to a European patent** is displayed.

Information on the opposed patent, the proprietor of the patent and the (first) opponent is displayed on the first page. The address for correspondence and the employee under Article 133(3) EPC are indicated.

![PDF view of the form "Notice of opposition to a European patent"](image)

*Figure 320: PDF view of the form "Notice of opposition to a European patent"*
The other opponents are listed on one or more additional sheets at the end of the PDF document.

Figure 321: PDF view of the additional sheet to the opposition, listing additional opponents
Example 3: Reply of the proprietor of the patent

If you selected the **Other action** option, the form entitled *Submission in opposition proceedings* is displayed.

Requests and attached documents are listed in the section after the information on the proprietor of the patent and the patent.

![PDF View of the Form "Submission in opposition proceedings"](image)

*Figure 322: PDF view of the form "Submission in opposition proceedings"*
Example 4: A third party submits information

If you selected the **Other action** option and designated a third party, the form entitled **Observations by third parties (Art. 115 EPC)** is displayed.

The attached documents and evidence are listed on the form.

![PDF view of the "Observation by third parties (Art. 115 EPC)" form](image)

**Figure 323: PDF view of the "Observation by third parties (Art. 115 EPC)" form**
10 PCT/RO/101

The request form PCT/RO/101 allows you to submit an international application electronically to the EPO, WIPO or any national office that accepts these online filings. The provisions of the PCT and its regulations (PCT Rules) apply, supplemented where applicable by the provisions of the EPC.

This document focuses on the EPO acting as receiving office. For more information about the PCT, see the WIPO website at IP Services > PCT > Treaty (http://www.wipo.int/pct/en/treaty/about.html).

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu bar</strong></td>
<td>Provides commands to edit, save, preview, print, import and export applications, switch to another section, view validation messages and access help.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td><strong>Navigation bar</strong></td>
<td>Displays tabs corresponding to the sections of the form.</td>
</tr>
<tr>
<td><strong>Details area</strong></td>
<td>Displays data entry fields appropriate to the selected tab.</td>
</tr>
<tr>
<td><strong>Traffic lights</strong></td>
<td>Uses colours to indicate the completeness of each section.</td>
</tr>
</tbody>
</table>
Toolbar

The toolbar provides buttons for the most common tools you will need to access as you prepare, sign and send your application. If the current status of your application does not allow you to perform a particular task yet, the corresponding button is deactivated.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>Preview</td>
<td>Shows a preview of the application in the PDF Viewer.</td>
</tr>
<tr>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
<td>Prints the application to your default printer.</td>
</tr>
</tbody>
</table>
| ![Sign](image) | Sign | Prepares the application for submission and moves it to **Ready to sign** status in File Manager.  
If the option **Start signing immediately when moving application forwards from draft status** is selected in the user preferences in File Manager, the application immediately opens in the PDF Viewer to be signed; see Signing the form (p. 344). |
| ![Save as Ready for Signing](image) | Save as Ready for Signing | Prepares the application for submission and moves it to **Ready to sign** status in File Manager.  
Signing can then be done from File Manager; see Signing the form (p. 344). |
| ![Help](image) | Help | Opens the online help in your default browser. |
| ![Validation](image) | Validation | Opens the **Validation Messages** window for the currently selected section (tab). |

Navigation bar (sections)

Form PCT/RO/101 is split into ten administrative sections represented by corresponding tabs.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
</table>
| **Request** | Request that the present international application be processed according to the Patent Cooperation Treaty (PCT)  
Select the receiving office, the International Searching Authority and the language  
Enter a title for the application |
| **States** | Exclude certain designated states  
Indicate reference to a parent application or grant |
| **Names** | Enter details of applicant, agent (representative) and inventor |
| **Priority** | Claim a national, regional or international priority |
| **Biology** | Enter details related to deposited microorganisms and the depositary institution  
Indicate that the description contains a sequence listing |
| **Declarations** | Make applicant or inventor declarations |
| **Contents** | Attach specification documents and other electronic files |
| **Fees** | Calculate fees according to the selected fee schedule |
| **Payment** | Select a payment option and enter related data. |
| **Annotate** | Create remarks and private remarks  
View the Validation Log  
Designate inventor(s) for certain states only |
Traffic lights (validation icons)
Validation messages are indicated by the traffic light icons. This way, you can see at a glance if the data you have entered is complete or if additional information is required.

<table>
<thead>
<tr>
<th>Traffic Light Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Red Traffic Light" /></td>
<td>A red traffic light icon signals that mandatory information is missing (for example, the description of the invention or the claims). You must supply this data before submitting the form. A PDF or XML document added in the <strong>Contents</strong> tab may also trigger a red traffic light if it is deemed not to be of a sufficient quality to meet the filing criteria.</td>
</tr>
<tr>
<td><img src="image" alt="Yellow Traffic Light" /></td>
<td>A yellow traffic light icon indicates that this information is required, but not mandatory at this stage (for example, the abstract). If a yellow light is displayed when you add a PDF or XML document in the <strong>Contents</strong> tab this may also reflect compliance or quality issues that should be reviewed. In this case, however, the documents are of sufficient quality to allow filing.</td>
</tr>
<tr>
<td><img src="image" alt="Green Traffic Light" /></td>
<td>A green traffic light icon indicates that the information is complete.</td>
</tr>
</tbody>
</table>

Viewing validation messages
For example, if you are working in the **Request** section and the traffic light icon in the **Request** tab is red, the validation window will provide you with more information about the data that is missing.

- To open the **Validation Messages** window, click the **Validation** button in the toolbar.
- Select **Tools > Validation** from the menu.

![Figure 325: Validation messages relating to the Request tab](image)

You can display the validation messages for each form section individually or you can view the **Validation Log** for the application as a whole; see PCT/RO/101 – Annotate (p. 338).

10.1 Creating a new PCT/RO/101 application

The most convenient way to create a new PCT/RO/101 application from scratch is by using the **PCT/RO/101** form in the **Forms** folder of File Manager.

For detailed information on working with folders, applications and templates in File Manager, see the corresponding section in the Online Filing user guide or in the online help for File Manager.
Launch the **Online Filing Client 5.0**.
By default, File Manager opens with the **Forms** folder displayed.

- Double-click the **PCT/RO/101** form.

![Figure 326: Selecting the PCT/RO/101 form in the Forms folder of File Manager](image)

The **Create a New Application** window opens.

- Enter the **User Reference** for the new application.
- Select the language you want in the **Language of proceedings** list.
  
  The form on which the application is transmitted to the EPO will be created in this language.
  
  By default, the language is **English** if your File Manager is also set to English.

- Select the **folder** where you want to save the new application.
  **Default Folder** is selected by default.

- Click **Create**.
A warning message appears if the user reference you entered has already been assigned to another PCT/RO/101 application.

Online Filing does not allow you to use the same user reference for multiple PCT/RO/101 applications.

➔ Edit your entry in the User Reference field.
➔ Click Create.
➔ The new PCT/RO/101 application opens in the form view.

### 10.1.1 Saving the form

The new application and all the data that you are going to enter are only stored in the Online Filing database if you save the form. If you close the form without saving, all data will be lost.

**Saving the draft application while keeping the form open**

➔ From the menu, select File > Save as Draft.

The saving process will take a few moments. You can then continue working in the application.

**Closing the form and saving the application on exit**

➔ From the menu, select File > Close Form.
or
Click the red closing button in the top right-hand corner of the form window.
or
Double-click the violet and white icon in the top left-hand corner of the form window.

In the following dialog, select **Save as Draft**.

Click **OK**.
The application is saved and closed, returning you to File Manager.

10.1.2 Working with templates

**Templates** are user-defined forms, containing data that you need every time you prepare certain applications, such as information relating to a particular applicant or to fee payments. The only way to create a template for a PCT/RO/101 form is to use a draft saved in the **Default Folder** of File Manager. If you create a template using any other folder, your template will not be visible from the File Manager interface.

Creating a template from the open form

- From the menu, select **File > Save as Template**.
- In the following dialog, enter a unique user reference for the template.
- Click **OK**.
Entering a description for the template

All templates based on form PCT/RO/101 are automatically saved in the Templates folder in File Manager.

- To assign a description to a template, right-click it and select Properties from the shortcut menu.

Existing PCT/RO/101 templates cannot be edited. If you want to copy or edit a template, create a new application based on this template, edit the data as required and save the form as a new template.

Using the template for a new application

- Double-click the template in the Templates folder. The Create a New Application window opens. The template's name is already selected in the Based on Template drop-down list.
- Proceed as described in Creating a new PCT/RO/101 application (p. 276).
10.2 PCT/RO/101 – Request

Form PCT/RO/101 opens with the **Request** tab by default. This section provides data entry fields for the most basic information of a new application.

The examples shown in this document are confined to applications where the EPO is selected as both receiving office and International Searching Authority (ISA).

- Select **EP** as the **Receiving Office**.
- Select **EP** as the **International Searching Authority**.
- Select the **Language of filing of the international application**.
  The available options are English, French and German.
- Enter the **Title of invention** using BLOCK CAPITALS.
  The title should be the same as on the first page of the description.
Request to use results of earlier search

- If appropriate, select the check box **Request to use results of earlier search**. This enables additional options for entering the required details.
- Double click the row **Open to add reference to earlier search**.
  - or
  - Click the **Open** button.

The **Details of Earlier Search** window opens.

- Select the **Country (or regional Office)**. The **European Patent Office (EPO)** is selected by default if the EPO was selected as the International Searching Authority.
- Enter the **Filing date**.
- Enter the **Application number** in the appropriate format.
- If applicable, select the check box for **This international application is the same, or substantially the same, as the application in respect of which the earlier search was carried out, except, where applicable, that it is filed in a different language**. The two remaining options are mutually exclusive.
- If search-related documents are already available to the ISA, select **The following documents are available to the ISA in a form and manner acceptable to it and therefore do not need to be submitted by the applicant to the ISA (Rule 12bis.1(f))**.
- Select all applicable check boxes.
The option **The receiving Office is requested to prepare and transmit to the ISA (Rule 12bis.1(c))** does not apply for applications where the EPO is the receiving office, because the EPO is also the ISA in these cases.

Figure 337: Details of earlier search, documents available to the ISA

- Click **OK**.  
  The **Details of Earlier Search** window closes.

Back in the **Request** tab, you can continue editing references to earlier searches.

- Add another reference by clicking **Open** once again.
- Delete a reference by right-clicking it and selecting **Cut** from the shortcut menu.

Figure 338: Deleting reference to earlier search results
10.3 PCT/RO/101 – States

The States tab of form PCT/RO/101 allows you to exclude pre-defined designation states and add references to parent applications or grants. The most recent list of PCT contracting states (http://www.wipo.int/pct/guide/en/gdvol1/annexes/annexa/ax_a.pdf) is available on the WIPO website.

By default, all contracting states bound by the PCT on the international filing date are designated when a new request is filed. However, the designation of Germany, Japan or the Republic of Korea can be excluded if a national priority of the particular state concerned is claimed.

➔ To exclude a designation irrevocably, select the corresponding check box.

Reference to parent application or grant

➔ To add a reference, click Reference to parent application or grant.

 The check box to the left of the button cannot be edited manually.

Figure 339: Designation of states, adding reference to parent application or grant

The Reference to Continuation or Continuation-in-Part ... window opens, with the National parent application or grant tab selected by default. All relevant countries are displayed in the list. If you excluded individual countries (DE, JP or KR) from designation, these are not listed.

➔ To enter or edit a reference, double-click the corresponding country in the list.
Figure 340: Adding reference to national parent application or grant

The **National parent application or grant** window opens.

- Select the **Kind of parent application or grant**.
- Enter the **Parent application or grant number**.
- Enter the **Parent application or grant date**.
- To add or edit another reference, click the corresponding country code on the left-hand side and enter the relevant details.
- Click **OK**.

Figure 341: Entering details for national parent application or grant

The national references are now displayed in the country list. The abbreviation stands for the kind of patent application or grant. For example, **poa** means **patent of addition**.

- To add an OAPI reference, click **OAPI parent application or grant** (OAPI = Organisation Africaine de la Propriété Intellectuelle).
Enter the details.  
Click OK.

Figure 343: Entering details for OAPI parent application

Back in the States tab, the check box for Reference to parent application or grant is now selected.

Figure 344: Check box is selected and indicates references to parent applications

10.4 PCT/RO/101 – Names

The Names tab of PCT/RO/101 is for adding contact details for all persons involved in this application:

- Applicant
- Inventor
- Agent
- Common representative
In certain cases, an additional special address for correspondence can be added. There are two different ways of adding names and addresses to the form. Choose the method which is most convenient for your personal workflow.

(1) Copying names from the Address Book

- To browse the Online Filing Address Book, click *Address Book*.
- Define a single entry for one of the functions in the *Names* tab; see Adding names from the Address Book to a form and vice versa (p. 300).

![Figure 345: Options for adding persons in the Names tab](image)

(2) Adding names in the Details window

- Open the details window for the applicant, inventor or agent, either by double-clicking the corresponding row in the list or by selecting an entry and clicking *Open*.
- Enter the name and address data manually.
  or
- Import an entry from the Address Book:
  - Select the first address book entry by clicking the address book icon.
  - Browse the address book in sequence using the left and right buttons.

Removing names

- To delete a name, right-click the corresponding entry and select *Cut* from the shortcut menu.
This action cannot be undone.

Figure 346: Removing person from the Names tab

10.4.1 Applicant

At least one applicant or applicant/inventor must be indicated for all designated states or group of designated states. For the competence of the EP as the receiving office at least one of the applicants must be resident in or have the nationality of one of the EPC states.

**Applicant is a legal entity**

The *Details concerning Applicant or Applicant/Inventor* window opens when you click *Open* in the *Names* tab. *Legal entity* is selected by default.

- In the *Name* field, enter the company name (full official name) in *BLOCK CAPITALS*.
- Enter the remaining address information.
- If applicable, enter additional address information such as the floor, building etc. in the first address field.
  The second address field is intended for the street and house/building number.
- If you wish, you can select your preferred option for the use of e-mail to send notifications.
  - At present, however, the EPO does not send any official communications by e-mail so this option is redundant when filing with the EPO.
- To continue adding entities, click the corresponding button on the left-hand side. For example, *+ App.* adds a second applicant to the list.
- Click *OK* when ready to return to the *Names* tab.
- Click *Cancel* to close the *Details* window without saving data.
Applicant or applicant/inventor is a natural person

- Select **Natural person**.
  - This also unlocks the check box **This person is also inventor** to the right.
- Where appropriate, select the check box to designate this applicant as inventor.
- Enter the last name in **BLOCK CAPITALS**.
- Complete the address data.
  - **Telephone**, **facsimile** and **e-mail** information is only required for the first applicant, so the corresponding fields are locked for the second and all further applicants.
  - The **Rep.** (common representative) option becomes available on the left-hand side.
Designated states
If you want to restrict the designated states for any applicant, you can specify the states individually.

- Select **Certain designated States only**.
- Click **select/modify**.

Select the desired countries by selecting the check boxes individually.
- Click **Select All** to select the complete list.
- Click **Clear All** to undo any selection.

Note that the list is ordered alphabetically by type and then country. A country may appear more than once under these types:
- ARIPO patent
- Eurasian patent
- European patent
- OAPI patent
- National patent

Figure 350: Designated states grouped by type

Common representative
If more than one applicant is entered, the common representative (Rep.) option becomes available if no agent or correspondence address is used. The common representative must be resident in or have the nationality of one of the EPC states. Agent (Agt.), common representative (Rep.) and correspondence address (Corr.) are mutually exclusive options, meaning that if one is chosen then the other two options are unavailable. If none of these three options is used, the first named applicant will be considered as the common representative and all correspondence will be addressed to him.

- Click Rep. on the left-hand side of the Details window.
  or
- Double-click the + Common Rep. row in the Names tab.

- Select one of the applicants from the Name drop-down list.
The address details are completed automatically.

Figure 351: Details concerning Common Representative, using data of 1. Applicant
Special address for correspondence
If no agent and no common representative are named, you can add an extra address for correspondence which is different from an applicant's primary address.

→ Click Corr. on the left-hand side of the Details window.

or


By default, the details are completed automatically with the name and address information of the first applicant.

→ Modify this data where necessary.

![Details concerning Special Address for Correspondence, legal entity](image)

Figure 352: Details concerning Special Address for Correspondence, legal entity

### 10.4.2 Inventor

You do not have to name the inventor(s) when you file your application, as the information can be submitted subsequently, but it is strongly recommended that you do so.

**Inventor only**

→ In the Names tab, double-click the + Inventor only row.

or

→ In the Details window, click + Inv.

→ Fill in the data fields or retrieve an entry from the address book.
Remember to enter the inventor’s last name in **BLOCK CAPITALS**.

![Figure 353: Details concerning Inventor Only](image)

**Deceased inventor**

The successor to the rights of the deceased inventor can be selected from defined applicants provided that an applicant is designated for the US in the **Names** tab. The deceased person remains the inventor.

- Select the **Deceased** check box in the **Details concerning Inventor Only** window.
  - The applicant names that appear on the list are those whose designations include the United States of America.
  - If no US designation is present under any of the applicants, then this list will be empty and you cannot enter any data for succession rights in the US.
- Select the check box for the applicant who is successor to the rights of the deceased inventor.
- Double-click in the corresponding **Capacity** box to open the list of options.
- Select the appropriate capacity.
- Repeat these steps if there is more than one legal representative for the deceased inventor.
10.4.3 Agent

If you don't specify a common representative or a special address for correspondence, you can name one or more agents.

→ In the **Names** tab, double-click the + **Agent** row.

or

→ In the **Details** window, click + **Agt**.

  ① Note that the options **Common Representative** and **Corr. Address** become unavailable once you added an agent.

→ Select the person type: **Legal entity** or **Natural person** (default option).

  – For legal entities, enter the company name in **BLOCK CAPITALS**.
  – For natural persons, enter the last name in **BLOCK CAPITALS**.

→ Complete the agent's data.

  For the competence of the EP as the receiving office the agent must be resident in or have the nationality of one of the EPC states.

→ If you provide an e-mail address, select the appropriate authorisation check box.
At present, however, the EPO does not send any official communications by e-mail.

Figure 355: Details concerning agent, legal entity

- Click + Agt. to name a second agent.
- Enter the agent's name.
- Select *Same address as the first-named agent*, if applicable.
  The address data entry fields are then removed from the form.
- Click OK when ready.
Back in the **Names** tab you have further options:

- To change the order of the agents, right-click a name and select **Move Up** or **Move Down** from the shortcut menu.
  The list will be re-arranged accordingly.
- Click **Power of Attorney** to create the Power of attorney document (p. 297).
10.4.4 Power of attorney document

You can create a power of attorney document as a PDF file and attach it to the application. The *Power of Attorney* button becomes available if

- at least one applicant and one agent are added
- or
- more than one applicant and a common representative are added.

- In the *Names* tab, click *Power of Attorney*. The *Power of Attorney* window opens.
- Select the applicant(s) giving power of attorney.
- Select the agent/common representative to whom power of attorney is given.
- Select the applicable authority from the drop-down list at the bottom of the form.
- Enter a date.
- To view the draft power of attorney document in the PDF Viewer before signing, click *Preview*.
- To open the PDF Viewer and then proceed further to the signing dialog, click *Sign*. 
The PDF Viewer window opens.

- To return to the **Power of Attorney** window and modify the data before signing, click **Cancel** in the bottom right-hand corner of the PDF Viewer.
- To launch the signing process, click **Continue**.

The **List of Signatories** window opens.

- If the applicant is a legal entity, enter the last name and first name of the person entitled to sign in the `<name_of_signatory>` field and that person's function in the `<capacity>` field.
- If the applicant is a natural person, only the applicant's name can be selected.
→ Click **Add Signatory**.

![Add Signatory](image)

**Figure 360: Adding signatory for 2. Applicant who is a natural person**

The **Signature** window opens.

→ In the **Signature** window, enter an alphanumeric signature between the two slashes `/.../` or attach a file with the facsimile signature.

→ Click **Apply Signature**.

![Apply Signature](image)

**Figure 361: Applying alphanumeric signature for applicant**

The **List of Signatories** window shows the new signature.

→ Repeat these steps to add more signatories if required.

→ Click **OK** when ready.
Back in the **Power of Attorney** window the names and capacity (if legal applicants) of the signatories are now indicated in the applicants' list.

- To view the form with the signatures in the PDF Viewer, click **Preview**.
- To return to the **Power of Attorney** window after checking the PDF, click **Cancel**.

> To save your data and exit the **Power of Attorney** window, click **OK**.

**10.4.5 Adding names from the Address Book to a form and vice versa**

The **Address Book Exchange** function provides a convenient way to copy existing addresses from the address book to a PCT/RO/101 form. Vice versa, it allows you to copy an address which was manually entered from the form to the Address Book.
The data structure of form PCT/RO/101 is not fully compatible with the Online Filing address book, because the PCT plug-in is based on the WIPO PCT-Safe software and uses an older technical platform. Please open the OLF address book from File Manager to check whether the address information has been copied correctly, and amend the data if necessary.

Adding names to the form

- In the **Names** tab, click **Address Book**.

In the upper part of the **Address Book Exchange** window the existing Address Book entries are listed, whereas the lower part lists the names added to the form at this time.

- To copy a name from the Address Book to the form, select an entry in the list at the top. Depending on the type of name, the following functions may be available:
  - Applicant only
  - Applicant/inventor (for natural persons only)
  - Inventor only (for natural persons only)
  - Agent
- Click the function you wish to add.

![Figure 364: Selecting legal person as applicant only](image)

The lower list now contains the entry to be added to the **Names** tab.

- To add more names, select another entry from the Address Book and click the appropriate function.
- To delete a name from the list, select it and click **Remove**.
- To finish the address selection and transfer the data to the **Names** tab, click **OK**.
Adding names to the Address Book

If you entered address data manually after adding a name in the Names tab, the lower list in the Address Book Exchange window displays this new address.

- Select the name in the list.
- Click Copy to Address Book.

The data is copied to the Address Book.

If an entry with the same name already exists in the Address Book, Online Filing creates a further entry.

- Note that not all data entered in your PCT/RO/101 form is transferred to the Address Book.
- Open the Address Book, verify and amend the data if necessary.
10.5 PCT/RO/101 – Priority

The **Priority** tab of PCT-RO-101 is for specifying details of an earlier application from which priority is claimed.

→ Double-click the **Add Priority Claim** row or click **Open**.

The **Details of Priority Claim of Earlier Application** window opens.

→ Select the appropriate option: **National**, **Regional** or **International (PCT)**.
Select the country, the regional office or the receiving office where the earlier application was filed.

Enter the filing date of the earlier application.

Enter the application number that was assigned to the earlier application. For some offices, the required application number format is pre-filled into the data entry field, e.g. PCT/IB____/______ if you select IB as the receiving office.

To add another priority, click the + icon on the left.

Options for requesting the International Bureau to obtain a certified copy of the earlier application

In the lower part of the Details window, you can select the method by which a certified copy of the earlier application should be made available to the International Bureau.

The WIPO Digital Access Service (DAS) is an electronic system allowing priority documents and similar documents to be securely exchanged between IP offices. For more information, go to the WIPO website at IP Services > Patents > Digital Access Service and follow the shortcut to Participating Offices (http://www.wipo.int/patentscope/en/priority_documents/offices.html). As of March 2012, the digital libraries of the following countries are participating for notification both as depositing office and as accessing office: AU, DK, CN, ES, FI, GB, IB, JP, KR, SE and US.

If applicable, select The International Bureau is requested to obtain from a digital library a certified copy of the above-identified earlier application.

A warning message appears, asking you to verify that the priority application can be retrieved by the receiving office. Note that the message is different if the country is one of the countries participating in the DAS or if the selected country is not a participating country.

Enter the access code into the field which is displayed if the upper check box is selected.

Alternatively, select The receiving Office is requested to prepare and transmit to the International Bureau a certified copy of the above-identified earlier application.
This is the appropriate option if you have e.g. chosen an EP priority, as the EPO does not participate in the DAS (applies only to earlier applications treated by the EPO).

**Request to restore the right of priority**

A request for restoration of the right of priority can be filed where the international application has an international filing date which is later than the date on which the priority period expired but within a period of two months from that date (Rule 26bis 3).

- If applicable, select the check box *The receiving Office is requested to restore the right of priority.*
  - The option to add the related statement is automatically added to the *Accompanying Items* sub-tab of the *Contents* tab. Please remember to attach the corresponding electronic document.
- To save your data and return to the *Priority* tab, click **OK**.

**Other actions**

The priority claims are automatically sorted chronologically.

- To delete a priority claim, right-click and select **Cut** from the shortcut menu.
- To move an individual priority to another position in the list, right-click it and select **Cut** from the shortcut menu. Then right-click the priority before which you want to insert the priority and select **Paste** from the shortcut menu.
- To return a list to the default sorting, select **sort priority claims chronologically**.

![Figure 370: Shortcut menu options available in the priority claims list](image)

**Validation messages**

The check boxes in the *Req.* and *Rest.* columns indicate whether one of the options for requesting a certified copy of the earlier application has been selected and if a request to restore the right of priority is being made.

- Please see the validation messages for information about additional documents required when adding any one of these requests.
If you cannot read the full text of the validation messages, open the Validation Log in the PDF Viewer, see PCT/RO/101 – Annotate (p. 338).

Figure 371: Validation messages referring to priority claims

10.6 PCT/RO/101 – Biology

The Biology tab is for providing information on biological material and indicating whether sequence listings are part of the description of the international application.

Information on nucleotide and/or amino acid sequence listing

- If applicable, select the check box The description contains a sequence listing.
- Attach the required documents in the Contents tab; see Sequence listing (p. 329) for more details. The following options are automatically added to the form if the above is checked:
  - In the International Application sub-tab:
    - description (excluding sequence listings) replaces description
    - sequence listing
  - In the Accompanying Items sub-tab:
    - sequence listing submitted for international search only
    - statement confirming that "the information in Annex C/ST.25 text format submitted under Rule 13ter is identical to the sequence listing as contained in the international application".
Adding indications relating to biological material

→ Double-click the first row *Open to add a new item* or click *Open*.

![Figure 372: Entering information on biological material](image)

The *Details concerning Indications Relating to a Deposited Microorganism* window opens.

→ Enter the page and line or paragraph number of the reference in the description.

→ Select the *depositary institution* (mandatory information) from the drop-down list. The full *address* is automatically provided.

→ Enter the *accession number* (mandatory information) and the *date of deposit* (mandatory information).

→ If you want to supply extra documents regarding this biological material, specify the documents in the *Additional Indications* field.

   1. The corresponding documents can be attached in the *Accompanying Items* (p. 327) sub-tab of the *Contents* tab.

→ In the *Separate Furnishing of Indications* field, specify the indications which you wish to supply by separate cover.

→ If required, modify the list of *designated states*; see the instructions under *Applicant* (p. 288).
10.7 PCT/RO/101 – Declarations

The **Declarations** tab allows you to prepare separate declaration sheets for filing with the application. These sheets contain the declarations as a default text, which is then complemented by additional data that is entered by you.

- Select an option from the **Declarations** drop-down list.
- Click **Add**.
10.7.1 Declaration as to the identity of the inventor

- In the **Declarations** tab, select **Declaration as to the identity of the inventor** from the drop-down list, and then click **Add**.
  The **Declarations** window opens.
- Double-click the **Add Inventor** row.
  The **Details concerning inventor** window opens.
- In the **Name** field, select one of the inventors from the drop-down list.
  The deceased inventors are not available in the list.
  The address data is automatically completed.
- To add another inventor, click the + icon on the left.
- To specify an inventor whose name has not been added to the form, select <other> from the list and enter the address data manually.
- Click **OK** when ready.

![Figure 375: Inventor's details for declaration as to identity of the inventor](image)

The inventor is added to the list in the **Declarations** window.
- Click **OK** to return to the **Declarations** main tab.

![Figure 376: Declaration as to the identity of the inventor added](image)
10.7.2 Declaration as to applicant's entitlement to apply for and be granted a patent

- In the Declarations tab, select **Declaration as to applicant's entitlement to apply for and be granted a patent** from the drop-down list, and then click Add. The Declarations window opens.
- Select one of the applicants from the list.
- Double-click the Add item row.

![Figure 377: Adding declaration as to applicant's entitlement to apply for and be granted a patent](image)

The Status/Event window opens.
- Select the appropriate option from the list:
  - Inventor
  - Employer of an inventor
  - Agreement
  - Assignment
  - Consent
  - Court order
  - Transfer of entitlement
  - Change of the applicant's name
Depending on your selection, more options and data entry fields become available.
- Make the appropriate selections and supply the required data.
- Click OK when ready.

![Figure 378: Selecting names for "employer of an inventor"](image)

- Back in the Declarations window, click OK to return to the Declarations main tab.
10.7.3 Declaration as to applicant's entitlement to claim priority

- In the Declarations tab, select **Declaration as to applicant's entitlement to claim priority of earlier application** from the drop-down list, and then click **Add**. The Declarations window opens.

- Select one of the applicants from the list.
- Select one of the priority applications from the list.
- Double-click the **Add item** row.

![Figure 379: Selecting application for declaration as to applicant's entitlement to claim priority](image)

The Status/Event window opens.

- Select the appropriate option from the list:
  - Inventor
  - Employer of an inventor
  - Agreement
  - Assignment
  - Consent
  - Court order
  - Transfer of entitlement
  - Change of the applicant's name

Depending on your selection, more options and data entry fields become available.

- Make the appropriate selections and supply the required data.
- Click **OK** when ready.

![Figure 380: Adding agreement between persons involved in the international application](image)

- Back in the Declarations window, click **OK** to return to the Declarations main tab.
10.7.4 Declaration of inventorship

- In the Declarations tab, select Declaration of inventorship (only for the purposes of the USA) from the drop-down list, and then click Add.
  The Declarations window opens.
  The Inventors table displays all inventors and applicants/inventors from the Names tab, except the deceased inventors.
- To exclude one of the inventors from this declaration, right-click the corresponding name and select Delete from the shortcut menu.
- To specify an inventor whose name has not been added to the form, double-click Inventor.

Figure 381: Adding inventor for declaration of inventorship

The Details concerning inventor window opens.
- Select <other> from the Name list.
- Enter the inventor's last name in BLOCK CAPITALS.
- Complete the address data.
- Click OK when ready.
Back in the Declarations window, click **Sign**.

The List of Signatories window opens.

- Select an applicant/inventor and click **Add Signatory**.
- In the **Signature** window, enter an alphanumeric signature or attach a file with the facsimile signature.
- Click **Apply Signature**.
  The signatory is added to the list.
- Create a signature for each applicant/inventor.
- Click **OK** to finish.
10.7.5 Declaration as to non-prejudicial disclosures or exceptions to lack of novelty

- In the Declarations tab, select Declaration as to non-prejudicial disclosures or exceptions to lack of novelty from the drop-down list and click Add. The Declarations window opens.
- Select the applicant or inventor concerned from the list.
- Double-click the Add Disclosure row.

The Disclosure window opens.
- Select the kind of disclosure from the drop-down list.
  or
  Select OTHER and then specify the kind of disclosure.
- Enter the corresponding data.
- Click the + icon on the left to add another disclosure.
- Click OK when ready.
10.7.6 Previewing declaration sheets

If you wish to verify your declaration data before submission, you can open the print preview of the declaration sheets in the PDF Viewer. The **Print declarations** button becomes available after the submission process, when you open the application from the **Sent** folder in File Manager.

→ In the **Declarations** main tab, double-click any of the declarations in the list.  
or  
Click **Open**.

The **Declarations** window opens.  
→ Click the **Preview** icon in the toolbar.
The **PDF Viewer** opens and shows all the declaration sheets for this application, starting with declaration no. 1.

- Browse the pages to see the following declarations.
- In the PDF Viewer, click the **Print file** icon to create a hard copy of the declarations.
- Click **Cancel** when finished.

The PDF Viewer closes.
- Click **OK** to return to the **Declarations** main tab.

## 10.8 PCT/RO/101 – Contents

The **Contents** tab of form PCT/RO/101 is where you attach documents to support the patent application.

See *Preparing documents for attachment* (p. 90) in the EPO Online Filing user guide for more information about the correct settings for electronic documents.

The **Contents** tab provides two sub-tabs for attaching documents:
- **International Application**
  Attaching the mandatory patent specification documents and other recommended files

- **Accompanying Items**
  Attaching additional documents

![Image of Contents tab with "International Application" and "Accompanying Items" sub-tabs]

**Validation messages**
A red traffic light indicates that one or more mandatory documents have not yet been attached.
- Click the validation icon to see the corresponding validation messages.

**Attaching documents**
The attachment process is basically the same for all document types. The example below shows how to attach a PDF file. The option **PDF attachments** is selected by default when you open the **Contents** tab. See XML attachments (p. 325) for an example of how to attach XML files.
- Double-click a document option in the check list, e.g. **Description**.
  or
  Select the document option and click **Open**.

The **Content Details** window opens. All document attachments for this application are listed on the left, with the currently selected item being highlighted.
- To select a file from your computer, click the **Open** button on the right.
In the **Open** window, navigate to the storage location of the corresponding file.

Select the appropriate option in the **files of type** list. The available file types depend on the type of document you want to attach. The default type for text documents is **Portable Document Format** and the alternative is **TIFF files**, i.e. attaching images as TIFF files. When attaching sequence listing documents, the options **ASCII Text (*.txt)** and **Annex C/ST.25 files (*.app)** become available.

- Select the required file.
- Click **Open**.

The file is attached and it retains its name in lower case in the **Content Details** window. The **number of pages** is calculated automatically when a PDF file is attached.

- If you attach a TIFF or JPEG file, e.g. a drawing, please enter the number of pages manually (1, in most cases). Otherwise, the software will not recognise the attachment.

- If you want to attach other files, select the corresponding document type on the left and repeat the described procedure until all required documents are attached; see PDF attachments (p. 320).

- Click **OK** when ready.
Exchanging and removing attached files

If an original document has been modified, you can reattach the updated file to your application.

- In the Contents tab, double-click a document to open it.
  The Content Details window opens.
- To reattach a file, click the Open button and select the corresponding file once again.
  The new file from your computer replaces the existing attachment in the application.
- To remove the file without attaching a new one, click Reset.

10.8.1 International Application

The International Application sub-tab provides different options and preconditions for document attachment.

- **PDF attachment** is selected by default. Use this option to attach the description, claims, drawings and abstract as separate PDF files.
- Select **Single specification file** if you have prepared one single PDF file containing the description, claims and abstract. Note that drawings cannot be included in a single specification file. They should be added separately if required.
- Select **XML attachments** if you have prepared the specification document as an XML file, e.g. with PatXML.

Document check list for PDF attachments

- Description
- Claims
- Abstract
- Drawings
Pre-conversion archive (optional, but strongly recommended; becomes available after one of the specification documents has been attached)

Document check list for PDF attachments if description contains a sequence listing
If the check box The description contains a sequence listing is selected in the Biology tab, the document check list is slightly different:
- Description (excluding sequence listing)
- Claims
- Abstract
- Drawings
- Sequence listing (should be attached as an ST.25 standard file, i.e. as ASCII text (*.txt) or Annex C/ST.25 (*.app) file)
- Pre-conversion archive (optional, but strongly recommended; becomes available after one of the specification documents has been attached)

Document check list for PDF attachments, single specification file
- Specification
- Drawings
- Pre-conversion archive (optional, but strongly recommended; becomes available after one of the specification documents has been attached)

Document check list for XML attachments
- Application body
- Pre-conversion archive (optional; becomes available after the XML specification file has been attached)

10.8.2 PDF attachments
Attaching separate PDF files for each part of the patent document is recommended as the most convenient procedure.
- The description and claims are mandatory.
- The abstract can be filed subsequently, but it is recommended to include it with the application.
- Drawings can also be added, if applicable.

Description
- In the International Application sub-tab of the Contents tab, double-click Description.
- The Content Details window opens. Once the Content Details window is open, you can immediately proceed to attach all other documents one after the other. You are not required to return to the Contents main tab.
- Click the Open button, navigate to the appropriate file and attach it.

Claims
- In the list on the left-hand side of the Content Details window, click Claims.
→ Click the **Open** button, navigate to the claims file and attach it.

**Abstract**
→ Click **Abstract** on the left.
→ Click the **Open** button, navigate to the appropriate file and attach it.
→ Select the **Language of the abstract**.
  The available options are English, French and German.

![Figure 394: Abstract attached](image)

**Drawings**
→ Click **Drawings** on the left.
→ Click the **Open** button, navigate to the appropriate file and attach it.
→ Enter the **Figure of the drawings which should accompany the abstract**.
→ If applicable, select **Yes** under **The figure of the drawings which should accompany the abstract contains text**.
→ Enter the text in the **Drawing Text** box.
→ Click **OK** to return to the **Contents** main tab.

![Figure 395: Drawings attached](image)
Summary
The software automatically calculates the total number of pages in the *International Application* sub-tab.

The fields showing the total number of **documents** and number of **files** at the bottom of this screen summarise all attachments, in both the *International Application* and *Accompanying Items* sub-tabs.

When all the attached documents show a green traffic light, everything is correct.

![Check List](image)

*Figure 396: All required documents are properly attached*

### 10.8.3 Single specification file (PDF)

The following rules apply when preparing a single specification file:

- All pages in the document must be accounted for and there must be no overlaps.
- Every element in the attached document must start on a new page.
- The order of the individual components should be: description, claims, abstract.

If your PDF file does not correspond to these requirements, you may not be able to enter the data appropriately and will receive corresponding validation warnings.

**Attaching the specification**

- In the *Contents* tab, select the check box *Single specification file*.
- Double-click *Specification*.
The **Content Details** window opens.

- Click the **Open** button, navigate to the PDF file and attach it.
- Enter the first page and last page of the **description**.
- Enter the first page and last page of the **claims**.
- Enter the first page and last page of the **abstract**.
- Select the **Language of the abstract**.

The number of pages for each document section and the total number of pages is calculated automatically.

- Check whether the number of pages contained in the PDF file equals the total number of pages.
- To view the corresponding section of the single document, e.g. the claims, click the **Preview** icon next to the page numbers on the right.

---

**Figure 397: Attaching a single specification file in a PDF**
Figure 398: Specification file attached and page numbers of document sections entered

**Further options**

- If you intend not to submit the abstract at this time, select the check box *abstract is not included*.
  
  This action deactivates the options referring to the abstract.

  - Note the validation message, informing you that the abstract is required.

- Click **Drawings** on the left to attach the drawings separately; see PDF attachments (p. 320).

Figure 399: "Abstract is not included" option triggers a corresponding validation message
10.8.4 XML attachments

If you produce the specification document as XML files, e.g. with PatXML, you can insert graphics into the text. All graphic files must be prepared in WIPO Annex F compliant format. The graphics are stored as separate image files and referenced in the XML file.

A full version of Annex F can be found on the WIPO website at IP Services > PCT > Legal Texts (http://www.wipo.int/pct/en/texts/).

- In the Contents tab, select the option XML attachments.
- Double-click Application body.

![Figure 400: Attaching specification document as XML file](image)

The Content Details window opens.

- Click the Open button.

- Navigate to the XML specification file.
  Only PatXML files can be selected.
- Select the PatXML file and click Open.
The file is renamed application-body.xml.

If the language attribute in the XML file does not match the language indicated in the Request tab, a warning message to this effect will be displayed.

- Please make sure that you entered the correct language in both the PatXML file and the Request tab.

Enter the figure of the drawings which should accompany the abstract, if applicable. The number of pages is calculated automatically from the PatXML file.

- Click the Preview icon to check whether the specification document is displayed correctly, including the images.

- Click OK when ready.
The green traffic lights in the **Contents** tab indicate that all the required documents have been properly attached. The **Pre-conversion archive** option is now available.

![Figure 404: Green traffic light for the Contents tab](image)

**10.8.5 Accompanying Items**

In the **Accompanying Items** sub-tab you attach all the other attachments which do not relate to the main application body. These include documents such as statements, translations and powers of attorney.

The available document types for attachment are:

- original separate power of attorney
- original general power of attorney
- copy of general power of attorney
- translation of international application into ...
- separate indications concerning deposited microorganisms or other biological material
- sequence listing submitted for international search only
- statement confirming that "the information in Annex C/ST.25 text format submitted under Rule 13ter is identical to the sequence listing as contained in the international application"
- applicant letter to ISA concerning earlier search ('PCT Direct')
- OTHER

System files, such as the fee calculation sheet and the original separate power of attorney document, are generated automatically as XML files by the software and do not require extra input from your side.

**Attaching predefined document types**

1. Go to the **Accompanying Items** sub-tab.
2. Select the appropriate document type from the drop-down list, e.g. **original general power of attorney**.
Then click **Add**.

A new item is created in the document check list.

Double-click this document to open the **Content Details** window.

Click the **Open** button, navigate to the corresponding file and attach it.

**Attaching other user-defined document types**

Select **OTHER** from the drop-down list.

The text becomes editable and reads `<specify>`.

**Figure 405: Selecting document type for attachment in the Accompanying items sub-tab**

**Figure 406: Adding selected document type to the application**

**Figure 407: Opening the document for attachment**

**Figure 408: Original general power of attorney attached**

**Figure 409: Other document to be specified**
→ Enter a document description.
→ Click Add.

![Figure 410: Description for other document entered](image)

The new item is created in the document check list.

![Figure 411: Other document added to the application; can be opened for attachment](image)

→ Attach the file in the Content Details window as described above.

**Statement for restoration of the right of priority**

If you have requested the restoration of the right of priority for one of the priority claims, you are required to attach a separate statement. This item is also automatically created in the check list in the Accompanying items tab. The numbering refers to the numbering sequence of the priorities in the Priority tab.

→ Double-click the statement for restoration of the right of priority to attach the corresponding file.

The Accompanying Items tab is ready when all the traffic lights are green.

![Figure 412: All documents are appropriately attached](image)

### 10.8.6 Sequence listing

Sequence listings should always be submitted in computer readable format, i.e. as Annex C/ST.25 files (*.app) file. Other possible file types are TXT, PDF and TIFF. However, when attaching one of these file types a corresponding validation message will inform you that the ISA may require a sequence listing compliant with WIPO Annex C/ST.25. If filed as PDF file, every page of the sequence listing will be counted in the total number of pages of the international application and for the calculation of the fees per page over 30.
Form PCT/RO/101 provides two different options for attaching sequences listings; see also PCT/RO/101 – Biology (p. 306).

(A) The description contains a sequence listing is selected in the Biology tab:

- Attaching a sequence listing in the International Application sub-tab is mandatory.
- If this sequence listing is not attached as an Annex C/ST.25 file, two more options become available in the Accompanying Items sub-tab:
  - The sequence listing submitted for international search only is required, but not mandatory for the initial submission.
  - The statement confirming that "the information in Annex C/ST.25 text format submitted under Rule 13ter is identical to the sequence listing as contained in the international application" is required, but not mandatory for the initial submission.

(B) The description contains a sequence listing is not selected in the Biology tab:

- Adding the document type sequence listing submitted for international search only in the Accompanying Items sub-tab is optional.

(A) Sequence listing as part of the description

- Go to the International Application tab.
- Double-click Sequence listing.
  - Scroll down the list if you cannot see the item.

![Figure 413: Selecting sequence listing for attachment](image)

The Contents Details window opens.

- Select the check box submitted as part of description under Electronic file.
  This unlocks the other fields for editing.
- Click the Open button and attach the file.
If you attached an APP or TXT file, the text at the bottom of the window is activated, i.e. it is true for this application.

Figure 414: The sequence listing submitted as part of the description is attached as an APP or TXT file and will also be used for the purposes of the international search.

Otherwise, i.e. if you attached a PDF or TIFF file, this text remains greyed out. In this case you are required to submit the two additional documents relating to the sequence listing:

- sequence listing submitted for international search only
- statement confirming that "the information in Annex C/ST.25 text format submitted under Rule 13ter is identical to the sequence listing as contained in the international application"

Figure 415: Sequence listing attached as a PDF file, additional documents for international search required.

(B) Sequence listing for international search only

- Go to the Accompanying Items sub-tab.
- Select sequence listing submitted for international search only from the drop-down list.
- Click Add.
Figure 416: Adding sequence listing for international search only to the documents

The item is added to the check list.

- Double-click *sequence listing* ... to open the *Content Details* window.

Figure 417: Opening sequence listing for international search to attach electronic file

- Attach the file.
  - You may select any of the available file types: TXT, PDF, APP or TIFF.
  - Click OK when ready.

### 10.8.7 Pre-conversion archive

Once you have attached a document in the *Contents* tab, the *Pre-conversion archive* appears as an item in the check list.

The *pre-conversion archive* option allows you to add your original documents, before converting them into PDF or XML files, as a compressed ZIP archive file. This may be helpful if you wish to provide the EPO with your original documents in colour. The documents contained in the ZIP file will not be publicly available nor will they be an integral part of the visible internal procedural file, but they can be accessed for reference, e.g. in the event of quality issues.

- The EPO does not recognise documents as legally binding if they are exclusively filed as part of a ZIP archive. To be accepted as legally binding filings, the official patent documents must always be attached as PDF or ST.25 files under the correct document type.

- Double-click *Pre-conversion archive* in the *International Application* sub-tab.
In the **Content Details** window, click the **Open** button and attach the ZIP file.

Click the **Preview** icon to check the contents of the pre-conversion archive.

The attached ZIP archive is opened as a temporary folder in Windows Explorer.
10.9 PCT/RO/101 – Fees

The Fees tab of PCT/RO/101 displays the fees and amounts due. These are calculated automatically from the data in other tabs.

Applying a fee schedule

As a default, the Fee Calculation table does not contain any fee amounts or totals and the fee schedule is set to None.

The default currency when filing with the EPO is EUR.

To define fee amounts, select a valid fee schedule from the drop-down list.

![Figure 421: Selecting a fee schedule](image)

The fee amount fields are populated and the Total Fees Payable is calculated. Reductions are displayed as negative amounts in red.

![Figure 422: Fee calculation table filled in and total fees payable calculated](image)

Editing fees

If required, individual fee amounts can be edited.

- Click the fee amount to be edited until the background of the table cell changes from blue to white.
- Edit the value.
Click away from the edited field to save the new amount. The **Total** for the modified fee and the **Total Fees Payable** value are recalculated automatically.

The **Update fee schedule** button is activated after a fee has been edited.

If you click **Update fee schedule**, the new fee amount will be copied to the fee management table in the Online Filing database. As a result, all PCT/RO/101 applications created subsequently will use this new fee amount instead of the original fee amount issued by the EPO. If you wish to restore the original fee from the EPO’s official fee schedule at a later stage, you will need to edit the fee amount manually again and save it by clicking **Update fee schedule**.

**Previewing the fee calculation sheet**

- Go to the **Contents** tab and click the **Accompanying Items** sub-tab.
- Double-click **fee calculation sheet**.
- In the **Content Details** window, click the **Preview** icon.

The fee calculation sheet is displayed in the PDF Viewer.
10.10 PCT/RO/101 – Payment

The Payment tab of PCT/RO/101 is where you specify the mode of payment and provide details of the EPO deposit account to be debited. The EPO as receiving office offers the following payment options:

- **No payment for the time being** – if you intend to pay at a later time.
- **Authorisation to charge current account** – the relevant fees will be debited from your EPO deposit account.
- **Automatic debit** – the EPO will calculate the fees payable using the information provided in your application and will debit this amount direct from your EPO deposit account.
- **Bank transfer** – you have to transfer the relevant amount to the EPO’s bank account with Commerzbank AG in Munich, Germany.
- **Other**
  - Select the applicable **Mode of payment**.
  - Depending on your selection, the dialog window will display further fields and options.

**Authorisation to charge current account**

- Clear any account authorisations which are not applicable.
  - By default, all account authorisations are selected.
- Enter your EPO deposit account number in the **Current account number** field.
  - EPO deposit account numbers are made up of eight digits, starting with 28.
- Provide the authorised user name and signature; see Signing the deposit account authorisation (p. 338).

![Figure 425: Details for payment by authorisation to charge deposit account](image)
**Automatic debit**
- Enter the EPO deposit account number in the *Current account number* field. EPO deposit account numbers are made up of eight digits, starting with 28.
- Provide the authorised user name and signature; see Signing the deposit account authorisation (p. 338).

![Payment by automatic debit](image)

*Figure 426: Payment by automatic debit*

**Bank transfer**
- If applicable, select the check box *In addition, indicate current account authorisation*.
  - Select the relevant authorisations for subsequent payments from your deposit account.
  - Enter the EPO deposit account number in the *Current account number* field.
  - Provide the authorised user name and signature; see Signing the deposit account authorisation (p. 338).

**Other**
- Enter information about your other payment method in the *Specify* field.
- If applicable, select the check box *In addition, indicate current account authorisation*.
  - Select the relevant authorisations for subsequent payments from your deposit account.
  - Enter the EPO deposit account number in the *Current account number* field.
  - Provide the authorised user name and signature; see Signing the deposit account authorisation (p. 338).
No payment for the time being
There are no further options.

10.1.0 Signing the deposit account authorisation

The signature of a person who is authorised to manage the deposit account is always required if you select one of the payment options using a specific EPO deposit account.

→ In the Payment tab, enter the Authorized User Name.
→ Click Sign.

Figure 427: Signing as the user authorised for the EPO deposit account

The Signature window opens; see Power of attorney document (p. 297).

→ Enter an alphanumeric signature or attach a file for a facsimile signature and click Apply Signature.

After the signature has been applied, the traffic lights for the Payment tab change to green.

10.11 PCT/RO/101 – Annotate

The Annotate tab is where you can see all the notes and comments that have been made for this application.

▪ A remark is a comment intended for the EPO and is part of the data submitted.
▪ A private remark is for internal use only and is not transmitted to the EPO.
The **Annotate** tab also contains the **Validation Log** with all the validation messages for the application. The **Entity** column indicates the tab relating to each item, i.e. in which tab the annotation was created.

![Figure 428: Remarks, private remarks, validation log and other annotations in the Annotate tab](image)

**Adding annotations referring to the application in general**

- To create a new annotation, select the appropriate category from the drop-down list.
- Click **Add**.

![Figure 429: Adding a new remark](image)

The **Annotation edit dialog** window opens.

- Enter your text.
- To view the other annotations, click the corresponding item on the left or browse through the list by clicking the up and down arrows.
- Click **OK** to save the entry.
Figure 430: Creating a new remark

The remarks intended for the receiving office can be found in section 13 at the end of the PCT form.

Figure 431: Applicant remarks in the form preview

Adding annotations referring to specific tabs
Remarks and private remarks can be created not only in the Annotate tab, but also in most of the other tabs of Form PCT/RO/101. Wherever this function is enabled, it is accessible from the shortcut menu.

- For example, to add a private remark right-click the Add Priority Claim item in the Priority tab and select Private Remark from the shortcut menu.
Viewing the Validation Log

- In the **Annotate** tab, double-click **Validation Log**. The **Annotation edit dialog** window opens. The validation messages are grouped and ordered by the form sections.
- Scroll through the list to read the messages.

If you cannot read the full text of the validation messages, click the **Preview** icon.

The Validation Log opens in the PDF Viewer.
10.11.1 Designating inventor for certain states only

As with the applicant, you can edit the list of designated states for the inventor, although this is quite unusual and seldom used.

- In the Annotate tab, select Inventor(s) for certain designated States only from the drop-down list.
- Click Add.
  The Annotation edit dialog window lists the names of the existing inventors and the designated states concerned.
- To edit the states for an inventor, double-click the inventor's name.

The View/Change States window opens.
- Select the countries as appropriate; see the instructions under Applicant (p. 288).
The selected states are displayed in the list of inventors.

Figure 436: Designated states selected for one of the inventors

10.12 Processing the PCT/RO/101 application

Once all required data has been entered and the appropriate documents attached, the application is ready for submission to the EPO.

In the toolbar, the Sign icon and the Save as Ready for Signing icon are now activated, and all the traffic lights show green.

Applications can also be filed if some of the traffic lights are yellow, provided that the user is satisfied that all the information required at the time of filing has been supplied and attached.

Figure 437: Application is ready for signing
10.12.1 Signing the form

Depending on the settings in the File Manager's User Preferences (see Confirmations (p. 58)), you can launch the signing process immediately from the PCT/RO/101 form or by using the workflow buttons in File Manager.

The option **Start signing immediately when moving application forward from draft status** triggers the following behaviour:

- If that option **is not selected** (default), both the **Sign** button and the **Save as Ready for Signing** button will move the application to the **Ready to sign** status. You can then start the signing process from File Manager.
- If that option **is selected**, the **Sign** button prepares the application for signature and opens the signing dialog immediately.

**Preparing the form for signature (default setting)**

- Click the **Save as Ready for Signing** button in the form toolbar.

![Figure 438: Starting the signing process from the form](image)

Preparation for submission now starts.

- If required, you can modify the **User Reference** here.
- Select **online** (default option) as the **Method of Submission**.
- Click **Continue**.

![Figure 439: Preparing the application for submission](image)

The data is saved, the form is rendered and the files are compressed and stored in the database.

- Click **Continue**.

  The form closes and you are returned to File Manager.
Figure 440: The application data has been prepared for submission

Start signing from File Manager

The form is now in **Ready to sign** status.

- Select the application and click the **Next** button (the tool-tip says "Sign").

Figure 441: Launching the signing process from File Manager

The **PDF Viewer** opens.

- Click **Sign Now** in the bottom right-hand corner.
- Proceed as described in **Signing applications** (p. 92) in the Online Filing user guide or in the File Manager online help.

The two fields **ePCT Customer ID** and **ePCT eOwnership code** are optional. These data are only relevant for EPO Online Filing users having registered an account for the ePCT private services run by WIPO. For more information, see the WIPO website at **IP Services > PCT > ePCT > FAQ** (http://www.wipo.int/pct/en/epct/pdf/pct_wipo_accounts_faq.pdf).
10.12.2 Sending the form

In File Manager, the application is in **Ready to send** status.

→ Select the application and click the **Next** workflow button (the tool-tip says "Send").
→ Proceed as described in Sending applications (p. 106) in the Online Filing user guide or in the File Manager online help.
Viewing submission information and the receipt
After the application has been sent, you can view it from File Manager. Both the submission information and the acknowledgement of receipt can be opened from the Annotate tab.

![Image of Annotate tab showing submission information and receipt details]

Figure 444: Submission details and receipt information available in the Annotate tab

10.12.3 Exporting and importing a form
For full instructions on exporting and importing applications via File Manager and Server Manager, see Exporting data from Online Filing (p. 109) and Importing data into Online Filing (p. 115) in the Online Filing user guide or in the File Manager online help.

If you want to export a single application from the PCT/RO/101 form view, use one of the following export options available in the File menu:

![Image of File menu showing export options]

Figure 445: Export options in the File menu

Export unpacked WAD to ...
WAD stands for "wrapped application documents". Attachments and data are rendered to XML, PDF, JPG and TXT files and are exported into an existing folder on your computer. The Pct101.PDF file is the application form.
Export WAD to ...

The same data as above is packed into a ZIP archive file and stored in the selected location.

![Figure 446: PCT/RO/101 application exported to WAD](image)

Export file package ...

This option corresponds to the Export Forms option in File Manager. It creates a ZIP archive containing the application form, the attached files and the accompanying items as XML and PDF files.

The text you entered for the figure accompanying the abstract is saved in a separate draw.txt file.

![Figure 447: PCT/RO/101 application exported as file package](image)
11 PCT-SFD

You can use Form PCT-SFD to file documents submitted after the filing of an international application under the Patent Cooperation Treaty (PCT). You can also use it to select the fees for the subsequently filed documents and the way you want to pay them. For more information about the PCT, see the WIPO website at [IP Services > PCT System > Treaty](http://www.wipo.int/pct/en/treaty/about.html).

This document focuses on the EPO acting as Receiving Office (RO), International Searching Authority (ISA), International Preliminary Examining Authority (IPEA) or Supplementary International Searching Authority (SISA).

Minimum requirements for subsequent filing with Form PCT-SFD

When filing with Form PCT-SFD, at least one of the following actions must be performed:

- attach a document
- select a fee payment and a mode of payment
- write an annotation.

Completing Form PCT-SFD

Form PCT-SFD is organised into five tabs. The capacity in which the EPO is acting is selected in the **Application** tab and this governs the options in the **Documents** and **Fee Payment** tabs. This is why you must start with the **Application** tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>Select filing office and capacity in which it is acting, enter details of the PCT application to which the subsequently filed document(s) belong(s).</td>
</tr>
<tr>
<td>Names</td>
<td>Enter details on applicant and contact person. If the EPO is selected as the filing office in the <strong>Application</strong> tab, no data needs to be entered in the <strong>Names</strong> tab. The option for adding persons to the form will be disabled.</td>
</tr>
<tr>
<td>Documents</td>
<td>Attach the subsequently filed document(s).</td>
</tr>
<tr>
<td>Fee Payment</td>
<td>Select fees and enter the mode of payment.</td>
</tr>
<tr>
<td>Annotations</td>
<td>Supply additional information for the EPO.</td>
</tr>
</tbody>
</table>

Mandatory fields

A red triangle in the upper right-hand corner of a field indicates mandatory information. You must either manually fill out this field or select one of the options provided. If mandatory fields are not completed, the corresponding tab will show a red validation icon. Consult the validation messages for more information.

Figure 448: The "Filing Office" is a mandatory field in the "Application" tab and is marked with a red triangle
Elements in Form PCT-SFD

Figure 449: Form PCT-SFD - Overview

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>Provides all options needed to edit, save, import and export drafts, set</td>
</tr>
<tr>
<td></td>
<td>the display and change the status, as well as other tools.</td>
</tr>
<tr>
<td>Toolbar</td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td>Location Indicator Bar</td>
<td>Shows the selected procedure, the current status and the user reference for</td>
</tr>
<tr>
<td></td>
<td>the open draft.</td>
</tr>
<tr>
<td>Navigation Bar</td>
<td>Displays tabs corresponding to the sections of the form. These tabs can</td>
</tr>
<tr>
<td></td>
<td>contain sub-tabs, which are a sub-division of the main tab sections within</td>
</tr>
<tr>
<td></td>
<td>the form.</td>
</tr>
<tr>
<td>Details Area</td>
<td>Displays data entry fields appropriate to the selected tab.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Displays information about the current activity. Shows the total number of</td>
</tr>
<tr>
<td></td>
<td>validation messages for the open draft.</td>
</tr>
</tbody>
</table>
11.1 PCT-SFD – Application

The Application tab is where you select the filing office and enter basic information about the international application for which the subsequently filed documents (SFD) are being filed. The Application tab contains two sections:

- Filing office and capacity in which it is acting
- Past record

11.1.1 Filing office and capacity in which it is acting

This document outlines the use of Form PCT-SFD when the EPO is selected as the filing office. For information specific to one of the other filing offices, please refer to the national patent office concerned.

- Select the EPO as filing office, either by entering the two-letter code EP into the first field or by selecting European Patent Office from the drop-down list.
- Select the appropriate option from the Capacity drop-down list:
  - Receiving Office (RO)
  - International Searching Authority (ISA)
  - International Preliminary Examining Authority (IPEA)
  - Supplementary International Searching Authority (SISA)

![Figure 450: Selecting the EPO as filing office and selecting the capacity in which it is to act](image)

**Note:**

- The types of documents that can be attached depend on the capacity in which the filing office is acting.
- You cannot attach documents before you have selected the filing office and the capacity in which it is to act.
- If you change the capacity in which the filing office is to act after you have attached documents, these will be detached.
- If you wish to file SFD to the EPO acting in a different capacity, please submit them as a separate filing.
11.1.2 Past record

The Past Record section provides entry fields for details of the international PCT application to which the SFD relate(s).

→ Enter the international application number of the PCT application.
   This information is mandatory.

→ Enter the international filing date of the PCT application.
   This information is mandatory.
   – Clicking on the calendar icon on the right of the date boxes will open a calendar from which you can select the date.
   – If the year of filing is different from the year in the PCT application number, a yellow validation icon is displayed. You can file your application to the EPO nevertheless, but please ensure that the data you enter is correct.

→ If a priority has been claimed for the PCT application, enter the (earliest) priority date (optional).

→ Enter the title of the invention exactly as specified in the PCT application (usually in block capitals).
   This information is mandatory.

Once you have entered all the mandatory information, the red validation symbol will disappear from the Application tab in the navigation bar. However, a yellow validation icon is displayed if you do not supply the (earliest) priority date.

![Figure 451: Entering details on the PCT application to which the subsequently filed documents relate](image-url)
11.2 PCT-SFD – Names

If the EPO has been selected as the filing office in the **Application** tab, no data needs to be entered in the **Names** tab. The **Add** button is disabled and a grey validation icon draws your attention to the relevant validation message.

If you want to specify details of any additions, changes or replacements to the parties to the application, please draft a letter to the EPO, have it signed and convert it into PDF. Then go to the **Documents** tab and attach the file under the appropriate category.

11.3 PCT-SFD – Documents

The **Documents** tab of Form PCT-SFD is where you attach documents subsequent to your original filing. The attachment options are determined by the capacity in which the filing office is acting, as selected in the **Application** tab. As a result, specific document categories and document types become available in the **Documents** tab.

Signing a PCT-SFD application in Online Filing does not automatically apply a signature to the attached documents. Before attaching the PDF files, you should therefore make sure that each document has been duly signed by the relevant person.

The following sections provide an overview of the document categories and document types applicable when filing with the EPO as:

- Receiving Office (RO)
- International Searching Authority (ISA)
- International Preliminary Examining Authority (IPEA)
- Supplementary International Searching Authority (SISA)

Specific document types cannot be filed with the EPO although it is possible to attach them; see the sections below for details.

11.3.1 Documents filed with the Receiving Office (RO)

This list contains document types printed in italics and marked with the symbol [N]. Although these document types are options presented in Form PCT-SFD of the Online Filing software, they cannot be filed with the EPO. If you select one of these document types when attaching files to your application, a red validation icon will appear in the **Documents** tab. The related validation message informs you which of the attached documents should be removed.
Correction of defects (Article 11)
www.wipo.int/pct/en/texts/articles/a11.htm
- Letter accompanying the replacement sheet(s)
- Missing claims
- Missing description
- Missing drawings or part thereof
- Missing part of claims
- Missing part of description

Correction and missing parts (Article 14)
www.wipo.int/pct/en/texts/articles/a14.htm
- Later filed abstract
- Letter accompanying the replacement sheet(s)
- Missing signature (Letter)
- Missing title (Letter)

Rectification of obvious mistakes (Rule 91)
www.wipo.int/pct/en/texts/rules/r91.htm
- Letter accompanying the rectification of obvious mistakes
- Rectified request
- Undefined rectification

Translations
- Translation of priority document
- Translation of the abstract
- Translation of the international application
- Translation of the textual parts of the drawings

Changes to indications in the request (Rule 92bis)
www.wipo.int/pct/en/texts/rules/r92bis.htm
- Changes to person, name or address of the agent
- Changes to person, name or address of the common representative
- Changes to person, name or address of the inventor
- Changes to person, name, residence, nationality or address of the applicant

Expressions, etc., not to be used (Rule 9)
- Amended abstract removing matter disallowed
- Amended claims removing matter disallowed
- Amended description removing matter disallowed
- Amended drawings removing matter disallowed
- Letter accompanying the replacement sheet(s)
- Undefined correction
Priorities (Rules 17 and 26bis)

www.wipo.int/pct/en/texts/rules/r17.htm
www.wipo.int/pct/en/texts/rules/r26bis.htm
- Correction or addition of a priority claim
- Request for restoration of priority rights (including evidence and witness statement)
- [N] Request to make the priority document available in WIPO Digital Access Service (DAS)

Later filed documents

Later filed sequence listings can only be filed with the EPO in computer-readable format. Please select either **ST25** or **ASCII Text** as the file type when attaching the file to the application.

- Agent's letter
- Declarations
- Microorganisms form BP/4: acknowledgement of receipt by the IDA
- Microorganisms form BP/9: viability statement
- Microorganisms form RO/134
- [N] Request for certification of international application registration data
- Request for certified copies of the international application
- Sequence listings

Earlier search (Rule 12bis)

www.wipo.int/pct/en/texts/rules/r12bis.htm
- Application for which earlier search was performed
- Cited documents in earlier search
- Results of earlier search
- Translation of application for which earlier search was performed
- Translation of result of earlier search

Regarding payment of fees

- [N] Fee payment receipt (RO/ES only)
- Letter regarding automatic debiting of fees (RO/EP only)
- [N] Letter regarding payment of fees
- Request for refund of undue fees

Assignment

- Assignment
Power of attorney
  – Power of attorney

Request for extension of time limit
  – Request for extension of time limit

Incorporation by reference
  – Copy of earlier application/priority document (for incorporation by reference)
  – Copy of translation of earlier application/priority document (for incorporation by reference)
  – New claims for incorporation by reference (Rule 20.6)
  – New description for incorporation by reference (Rule 20.6)
  – New drawings for incorporation by reference (Rule 20.6)
  – New sequence listings for incorporation by reference (Rule 20.6)
  – Notice confirming incorporation by reference of missing elements and parts

Substitute sheets (Rule 26)
  – Letter accompanying the replacement sheet(s)
  – Substitute sheet(s) abstract (Rule 26)
  – Substitute sheet(s) claims (Rule 26)
  – Substitute sheet(s) description (Rule 26)
  – Substitute sheet(s) drawings (Rule 26)
  – Substitute sheet(s) request (Rule 26)

Withdrawals (Rule 90bis)
  www.wipo.int/pct/en/texts/rules/r90bis.htm
  – Withdrawal of application
  – Withdrawal of designation
  – Withdrawal of priority claim

Other document
  Communication in cases for which no other form is applicable
  – Reply to any other invitation or notification (Form PCT/RO/132)
11.3.2 Documents filed with the International Searching Authority (ISA)

This list contains document types printed in italics and marked with the symbol [N]. Although these document types are options presented in Form PCT-SFD of the Online Filing software, they cannot be filed with the EPO. If you select one of these document types when attaching files to your application, a red validation icon will appear in the Documents tab. The related validation message informs you which of the attached documents should be removed.

Rectification of obvious mistakes (Rule 91)

www.wipo.int/pct/en/texts/rules/r91.htm
- Letter accompanying the replacement sheet(s)
- [N] Rectification to amended claims
- [N] Rectification to amended description
- [N] Rectification to amended drawings
- [N] Rectification to amended sequence listing part of the description
- Rectified claims
- Rectified description
- Rectified drawings
- Rectified sequence listing part of the description
- [N] Undefined rectification

Earlier search (Rule 12bis)

www.wipo.int/pct/en/texts/rules/r12bis.htm
- Application for which earlier search was performed
- Cited documents in earlier search
- Results of earlier search
- Translation of application for which earlier search was performed
- Translation of result of earlier search

Later furnished sequence listing (Rule 13ter)


Later filed sequence listings can only be filed with the EPO in computer-readable format. Please select either ST25 or ASCII Text as the file type when attaching the file to the application.

- Late furnished nucleotide and/or amino acid sequence
- Letter regarding the sequence listing
- Statement concerning the sequence listing

Lack of unity of invention (Rule 40)

www.wipo.int/pct/en/texts/rules/r40.htm
– Reply to invitation to pay additional fees due to lack of unity of invention
– Request to review the opinion regarding the lack of unity of the invention

Regarding payment of fees
  – [N] Fee payment receipt (ISA/ES only)
  – Letter regarding automatic debiting of fees (ISA/EP only)
  – [N] Letter regarding payment of fees
  – [N] Request for refund of undue fees

Power of attorney
  – Power of attorney

Assignment
  – [N] Assignment

Request for extension of time limit
  – Request for extension of time limit

Comments regarding abstract
  – Comments regarding the abstract

Sequence listing free text (Rule 5.2b)
  www.wipo.int/pct/en/texts/rules/r5.htm#_5_2_b
  – Amended description with sequence listing free text added
  – Letter accompanying the replacement sheet(s)

Other document
  Communication in cases for which no other form is applicable
  – Reply to any other invitation or notification (Form PCT/ISA/224)
11.3.3 Documents filed with the International Preliminary Examining Authority (IPEA)

This list contains document types printed in italics and marked with the symbol \[N\]. Although these document types are options presented in Form PCT-SFD of the Online Filing software, they cannot be filed with the EPO. If you select one of these document types when attaching files to your application, a red validation icon will appear in the Documents tab. The related validation message informs you which of the attached documents should be removed.

Rectification of obvious mistakes (Rule 91)
www.wipo.int/pct/en/texts/rules/r91.htm
- Letter accompanying the rectification of obvious mistakes
- Rectification of indeterminate type
- Rectification to amended claims
- Rectification to amended description
- Rectification to amended drawings
- Rectification to amended sequence listing
- Rectified claims
- Rectified description
- Rectified drawings
- Rectified sequence listing

Amendments (Article 34 and Rule 60.1(g))
www.wipo.int/pct/en/texts/articles/a34.htm
www.wipo.int/pct/en/texts/rules/r60.htm#_60_1_g
- Amended claims
- Amended description
- Amended drawings
- Amended sequence listing
- Letter accompanying the replacement sheet(s)
- Statement concerning the sequence listing

Translations
- Translation of amendments
- Translation of priority document
- Translation of the application and/or corrections

Earlier search
- Application for which earlier search was performed
- Cited documents in earlier search
- Results of earlier search
Translation of application for which earlier search was performed
Translation of result of earlier search

Later furnished sequence listing (Rule 13ter)
www.wipo.int/pct/en/texts/rules/r13ter.htm

Later filed sequence listings can only be filed with the EPO in computer-readable format. Please select either ST25 or ASCII Text as the file type when attaching the file to the application.

Late furnished nucleotide and/or amino acid sequence
Letter regarding the sequence listing
Statement concerning the sequence listing

Lack of unity of invention (Rule 68)
www.wipo.int/pct/en/texts/rules/r68.htm
Reply to invitation to pay additional fees due to lack of unity of invention
Request to review the opinion regarding the lack of unity of the invention

Regarding payment of fees
[N] Fee payment receipt (IPEA/ES only)
Letter regarding automatic debiting of fees (IPEA/EP only)
[N] Letter regarding payment of fees
Request for refund of undue fees

Withdrawals (Rule 90bis)
www.wipo.int/pct/en/texts/rules/r90bis.htm
Withdrawal of application
Withdrawal of Demand
Withdrawal of designation
Withdrawal of election
Withdrawal of priority claim

Assignment
Assignment

Power of attorney
Power of attorney

Request for extension of time limit
Request for extension of time limit
Corrected Demand (Form PCT/IPEA/401) – Rules 60.1 a) - f)
www.wipo.int/pct/en/texts/rules/r60.htm#_60_1
- Corrected demand (Form PCT/IPEA/401)
- Letter accompanying the replacement sheet(s)

Comments and observations
- Reply to written opinion of the IPEA (Form PCT/IPEA/408)
- Other comments and observations

Sequence listing free text (Rule 5.2b)
www.wipo.int/pct/en/texts/rules/r5.htm#_5_2_b
- Amended description with sequence listing free text added
- Letter accompanying the replacement sheet(s)

Other document
Communication in cases for which no other form is applicable
- Reply to any other invitation or notification (Form PCT/IPEA/424)
- [N] Reply to request to indicate the competent IPEA (Form PCT/IPEA/442)
11.3.4 Documents filed with the Supplementary International Searching Authority (SISA)

This list contains document types printed in italics and marked with the symbol [\textit{N}]. Although these document types are options presented in Form PCT-SFD of the Online Filing software, they cannot be filed with the EPO. If you select one of these document types when attaching files to your application, a red validation icon will appear in the \textit{Documents} tab. The related validation message informs you which of the attached documents should be removed.

\textbf{Assignment}

- Assignment

\textbf{Earlier search}

- Application for which earlier search was performed
- Cited documents in earlier search
- Results of earlier search
- Translation of application for which earlier search was performed
- Translation of result of earlier search

\textbf{Regarding payment of fees}

- [\textit{N}] Letter regarding payment of fees

\textbf{Power of attorney}

- Power of attorney

\textbf{Request for extension of time limit}

- Request for extension of time limit

\textbf{Late furnished sequence listing}

  \begin{itemize}
  \item Later filed sequence listings can only be filed with the EPO in computer-readable format. Please select either \textit{ST25} or \textit{ASCII Text} as the file type when attaching the file to the application.
  \item Late furnished nucleotide and/or amino acid sequence
  \end{itemize}

\textbf{Lack of unity of invention (Rule 13)}

- Reply to invitation to pay additional fees for lack of unity of invention
– Request to review the opinion regarding the lack of unity of the invention

Withdrawals (Rule 90bis)
www.wipo.int/pct/en/texts/rules/r90.htm
– Withdrawal of request for supplementary search

11.3.5 Attaching PDF documents

To attach a document, you need to select a category in the first step. After selecting the required file from your computer, you can select the document type.

If you are not sure which the correct category for your document is, please refer to the relevant section above (RO, ISA, IPEA or SISA).

This example demonstrates how to attach the missing claims for filing with the EPO as receiving Office.

➔ In the Documents tab of PCT-SFD, click the Add button.
➔ Select the appropriate category, e.g. Correction of defects (Article 11).

![Figure 452: Selecting a document category](image)

➔ In the Open window, navigate to the storage location of your file.
➔ Select the required file and click Open.
The file is attached to the application under its original file name. The explanatory text on the lower right displays information on the PCT regulations relevant for the selected document category.

- Select the appropriate document from the **Document type** drop-down list, e.g. **Missing claims**.
  - Note that most document types can only be attached once.

The file is renamed to the Online Filing default file name, e.g. **MISSCLMS.pdf**. The original file name is also displayed at the top of the screen, along with the number of pages.

- Select the **language of the document** (mandatory).
  
  You can either type the two-letter language code (**EN, DE or FR**) into the field to the left or select the language from the drop-down list to the right.
Document types blocked by the EPO

If you attach a document type which is not accepted by the EPO acting as the selected capacity, a red validation icon appears in the Documents tab.

- Open the validation messages to see which of the documents should be removed.

11.3.6 Attaching sequence listings

Sequence listings must always be submitted in computer-readable format in accordance with WIPO Standard ST.25. If you attach a sequence listing in PDF when filing with the EPO as ISA, IPEA or SISA, a red validation icon is displayed in the Documents tab.

- In the Documents tab of PCT-SFD, click the Add button.
- Select the appropriate category:
  - Later filed documents if the EPO is acting as RO
  - Later furnished sequence listing (Rule 13ter) if the EPO is acting as ISA, IPEA or SISA
- In the Open window, navigate to the storage location of your file.
- Change the option in the Files of type drop-down list from Portable Document Format (default) to ST25 (file type .app or .seq) or ASCII Text (file type .txt).
Select the required file and click **Open**.

The file is attached to the application under its original file name.

Select the appropriate document from the **Document Type** drop-down list:

- **Sequence Listings** if the EPO is acting as RO
- **Late furnished nucleotide and/or amino acid sequence** if the EPO is acting as ISA, IPEA or SISA
11.3.7 Viewing attached documents

You can check your application and the attached documents in the print preview.

➔ Click the Preview button in the toolbar.

The application (pct-sfd.pdf) is displayed in the PDF Viewer. Section 3 of the form contains the attached documents with their original file names. The list is grouped by category. The left pane in the PDF Viewer lists all the files with their system names.

➔ Click a file name to the left to display the corresponding document in the PDF Viewer.
11.4 PCT-SFD – Fee Payment

In the Fee Payment tab you can select the fees associated with your application and indicate how you wish to pay them. All fees must be paid in euros.

The fees displayed in the Fee Payment tab reflect the fee schedules located in File Manager > Tools > Fee Management.

Make use of the Live Update function in Online Filing to ensure that your fee schedule is always up to date. You will find the most recent fee schedule on the EPO website at Applying for a patent > Online services, following the link Interactive schedule of fees (http://www.epoline.org/portal/portal/default/epoline.Scheduleoffees).

11.4.1 Payment details

In the Payment details sub-tab you can specify the mode of payment and provide further details required by the EPO.

Mode of payment

Select the appropriate option from the Mode of payment list.
• **Automatic debit**
  If you select this option the check boxes in the **Fee selection** sub-tab are automatically deactivated and the total amount of the fees is shown as EUR 0.00. The EPO will calculate the amount of the fees payable using the information you provided in your application and will debit this amount direct from your account. With this option you cannot select the fees yourself in the form.

• **Bank transfer**
  The EPO accepts EUR payments to its account with the Commerzbank AG in Munich, Germany. The IBAN and BIC codes of the EPO's bank account are supplied automatically when you select **DE, Commerzbank AG, München** from the drop-down list.

• **Debit from deposit account**
  If you choose this mode of payment, the relevant fees will be debited directly from your EPO deposit account. If you issue a debit order during normal working hours (08.00-18.00 hrs), you can usually view it under **Pending orders** within about 30 minutes. The actual deduction from your account will appear 5 to 6 days later.

• **Not specified**
  If you do not intend to pay fees with this submission, you can indicate **Not specified**.

For more information on EPO deposit accounts and the automatic debiting procedure, please refer to the Official Journal:

• Arrangements for deposit accounts (ADA)
  Supplementary publication 3/2015, p. 8-16

• Notice from the European Patent Office dated 12 February 2015 concerning revision of the Arrangements for deposit accounts (ADA) and their annexes
  Supplementary publication 3/2015, p. 2-7

• Decision of the President of the European Patent Office dated 29 September 2016 revising points 5.3 and 7 of the Arrangements for deposit accounts (ADA)

**Automatic debit**
If you are filing with the EPO acting as RO, ISA or IPEA, you can use the **automatic debit** procedure. Automatic debiting is not allowed if you are filing with the EPO acting as SISA.

→ Enter the number of your deposit account and the name of the account holder.
EPO deposit account numbers are made up of eight digits, starting with **28**.

**Debit from deposit account**
An EPO deposit account is required to use the option **Debit from deposit account**.

→ Enter the number of your deposit account and the name of the account holder.
EPO deposit account numbers are made up of eight digits, starting with **28**.

→ If applicable, select the check box **Authorisation to charge any deficiency or credit any overpayment in the total fees**.
11.4.2 Fee selection

The fees payable are determined by the capacity in which the EPO is acting, as selected in the Application tab.

In the Fee selection sub-tab, you can select all fees individually, including late payment fees, and apply the reduction for low-income countries for eligible applicants. For more information, see the following chapters.

Fees payable when submitting specific documents
There is no automatic fee selection when you attach a specific document in the Documents tab. The validation messages inform you which fee should be paid in relation to the attached document.

For example, if you attach a request for restoration of priority rights (RESTPRIOR.pdf), fee 013EP is due when filing with the EPO acting as Receiving Office.
Figure 463: Fee 013EP is due when filing a request for restoration of priority rights

To select the corresponding fee, go to the Fee selection sub-tab. The total of fees is automatically calculated.

Figure 464: Selecting fees payable to the EPO acting as RO
11.4.3 Fees payable to the Receiving Office (RO)

In the Fee selection sub-tab, select the fees you wish to pay. The quantity of each selected fee is set to 1 and the total amount payable is automatically calculated.

If you select the fee 029EP – Certified copy of application, priority document, the check box for No. of certified copies at the bottom right is automatically selected (and vice versa) and the corresponding entry field is activated.

Enter the number of certified copies you wish to pay for (mandatory). The total amount payable is automatically calculated.

Applying reductions

A 90% reduction for applicants from low-income countries can be applied to fees 222EP, 225EP, 316EP, 318EP and 319EP. Furthermore, the EPO offers a fee reduction for filing an application online, depending on the method of submission.

If appropriate, select the check box Reduction low income countries 90%. The reduction is applied to the fees you selected.

If you wish to get the reduction for online filing, select one of these fees:
- 316EP – PCT - Web form filing reduction
- 318EP – PCT- PDF reduction
- 319EP – PCT- XML reduction

You can only select one of the fees. The quantity of the selected fee is set to -1, i.e. the amount becomes negative and is subtracted from the total amount payable. If you only select one of the fees 316EP, 318EP or 319EP, the total amount will be negative, which is correct.
11.4.4 Fees payable to the International Searching Authority (ISA)

- In the **Fee selection** tab, select the fees you wish to pay.
  
  The quantity of each selected fee is set to 1 and the total amount payable is automatically calculated.

  If you select the fee **003EP – Fee for an international search**, the check box for **Tick here if you wish to pay fees for lack of unity of invention** at the bottom left is automatically selected (and vice versa) and the field **No. of independent inventions** below is activated.

- Enter the number of independent inventions (mandatory).
  The total amount payable is automatically calculated.
Applying reductions
A 75% reduction for applicants from low income countries can be applied to fee 003EP.

⇒ If appropriate, select the check box **Reduction low income countries 75%**.

The reduction is applied to the fee and the total amount payable is automatically calculated.

![Image of fee schedule]

Figure 468: Applying the reduction for low-income countries when filing with the EPO acting as ISA

11.4.5 Fees payable to the International Preliminary Examining Authority (IPEA)

⇒ In the **Fee selection** tab, select the fees you wish to pay.

The quantity of each selected fee is set to 1 and the total amount payable is automatically calculated.

The quantity for fee 021EP – Fee for preliminary examination of int. application cannot be edited.

⇒ If you need to pay additional preliminary examination fees, select the check box for **Tick here if you wish to pay fees for lack of unity of invention** at the bottom left.

The fee 021eEP – Additional preliminary examination fee is automatically selected and the field **No. of independent inventions** is activated.

1. Fee 021eEP cannot be selected manually.

⇒ Enter the number of independent inventions (mandatory).

The total amount payable is automatically calculated.
Applying reductions

The reduction for applicants from low-income countries can be applied to fee 021EP (75% reduction) and fee 224EP (90% reduction).

→ Select the check boxes as appropriate:
  - **Reduction low income countries 75%**
  - **Reduction low income countries 90%**

The reduction is applied to the selected fee(s) and the total amount payable is automatically calculated.
11.4.6 Fees payable to the Supplementary International Searching Authority (SISA)

If the EPO is acting as SISA, the only fee applicable is 069EP – Review fee for a supplementary international search.

- In the Fee selection tab, select fee 069EP if appropriate.
  The quantity of the fee is set to 1 and the total amount payable is automatically calculated.
  There is no reduction for fees.

![Figure 471: Fees applicable when filing with the EPO acting as SISA](image)

11.5 PCT-SFD – Annotations

In the Annotations tab you can enter notes to be transmitted to the EPO.

Creating notes for the EPO

- Click the Add button and select New Note.

  ![New Note button](image)

- Enter the relevant information in the Note field.
To add notes that are not intended for the EPO, use the *Internal notes* (p. 43) function on the form's toolbar.

11.6 Signing an application with Form PCT-SFD

Once you have entered all the mandatory information, you can prepare your applications for signature and proceed to sign it and send it to the EPO. For more information, see sections Signing applications (p. 92) and Sending applications (p. 106).

Entering signatories

When signing a PCT-SFD application, you are required to provide the names of the signatories manually. Unlike in other EP forms, this information is not automatically copied from the *Names* tab because no data is entered in the PCT-SFD form when filing with the EPO.

The *Sign Application* window allows you to add all the required signatories.

- To sign as or for the applicant, click `<other>` under the heading *Sender* to the left.
  - Enter the *applicant name*.
  - If you are signing as an employee, also enter your name into the *Employee name* field.
- To sign as or for the representative, click `<other>` under the heading *Representatives* to the left.
- If applicable, enter the **Association**.
- Enter the representative's name.
- Select the type of signature.
- Complete the data as required.
- To apply the signature, click **Sign**.
- Add more signatories if necessary and finalise the signing process by applying an enhanced electronic signature with a smart card and PIN.

![Sign Application](image)

*Figure 473: Adding signatories and signing the form*
12 PCT-DEMAND (PCT/IPEA/401)

Form PCT/IPEA/401 is used for filing demands for international preliminary examination according to Chapter II of the Patent Cooperation Treaty (PCT). For more information, see the WIPO website at [IP Services > PCT System > Legal Texts > Treaty > Article 31](http://www.wipo.int/pct/en/texts/articles/a31.htm).

This document focuses on the EPO acting as the International Preliminary Examining Authority (IPEA).

**Data input in Form PCT-DEMAND**

Form PCT-DEMAND is organised into six tabs. It is recommended that you enter the data in the tab sequence given, i.e. you should start with the **Demand** tab. Certain options and conditions in the **Documents** tab, for instance, are determined by the selections you make in the **Examination Basis** tab.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Demand</td>
<td>Select the IPEA, enter details of the PCT application to which this demand for international preliminary examination belongs.</td>
</tr>
<tr>
<td>Names</td>
<td>Enter details on applicant(s), enter details on agent(s) or supply an address for correspondence.</td>
</tr>
<tr>
<td>Examination Basis</td>
<td>Specify the basis for the international preliminary examination and select the language for the purposes of the examination.</td>
</tr>
<tr>
<td>Documents</td>
<td>Attach examination documents or other documents.</td>
</tr>
<tr>
<td>Fee Payment</td>
<td>Review fees and enter the mode of payment.</td>
</tr>
<tr>
<td>Annotations</td>
<td>Supply additional information for the EPO.</td>
</tr>
</tbody>
</table>

**Mandatory fields**

A red triangle in the upper right-hand corner of a field indicates mandatory information. You must either manually fill out this field or select one of the options provided. If mandatory fields are not completed, the corresponding tab will show a red validation icon. Consult the validation messages for more information.

*Figure 474: "Filing Office/IPEA" is a mandatory field in the "Demand" tab and is marked with a red triangle
Elements in Form PCT-DEMAND

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Menu Bar</strong></td>
<td>Provides all options needed to edit, save, import and export drafts, set</td>
</tr>
<tr>
<td></td>
<td>the display and change the status, as well as other tools.</td>
</tr>
<tr>
<td><strong>Toolbar</strong></td>
<td>Provides shortcuts to the most frequently used tasks and tools.</td>
</tr>
<tr>
<td><strong>Location Indicator Bar</strong></td>
<td>Shows the selected procedure, the current status and the user</td>
</tr>
<tr>
<td></td>
<td>reference for the open draft.</td>
</tr>
<tr>
<td><strong>Navigation Bar</strong></td>
<td>Displays tabs corresponding to the sections of the form. These tabs</td>
</tr>
<tr>
<td></td>
<td>can contain sub-tabs, which are a sub-division of the main tab sections</td>
</tr>
<tr>
<td></td>
<td>within the form.</td>
</tr>
<tr>
<td><strong>Details Area</strong></td>
<td>Displays data entry fields appropriate to the selected tab.</td>
</tr>
<tr>
<td><strong>Status Bar</strong></td>
<td>Displays information about the current activity. Shows the total number of</td>
</tr>
<tr>
<td></td>
<td>validation messages for the open draft.</td>
</tr>
</tbody>
</table>

**Figure 475: Form PCT-DEMAND – Overview**

12.1  PCT-DEMAND – Demand

The **Demand** tab is where you select the filing office and enter basic information about the international application for which international preliminary examination is requested.
Select the EPO as the IPEA, either by entering the two-letter code **EP** into the first field or by selecting **European Patent Office** from the drop-down list. This information is mandatory.

Enter the **international application number** of the PCT application. This information is mandatory.

Enter the **international filing date** of the PCT application. This information is mandatory.

- Clicking on the calendar icon on the right of the date boxes will open a calendar from which you can select the date.
- If the year of filing is different from the year in the PCT application number, a yellow validation icon is displayed. You can file your application to the EPO nevertheless, but please ensure that the data you enter is correct.

If a priority has been claimed for the PCT application, enter the **earliest priority date** (optional).

Enter the **title of the invention** exactly as specified in the PCT application (usually in block capitals). This information is mandatory.

Once you have entered all the mandatory information, the red validation symbol will disappear from the **Demand** tab in the navigation bar. However, a yellow validation icon is displayed if you do not supply the (earliest) priority date.

![Figure 476: Entering details on the PCT application for which international preliminary examination is requested](image)
12.2 PCT-DEMAND – Names

The *Names* tab is where you enter details of the applicant(s), an agent (representative) or an address for correspondence. Details of at least one applicant are required.

**Adding names**
- In the *Names* tab, click the *Add* button.
- Select a role.

![Options for adding names in Form PCT-DEMAND](image)

**Removing names from the form**
- Select the name to be removed on the left-hand side of the form.
- Click the *Delete* button.

12.2.1 Applicant

At least one applicant is required for filing. If you add two or more applicants, you can appoint one of them to act as the common representative. Any correspondence intended for the applicants will then be sent to the address of that applicant.

- In the *Names* tab, click the *Add* button.
- Select *Applicant, Natural* or *Applicant, Legal*.
- Enter the name and address information for the applicant or copy the data from the Address Book.
- If you provide an e-mail address, select the appropriate check box to authorise the IPEA to use that e-mail address.

The two options are mutually exclusive.

₁ At present, however, the EPO does not send any official communications by e-mail.
- If required, add more applicants by repeating the above procedure.

It is recommended that you name either a representative (agent) or a common representative. The yellow validation icon in the *Names* tab informs you about the corresponding validation message.
Appointing a common representative

Once you have added two or more applicants, the option to select a common representative is enabled.

- Select the applicant to be appointed as the common representative.
- Select the check box *This applicant is also common representative* (applicant, legal) or *This person is also common representative* (applicant, natural).

Once you select the check box for the selected applicant, it is disabled for the other applicants.
Note that the **Representative** and **Correspondence address** options have disappeared from the list. This means that you cannot add an agent or an address for correspondence if you have already appointed a common representative.

**Figure 480: The common representative option is disabled for the second applicant**

12.2.2 Agent

You can add only one agent. Where an agent is appointed, any correspondence intended for the applicant will be sent to the address indicated for that agent.

- In the **Names** tab, click the **Add** button.
- Select **Representative, Natural Person** or **Representative, Legal Entity**.
- Enter the name and address information for the representative or copy the data from the Address Book.

Note that the **Representative** and **Correspondence address** options are not available in the list once you have added the first representative (agent).

**Figure 481: Details of representative (agent)**

**Details relating to the agent's authorisation**

The lower part of the screen allows you to specify the relationship between applicant and agent (representative) for the purpose of this application. The option **The agent above ... has been appointed earlier ...** is selected by default.

- To specify a new appointment, select the appropriate option.
Related documents, e.g. a separate power of attorney, can be attached from the **Documents** tab.

![Figure 482: Details relating to the authorisation of the agent](image)

### 12.2.3 Address for correspondence

Where no agent or common representative is appointed, any correspondence will be sent to the address of the applicant (if only one person is named as applicant) or of the applicant who is considered to be common representative (if there are two or more persons named as applicants).

If the applicant wishes correspondence to be sent to a different address in such a case, that correspondence address may be indicated in the form.

- In the **Names** tab, click the **Add** button.
- Select **Correspondence address (natural person)** or **Correspondence address (legal entity)**.
- Enter the details for that address or copy the data from the Address Book.

Once you indicate an address for correspondence, you cannot appoint one of the applicants as the common representative. However, if you add a representative (agent) after indicating an address for correspondence, the address for correspondence is removed from the form.

![Figure 483: Address for correspondence specified for a legal entity](image)
12.3 PCT-DEMAND – Examination Basis

The Examination Basis tab is where you enter details about the basis for the requested examination.

Basis for the international preliminary examination
The examination can be carried out on the basis of the application as originally filed, or as amended under Article 19 and/or Article 34 PCT.

► If you wish the examination to be based on the application as originally filed, do not change the options under statement concerning amendments. The default options are as originally filed (the description, the claims, the drawings) and not applicable (the sequence listing).

Where only as originally filed is indicated, international preliminary examination will start on the basis of the international application as originally filed or, where a copy of amendments to the claims under Article 19 and/or amendments of the international application under Article 34 are received by the International Preliminary Examining Authority before it has begun to draw up a written opinion or the international preliminary examination report, as so amended.

Figure 484: The international preliminary examination will be based on the international application as originally filed

► If you wish the examination to be based on the application as amended, select the appropriate option from each of the drop-down lists:

- the description:
– as originally filed (default)
– as amended under Article 34

**the sequence listing:**
– as originally filed
– as amended under Article 34 (in the form of an Annex C/ST.25 text file)
– as amended under Article 34 (in the form of an image file)
– not applicable (default)

If you select the image file option, a red validation icon will appear in the Examination Basis tab, because the EPO only accepts amendments to the sequence listing in Annex C/ST.25 text file format.

**the claims:**
– as originally filed (default)
– as amended under Article 19
– as amended under Article 34
– as amended under Article 19 and Article 34

**the drawings:**
– as originally filed (default)
– as amended under Article 34
– not applicable

† If you want any amendments to the claims made under Article 19 to be reversed, select *Any amendment to the claims under Article 19 should be considered as reversed.* This check box is disabled if you selected the *as amended under Article 19* option for the claims.

† Select when to **start the examination:**
– Ordinary start (default)
– Postpone the start, Rule 69.1(b), 69.1(d)
– Start earlier, before time limit under Rule 54bis1(a)

Figure 485: The examination will be based on the international application as amended and amendments to the claims under Article 19 should be reversed
Language for the purposes of the examination

- Select the language (mandatory).
  
  You can either type the two-letter language code (EN, DE or FR) into the field to the left or select the language from the drop-down list to the right.
- Select the appropriate option for which is the language...
  - in which the international application was filed (default)
  - of a translation furnished for the purposes of the international search
  - of publication of the international application
  - of the translation (to be) furnished for the purposes of the examination.

Figure 486: Selecting the language and indicating where this language is used

12.4 PCT-DEMAND – Documents

The Documents tab of Form PCT-DEMAND is where you attach documents to be used by the IPEA in the international preliminary examination. If you specify amended parts of the application in the Examination Basis tab, a yellow validation icon will appear in the Documents tab, indicating that you should also attach the relevant documents.

To attach a document, you first need to select the suitable document category. The following document categories are available:

- Examination documents (p. 388), e.g. amendments
- Accompanying items (p. 391) as PDF files, e.g. power of attorney document
  A sequence listing (see "Attaching sequence listings" p. 392) is also attached under the Accompanying items category.
- Pre-conversion archive (p. 393), i.e. a ZIP file containing the original documents which are not converted into PDF

12.4.1 Examination documents

The examination documents category offers the following document types:

- Translation of international application
- Amendments under Article 34
- Copy (or, where required, translation) of amendments under Article 19
- Copy (or, where applicable, translation) of any statement under Article 19 (Rule 62.1(ii))
- Copy of the letter accompanying the amendments under Article 19 (Rules 46.5(b) and 53.9)
- Letter accompanying the amendments under Article 34 (Rule 66.8)
- Other document

  - To attach a document, click the **Add** button in the **Documents** tab.
  - Select **Examination documents**.

  ![Figure 487: Adding examination documents](image)

  - In the **Open** window, navigate to the storage location of your file.
  - Select the required file and click **Open**.

  ![Figure 488: Selecting the file to be attached](image)

The file is attached to the application under its original file name.

  - Select the appropriate document type, e.g. **Amendments under Article 34**.
The file is renamed to the Online Filing default file name, e.g. **AMDA34-1.pdf**. The original file name is also displayed at the top of the screen, along with the number of pages.

**Attaching other documents**
You can specify your own document type if there is no suitable attachment option.

- Click the **Add** button and select **Examination documents**.
- Navigate to the PDF file and attach it.
- Select **Other document** from the **Document Type** list.
  - The file is renamed **OTHERDOC-1.pdf**.
- To describe this document enter your text in the **Details** field, e.g. **Explanatory Note**.
12.4.2 Accompanying items

The **accompanying items** category offers the following document types:
- General power of attorney
- Copy of general power of attorney
- Separate power of attorney
- Sequence listing (PDF) (see "Attaching sequence listings" p. 392)
- Fee payment receipt (OEPM only)
- Other document

- To attach a document, click the **Add** button in the **Documents** tab.
- Select **Accompanying items** from the list.
- In the **Open** window, navigate to the storage location of your file.
- Select the required file and click **Open**.
  
  The file is attached to the application under its original file name.
- Select the appropriate document type, e.g. **Separate power of attorney**.

![Selecting the document type for the accompanying item](image1)

Figure 492: Selecting the document type for the accompanying item

The file is renamed to the Online Filing default file name, e.g. **SPOAT.pdf**.

The original file name is also displayed at the top of the screen, along with the number of pages.

![Separate power of attorney document attached under accompanying items](image2)

Figure 493: Separate power of attorney document attached under accompanying items

Attaching other documents

You can specify your own document type if there is no suitable attachment option.
- Click the **Add** button and then select **Accompanying items** from the list.
- Navigate to the PDF file and attach it.
→ Select **Other document** from the **Document Type** list. The file is renamed **OTH-E1.pdf**.
→ To describe this document enter your text in the **Details** field, e.g. **Assignment document**.

**Figure 494: Other accompanying item attached and specified**

12.4.3 Attaching sequence listings

Sequence listings must always be submitted as computer-readable files in accordance with WIPO Standard ST.25. If you attach a sequence listing in a PDF when filing with the EPO acting as the IPEA, a red validation icon is displayed in the **Documents** tab.

→ To attach a sequence listing in WIPO ST25 text format, click the **Add** button.
→ Select **Accompanying items**.
→ In the **Open** window, navigate to the storage location of your file.
→ Change the option in the **files of type** drop-down list from **Portable Document Format** (default) to **Nucleotide and Amino Acid Sequence Listing** (file type .app, .seq or .txt).

**Figure 495: Selecting the file type for attaching a sequence listing file**

→ Select the required file and click **Open**.
The file is attached to the application under its original file name.

- From the **Document Type** list select **Sequence listing (text format to WIPO Standard 25)**.
  Depending on the original file type, the file will be renamed **SEQLTXT.app**, **SEQLTXT.seq** or **SEQLTXT.txt**.

**12.4.4 Pre-conversion archive**

The **pre-conversion archive** option allows you to add your original documents, before converting them into PDF files, as a compressed ZIP archive file. This may be helpful if you wish to provide the EPO with your original documents in colour. The documents contained in the ZIP file will not be publicly available nor will they be an integral part of the visible internal procedural file, but they can be accessed for reference, e.g. in the event of quality issues.

- To attach the ZIP archive, click the **Add** button.
Select **Preconversion archive**.

Navigate to your ZIP file and select it.

Click **Open** to attach the file.

The file is renamed **OLF-ARCHIVE.zip**.

The names of the original files from the attached pre-conversion archive are listed on the right.

![Image](88x746)

Figure 498: ZIP archive containing the unconverted documents is attached

### 12.4.5 Viewing attached documents

You can check your application and the attached documents in the print preview.

- Click the **Preview** button in the toolbar.

The application (**pct-demand.pdf**) is displayed in the **PDF Viewer**.

Section VI of the form contains the attached documents with their original file names.

The left pane in the PDF Viewer lists all the files with their system names.

- Click a file name to the left to display the corresponding document in the PDF Viewer.
12.5 PCT-DEMAND – Fee Payment

In the Fee Payment tab you can review the fees associated with your demand and indicate how you wish to pay them. All fees must be paid in euros.

The fees displayed in the Fee Payment tab reflect the fee schedules located in File Manager > Tools > Fee Management.

Make use of the Live Update function in Online Filing to ensure that your fee schedule is always up to date. You will find the most recent fee schedule on the EPO website at Applying for a patent > Online services, following the link Interactive schedule of fees (http://www.epoline.org/portal/portal/default/epoline.Scheduleoffees).
12.5.1 Fee selection

The Fee selection sub-tab displays the fees payable to the EPO for the preliminary examination of the international application. The fees payable for filing a PCT-DEMAND form are the examination fee and the handling fee. The check boxes for these fees are automatically selected and cannot be cleared. No further action is necessary.

![Figure 500: Fees payable for PCT-DEMAND are automatically selected](image)

12.5.2 Payment details

In the Payment details sub-tab you can specify the mode of payment and provide any details required by the EPO acting as the IPEA.

Mode of payment

- Select the appropriate option from the Mode of Payment list.
- **Automatic debit**
  
  If you select this option the check boxes in the Fee selection sub-tab are automatically deactivated and the total amount of the fees is shown as EUR 0.00. The EPO will calculate the amount of the fees payable using the information you provided in your application and will debit this amount direct from your account. With this option you cannot select the fees yourself in the form.
Bank transfer
The EPO accepts EUR payments to its account with the Commerzbank AG in Munich, Germany. The IBAN and BIC codes of the EPO's bank account are supplied automatically when you select **DE, Commerzbank AG, München** from the drop-down list.

Debit from deposit account
If you choose this mode of payment, the relevant fees will be debited directly from your EPO deposit account. If you issue a debit order during normal working hours (08.00-18.00 hrs), you can usually view it under **Pending orders** within about 30 minutes. The actual deduction from your account will appear 5 to 6 days later.

Not specified
If you do not intend to pay fees with this submission, you can indicate **Not specified**.

For more information on EPO deposit accounts and the automatic debiting procedure, please refer to the Official Journal:

- **Arrangements for deposit accounts (ADA)**
  Supplementary publication 3/2015, p. 8-16

- **Notice from the European Patent Office dated 12 February 2015 concerning revision of the Arrangements for deposit accounts (ADA) and their annexes**
  Supplementary publication 3/2015, p. 2-7

- **Decision of the President of the European Patent Office dated 29 September 2016 revising points 5.3 and 7 of the Arrangements for deposit accounts (ADA)**

Automatic debit
If you are filing with the EPO, you can also use the **automatic debit** procedure. An EPO deposit account is required and orders for automatic debiting must be signed by an authorised person.

- **Enter the number of your deposit account.**
  EPO deposit account numbers are made up of eight digits, starting with **28**.

- **Enter the name of the account holder.**

- **Enter the name of the person authorised for signature.**

- **Enter the alphabetical signature of that person by writing the name between two slashes, e.g. /Laura Huffington/_.**

Debit from deposit account
An EPO deposit account is required to use the option **Debit from deposit account**. Debit orders must be signed by an authorised person.

- **Enter the number of your deposit account.**
  EPO deposit account numbers are made up of eight digits, starting with **28**.

- **Enter the name of the deposit account holder.**

- **If applicable, select the check box **Authorisation to charge any deficiency or credit any overpayment in the total fees.****
Enter the name of the person authorised for signature.

Enter the alphabetical signature of that person by writing the name between two slashes, e.g. /Laura Huffington/.

**Figure 501: Entering payment data for debit from deposit account**

### 12.5.3 Viewing the fee sheet

The data relevant for fee payment and the fee amounts to be paid are summarised in a separate fee sheet. You can preview this document in the PDF Viewer.

- Click the **Preview** button in the toolbar.

The application (**pct-demand.pdf**) is displayed in the PDF Viewer.

- To display the fee sheet, click **fees.pdf** in the list to the left.
12.6 PCT-DEMAND – Annotations

In the *Annotations* tab you can enter notes to be transmitted to the EPO.

**Creating notes for the EPO**

- Click the *Add* button and select *New Note*.
- Enter the relevant information in the *Note* field.
Figure 503: Writing a note to the EPO acting as IPEA

To add notes that are not intended for the EPO, use the Internal notes (p. 43) function on the form's toolbar.
13 Server Manager

Server Manager allows Online Filing users to administer and manage the Online Filing server and databases in their office environment. Server Manager is automatically installed together with the Online Filing software version 5.10 when Server installation or Stand alone installation is selected during setup. Server Manager cannot be run on a machine with the thin client only.

Starting Server Manager

You need Windows Administrator privileges to start Server Manager.

→ Right-click the Online Filing 5.0 Server Manager icon.

→ In Windows 7, select Run as administrator from the shortcut menu.

![Figure 504: Starting Server Manager via the Start menu in Windows 7](image)

→ In Windows 8/8.1, select Run as administrator from the shortcut menu.

![Figure 505: Starting Server Manager via the Apps screen in Windows 8.1](image)

→ In Windows 10, select More > Run as administrator from the shortcut menu.

![Figure 506: Starting Server Manager via the Start menu > All apps in Windows 10](image)

→ If you are not the Windows Administrator, you must now enter his or her Windows account name and password.

→ Click Yes in the User Account Control window.
The Server Manager login window then appears.

**Login to Server Manager**
Server Manager can only be started in production mode. However, most of the functions are available for both the production database and the demo database. Users who are members of the Administrators group can log on to Server Manager with their user name and password. A user with Administrator ID is entitled to add users to the Administrators group in Online Filing's User Administration (p. 69) window.

![Login to Server Manager](image)

**Figure 507: Login to Server Manager**

13.1 **Server Manager overview**

By default, Server Manager starts with the Services tab opened. Server Manager's major features can be accessed via ten tabs. Every tab features a toolbar with buttons to use the functions currently available. You can also use the functions via the Action menu.

<table>
<thead>
<tr>
<th>Tab</th>
<th>What you can do</th>
</tr>
</thead>
<tbody>
<tr>
<td>Services</td>
<td>Control services: monitor, stop, start, activate and deactivate the Online Filing services.</td>
</tr>
<tr>
<td>Backup</td>
<td>Backup, restore and clear the complete database. Configure automatic backup.</td>
</tr>
<tr>
<td>Export</td>
<td>Export items from the database, e.g. applications or templates, and store them as ZIP files. Deleting items after export is optional.</td>
</tr>
<tr>
<td>Import</td>
<td>Import items into the database that have been previously exported, e.g. applications or templates, to use them in File Manager.</td>
</tr>
<tr>
<td>Users</td>
<td>Monitor and manage users logged in to Online Filing.</td>
</tr>
<tr>
<td>Unlock</td>
<td>Disconnect users from items in the database, so that the respective record (application) in the database becomes unlocked and, hence, editable for other users.</td>
</tr>
<tr>
<td>History</td>
<td>List of user activities in File Manager and the other services, with IP addresses, Windows account names and OLF user names. Export server log file.</td>
</tr>
<tr>
<td>Live Update Countries</td>
<td>Select the countries for which Live Update should search for new or updated national plug-ins.</td>
</tr>
</tbody>
</table>
### 13 Server Manager

#### Settings
Define default file locations for backup, import and export.  
Define settings for Live Update and perform a live update.

#### Data Migration
Transfer user administration settings from one server to another.  
Move the Online Filing database to another hard disk.

---

**Figure 508: Server-Manager - Overview**

#### 13.2 Services management

The **Services** tab allows for monitoring and managing the Online Filing services.  
The list displays all installed services by **Plugin name, Exe file name** (path to the program file), **Service name, Status, Corba port, SOAP port** and **Connections** (number of active user sessions).

In a typical installation of the EPO OLF Server the following services are installed and activated:

- EPO OLF File Manager
- EPO OLF EP1038 – Form EP(1038E)
- EPO OLF EP122K – Form Euro-PCT(1200E2K)
- EPO OLF EP2000 – Form EP(1001E2K)
- EPO OLF EPOPPO – Form EP(OPPO)
- EPO OLF PCT – Form PCT/RO/101
- EPO OLF PCT-DEMAND – Form PCT-DEMAND
- EPO OLF PCT-SFD – Form PCT-SFD

When setting up Online Filing you can select which national plug-ins should be activated. All plug-ins available for Online Filing are installed as a matter of course, but only the ones you select are activated as a service and started. Check the Online Filing installation guide for more details.
The **Services** tab indicates the status of the various services in the following manner:

- Services that are activated are indicated in black.
- Services that are not activated are indicated in grey.
- Services that are running are indicated by a small green triangle.
- Services that are not running (including deactivated services) are indicated by a small square.

In the example below, the standard EPO OLF plug-ins and the EPO OLF File Manager are all running (black font with triangle), with the exception of the **EPO OLF EP1038** service which has been stopped (black font with square). The services for the national plug-ins are not active.

![Figure 509: Services running and stopped](image)

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Start as a service" /></td>
<td>Start as a service</td>
<td>Start an online service that has been stopped.</td>
</tr>
<tr>
<td><img src="image" alt="Stop" /></td>
<td>Stop</td>
<td>Stop an online service that is running.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refresh</td>
<td>Retrieve current status of online services from servers.</td>
</tr>
<tr>
<td><img src="image" alt="Activate service" /></td>
<td>Activate service</td>
<td>Activate service for a national plug-in (available for non-active services)</td>
</tr>
<tr>
<td><img src="image" alt="Deactivate service" /></td>
<td>Deactivate service</td>
<td>Deactivate service for a national plug-in (available for stopped services, apart from EPO OLF standard services)</td>
</tr>
</tbody>
</table>

**Running a service**

- Select the service you wish to start - the current status is **Stopped**.
- Click the **Start as a service** button.
  
    ![Start as a service](image)

- The service will be started and made available to users.
Stopping a service

- Select the service you wish to stop - the current status is *Running*.
- Click the **Stop** button.

The service will be stopped. Active users will be disconnected.

Stopping/starting the File Manager service (*EPO OLF File Manager*) will stop/start all other OLF services at the same time.

Activating a service

- Select the service for the national plug-in you want to activate - the current status is deactivated (grey font) and **Stopped**.
- Click the **Activate Service** button.

The selected service is activated but not automatically started.
- Click the **Start as service** button.

A national plug-in activated in this way is not available in Online Filing’s File Manager until all users have shut down and restarted this tool.
Deactivating a service

If a service is deactivated, the applications created with this national procedure are no longer available in File Manager. However, the data is not removed from the database. The applications reappear as soon as the service is reactivated.

To deactivate a service that is running you must first stop it.

1. Select the service you want to deactivate - its current status is **Running**.
2. Click the **Stop** button.
   - The service is stopped and the **Deactivate Service** button reappears.
3. Click the **Deactivate Service** button.

![Image](image.png)

You cannot deactivate the EPO OLF standard services, that is, the EPO OLF File Manager, the four EPO OLF plug-ins and the EPO PCT plug-in.

13.3 Database management (Backup)

The Server Manager's **Backup** functionalities allow you to back up, restore and clear the complete Online Filing database.

The **Backup** tab displays a list of all existing backup files stored in your default Backup directory. The file location can be specified in **Settings**. The type of database, file name and file date are indicated in the backup list.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td><strong>Backup</strong></td>
<td>Back up the complete Online Filing database to a compressed archive file.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Restore</strong></td>
<td>Restore the database from a selected backup file.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Delete file</strong></td>
<td>Delete a backup file.</td>
</tr>
<tr>
<td>![Icon]</td>
<td><strong>Empty database</strong></td>
<td>Empty the Online Filing database. Specific data from the production database can be copied to the new database.</td>
</tr>
</tbody>
</table>
13 Server Manager

Use backup regularly to save all users’ data in a physical location different from the hard drive used by the server. Backup is available for both demo and production mode.

Applications that have been moved to the Trash folder in File Manager will not be included in the database backup. They are therefore not available for restore at a later date.

- Click the **Backup** button to start the backup process.
- In the **Backup logging** window, select the database you want to back up: **Production** or **Demo**.
- Click **Start**.

The database will be backed up and stored in the default backup directory. The **Backup complete** message will inform you when the process is finished.
The backup file list is automatically refreshed.

Deleting backup files

- Select the backup file(s) in the list that you want to delete.
  - To select multiple files, select the first backup file you want to delete with a click and all other individual files with CTRL+click.
  - or
  - Select the first file and then press SHIFT+click the last one to select all of them.
- Click the **Delete** button.
Enabling automatic backup procedure

You can enable the automatic backup procedure for the production database in an Online Filing server installation. Automatic backup runs database backups at regular intervals without user interaction.

» Select the check box **Enable automatic backup procedure**.

![Figure 518: Default settings for automatic backup](image)

- Enter the number of days between the backups, e.g. **1** for daily backup or **7** for weekly backup.
  - Keep in mind that daily backups require considerable amounts of free disk space and that you should therefore delete old backup files regularly. It is recommended to set the backup directory path to a physical hard drive with adequate storage capacity; see **Settings for file locations** (p. 419).

- Enter the time of day.
  - If the OLF server is down at this time, the automatic backup will start at a later time once the server is running.

- Enter the **Starting date**.

![Figure 519: Settings for the automatic backup procedure](image)

The backup settings will take effect after restarting the File Manager service. Once you click away from the **Backup** tab or you close Server Manager, the following message is displayed as a reminder.

![Figure 520: Reminder to restart the File Manager service, thereby activating the automatic backup](image)

13.3.2 Restoring database

**Warning**: Restore overwrites the whole database and restores it to the state it was in when the backup file was generated. You will lose all applications created since the backup.

» Click the backup file in the list from which you want to restore your database.

Any backup of the production database can only be restored to the production database, and any backup of the demo database can only be restored to the demo database. There
is only one option available at a time, that is to say it is not possible to restore a backup file of the production database to the demo database or vice versa.

- Click the **Restore** button.

If users are connected to the system, you will be prompted to disconnect them first.

![Warning message if there are active user connections](image)

**Figure 521:** Warning message if there are active user connections

- In the **Restore logging** window, click **Start**.

![Restore logging window](image)

**Figure 522:** Restore logging window

The next window prompts you to confirm that the data in the database will be overwritten.

- Click **Yes**.

![Warning before restore will overwrite data in the database](image)

**Figure 523:** Warning before restore will overwrite data in the database

The database will be restored.

### 13.3.3 Creating a new empty database

Proceed as follows before you select **Empty**:

- Use **Backup** to create a complete copy of your database for backup.
- Terminate any active user sessions in the **Users tab** (see "User sessions" p. 414).

Emptying the database will create a new database and will delete all applications from the existing database. You can opt to transfer data like **users**, **groups**, **profiles**, **mappings**, **templates** and the **Address Book** as well as all applications that are not in Status **Sent** to the new database.

- Click the **Empty** button to start.

- Select which database is to be emptied.
Extended options are available for the production database only.

Figure 524: Empty database - selection of data to be transferred

- Click **OK** to continue.
- Click **Yes** in the **Question** window to confirm that you are sure you want to empty the selected database.

The new database is created. If applicable, the data previously selected is transferred from the old database to the new one.

### 13.4 Exporting items

The **Export** tab shows all the items stored in the Online Filing database. All existing applications and templates, including the corresponding number of validation messages and attachments, are listed to the right.

The export functions in Server Manager apply to the production database only.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Export</td>
<td>Export selected items to the default export location. Applications will be saved as ZIP files containing XML and PDF documents.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refresh</td>
<td>Update current status of applications.</td>
</tr>
</tbody>
</table>
Filtering by date

You can restrict the applications to be displayed by enabling the filter by last saved date.

- Select the **Enable Filter** check box.
  
  This enables the **Start Date** and **End Date** fields. The default settings are the day before the current date in the **End Date** field and the day four weeks before the **End Date** in the **Start Date** field.

- Modify the **Start Date** and **End Date** as required.

- Click **Apply Filter**.

Exporting selected items

Each application will be stored as a separate ZIP file in the default **Export directory** specified in **Settings**.

- Narrow down the list of displayed items by selecting a workflow folder from the list on the left and/or enabling a filter by date.

- Click the check box next to an item to select it for export.

- Click other check boxes to select more than one item.

  or

  Click the **Select All** icon in the list header to select all items. Click the icon again to cancel the selection of all items.

- Click the **Export** button to start exporting files.
Each time you export an application, the Export function creates a new ZIP file and names it according to the application's user reference. If a ZIP file of the same name already exists in the export folder, e.g. sample_oppo.zip, the following ZIP files will be named sample_oppo_001.zip, sample_oppo_002.zip and so on. The same applies if two or more applications have the same user reference.

Deleting items from database
You can opt to delete exported items from the database.
- Select the option **Delete items from database after archiving**.
- Click the **Export** button.

**Attention:** Do not click **Cancel** while the Export progress window is still visible. Doing this will delete the selected applications processed up to this point but will not export them.

The applications will be exported and permanently deleted from the database. If you need to retrieve them, use the Import functions in File Manager or Server Manager.

### 13.5 Importing items

The Import tab shows all the applications available in the default import folder; see Settings for file locations (p. 419). Server Manager reads the ZIP files that have been created during export by File Manager or Server Manager.

Like Export, Import works for the production database only.
### 13 Server Manager

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Import" /></td>
<td><strong>Import</strong></td>
<td>Import selected items from the default import location. ZIP files will be converted into database records including the original attachments.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td><strong>Refresh</strong></td>
<td>Update current status of applications.</td>
</tr>
</tbody>
</table>

#### Selecting items for import

All items are selected by default.
- Click one of the folders to the left to display applications grouped by workflow status or to select templates only.
- Clear the check boxes for the items that should not be imported.
  - or
  - Reset the selection of all items by clicking the ✔️ icon in the list header and selecting individual items.
- Click the **Import** button to start importing items.

![Figure 528: Import selected items](image)

Applications imported into the database always have **Draft** status, irrespective of their pre-export status. Only sent applications are imported in **Sent** status.
In File Manager, you will find all imported applications in the default import folder that you specified under **Settings** for Server Manager. You can edit these applications once again in File Manager and move them to the required status.

### 13.6 User sessions

The **Users** tab displays all users currently connected to the Online Filing server. In a stand-alone installation of Online Filing with a single user, the **Users** tab is empty.
Individual users can open multiple connections to the server: starting File Manager, opening applications and templates. All Online Filing plug-ins, e.g. **EPO OLF EP122K**, run as
individual services to which users can connect when working in the specific Online Filing procedure.
Each individual connection is listed by **Plugin name** (service) and **User ID**. **User info** shows the path to the service's configuration file, the user's IP address, domain name and login name within the computer network as well as the internal Online Filing user name.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Get user log" /></td>
<td><strong>Get user log</strong></td>
<td>Display log information for selected user session in the right-hand pane.</td>
</tr>
<tr>
<td><img src="image" alt="Get full user log" /></td>
<td><strong>Get full user log</strong></td>
<td>Display more detailed log information.</td>
</tr>
<tr>
<td><img src="image" alt="Terminate user" /></td>
<td><strong>Terminate user</strong></td>
<td>Disconnect user from server.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td><strong>Refresh</strong></td>
<td>Update current user session list.</td>
</tr>
</tbody>
</table>

- Click the **Get user log** or the **Get full user log** button to see the log for the OLF service connected to the currently selected user session ID.

![Server Manager](image)

**Figure 529: Users logged in to Online Filing services**

**Terminating user sessions**

- Select the user session to be disconnected in the left-hand pane.
- Click the **Terminate user** button.
The connection will be terminated. In File Manager or in the form, the user will receive the following message:

![Figure 531: User info - connection to server lost](image)

### 13.7 Unlocking forms

The **Unlock** tab displays a list of all database records locked by users. In a stand-alone installation of Online Filing with a single user, the **Unlock** tab is empty.

If a user logged on to File Manager and opened an application or template for processing, the corresponding record is locked in the database. If other users now try to open this specific application, they receive a message that this record is locked and a read-only copy of the application is opened.

![Figure 532: Warning about a locked application/document](image)

In the **Unlock** tab, you can unlock locked records to enable other users to continue working on the relevant application. The **Unlock** function is not applicable for the PCT forms and works only for the production database.
The **Plugin name** (service for the selected plug-in), **Session ID** (internal user number), **Table** (table in the database) and **Record** (internal number of the record) are listed for each record. The **User info** column shows the IP address of the computer and the domain name of the network where the user logged on, the user's Windows logon name as well as his or her user name in Online Filing.

### Unlocking a record

1. Select the record to be unlocked.
2. Click the **Unlock** button.

Server Manager terminates the active user session when unlocking a record.

3. Click **Yes** to confirm.

![Unlock Confirmation](image_url)

**Figure 534: Unlocking a record also terminates the user session**
13.8 History

The **History** tab provides a chronological list of login and logout actions by all users as well as the status of Online Filing services. A separate log is available for every service. Older entries are automatically hidden.

This enables the administrator to check user activities, find errors and, if necessary, prevent unauthorised operations.

- Click the **Refresh** button to retrieve the most recent status.
- Click a service (**Plugin name**) to display the associated history on the right.

![Figure 535: Log of user activities in the History tab](image)

**Exporting server log files**

You can export the logs for every individual OLF service for later evaluation, if required.

- Select the Plugin name.
- Click the **Export** button.

Server Manager creates a CSV file, which is named according to the selected service and stores it in the default export folder.

13.9 Settings

The **Settings** tab comprises various options for configuring Server Manager.

- Setting the target directories for backup and restore, for export and import in the file system of your computer or network.
- Selecting the destination folder in File Manager for importing applications.
- Entering data for internet access via a proxy server, if applicable.
- Entering access data for the internet connection used by Live Update, if applicable.
- Configuring the e-mail service for distributing Live Update information.
- Configuring Live Update and checking for updates manually.

### 13.9.1 Settings for file locations

During the installation of Online Filing, the default setting for all directories is defined by the program path to Server Manager (`C:\Program Files\EPO_OLF5\tools\smanager\data`). You can designate your own specific directories for the Server Manager's data exchange functions, for example on a different hard disk partition or a mapped network drive.

In the **Backup**, **Export** and **Import** tab, Server Manager only lists the files located in these designated directories; files stored in sub-directories are ignored.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Backup and restore directory</strong></td>
<td>Location for storing database backup files.</td>
</tr>
<tr>
<td><strong>Export directory</strong></td>
<td>Location for exporting applications as ZIP files.</td>
</tr>
<tr>
<td><strong>Import directory - source</strong></td>
<td>Default location from which ZIP files are imported to new applications.</td>
</tr>
<tr>
<td><strong>Import directory - destination</strong></td>
<td>Default folder in File Manager where imported applications are created.</td>
</tr>
</tbody>
</table>

#### Changing directory settings

- Click the folder button to the right of the directory path you wish to modify.
- Navigate to the new folder in your computer/network drives.
- Click **OK**.

The new path will be displayed in the **Settings** tab.

![Figure 536: Default settings for file locations](image)
![Figure 537: Example of individual settings for file locations](image)
13.9.2 Default Network Settings

The administrator defines the default network settings in Online Filing for all users in the corporate network. PC workstations in larger companies usually do not connect directly to the internet but rather are routed over a proxy server. This proxy examines all incoming and outgoing connections and rejects unauthorised connection attempts.

- Enter the IP address of the proxy server in the **Proxy server** field.
- In the field to the right of it, enter the number of the proxy server port that Online Filing should use to establish an internet connection. You can configure the proxy server in such a way, for instance, that this port is only used by Online Filing.
- Enter appropriate access data in the fields **Username** and **Password** if the proxy server requires authentication every time a connection is established.

**Attention:** The username and password for the proxy user are saved in unencrypted form in the file `OLFfm.conf`. For security reasons, these credentials should never be identical to your Windows authentication.

The **SSL Version** is set to **TLSv1** by default and cannot be changed. To provide for enhanced security in terms of data encryption, Online Filing does not use previous SSL versions anymore.

- Please contact your system administrator if you are unsure about the information you need to enter in your situation.

![Network settings](image)

**Figure 538: Network settings**

13.10 Live Update

The Live Update service is used to update the Online Filing software. Live Update establishes a connection between the Online Filing client and the EPO’s update server and checks for updates for the installed version of the software.

Live Update is configured and can be activated manually in Server Manager. This means that only users in the **Administrators** group are allowed to perform a live update in Online Filing.

**How to update Online Filing**

- Log on to **Server Manager** with your user name.
- Use **Backup** to create a copy of your database.
- Check if there are any updates available in the **Settings** tab.
- Download the update.
- Install the update in a test environment to ensure that it does not cause any problems on your productive system.
Shut down all Online Filing services.
Install the update in the server installation. If the update also includes amendments to Online Filing's thin client, a new installation file is generated for the thin client when updating the server and stored in the program folder EPO_OLF5/ThinClient_v500.
Restart the services.
Distribute the thin client update to the individual users.

Update types
Live Update performs three different types of update.

- **Maintenance**: Changes in the maintenance tables, such as countries, languages, fees, URLs, addresses. The relevant maintenance tables are automatically updated when starting File Manager after the update has been downloaded.
- **Patch**: Changes to the existing software, new features, new national routes.
- **Installation**: New version of the Online Filing software released following a complete revision.

You can either install updates via Live Update or download the installation files from the EPO website at Online Services > Online Filing > Download software for filing with the EPO (http://www.epo.org/applying/online-services/online-filing/download.html).

13.10.1 Settings for Live Update
The basic settings for Live Update are made in Server Manager.
- Log on to Server Manager with the **Administrator** user name.
- Go to the **Settings** tab.
  The Live Update options are listed on the lower part of the tab.
Enabling Live Update

The check box for **Enable software update system** is selected by default.

- Enter how frequently you want to check for updates in the field **Check for update every ... day(s)**.
  
  The default setting is 1 day.

- Select the location of the server you want to check for updates in the **Live Update Server Location** list.
  
  The only option in the latest version of Online Filing is the EPO's Live Update server in The Hague.

Live Update check in File Manager

Online Filing automatically checks for updates every time File Manager starts and reports any updates found.

Only the administrator can perform live updates manually in Server Manager. The following message appears when a user opens File Manager for the first time on the day in question:
Connection to Live Update server
If your corporate network uses a proxy server to connect to the Internet, you can enter the relevant data in the Live Update settings.

- Enter the server name or the IP address of the proxy server in your network in the Server field under Live Update proxy.
- In the Port field, enter the number of the port that the server should use to set up the connection to the EPO Live Update server.
- If the proxy server requires authentication, enter the appropriate data in the fields Username and Password.

E-mail to the user
You can inform the users in your company when a new update is available for installation.

- Enter the address of your mail server in the Server field under Live Update e-mail. Server Manager can only send e-mails via your mail server if the outgoing mail server (SMTP) does not require authentication.
- Enter the e-mail address of the sender in the Sender field.
- Enter the e-mail address(es) of the recipient(s) in the Receiver field.
- If you enter multiple addresses, add a separator after each e-mail address. You can use commas, semicolons or line breaks. The configuration of a special collective address which forwards mail internally to individual recipients is recommended.
- To verify your settings, click Test. If all settings are correct, the receivers will get an e-mail. If not, you can find the error log file in the OLF program folder under C:\Program Files\EPO_OLF5\tools\smanager\logs\SendMail.log.

Including country-specific procedures in Live Update
Live Update automatically checks for new national procedures or their updates if you selected specific countries in the Live Update Countries tab.

- Select the appropriate countries. If you activated national plug-ins when installing Online Filing, the relevant countries are automatically selected by default.
Live Update informs you that updates are available for download as soon as the EPO publishes a new national procedure for one of your selected countries.

![Figure 541: Selecting countries for Live Update](figure)

### 13.10.2 Downloading updates

Irrespective of the settings for Live Update, you can check for updates at any time you wish.

- Click the **Settings** tab in Server Manager.
- Click **Check Now**.

Online Filing establishes a connection to the EPO's Live Update server and checks for updates for the software and the selected countries. If so, a message appears asking you if you want to download the updates now.

- Click **Yes** to download the updates.

![Figure 542: New updates found](figure)

The Live Update window opens with a list of the updates available. Live Update shows all the available updates in order of **Date**. The entry in the **Type** column indicates whether it is a maintenance update, patch or full installation. The **Status** column
shows whether the update is new or has already been downloaded. An exclamation mark in the **Critical** column indicates that the EPO considers that the update is particularly important and should be installed.

Further information about the selected update can be found at the bottom of the window under **Package Content**.

- Select the update in the list.
- Click **Download**.

The **Install** button does not become active until after the update has been downloaded.

**Figure 543: Updates available for download**

### Downloading multiple updates

- From the **View** drop-down list in the top right-hand corner select **New**.
  - The **Update** column now contains a check box for each update.
- Select the check boxes of the updates you wish to download.
- Click **Download**.

### Downloading an update

With larger files, a progress indicator shows the progress of the download operation.

**Figure 544: Progress indicator during Live Update download**

Before the files are saved on your hard disk, they are subjected to verification.

**Figure 545: Verification of updates after download**

Live Update always indicates when downloading and verification are successfully completed.
- Click **OK**.
Figure 546: Downloading and verification completed.

The downloaded updates are now displayed with Downloaded status in the Live Update window.

- Click Close to exit Live Update without installing any updates.

### 13.10.3 Installing updates

#### Installing maintenance updates

Maintenance updates are automatically loaded into the database after the files have been downloaded via Live Update.

- Download the maintenance update.
- Close both File Manager and Server Manager.
- Start File Manager on the server machine.
  - If User Management is enabled, log on as Administrator.

The maintenance update will be loaded before the File Manager window opens.

#### Installing a patch via Live Update

- In the Live Update window select the update you require.
- Click Install.

Figure 547: Installing a downloaded update

For the update to be installed correctly, all OLF programs and services must be stopped.

- Check the Users tab in Server Manager to see if there are any users currently working on applications and give them ample warning of the impending disruption of online services.
- Click Yes when the following window appears.
File Manager and any other active services are terminated. The Live Update window remains open in the background.

The installation program starts.

Running installation files as a program

→ Close the Live Update window.
→ Give any logged-on users ample warning of the impending disruption.
→ Terminate all active Online Filing services in the Services tab in Server Manager.
→ Open the Windows Explorer.

The downloaded updates are stored in the C:\Program Files\EPO_OLF5\fm\config\LU\Installations folder as executable EXE-files.

→ Double click the update you wish to install.
  or
  Right-click the file and select Run as administrator.

The installation program starts.

→ Follow the instructions provided by the installation wizard.
13.11 Data Migration

The Data Migration tab in Server Manager offers options for migrating data from one server to another or from the production database to the demo database, without the need to run the installation program. You can migrate the selected data either to a different hard drive or to a different machine.

Migrating user data
- Copy the complete user administration from the production server to the demo server.
- Export the user administration from the production server to a file.
- Import the user administration from a file to the production server.

Migrating databases
- Move the production database to another storage location.
- Move the demo database to another storage location.

13.11.1 User Data Migration

If your company has been working with Online Filing for some time, your Online Filing administrators may have created a specific system of user accounts, groups and profiles for your purposes.

When you install Online Filing on a new machine, you can conveniently transfer this user management set-up to the new installation. Likewise, the user settings of your OLF production server can be copied to your demo server for testing purposes.

**Attention:** To avoid data conflicts, User Administration should only be copied to or imported into an empty Online Filing database.

- Open the Data Migration tab.
- Under User Data Migration, select the appropriate option.
- Click Execute.

*Figure 550: Options for migrating the User Administration*
If users are connected, a message appears and the action is cancelled.

**Figure 551: Warning to disconnect users before exporting or importing user management settings**

**Exporting user administration**
The export operation creates a ZIP file in the Server Manager’s default export directory. The ZIP file is named `useradministration[date]_[time].zip`, e.g. `useradministration20120628_153639.zip` and contains three files, `um.tmp`, `uma.tmp` and `umr.tmp`.

**Figure 552: Locating the user administration file in the Server Manager’s export folder**

**Importing user administration**
The User Administration ZIP file can either be copied to the Server Manager’s default import directory on the target machine or it can be located during import.
The **Data Migration** function opens the default import directory.

- Select the appropriate ZIP file or browse the file system to locate your user administration file.
- Click **Open**.
13.11.2 Database Migration

You can move the Online Filing databases to a different hard disk drive if your server computer's hard disk runs out of space or if you have to replace the hardware. By migrating the database to another location, the Online Filing server will be reconfigured to connect to the new database path.

Inform all users to save their work and log out of Online Filing before you start the database migration.

Under **Database Migration**, select the appropriate option:
- Leave the copy of the database in the former location after successful migration (default)
- Delete the copy of the database in the former location after successful migration

It is recommended to leave the copy of the database in the former location until you are sure that everything works correctly in the new location.

Both the production database and demo database can be migrated independently.

Click the folder icon next to the database path you wish to modify.
→ Select an existing folder in your file system or create a new one.
→ Click OK.

![Figure 555: Selecting a new location for the OLF database](image)

→ Wait until the Information window appears.
  If the database is very large, the process of copying and verifying the database could take some time.
  The new path is displayed in the message.

![Figure 556: Confirmation of successful database migration](image)
14 Glossary

ASCII
American Standard Code for Information Interchange.
May contain letters, numbers, spaces and punctuation, but no formatting. Also called a text file.

CD-ROM
A CD-ROM (Compact Disc Read-Only Memory) is a CD with permanently stored data. A CD-RW, in contrast, is rewritable (RW), meaning it permits the deletion of data on the CD.

Check digit
A check digit contains an algorithm that verifies the other numbers entered and helps reduce typing errors.

CORBA
Common Object Request Broker Architecture: defines cross-platform protocols and services, eases development of distributed applications in heterogeneous environments.

CSV
Character separated values.
A file format typically used for data sets where the data is arranged in columns and rows. The individual data fields are separated from each other by delimiters such as commas.

Default
An automatic selection made by the system when the user does not specify an alternative.

Delimiter
A special character that sets off, or separates, individual items in a set of data.

Commases and semi-colons are examples of delimiters commonly used.

Dock
To move a toolbar or window to the edge of an application window so that it attaches and becomes a feature of the application window.

DVD-ROM
A DVD (Digital Video Disc) is an optical data storage unit like a CD but with significantly more capacity (approx. 4 GB). It is therefore used primarily for the storage of video films. DVD-ROMs (Read-Only Memory) are generally used to save data. An appropriate DVD burner is needed to write data to a DVD.

Field
A space in an on-screen form where the user can enter a specific item of information, for example a name or a date. Fields may have restrictions on the length and type of data that may be entered, for example text only, or numbers in a certain format.

Firebird SQL database server
Firebird is a simplified Open Source spin-off of the InterBase relational database management system produced by Borland.

GUI
Graphical User Interface: software component allowing user interaction with graphical elements in the program via a mouse and keyboard.

HTTP
HyperText Transfer Protocol: method of transferring information on the WWW, usually in HTML.
HTTPS
HyperText Transfer Protocol Secure: indicates that HTTP is used with a different port (443) and an additional encryption/authentication layer between HTTP and TCP.

Icon
A small image displayed on the screen that allows the user to control certain computer actions without having to remember commands or type them on the keyboard.

IIOP
Internet Inter ORB Protocol: defined in CORBA, used to execute remote procedure calls.

LAN
Local Area Network: typically within one building of a company.

Non-repudiation
To protect and ensure trust in digital signatures, the parties may employ non-repudiation, which not only validates the sender, but also time-stamps the transaction, so it cannot be claimed subsequently that the transaction was not authorised or was not valid.

ORB
Object Request Broker: agent enabling communication between objects within a distributed system, for example the internet.

Patch
A new feature or function added to a program, commonly used as an interim measure before release of a full version of the software.

PDF
Portable Document Format. A file format used in saving documents. It can be read using free PDF Reader software.

PIN
Personal Identification Number: a numeric password shared between a user and a system, used to authenticate the user to the system.

PMS
Patent Management System.

Port
A port is part of a network address for a server application running on a computer within the network. Typical ports are 80 for HTTP Web servers and 110 for POP3 mail servers.

Proxy server
A firewall component that manages internet traffic to and from a network.

SOAP

SQL
Simple Query Language. Used to query and modify databases.

SSL
Secure Socket Layer. A protocol for ensuring security and privacy in internet communications. Supports authentication of client, server, or both, as well as encryption during a communication session.
TCP
Transmission Control Protocol.
Used to manage data exchange between computers via network connections.

TIFF
Tagged Image File Format.
A standard file format commonly used for scanning and storing grey-scale images. TIF files may be used for scanned signatures.

URL
Uniform Resource Locator.
An address for a resource on the internet. Used by Web browsers to locate internet resources.

WAN
Wide Area Network: normally across several offices/subsidiaries of a large company or organisation, including internet connection parts in between.

Workflow
The tracking and management of all activities from start to finish.

XML
eXtensible Markup Language. XML is a document-processing standard officially recommended by the World Wide Web Consortium and widely accepted throughout the internet community. It provides a way to define and manage information. It can be used to check the accuracy and quality of documents.
15 Index

A
Abstract • 149, 153, 154, 186, 189, 219, 320, 322
Accelerated processing • 254
Accelerated search • 215, 219, 227
Accession number • 146, 184, 306
Accompanying items • 316, 327
Account holder • 165, 204, 231, 266, 336, 368
Account number • 165, 204, 231, 266, 336, 368
Acknowledgement • 107, 219, 259, 344
Activate • 16, 403
Additional opponents • 248, 270
Address book • 45, 49, 50, 52, 54, 128, 178, 286, 300
Address for correspondence • 129, 178, 213, 248, 252, 286, 288, 385
Administration • 69, 71, 73, 76, 78, 401, 420, 426
Adobe Acrobat • 90
Affidavit • 265
Agent • 48, 294, 297, 384
Agreement • 135, 310, 311
Alphabetical signatures • 95, 105, 297, 396
Amendments • 185, 186, 219, 359, 386, 388
Amicus curiae • 219
Amino acids • 159, 194, 306, 365
Amyuni PDF converter • 90
Annex C/ST.25 • 306, 316, 329
Annex F • 90, 97, 325
Annotations • 43, 172, 197, 209, 219, 239, 269, 338, 376, 399
APP file • 159, 194, 329, 365, 392
Appeal • 92, 211, 219, 228
Applicant • 48, 49, 129, 141, 178, 213, 288, 297, 310, 311, 312, 377, 382
Application • 26, 27, 28, 29, 30, 31
Application body • 319, 325
Application date • 177, 281
Application number • 107, 144, 175, 177, 210, 213, 240, 246, 352, 380
Application workflow • 38
Archiving • 109, 112, 407, 411
ARIPO • 288
ASCII file • 159, 194, 225, 316, 329, 353, 365
Assignment • 219, 310, 311, 353, 357, 359, 362
Association • 134
Attachments • 58, 59, 147, 185, 218, 258, 316, 353
Authentication • 14, 99, 105, 107, 219, 259
Automatic debit order • 165, 204, 231, 266, 368, 396
Auxiliarily • 254
B
Backup • 406, 407
Bank transfer • 165, 266, 336, 368
Batch send • 108
Biological material • 146, 184, 306
Biology • 146, 184
Build number • 18
Button • 22, 38
Capacity • 292, 297, 349, 351
Card reader • 99, 102
Category (documents) • 219, 259, 353, 357, 359, 362
CD-ROM • 59, 68
Certificate • 99, 103
Certified copy • 124, 303
Changing status • 38, 39, 40, 92, 106
Citations by third party • 219, 259
Claims • 124, 149, 153, 154, 186, 189, 219, 247, 259, 320, 322, 386
Clean copy • 219
Client • 14
Common Representative • 286, 288
Company • 47, 99, 129, 178, 213, 248, 288, 294
Computer readable file • 159, 194, 392
Confirmation • 58
Connections • 403, 414, 416, 420
Consent • 310, 311
Contents • 316
Continuation • 284
Contracting states to the EPC • 120, 141, 182, 242
Conversion • 90, 158, 200
Copies of search report • 165, 204
Copying • 27, 33, 278
CORBA • 14, 403
Corrected demand • 359
Corrections • 353
Correspondence address • 385
Country • 141, 421
Court order • 310, 311
CSV file • 52, 54
Currency • 165, 203, 230, 266, 334
Customer number • 27
D
Data backup • 112, 407
Database • 28, 109, 112, 406, 428
Deactivate • 16, 403
Debiting • 165, 203, 204, 230, 231, 266
Deceased inventor • 135, 292
Declaration • 308
Declaration sheet • 308, 315
Defects • 353
Deferred execution date • 165, 204, 231, 266
Delete application • 24, 30, 112, 410
Deleting • 24, 30, 47, 112, 411
Demand for international preliminary examination • 379
Demo mode • 12, 57, 407
Deposit account • 165, 204, 231, 266, 336, 368, 396
Depositary institution • 146, 184, 306
Description (patent) • 149, 153, 154, 159, 189, 194, 219, 259, 320, 322, 386
Designated office • 175
Designated states • 140, 182, 238, 284, 288, 342
Designation • 141, 165, 182, 230, 238, 342
Designation fee • 141, 182, 238
Designation of inventor • 135, 219, 309, 342
Diagnostic file • 18
Digital library • 303
Directories • 57, 419
Disable • 73
Disclosure • 314
Divisional application • 123, 141
Documents • 90, 147, 185, 218, 258, 316, 353, 388
Download • 17, 424
Draft • 27, 28, 36, 38, 39, 115, 278, 413
Drawing • 90, 149, 154, 163, 186, 189, 219, 265, 320, 325, 386

E
Earlier application • 123, 124, 144, 162, 303
Earlier search • 353, 357, 359, 362
Editor • 52, 54
Elected office • 175
Employee • 129, 178, 213, 248
Employee, authorised representative • 97, 99, 129, 178, 213, 248
Employer • 135, 310, 311
Encryption • 60, 99, 420
Enquiry as to the processing of the file • 217, 219
Entitlement • 129, 248, 310, 311
EP application number • 107, 144, 177, 213, 240, 246
EP Phase • 175
EP(1001E2K) • 118
EP(1038E) • 211
EP(Oppo) • 242
EPC • 140, 175, 182
EPO customer services • 10, 18
EPO online services • 10, 165, 203, 230
Error • 41
Eurasian patent • 288
Euro-PCT(1200E2K) • 173
Evidence • 219, 242, 264, 265
Examination • 379, 386, 388
Examination procedure • 219
Examination report • 186, 197, 219
Excel • 52, 54
EXE file • 426
Exempted offices • 124, 144
Exporting • 120, 168, 175, 206, 231, 234, 334
Extension of time limit • 219, 353, 357, 359, 362
Extension states • 143, 182

F
Facts and arguments • 259, 260
Fee calculation sheet • 327, 334
Fee reduction • 120, 168, 175, 206, 231, 234, 334
Fee reform • 86, 238
Fee schedule • 86, 168, 206, 231, 234, 334, 368
Fee sheet • 334, 398
Fees • 86, 165, 203, 230, 266, 334, 368, 395
Field names • 52, 54
Figure • 149, 153, 154, 320, 325
File Manager • 20, 109, 413
File type • 90, 147, 153, 159, 194, 219, 316
Files • 90
Filing date • 352, 380
Filing fee • 118, 168, 173
Filing office • 48, 88, 90, 103, 120, 124, 175, 281, 351
Filtering • 20, 26, 168, 206, 234, 411
First communication • 242, 248
Folders • 24, 27, 30, 33, 59, 84, 113, 419
Forms • 12, 27, 109, 110, 118, 173, 211, 242, 349, 379, 416

G
General authorisation • 129, 134, 178, 197, 259
General enquiry • 219
Generation • 123
Grant • 284
Graphical User Interface (GUI) • 27, 57, 401
Grounds for opposition • 247
Groups • 69, 71, 76, 83, 84

H
Hearing • 254
Help • 10, 18, 22
Highlighting • 186, 197, 219
History • 418

I
Identity of the inventor • 309
Images • 90, 97, 158
Importing • 54, 115, 117, 347, 413, 428
Incorporation by reference • 353
Info Pane • 20, 31, 41, 71, 107
Inspection of the file • 219
Installation • 14, 16, 17, 426
Interface • 66
Internal notes • 43, 172, 209, 239, 269, 338
International application • 124, 173, 177, 185, 186, 189, 194, 319, 352, 380
International Bureau • 103, 303
International priority • 144, 303
International search • 329
Interpreter • 254
Interveners • 242, 248, 252, 259
Intervention • 242, 245
Inventor • 135, 288, 292, 309, 310, 311, 312, 342
Inventor waiver • 135, 219
IP address • 14, 414, 420
IPEA • 177, 185, 351, 359, 374, 379, 380
IPER • 197, 219
ISA • 177, 281, 351, 357, 373

J
JPG • 90, 97, 158

K
Keyboard • 11

L
Lack of novelty • 247, 314
Lack of unity of invention • 357, 359, 362
Language • 27, 57, 120, 129, 147, 154, 175, 177, 254, 281, 320, 322, 325, 363, 365, 386
Language of proceedings • 27, 33, 35, 120, 147, 154, 163
Later filed documents • 353, 365
Legal person • 45, 47, 49, 50, 54, 129, 288, 294, 382, 384
Legal remedies • 219
Limitation • 219
Live Update • 17, 420, 421
Location indicator • 20, 118, 173, 211, 242, 349, 379
Log file • 418

M
Maintenance • 88, 420, 426
Maintenance tables • 88, 426
Mandatory data • 38, 41
Mandatory field • 118, 173, 211, 242, 349, 379
Mapping profiles • 83
Medical certificate • 219, 227
Menu • 20, 22
Menu bar • 20, 118, 173, 211, 242, 274, 349, 379
Message • 41
Microsoft Excel • 52, 54
Microsoft Word • 90
Migration • 428, 430
Missing parts • 353
Modify application • 27, 39
Move application • 24, 30
Moving • 24, 30

N
Names • 47, 49, 50, 128, 178, 213, 248, 286, 300, 353
National priority • 144, 303
National procedures • 16, 403, 421
Nationality • 120, 129, 175, 231
Natural person • 45, 47, 49, 50, 54, 129, 135, 288, 294, 382, 384
Navigation bar • 20, 118, 173, 211, 242, 274, 349, 379
Network • 14, 60, 401, 403, 420
Non-patent literature • 219
Non-patentability • 247
Non-profit organisation • 129
Non-public submission • 211, 215, 219, 227, 263
Non-repudiation • 105, 108
Non-scannable object • 265
Note • 43, 172, 209, 239, 269, 376, 399
Notepad • 52, 54
Notice of appeal • 219
Notice of intervention • 245, 259
Notice of opposition • 245, 259
Nucleotides • 159, 194, 306, 365, 392
Number of pages • 189, 316, 325

O
OAPI • 284, 288
Observations • 259, 270, 359
Online Fee Payment • 165, 203, 230, 266
Online help • 18, 22
Opponents • 242, 248, 252, 259
Opposition • 245, 248
Opposition fee • 266
Oral proceedings • 219, 245, 254
Original document • 90, 154, 158, 200, 265
Other action • 245, 252, 259

P
PACE programme • 144, 215
Package • 347
Page orientation • 90
Paper size • 90
Parent application • 284
Party • 248
Password • 60, 62, 66, 71, 73, 75, 420, 421
Password policy • 62, 71, 75
Patch • 420, 426
Patent number • 246
Patent of addition • 284
Patent Prosecution Highway • 219
PATENTSCOPE • 303
PatXML • 90, 153, 154, 319, 325
Payments • 165, 203, 230, 266, 336, 388, 395
PCT • 48, 90, 274, 284, 349, 379
PCT application number • 144, 177, 210
PCT/RO/101 • 274
PCT-DEMAND • 379
PCT-SFD • 349
PDF • 31, 90, 107, 149, 154, 159, 162, 186, 194, 197, 225, 319, 363
PDF viewer • 31, 92, 107, 163, 201, 230, 270, 297, 315, 338, 367, 394, 398
Persons • 45, 54
PIN code • 66, 99, 103, 105, 106, 108
Place of principal business • 120, 129, 175, 231
Plug-in • 16, 403, 421
PMS • 66
PMS gateway • 66
Port • 14, 60, 403, 421
Portable Document Format • 316
Power of attorney • 294, 297, 327, 353, 357, 359, 362, 391
PPH • 219
Pre-conversion archive • 90, 158, 200, 319, 332, 393
Preferences • 57, 61, 418
Preliminary international examination • 386, 396
Preview • 31, 107, 163, 201, 230, 270, 297, 315, 338, 367
Printing • 31, 107, 163, 201
prior application • 312
Priority • 144, 197, 303
Priority claim • 144, 303, 311, 327
Priority documents • 124, 162, 185, 186, 197, 219, 259, 353
Private remark • 338
Privileges • 69, 78, 83
Procedural language • 27, 33, 57, 120, 147, 154, 163
Procedure • 16, 27, 33, 48
Proceedings • 245, 254
Proceedings before the EPO • 185
Production mode • 12, 57, 401, 407
Profiles • 69, 78, 83
Proprietor of the patent • 242, 252, 259
Proxy server • 60, 420, 421
Public research organisation • 129
Public submission • 211, 215, 217
Publications • 264
<table>
<thead>
<tr>
<th>R</th>
<th>Ready to send status • 38, 106, 346</th>
<th>Sub-tab • 118, 173, 211, 242</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Ready to sign status • 38, 58, 92, 344</td>
<td>Successor • 135, 292</td>
</tr>
<tr>
<td>R</td>
<td>Receipt • 107, 219, 259, 344</td>
<td>Summons • 248</td>
</tr>
<tr>
<td>R</td>
<td>Receiving office (RO) • 48, 88, 90, 103, 120, 124, 175, 281, 351, 353, 372</td>
<td>System settings • 61</td>
</tr>
<tr>
<td>R</td>
<td>Rectification • 353, 357, 359</td>
<td>T</td>
</tr>
<tr>
<td>R</td>
<td>Re-establishment of rights • 124, 144, 219, 259, 370</td>
<td>Tab • 41, 118, 173, 211, 242, 274, 349, 379, 402</td>
</tr>
<tr>
<td>R</td>
<td>Reference • 124</td>
<td>Technical documents • 149, 153, 154</td>
</tr>
<tr>
<td>R</td>
<td>Refunds • 165, 204, 231, 266</td>
<td>Templates • 24, 27, 28, 33, 36, 37, 110, 278, 279</td>
</tr>
<tr>
<td>R</td>
<td>Regional phase • 175, 231, 238</td>
<td>Test reports • 185</td>
</tr>
<tr>
<td>R</td>
<td>Regional priority • 144, 303</td>
<td>Thin client • 14</td>
</tr>
<tr>
<td>R</td>
<td>Registration number • 48, 54</td>
<td>Third party • 252, 259</td>
</tr>
<tr>
<td>R</td>
<td>Reimbursement • 165, 204, 231, 266</td>
<td>Third party observations • 219, 259</td>
</tr>
<tr>
<td>R</td>
<td>Remark • 338</td>
<td>TIFF file • 90, 97, 153, 158, 316</td>
</tr>
<tr>
<td>R</td>
<td>Rename application • 29</td>
<td>Time limit • 246, 254</td>
</tr>
<tr>
<td>R</td>
<td>Renaming • 24, 29, 58, 71</td>
<td>Title of invention • 31, 120, 246, 281, 352, 380</td>
</tr>
<tr>
<td>R</td>
<td>Replies • 197, 219, 259, 353, 357, 359</td>
<td>TLS • 60, 420</td>
</tr>
<tr>
<td>R</td>
<td>Representative • 134, 178, 213, 248, 252, 286, 377, 384</td>
<td>Toolbar • 20, 22, 118, 173, 211, 242, 274, 349, 379</td>
</tr>
<tr>
<td>R</td>
<td>Request • 120, 124, 175, 254, 281</td>
<td>Tool-tip • 38, 39, 40, 92, 106</td>
</tr>
<tr>
<td>R</td>
<td>Request for accelerated processing • 254</td>
<td>Traffic lights • 274</td>
</tr>
<tr>
<td>R</td>
<td>Request for accelerated search/examination • 215, 219, 227</td>
<td>Transfer of entitlement • 310, 311</td>
</tr>
<tr>
<td>R</td>
<td>Request for clarification • 219</td>
<td>Transfer of rights • 219, 259</td>
</tr>
<tr>
<td>R</td>
<td>Request for decision • 219</td>
<td>Translation • 120, 147, 154, 162, 186, 197, 219, 259, 265, 327, 353, 359, 388</td>
</tr>
<tr>
<td>R</td>
<td>Request for examination • 120, 175, 219</td>
<td>Transmission to EPO • 68, 106, 108</td>
</tr>
<tr>
<td>R</td>
<td>Residence • 120, 129, 175, 231</td>
<td>Trash • 24, 30</td>
</tr>
<tr>
<td>R</td>
<td>Restoration of the right of priority • 303, 327, 353</td>
<td>TXT file • 159, 194, 329, 365, 392</td>
</tr>
<tr>
<td>R</td>
<td>Restore • 409</td>
<td>U</td>
</tr>
<tr>
<td>R</td>
<td>Review procedure • 219</td>
<td>Unblock records • 416</td>
</tr>
<tr>
<td>R</td>
<td>Revocation • 219, 254</td>
<td>University • 129</td>
</tr>
<tr>
<td>R</td>
<td>Roles • 48</td>
<td>Update • 17, 37, 420, 424</td>
</tr>
<tr>
<td>R</td>
<td>Route • 48</td>
<td>URL • 88</td>
</tr>
<tr>
<td>R</td>
<td>RSS feed • 17</td>
<td>US priority documents • 162, 197, 219, 327</td>
</tr>
<tr>
<td>R</td>
<td>Runtime variable • 66</td>
<td>User • 12, 69, 71, 73, 75</td>
</tr>
<tr>
<td>S</td>
<td>Saving • 28, 31, 278</td>
<td>User Account Control (Windows) • 401</td>
</tr>
<tr>
<td>S</td>
<td>Search authority • 177</td>
<td>User administration • 62, 69, 401, 428</td>
</tr>
<tr>
<td>S</td>
<td>Search reports • 165, 197, 204, 219</td>
<td>User authorisation • 12, 14, 69, 76, 78</td>
</tr>
<tr>
<td>S</td>
<td>Search results • 144, 162, 197, 219, 281</td>
<td>User name • 12, 69, 71, 73, 75</td>
</tr>
<tr>
<td>S</td>
<td>Second communication • 242, 248</td>
<td></td>
</tr>
</tbody>
</table>
User preferences • 57
User reference • 27, 29, 36, 113, 115, 117, 210, 240, 276, 344
User session • 403, 416, 418
User support • 10, 18

V
Validation • 41, 143, 182
Validation icons • 41, 118, 173, 211, 242, 274, 349, 379
Validation Log • 303, 338
Validation messages • 41, 57, 274, 303, 338
Validation states • 143, 182
Variable • 66
Version • 18
View • 20, 24, 31, 41

W
WAD • 347
Waiver for communication • 175, 219
Warning • 41
Window • 41, 43
Windows 10 • 401
Windows 7 • 401
Windows 8 • 401
WIPO • 90, 103, 173, 274
Withdrawals • 219, 254, 353, 359, 362
Witnesses • 242, 248, 252, 254
Workflow • 38, 39, 40, 92, 106, 343
Working directories • 59, 419

X
XML • 66, 90, 110, 113, 115, 117, 153, 154, 319, 325

Z
ZIP file • 110, 113, 115, 158, 159, 194, 200, 332, 347, 393, 428